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1

Introduction
PLAXIS 3D is a special purpose three-dimensional finite element program used to perform deformation, stability
and flow analysis for various types of geotechnical applications.
The program uses a convenient graphical user interface that enables users to quickly generate a geometry model
and finite element mesh.
Users need to be familiar with the Windows environment, and should preferably (but not necessarily) have
some experience with PLAXIS 2D. To obtain a quick working knowledge of the main features of PLAXIS, users
should work through the example problems contained in the Tutorial Manual .
The Reference Manual is intended for users who want more detailed information about program features. The
manual covers topics that are not covered exhaustively in the Tutorial Manual. It also contains practical details
on how to use the PLAXIS program for a wide variety of problem types. The user interface consists of two subprograms (Input and Output).
The Input program is a pre-processor, which is used to define the problem geometry, to create the finite
element mesh and to define calculation phases.
The Output program is a post-processor, which is used to inspect the results of calculations in a threedimensional view or in cross sections, and to plot graphs (curves) of output quantities of selected geometry
points.
The contents of this Reference Manual are arranged according to the sub-programs and their respective options
as listed in the corresponding modes and menus. This manual does not contain detailed information about the
constitutive models, the finite element formulations or the non-linear solution algorithms used in the program.
For detailed information on these and other related subjects, users are referred to the various chapters and
papers listed in the Scientific Manual and the Material Models Manual. Additional information can be found in
Bentley Communities (https://communities.bentley.com/products/geotechnical1/w/wiki/41123/plaxis).
Some functions are only available in some specific modules. If so, the symbol of the module appears in front of
the function's name:
PLAXIS GSE features available only to users with Geotechnical SELECT subscription .
Available in Dynamics module only.
Available in PlaxFlow (Flow module) only.
A feature that is available as Tech Preview.

PLAXIS
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2

General Information
Before describing the specific features in the different parts of the PLAXIS 3D user interface, the information
given in this chapter applies to all parts of the program.

2.1 Units and sign conventions
2.1.1 Units
It is important in any analysis to adopt a consistent system of units. At the start of the input of a geometry, a
suitable set of basic units should be selected. The basic units comprise a unit for length, force and time. These
basic units are defined in the General Settings tabsheet of the Project properties window in the Input
program. The default units are meters [m] for length, kilonewtons [kN] for force and days [day] for time, seconds
[s] for dynamic time. Given below an overview of all available units, the [default] settings and conversion factors
to the default units. All subsequent input data should conform to the selected system of units and the output data
should be interpreted in terms of the same system. From the basic set of units, as defined by the user, the
appropriate unit for the input of a particular parameter is generally listed directly behind the edit box or, when
using input tables, above the input column. In all of the examples given in the PLAXIS manuals, the standard
units are used.

PLAXIS

Length

Conversion

Force

Conversion

Time

Conversion

mm

0.001 m

N

0.001 kN

s (sec)

1/86400 day

cm

0.01 m

[kN]

1 kN

min

1/1440 day

[m]

1m

MN

1000 kN

h

1/24 day

km

1000 m

lbf (pounds
force)

0.0044482 kN

[day]

1 day

in (inch)

0.0254 m

kip (kilo pound)

4.4482 kN

ft (feed)

0.3048 m

yd (yard)

0.9144 m
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General Information
Units and sign conventions
For convenience, the units of commonly used quantities in two different sets of units are listed below:

Basic units

Geometry

Material properties

Forces & stresses

International system

Imperial system

Length

[m]

[in] or [ft]

Force

[N]

[lbf] or [kip]

Time

[day]

[day]

Coordinates

[m]

[in] or [ft]

Displacements

[m]

[in] or [ft]

Young's modulus

[kN/m2]=[kPa]

[psi]=[lbf/in2] or
[ksf]=[kip/ft2]

Cohesion

[kN/m2]

[psi] or [ksf]

Friction angle

[deg.]

[deg.]

Dilatancy angle

[deg.]

[deg.]

Unit weight

[kN/m3]

[lbf/cu in] or [kip/ft]

Permeability

[m/day]

[in/day] or [ft/day]

Point loads

[kN]

[lbf] or [kip]

Line loads

[kN/m]

[lbf/in] or [kip/ft]

Distributed loads

[kN/m2]

[psi] or [kip/ft2]

Stresses

[kN/m2]

[psi] or [kip/ft2]

Units are generally only used as a reference for the user but, to some extent, changing the basic units in the
Project properties window will automatically convert existing input values to the new units. This applies to
parameters in material data sets and other material properties in the Input program. It does not apply to
geometry related input values like geometry data, loads, prescribed displacements or phreatic levels or to any
value outside the Input program. If it is the user's intention to use a different system of units in an existing
project, the user has to modify all geometrical data manually and redo all calculations.
The generation of a 3D finite element model in PLAXIS 3D is based on the creation of a geometry model. The
geometry model involves a composition of volumes , areas, lines and points. Multiple vertical boreholes can be
defined to determine the soil stratigraphy at different locations. In between the boreholes the soil layer positions
are interpolated. Soil layers and ground surfaces may be non-horizontal.

2.1.2 Sign convention
Stresses computed in PLAXIS 3D are based on the Cartesian coordinate system shown in Figure 1 (on page 13).
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In all of the output data, compressive stresses and forces, including pore pressures, are taken to be negative,
whereas tensile stresses and forces are taken to be positive. Figure 1 (on page 13) shows the positive stress
directions.
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Figure 1: Coordinate system and indication of positive stress components

2.2 File handling
All file handling in PLAXIS 3D is done using a modified version of the general Windows® file requester Figure 2
(on page 13).

Figure 2: PLAXIS 3D file requester
With the file requester, it is possible to search for files in any admissible folder of the computer (and network)
environment. The main file used to store information for a PLAXIS 3D project has a structured format and is
named <project>.P3D, where <project> is the project title. Besides this file, additional data is stored in multiple
files in the sub-folder <project>.P3DAT. It is generally not necessary to enter such a folder because it is not
possible to read individual files in this folder.
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2.3 Integrated Structural Modelling (ISM)
Note:
This feature is provided as a Technical Preview
Bentley's Integrated Structural Model (ISM) is a technology for sharing structural engineering project
information among structural modelling, analysis, design, drafting, and detailing applications. ISM is similar to
Building Information Modelling (BIM), but focuses on the information that is important in the design,
construction, and modification of the load bearing components of buildings, bridges, and other structures.
PLAXIS 3D can exchange structure information with Bentley Integrated Structural Model (ISM) repositories.

2.3.1 Purpose of ISM
There are two related purposes for ISM:
• The transfer of structural information between applications.
• The coordination of structural information between applications.
To provide for the first purpose (transferring information), ISM provides a means of defining, storing, reading
and querying ISM models.
To provide for the second purpose (coordination of information), ISM additionally provides capabilities to detect
differences between ISM models and to selectively (based on user selection) update either an ISM repository or
an application's data to provide a user-controlled level of consistency between the two data sets.

2.3.2 ISM and Application Data
ISM is not intended to store all of the information that all of its client applications contain. Rather, it is intended
to store and communicate a consensus view of data that is common to two or more of its client applications, such
as PLAXIS 3D.
PLAXIS 3D continues to hold and maintain its own private copy of project data. Some of the application data will
duplicate that of the associated ISM repository. The application data may even conflict with that in the ISM
repository. PLAXIS 3D (or the user) may decide that a conflict gives the best data for the different uses in PLAXIS
3D versus ISM.
The following lists show which information is supported for use with ISM.
Supported PLAXIS 3D object types:
•
•
•
•
•

PLAXIS

Beam (not curved)
Point (only those belonging to a beam)
Surface (not curved)
Plate (flat, may contain holes, but no curved edges like arcs)
Materials (linear-elastic only) for the above
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Supported ISM object types:
•
•
•
•
•
•
•
•

CurveMember (Not curved)
SurfaceMember (Not curved)
Node
ParametricSection
TableSection
CustomSection
Concrete
Steel

Supported ISM object properties:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Id
ShortId
Location
Material
Area
Diameter
Thickness
Depth
Width
Orientation
Section
SectionName
StandardsOrganization
Manufacturer
Revision
Nodes
Members
Openings
ParametricShapeKind
PlacementSurface
PoissonsRatio
UnitMass
ElasticModulus
SpecifiedElasticModulus

2.3.3 ISM synchronizer tools
PLAXIS 3D can send structural data to and from an ISM repository through a set of ISM Syncing tools. These tools
allow both creation and updating of PLAXIS 3D models as well as ISM repositories. Further, these flexible tools
allow you to begin models and move data as your workflow dictates.
These tools are available from the File > ISM menu:
•

PLAXIS

Create ISM Repository. Transfers the current model opened in PLAXIS 3D and generates a new ISM
repository. This is the most common way in which an ISM repository is initially created.
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•
•
•

New From ISM Repository. Creates a new PLAXIS 3D model from an existing ISM repository. This is used
to transfer model data from other tools used in the workflow.
Update ISM Repository. Will coordinate changes made to the model in PLAXIS 3D and coordinate some or
all of those changes with an existing ISM repository.
Update From ISM Repository. Allows the user to update a PLAXIS 3D model with some or all of the
changes which have been made to the ISM repository.

2.3.4 ISM synchronizer
Before using the ISM tools, you have to start the Remote Scripting Server first, by going to the menu Expert >
Configure Remote Scripting server and starting the server.
When using one of the synchronizer tools, the ISM synchronizer is opened, see Figure 3 (on page 16) .

Figure 3: ISM Synchronizer
To choose the repository, click the ellipsis button (...) and browse for the folder and file.
Once the repository is set, click the Run button to create or update a repository. Whenever necessary, the
Structural Synchronizer will open in a new window.

2.3.5 Structural Synchronizer
Note: Structural Synchronizer needs to be installed. The software can be downloaded from Bentley's Connect
Center.
When running a tool from the ISM synchronizer, the Structural Synchronizer will be opened.

PLAXIS
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The program provided by ISM for accepting or rejecting model data changes is called "Structural Synchronizer".
Structural Synchronizer provides the user with a powerful set of tools for moving data between the applications
used in a daily workflow. Even relatively small structural models have enormous amounts of data and ISM
allows this data to be re-used with ease. Care must be taken that only desired data is transferred between
applications.
When accepting changes made by client applications to an ISM Repository, some attention must be paid to what
changes are actually being made. A small change in a client application can have unintended repercussions, if
accepted. A repository is intended to represent the data that is common to all the client applications. Some client
application models will use only a subset of the repository data but changes made to them can affect the entire
repository if these changes are accepted when a repository update action is performed.
Note: This brief overview is not intended as a sufficient description on using the full capabilities of Structural
Synchronizer. Please refer to the Structural Synchronizer product documentation for more detailed information.

2.4 PLAXIS Coupling Tool
The PLAXIS Coupling Tool enables users to integrate the structural FEM package STAAD into PLAXIS 3D.
Mostly, the superstructure (above ground level) is modeled in structural FEM software by structural engineers
and the substructure (below ground level) is modeled by PLAXIS 3D, and that way the flow of information
between systems is decoupled.
As a consequence, simplifying assumptions are made to be able to handle the interaction calculations between
super- and substructure. While this works for simple cases, more complicated cases require a coupled analysis.
The PLAXIS Coupling Tool performs an iterative analysis, which will converge to a solution that satisfies
boundary conditions in both models (super- and substructure). The assumption for this type of analysis is that
the user has modeled the superstructure in a structural FEM package (STAAD.Pro) which provides an API, and
the substructure is modeled in PLAXIS 3D.

2.4.1 Coupling tool - Connection
To start working with the Coupling tool and connect PLAXIS 3D and STAAD.Pro do the following:
1.
2.
3.
4.

Start STAAD and open a project.
Start and open a project.
In PLAXIS 3D go to the Expert > PLAXIS Coupling tool menu to open the Coupling Tool.
The tool needs a running remote scripting server. If there is no server started yet, the Current state server
window will open. Set the Port and Password and click the Start server button. Once the server has started,
click the Close button to close the window.
5. The Coupling tool opens on the Connection tab, see below. The Connection tab shows the details about the
Structural solver and the PLAXIS 3D input.
6. Click the Connect button to connect to the Structual solver you have chosen in Application.

PLAXIS
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2.4.2 Coupling Tool - Model setup
The Model setup tab (see Figure 4 (on page 19)) is used to prepare both models (Structual solver and PLAXIS
3D ) for the analysis.

PLAXIS
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Figure 4: Model Setup Start

2.4.3 Load condition
First the load condition needs to be set. For the structural solver the Load case has to be selected and for PLAXIS
3D the phase has to be selected.
The phase for PLAXIS 3D is the stage in which the foundation of the model is included. For example, the user has
created the following 3 stages for a simple structure foundation construction system:
1. Initial phase
2. Foundation construction phase
3. Foundation construction phase and Structure built

2.4.4 Interaction elements
The second step is the definition of the interaction elements, by mapping a structural joint with a restraint
(structural model) to a point load (PLAXIS 3D model), within a certain coordinate tolerance.
The requirement is that, each joint must have a corresponding point load. PLAXIS 3D will detect all the joints in
the structural model that have a restraint defined, and present them in the left table.
In this table, you can choose the joints to include by setting a check mark. The table also allows you to detect if
joints are missing. In that case, go back and modify the structural model (in the structural solver) and click the
Refresh button, which will re-detect all of the joints. After determing the structural joints to be coupled are
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determined, you have to check if each of them has a corresponding point load. The point loads are shown in the
table on the right.
The tool will detect all of the point loads in the stages mode of PLAXIS 3D. If there are missing point loads, these
point loads with their coordinates will be presented in the table on the right, and there are two options. You can
create the missing point loads in PLAXIS 3D and click the Refresh button. Alternatively let the Coupling tool
create them by clicking the Auto create button.
Note that, using the first option, you have control over the mesh. For the second option, PLAXIS 3D automatically
add the points and mesh the model again.
At any point during the model setup, if you try to proceed to the Analysis tab, the tool will check whether the
load conditions and interaction elements are complete. If they are not complete, a dialog with information on
missing settings is shown and progressing to the Analysis tab is prevented. If the checks are ok, the tool will
automatically launch PLAXIS 3D output and proceed to the analysis tab.

Figure 5: Model Setup after creating point loads

2.4.5 Coupling Tool - Analysis
The Analysis tab shows information on the analysis control parameters and convergence criteria.
Click the Run button to start the iteration. You can watch the progress of the iterations on the middle section,
including status messages. Clicking the corresponding buttons, you can stop or pause the iterations in case you
estimate the error is enough, or see the analysis diverge, even though there are predetermined convergence
criteria.
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Note: The pause or stop button will not stop calculations immediately, but wait until the iteration ends. This
could take a significant amount of time.

Figure 6: Coupling tool -Analysis

2.4.6 Coupling Tool - Results
On the Results tab, you see a table with the iteration results. It shows the results for the interaction elements,
which are only the coupling related results.
The table shows the following values: error, displacement values, forces.
Model related results are in PLAXIS 3D Output and the structural solver if you wish to check them.
You can also calculate the linear equivalent spring stiffness in z direction per joint by clicking on the calculate
spring constants button, and they will be presented in the table in a column. After checking and if necessary
modifying the stiffness values, you will be able to import the springs to the structural solver by clicking the
Import springs button. The springs cannot be imported into the model that is used for analysis. You have to save
it in a different model.
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Figure 7: Coupling tool results

2.5 Help facilities
To inform the user about the various program options and features, PLAXIS 3D provides a link in the Help menu
to a digital version of the Manuals. A link is provided to the reference document of the commands used in the
program as well. Moreover, the Help menu may be used to view and configure licences. A more detailed
description of the Help menu of the Input and Output program is given in Help menu (on page 47) and Help
menu (on page 419) respectively.
Many features are available as buttons in a toolbar. When the mouse pointer is positioned on a button for more
than a second, a short description ('Note') appears, indicating the function of the button. Feedback from the
program on the user actions is given in the command line area. For some input parameters side panels appear to
help the user decide which value to select.
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To carry out a finite element analysis using the PLAXIS 3D program, the user has to create a 3D geometry model
composed of points, lines, surfaces, volumes, and other components and specify the material properties and
boundary conditions. This is done in the first two tabsheets (Soil and Structures) of the Input program (see
Figure 23 (on page 39)). The mesh generation and the definition of the calculation phases is done in the last
three tabsheets (Mesh, Flow conditions and Staged construction) of the Input program(see Figure 23 (on
page 39)).
Note:
1. The Soil and Structures tabsheets are known as Geometry modes.
2. The Mesh, Flow conditions and Staged construction tabsheets are known as Calculation modes.

3.1 Starting the Input program
This icon represents the Input program.
Start PLAXIS 3D by double clicking the shortcut on your desktop or clicking the entry in the Windows > Bentley
Geotechnical menu.
PLAXIS 3D will first check if you are entitled to use the software and present you with the available options and
licences, see Figure 8 (on page 24).
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Figure 8: Licence check
If you need to change the licence configuration, e.g. if you have to add some modules, click Configure licences.

Figure 9: Licence configuration
In the configuration dialog, see Figure 9 (on page 24), you may select the modules that you want to use.
Note:
1- The licence configuration is also available from the menu Windows > Programs and from the menu Help >
Licence configuration.
2- If you change the license configuration while PLAXIS 3D is open, you have to restart PLAXIS 3D for the
changes to take effect.
The licence administrator grants access to software licences. If you miss licences in this list, contact the licence
administrator of your company.
For more information on the Product activation wizard and the Licence management tool, see this info on
Bentley communities: Info on Product Activation/License Management.
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When you have chosen the licences to use, click Continue to start using PLAXIS 3D.
At the start of the Input program the Quick select window appears in which a choice must be made between the
selection of an existing project and the creation of a new project (Figure 10 (on page 25)).

Figure 10: Quick start window

3.1.1 New project
When the Start a new project option is selected, the Project properties window appears in which the basic
model parameters of the new project can be defined. The Project properties window contains the Project and
the Model tabsheets. The Project tabsheet (Figure 11 (on page 26)) contains the project name and description
and offers the possibility to select a company logo.
The Model tabsheet (Figure 12 (on page 27) contains the basic units for length, force and time (see Units (on
page 11)), the direction and the value of gravity, the unit weight of water and the initial dimensions of the model.
The default values can be replaced by the current values when selecting Set as default and clicking the OK
button. A more detailed description of all these options is given below.
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Project properties

Figure 11: Project properties window (Project tabsheet)
1. Project
The title, folder and the file name of the project are available in the Project group box available in the Project
tabsheet.
Title

The defined title appears as a default name for the file of the project when it is
saved.

Company

The company that holds the licence for this software.

Directory

The address to the folder where the project is saved is displayed. For a new
project, there is no information shown.

File name

The name of the project file is displayed. For a new project, no information is
shown.

2. Comments
The Comments box in the Project tabsheet gives the possibility to add some extra comments about the
project.
3. Company logo
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Clicking the Company logo box in the Project tabsheet will open a file requester from which the desired file
can be selected. This logo can be included in the output plots.

General model properties
The general options of the project are available in the Model tabsheet of the Project properties window.

Figure 12: Project properties window (Model tabsheet)
1. Gravity
By default, the earth gravity acceleration, g, is set to 9.810 m/s2, assuming the default basic length unit is [m].
The direction of gravity coincides with the negative z-axis. Gravity is implicitly included in the unit weights
given by the user (Material properties and material database (on page 190)). In this way, the gravity is
controlled by the total load multiplier for weights of materials, ΣMweight (General phase parameters (on
page 355)).
In dynamic calculations, the value of the gravity acceleration, g, is used to calculate the material density, ρ,
from the unit of weight, γ ( ρ=γ/g).
2. Unit weight of water
In projects that involve pore pressures, the input of a unit weight of water is required to determine the
effective stresses and pore pressures. The water weight (γwater) can be entered in the Model tabsheet of the
Project properties window. By default, the unit weight of water is set to 10.00, assuming the default basic
units of [kN] and [m] are used.
3. Units
Units for length, force, time, temperature, energy, power and mass to be used in the analysis need to be
specified. These basic units are entered in the Model tabsheet of the Project properties window.
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The default units, as suggested by the program, are m (metre) for length, kN (kilonewton) for force and day
for time. The corresponding units for stress and unit weights are listed in the box below the basic units.
In a dynamic analysis, the time is usually measured in [seconds] rather than the default unit [days]. In PLAXIS
3D Time and Dynamic time are different parameters. The time interval in a dynamic analysis is always the
dynamic time and PLAXIS 3D always uses seconds [s] as the unit of Dynamic time.
4. Contour
At the start of a new project the user needs to specify the contours of the geometry model. The initial setting
of the xmin, xmax, ymin and ymax parameters set the outer horizontal boundaries of the geometry model. The
initial view of the drawing area is such that the model dimensions are fully visible within the drawing area.
The aforementioned parameters are entered in the Model tabsheet of the Project properties window. The
contour of the geometry can also be modified in the drawing area when the Soil mode is selected.

3.1.2 Existing project
When the Input program is started, a list of the recent projects appears in the Quick select window. In the case
when a project other than the listed recent ones is required, the Open an existing project option should be
selected. As this selection is made, the Windows ® file requester Figure 2 (on page 13) pops up. It enables the
user to browse through all available folders and to select the desired PLAXIS 3D project file ( *.P3D). After the
selection of an existing project, the corresponding geometry is presented in the main window.
An existing PLAXIS 3D project can also be read by selecting the Open project option in the File menu. In the file
requester, the type of the file is, by default, set to 'PLAXIS 3D files *.P3D'.

3.1.3 Packing a project
The created project can be compressed using the Pack project application (Figure 13 (on page 29)),
which is available in the File menu of the Input program. This application can be executed directly from the
PLAXIS 3D installation folder by double clicking the corresponding file (PackProject.exe). A shortcut to the
application can be created as well.
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Figure 13: Pack project window
The project to be compressed and the archive can be located using the Browse button. The options available in
the Purpose box are:

Backup

All the files in the project are included in the compressed project as well as the mesh
information, phase specification and the results of all the saved calculation steps. The
extension of the project file, indicating in which program it was created, and the archiving
date are included in the archive name.

Support

Selecting this option enables including all the information required to give support for the
project at hand. Note that support is only provided to GSE users.

Custom

The user can define the information to be included in the archive.

The options for compression and volume size are available in the Archive options window (Figure 14 (on
page 30)), displayed by clicking the button in the Purpose box.
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Figure 14: Archive options window
The Content box displays the options for the information to be included in the archive is shown. The options
available are:
Mesh

The information related to geometry is included when the Mesh option is selected.
The options available are:

Phases

• Smart: When a phase is selected in the tree, the parent phase is selected automatically in
order to provide a consistent chain of phases.
• All: All the phases available in the project are selected.
• Manual: Specific phases can be selected by the user.
The results to be included in the archive can be selected. The options available are:

Results

• All steps: The results of all the calculation steps are included in the archive.
• Last step only: The results of only the last calculation step of each phase are included in
the archive.
• Manual: The results of specific calculation steps can be selected by the user.

Note that when the Backup or the Support option is selected, the Content options are automatically selected by
the program.

3.2 ProjectWise Integration Commands
When ProjectWise has been installed, four specific Integration commands are available in PLAXIS 3D.
•
•
•
•

Open…
Add…
Save…
Properties…

These commands are accessible through the File > ProjectWise menu and the toolbar.
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3.2.1 Add File to ProjectWise
To add the current PLAXIS 3D to aProjectWise repository, use the following procedure:
You must have a PLAXIS project open.
Either select File > ProjectWise > Add to ProjectWise or select the Add File to ProjectWise icon in the toolbar
.
If you have not previously logged into a ProjectWise datasource, then the ProjectWise Log in dialog opens.
Provide the Datasource and required user credentials and then click Log in.

Figure 15: ProjectWise Log in dialog
Select a Wizard dialog appears, as shown in Figure 16 (on page 31). Select any of the options - No Wizard or
Advanced Wizard.

Figure 16: Select a Wizard dialog
Selecting No Wizard opens Save Document As window (Figure 17 (on page 32)). Select the target folder. Fill
in Document name and Description. Format type should be Packed PLAXIS 3D Project.
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Figure 17: Save Document As dialog
On selecting Advanced Wizard, Advanced document creation window appears. Click Next, Select Target
folder dialog appears. Select folder, and click Next. Document Properties window appears. Fill in Document
name, Description, Version. Save as Type format should be Packed PLAXIS 3D Project. Click Next, Create a
Document window appears. Confirm the document properties and click Next. Provide the Datasource and
required user credentials and then click Log in. In the next dialog enter comments describing the document or
later the changes you have made.
Note: These comments will be visible in the Audit Trail tab in the ProjectWise Properties window.
A progress bar is displayed during the data transfer indicating the file content transfer status.
Add to ProjectWise dialog appears (Figure 18 (on page 33)), where the user can choose the corresponding
files in the project to be compressed and uploaded to ProjectWise .
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Figure 18: Add to ProjectWise
The uploaded PLAXIS project is now checked out from the ProjectWise datasource. This means that you have
exclusive access to the project. Others can only open it as 'read-only'. PLAXIS now recognizes that the current
model is linked to ProjectWise with a '[PW:Checked Out]' text appearing in the project title, and allows the File >
ProjectWise > Properties commands to become active.

3.2.2 Open File stored in ProjectWise
To open a PLAXIS file stored in a ProjectWise repository, use the following procedure:
1. Either select File > ProjectWise > Open from ProjectWise or select the Open from ProjectWise tool
from the toolbar. If you have not previously logged into a ProjectWise datasource, then the ProjectWise Log
in dialog opens, allowing you to log into a ProjectWise datasource. After logging in to the datasource, the
Open from ProjectWise dialog (Figure 19 (on page 34)) is displayed, allowing the user to browse/search
the datasource contents and select the document to open.
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Figure 19: Open from ProjectWise
2. Select a project within the ProjectWise datasource.
3. Click Open.
a. If the project has never been opened before, then PLAXIS asks to specify a local folder where the project
can be downloaded.
b. If the project has been opened before, PLAXIS will check if the local version is up-to-date, and if not, it will
be updated. If there are local changes then, there is an option to overwrite them or select a different
folder.
The ProjectWise project is checked out from the ProjectWise datasource, copied to local disk, and opened by
PLAXIS. If the project is checked out by another user then it can only be opened on 'read-only' mode. This means
that if changes are made to the local model it cannot be uploaded to the server. If the other user finishes working
on the model and checks in the project, your local copy will have conflicts with the server copy. The next time
when you open the project you will get a notification about this conflict. Then you can either overwrite your
local changes with the server copy or you can open the project from the server into a new folder.
PLAXIS recognizes that the current model is linked to ProjectWise and allows the File > ProjectWise > Save to
ProjectWise and the File > ProjectWise > Properties commands to become active.

3.2.3 Save to ProjectWise
To update the ProjectWise server copy of the file with the latest changes that have been made to the local copy of
the file, use the following procedure.
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When a PLAXIS model is either opened from a ProjectWise datasource or has been added to a ProjectWise
datasource , this functionality is active.
1.

Select File > ProjectWise > Save to ProjectWise or the Save to ProjectWise icon

from the toolbar.

The model that is currently open in PLAXIS is checked for changes. If the model has been edited since the last
save, a message is displayed asking if these changes should be saved before updating the file server copy.

Figure 20: Save project dialog
2. Click Save.
3. Refer to Add File to ProjectWise (on page 31) for further steps.
A Progress bar is displayed during the data transfer indicating file content transfer status.

3.2.4 To View ProjectWise properties
To review or edit the ProjectWise properties and metadata associated with the current PLAXIS model, use the
following procedure.
1. Select File > ProjectWise > Properties.
The ProjectWise Document Properties dialog opens.
2. Edit the ProjectWise properties and metadata as necessary.
Note: The 'Audit Trail' tab shows the edit history and the comments entered while saving changes.
3. Click Save.
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Figure 21: ProjectWise Document Properties
A Progress bar is displayed during the data transfer indicating file content transfer status.

3.3 Bentley Cloud Services
Bentley Cloud Services can be accessed from the File menu, or from the icons in the menu bar. This menu
contains the following four options:
•

PLAXIS

Associate project: this opens a separate window listing the available Bentley projects. The user can
select any of them. This will store into "Project.ConnectedProjectInfo" (available from the command line as
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read-only properties) the GUID and the name of this cloud project. This property is not reset when using
"Save as", i.e. a "saved as" project will also carry this project association.
•
•
•

Disassociate project: when there is a project association, this item removes the association between the
current PLAXIS project and the Bentley project (i.e. it resets the content of "Project.ConnectedProjectInfo").
Personal portal: This can be used at any time to open the personal Bentley portal of the user in the
default web browser.
Project portal: When a Bentley project is associated to the current PLAXIS project, this opens the project
portal in the default web browser.

Except the Disassociate project functionality, the other three requires the user to be logged in with the
Connection Client.

3.4 Exporting geometry
3.4.1 STEP and DXF format
PLAXIS 3D allows to export the geometry of the model in different formats. This is available in the File menu of
the input program (Figure 22 (on page 37)) .

Figure 22: Export geometry
The file can be saved as a *.step (Standard for the Exchange of Product model data) or *.dxf (Drawing Interchange
Format) file. The file contains the entire generated geometry in one file (not the cut geometry). This means items
such as boreholes, top soil surface and tunnel designer data are excluded, only the entities generated from those
are included (e.g. generated soil volumes, generated tunnel slices, lining, rock bolts lines). The data is purely
geometric, not annotated with features, and not divided in layers.
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3.4.2 STL format
PLAXIS 3D also allows for storing volume and surface objects in STL format. This enables, for example, the
visualisation of a PLAXIS 3D model using external 3D visualisation software, or to create a 3D print of a PLAXIS
3D model.
In order to create STL files of your PLAXIS 3D model, the following command can be used:
__saveobjects 'stl' '<folder>' (Note the double underscore!) where <folder> is the name of the folder on the
computer or network drive where the STL-files are to be stored (for example 'c:/temp'). Each volume and
surface object is stored in a separate STL-file.
Note that for 3D printing only volumetric objects can be used.

3.5 Layout of the Input program
The general layout of the Input program for a new project is shown in Figure 23 (on page 39). The main
window of the Input program contains the following items:
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Figure 23: Layout of the Input program
1. Title bar
The name of the program and the title of the project is displayed in the title bar. Unsaved modifications in the
project are indicated by a '*' in the project name.
2. Menu bar
The menu bar contains drop-down menus covering the options available in the Input program.
3. Mode tabs
The mode tabs are used to separate different workflow steps. The following tabs are available:

PLAXIS

Soil

The soil stratigraphy is defined.

Structures

The structural components of the model are defined.

Mesh

The mesh properties are defined and the geometry model is discretised and
transformed to a finite element model.
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Flow conditions

Water levels are defined.

Staged
construction

The calculation settings are defined and the project is calculated.

Note: The first two modes (Soil and Structures) are referred to as the Geometry modes, whereas the latter
three modes (Mesh, Flow conditions and Staged construction) are referred to as the Calculation modes.
For a more detailed description of the modes in the Input program see Input program structure - Modes (on
page 48).
4. General toolbar
The general toolbar contains buttons for general actions such as file operations, printing and model display
arrangement. It also contains a button to start the Output program.
Note: If the mouse is moved over a button in a toolbar, a hint about the function of this button is displayed.
5. Explorers
Information about the model and the project is given in the explorers. The availability and the functionality of
the explorers depend on the active mode.
The explorers available in the input program are:
It displays the properties of the selected geometry objects and the features assigned
Selection explorer to them and gives the possibility to hide/show, activate/deactivate these objects (
Selection explorer (on page 67)).
Model explorer

It displays the properties of all the geometry objects and the features assigned to
them in the model and gives the possibility to hide/show, activate/deactivate these
objects ( Model explorer (on page 62)).

Phases explorer

It shows the list of the calculation phases and enables adding, inserting, deleting or
modifying a calculation phase as well as the dependencies of all calculation phases (
Phases explorer (on page 67)).

Note: Selection explorer and Model explorer are referred as Object explorer
6. Side toolbar
The buttons of the features available in the active mode are located in the side toolbar. A hint on the function
of the button is displayed when the pointer is hovered over it for a few seconds. The side toolbar also
contains options to select one or more objects in the drawing area.
7. Command line
PLAXIS 3D enables to carry out actions using keyboard input by typing the corresponding commands in the
command line. On the other hand, most of the actions carried out using the mouse are translated into
commands. All the commands executed in the project are displayed when the Model history tab is clicked,
whereas only the commands executed in the active session together with the program's feedback are
displayed when the Session tab is clicked.
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Information about the available commands is provided when the Command reference option of the Help menu
is selected.
8. Drawing area
The drawing area is the workspace on which the geometry model is created and modified. The geometry
model can be created by means of the mouse and using the buttons available in the side toolbar. The buttons
in the side toolbar vary according to the active mode. A more detailed description on the drawing area is
given in Model in the drawing area (on page 49).
9. Status bar
The status bar displays information about the location of the mouse cursor in the drawing area, the model
object it is located on and a hint on snapping when a drawing tool is selected.

3.6 Menus in the Menu bar
The menu bar of the Input program contains drop-down menus covering most options for handling files,
transferring data, viewing graphs, creating a geometry model, generating finite element meshes and entering
data in general.
The availability of the menus depends on the active mode ( Input program structure - Modes (on page 48)).
The menus available in the Input program are:

3.6.1 File menu
New project

To create a new project. In case of a new project, the Project properties window is
automatically displayed to define its properties.

Open project

To open an existing project. The file requester is displayed.

Recent projects

To quickly open one of the most recent projects.

Save project

To save the current project under the existing name. If a name has not been given before,
the file requester is presented.

Save project as

To save the current project under a new name. The file requester is displayed.

Pack project

To compress the current project.

Close project

To close the current project.

Bentley cloud
services

To access to the different cloud services.

ProjectWise

To integrate PLAXIS projects with ProjectWise for infrastructure design collaboration.
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ISM
Export geometry

To create or update a (new) ISM repository ( Integrated Structural Modelling (ISM) (on
page 14)).
To export the current project. Available in Soil and Structures modes only.

Project properties

To activate the Project properties window ( Project properties (on page 26)).

Print

To print the geometry model on a selected printer.

Exit

To leave the Input program.

3.6.2 Edit menu
Undo

To restore a previous status of the geometry model (after an input error).

Redo

To redo an action that was undone.

Copy screen image

To quickly open one of the most recent projects. To copy the model image to the
Windows clipboard.

Delete

To remove an object.

Select all

To select all the selectable entities in a mode.

Deselect all

To deselect the selected entities.

3.6.3 View menu
Pan camera

To move the view in the drawing area. Note that the model is not relocated.

Rotate camera

To rotate the view in the drawing area. Note that the model is not reoriented.

Zoom in

To zoom into a rectangular area for a more detailed view. After selection, click on the
location to zoom in, or indicate the zoom area using the mouse. Click the left mouse
button at a corner of the zoom area; hold the mouse button down and move the mouse
to the opposite corner of the zoom area; then release the button. The program will zoom
into the selected area. The zoom option may be used repetitively. Alternatively, the
mouse scroll wheel may be used for zooming.

Zoom out

To zoom out of the current view, proportionally to the drawn square size.
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Reset zoom

To restore the full drawing area.

Default views

To change the orientation of the model to the views defined by the program.

Explode

To virtually disassemble the components of the project geometry. This option is
available only in the Calculation modes.

Implode

To virtually re-assemble the components of the project geometry. This option is
available only in the Calculation modes.

3.6.4 Soil menu
Modify soil layers

To modify the soil layers in the model using the borehole facility.

Select

To select boreholes and volumes in the model (Selecting geometry components (on page
90)).

Select multiple
objects

To select boreholes and volumes in the model located in the region defined using the
tool (Selecting geometry components (on page 90)).

Move object

To relocate boreholes in the model.

Adjust soil contour To modify the soil contour.
Create borehole

To create a new borehole.

Import soil

To import predefined soil volumes.

Show material

To open the material data base with material data sets.

The Soil menu is available only in the Soil mode.

3.6.5 Structures menu
Show dynamic
multipliers
Show movement
functions

PLAXIS

To open the Dynamic multipliers window.
To open the Movement functions window, see Moving loads (on page 134) for more
info.
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Select

To select entities in the model. The feature is described in Selecting geometry
components (on page 90).

Select multiple
objects

To select entities in the model located in the region defined using the tool Selecting
geometry components (on page 90).

Move object

To move or rotate structural entities in the model (Move object (on page 91) and
Rotate object (on page 91)).

Extrude object

To extrude a selection of entities (Extrude object (on page 92)).

Create array

To create multiple copies of a selection of entities (Copy object - Array (on page 95)).

Create point

To create a point in the model (Create point (on page 97)).

Create line

To create a line in the model (Create line (on page 98)).

Create surface

To create a surface in the model (Create surface (on page 105)).

Start designer

Has sub-menus: the menu Creat polycurve to create a single continuous curve
composed of lines and arcs in the model (Definition of tunnel cross section geometry (on
page 155)) and the menu Creat tunnel to start Tunnel designer ( Tunnels (on page
152)).

Create load

To create a load in the model (Loads (on page 116)).

Create prescribed
displacement

To create a prescribed displacement in the model (Prescribed Displacements (on page
121)).

Create hydraulic
conditions

To create hydraulic conditions in the model (Hydraulic conditions (on page 175)).

Import

Sub-menus to import predefined structures composed of volumes and surfaces or to
import point clouds.

Show materials

To open the material data base with material data sets.

Check geometry

To check for geometric inconsistencies in the model.

The Structures menu is available only in the Structures mode.

3.6.6 Mesh menu
Select

PLAXIS

To select entities in the model Selecting geometry components (on page 90).
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Select multiple
objects

To select entities in the model located in the region defined using the tool Selecting
geometry components (on page 90).

Check geometry

To check for geometric inconsistencies in the model.

Refine mesh

To refine the mesh locally.

Coarsen mesh

To coarsen the mesh locally.

Reset local
coarseness

To reset the fineness factor of the mesh locally to the default value.

Check geometry

To check the geometry consistency

Generate mesh

To generate the mesh for the defined geometry.

View mesh

To display the generated mesh for the defined geometry.

Select points for
curves

To select points to be considered in the plots.

The Mesh menu is available only in the Mesh mode.

3.6.7 Flow conditions menu
Select

To select entities in the model Selecting geometry components (on page 90).

Select multiple
objects

To select entities in the model located in the region defined using the tool (Selecting
geometry components (on page 90)).

Move object

To relocate a user water level in the model (Move object (on page 91)).

Create water level

To create a water level in the model.

Import water level

To import predefined water levels. More information on importing geometry is available
in Importing geometry (on page 112).

Preview phase

To preview the phase selected in the Phases explorer.

The Flow conditions menu is available only in the Flow conditions mode.
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3.6.8 Phases menu
Edit phases

To open the Phases dialog window.

Show materials

To open the material data base with material data sets.

Show dynamic

To open the Dynamic multipliers window.

multipliers
Show flow
functions

To open the Flow functions window.

The Phases menu is available only in the Flow conditions and Staged construction modes.

3.6.9 Options menu
Snap to grid

To enable or disable snapping to grid.

Show grid and
ruler

To show or hide grid and ruler.

Show cursor
location

To show the cursor location in the drawing area.

Show local axes

To show or hide local axes. Note that different colours are used to differentiate the local
axes. Red, green and blue indicate the local axis 1, 2 and 3 respectively.

Visualization
settings

To modify visualisation settings. The settings of the visualization of the program may be
changed in the Visualization settings window.

Display numbers
using

To select the Significant digits for the project.

Autocomplete

To activate or deactivate the autocomplete function in the command line.

Licencing
information

To switch on or off showing the licence information at startup.
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3.6.10 Expert menu
Examine
commands

To display the commands executed in the project and to enable their examination.

Run commands

To open the Commands runner window.

Macro library

To modify and run macros. Macros can be defined and indexed in the Macro library
window, displayed as the corresponding option is selected in the sub-menu. To run a
macro click the corresponding option in the sub-menu.

Run Python script

To configure remote scripting server and open python script to run them (Appendices
Python HTTP REST API wrapper (on page 534) and HTTP REST API (on page 560)).

Run Python tool

To configure remote scripting server and run python scripts (Appendices Python HTTP
REST API wrapper (on page 534) and HTTP REST API (on page 560)).

Python

To Configure Python Interpreter, open and use Interpreter, Editor, Command
prompt, Jupyter notebook and to run python scripts (Appendices G and H).

Configure remote
scripting server

To specify an available port and open it for connections by local or remote clients
(Appendices Python HTTP REST API wrapper (on page 534) and HTTP REST API (on
page 560)).

Calculation
manager

To easily run unattended calculations on projects (Typically less than 10 projects).

Plaxis Coupling
Tool

To start the coupling tool to integrate the structural FEM package STAAD.Pro into
PLAXIS 3D.

View files

To display the contents of the (binary) files used in the current project.

3.6.11 Help menu
Manuals

To display the manuals.

Command
reference

To display information about commands in the program.

Scripting reference To open a Jupyter notebook with examples of PLAXIS commands using the Python
scripting capabilities
Instruction movies

PLAXIS

To reach the Bentley communities website where instruction movies are displayed.
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Request support

To send a request for support.

Licence
configuration...

To view, configure and update licences.

Visit website

To reach the PLAXIS product page.

News Feed

To launch the PLAXIS latest news

Disclaimer

The complete disclaimer text is displayed.

About

Information about the program version and licence are displayed.

3.7 Input program structure - Modes
The modelling process is completed in five modes. The mode tabs are shown in the mode bar. The modes are
separated into Geometry and Calculation modes.

3.7.1 Geometry modes
The geometric configuration of the project is defined in the Geometry modes which are indicated by blue
coloured tabs in the Input program. All the changes of geometry (such as creation, relocation, modification or
removal of entities) are only possible in the Geometry modes. Features, such as structures (plates, beams),
interfaces or loads, can be assigned to geometric entities only in the Structures mode.
The Geometry modes are:

Soil

The soil stratigraphy, the general water levels and the initial conditions of the soil layers
are defined in the Soil mode. The features required to define the soil material and
stratigraphy in the geometry are available. A detailed description on modelling soil
stratigraphy is given in Material properties and material database (on page 190). Note
that the model contour and soil stratigraphy can only be edited in this mode.

Structures

The geometric entities as well as the structural elements and forces in the project are
defined in the Structures mode. Note that features, such as structures (plates, beams),
interfaces or loads, can be assigned to geometric entities only in the Structures mode.

3.7.2 Calculation modes
The calculation process is defined in the Calculation modes which are indicated by green coloured tabs in the
Input program. In these modes entities cannot be created and new features cannot be assigned to existing
geometry entities. However, the properties of the defined features (material dataset, load values) can be
modified.
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The Calculation modes are:
Mesh

The geometry model is discretised and a finite element mesh is generated in the Mesh
mode. The geometric configuration cannot be modified in this mode. The mesh should
be regenerated whenever the geometry of the project is modified.

Flow conditions

Besides water levels generated from the water conditions defined in the Soil mode, user
defined water levels can be specified and modified in this mode.

Staged
construction

Parts of the geometry model can be activated/deactivated and properties can be
modified. The project is calculated in the Staged construction mode.

Note: The Flow conditions and Staged Construction modes are known as Phase definition modes.

3.8 Model in the drawing area
The drawing area displays the physical model and is automatically updated after any change in the geometry.
The buttons in the toolbar located at the left side of the drawing area (side toolbar) can be used to create and
modify the model. The availability of the tools depends on the active mode. These features are described in the
following chapters depending on their function.

3.8.1 Model view - Zooming
To zoom in and out of the view, scroll the middle button (wheel) of the mouse. The location of the mouse cursor
is the centre of the zoom. Other options for zooming are available in the View menu or in the toolbar.
•

•
•

To define a local zooming rectangle, click the Zoom in button. The zoom area must be indicated using the
mouse. Click the left mouse button at a corner of the zoom area; hold the mouse button down and move the
mouse to the opposite corner of the zoom area; then release the button. The program will zoom into the
selected area. The zoom option may be used repetitively.
To zoom out from the current view, click the Zoom out button or select the corresponding option in the
View menu.
To restore the original view, click the Reset zoom button.

3.8.2 Selecting geometry components
•
When the Selection tool is active, a geometry component may be selected by clicking once on that
component in the geometry model. Multiple selection is possible by holding down the Ctrl key on the
keyboard while selecting the desired components.
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•

In addition to selecting geometry components one by one by using the Selection tool, several geometry
components can be selected at once by using the Select multiple objects tool. A rectangle can be drawn in the
drawing area by clicking on the first corner of the desired rectangle and moving the cursor while holding
down the mouse button. After release of the mouse button, all visible geometry components in this rectangle
will be selected.
The order in which the rectangle is created influences the selection type. Drawing from the upper left corner
to the lower right corner selects all components that fall completely inside the rectangle. Drawing from the
lower right corner to the upper left corner selects all components of which parts fall inside the rectangle.
It is also possible to select multiple geometry components of one type (for example points, lines or surfaces)
or multiple structural elements of one type (for example node-to-node anchors , beams or plates) at once by
selecting the desired sub-tool from the Select rectangle menu.

Note: Right-clicking can be used to select entities in the model. After right-clicking an entity or a multiple
selections of entities either in the drawing area or explorers, a menu appears displaying the name of the
selection and different options depending on the selection. Clicking the name of the object in the menu copies it
to clipboard. The copied name can be used in the command line ( General information on command line (on page
56)).

3.8.3 Model View - Visualisation settings
The general settings of the view are arranged in the Visualization settings window, which consists of two
tabsheets where the view options and the default visibilities can be defined.
Note: The Visualization settings window is displayed as the corresponding option is selected in the Options
menu.

View options
The display of the supporting tools (symbol, grid, global axes, etc.) in the view and their presence in the drawing
area is defined in the Visualization settings window in the Options menu.
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Figure 24: View options for drawing area
Symbol size: The size of the symbols is defined in the Symbol size dialog box. The default values are as shown
in Figure 24 (on page 51). These values can be used as a reference to get the preferred display.
Grid: The grid spacing and the number of intervals are available in the Grid dialog box. To display the grid and
ruler select the corresponding option in the Options menu. Points indicating the grid are shown in the rulers
which are displayed at the mouse cursor when a drawing tool is selected.
Global axes: The availability, the display and the origin of the global axis in the drawing area are defined in the
Global axes box.
3D view: The view of the model can be arranged according to the selected option in the Visualization settings
window. The options available are:
Most applicable

The perspective view of the model is displayed only when the corresponding option is
selected as default orientation (Model View - Orientation (on page 52)). For the other
default view options the objective view of the model is displayed.

Always perspective

The perspective view of the model is displayed regardless of the options selected as
default orientation (Model View - Orientation (on page 52)). The perspective view
mimics real life such as closer objects appear larger than far away objects, and parallel
lines vanish toward the horizon.

Always orthogonal

The model will always be displayed such that two same-size objects will appear the
same size no matter how far apart they are from each other or from the camera.

Default visibilities: The default visibility of the objects in the model can be defined in the Visibility tabsheet
(Figure 25 (on page 52)).
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Figure 25: Visibility of objects
The available options are:
•

The objects are displayed in full opacity. For individual objects in the model, right-click the object then
click Show.

•

The objects are displayed in 70 percent opacity (30 percent transparent). For individual objects in the
model, right click the object, point to Custom and then click Show 70% .

•

The objects are displayed in 30 percent opacity (70 percent transparent). For individual objects in the
model, right click the object, point to Custom and then click Show 30% .

•

The objects are displayed as wireframes. For individual objects in the model, right click the object, point
to Custom and then click Show as wireframe .

•

The objects are made completely invisible (hidden). For individual objects in the model, right click the
object then click Hide.

The default visibility of an object (or group of objects) is indicated by the letter 'A' in the explorers. The default
values for visualisation settings are shown in Figure 24 (on page 51) and Figure 25 (on page 52).
The settings defined in this tabsheet will be the default for the entities in the drawing area. However, the settings
can be modified by right-clicking on the entity either in the drawing area or in Object explorers ( Explorers (on
page 61)). The view can be shown or hidden by selecting the corresponding option. More options on the view
are available under the Custom option in the right mouse button menu.
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3.8.4 Model View - Orientation
The orientation of the view of the model can be changed to achieve better examination by either using the
default view options or by panning or rotating the view.

∙ Default view options
Default views are available both in the View menu and in the general toolbar.

Figure 26: Default view options
The Movement limitation window pops up as one of the default views, except the first (Perspective view), is
selected. The movement limitation simplifies defining three dimensional geometry. The movement limitation is
cancelled by clicking on the Perspective view button. Definition of geometry is described in detail in Drawing in
3D (on page 53).

∙ View states...
The user can save the current camera orientation under the specified name.
•

Click the View states... button to save the state view or to see the saved views.

∙ Non-default views
The model in the drawing area can be panned or rotated using the left and the middle mouse buttons. The
options are available either as buttons in the general toolbar or as options in the View menu.
•
•

Click the Pan camera button to pan holding the left mouse button pressed. To rotate the view, keep the
Ctrl key pressed while dragging the view.
Click the Rotate camera button to rotate holding the left mouse button pressed. To pan the view, keep the
Ctrl key pressed while dragging the view.

3.8.5 Drawing in 3D
Defining 3D geometry using mouse input is a difficult task considering the fact that the location in the direction
perpendicular to the view cannot be precisely defined. This part of the manual introduces the tools used in
PLAXIS 3D to enable drawing in 3D. The drawing procedure is illustrated with an example.
Note: Instruction movies describing definition of geometry in 3D are available on https://www.youtube.com/c/
BentleyGeotechnicalEngineering.
The drawing tools available in the side toolbar of the Geometry modes enable defining the geometry of the
model. When one of the drawing tools is selected, the location of the mouse cursor in the drawing area is
displayed in the status bar.
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Default movement limitation
While defining geometry, it is possible to move either in a plane or in the direction of an axis perpendicular to
the plane.
When a new project is created, the program, by default, enables movement in the xy-plane located at z=0. Note
that only the x- and y-coordinates change in the Cursor location indicator.
Holding the Shift key pressed while moving the mouse, relocates the cursor in the z- direction. While doing this,
the x- and y- coordinates remain the same, only the z- coordinate changes in the Cursor location indicator.

Defining movement limitation
Default views can be used as an assisting tool to define geometry in 3D. When one of the default views is selected,
the model view is re-oriented and the Movement limitation window pops up.
In the Movement limitation window, one of the options available in the drop-down menu can be selected as
movement plane. There are two options of movement in the direction perpendicular to the movement plane.
(x/y/z)-coordinate
is fixed

The location of the plane in the axis perpendicular to it should be defined in the
Movement plane box. As the value is defined, the coordinate will be fixed at that value
while moving in the drawing area. The coordinate is added in the Available drop-down
menu. More than one location in the perpendicular axis can be defined.

Shift moves in the
x/y/z-direction

The movement will be restricted to the perpendicular direction when the Shift key is
pressed while moving in the drawing area.

The movement limitation can be reset to default by clicking the Free movement (default) button in the
Movement limitation window or by clicking the Perspective view button in the general toolbar.
The drawing process in 3D is illustrated in the following example:
• Create a new project.
• Activate the Structures mode by clicking the corresponding tab in the Modes menu.
•
Click the Create line button in the side toolbar of the Structures mode.
• Click at (0 0 0) in the drawing area to define the first point.
• Move the mouse cursor in the drawing area. Note that only the x and y coordinates change in the cursor
position indicator. Click at (0 10 0) to define the second point.
•
Click the Back view button in the general toolbar. The model view will be re-oriented showing the back
side of the model. The Movement limitation window pops (Figure 27 (on page 55)). Note that the ycoordinate is fixed to 10.
• Click at (0 10 4) to define the third point.
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Figure 27: Movement limitation window for Back view
•

Click the Left view button in the general toolbar. The model view will be oriented showing the left side of
the model. The Movement limitation window pops. Select the SHIFT moves in x-direction option. Keep the
Shift key pressed while moving in the drawing area. The values corresponding to y and z do not change.
• Release the Shift key at x = 12 and click at (12 0 4).
•
Click the Perspective view button in the general toolbar. The Movement limitation window is closed.
• Click at the commandline. Note that the first point in the current line segment is already defined. Type 0 0 0
to define the last point and press Enter.
• Right-click to finalize the process. The resulting geometry is shown in Figure 28 (on page 55).

Figure 28: Resulting geometry of the illustration example
Note: The Movement limitation window can be closed by selecting the Perspective view option of the default
views.
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3.9 General information on command line
At the bottom of the input application, a command line panel is available. The command line provides an
alternative way of executing operations, by entering text commands. In fact, all operations in the input
application generate a command as text, that is sent to an interpreter, before being processed. It is possible to
make the command line panel into a new window, by right clicking in the command window and choosing the
option Pop out.
It is also possible to copy All commands, Successful commands or Successful responses, by selecting the desired
commands in the command line panel and right clicking the selected commands for menu options.
A feedback panel is situated above the command line panel. Here, the executed commands are shown, together
with the feedback of the command. Successful commands return green coloured feedback, consisting of details
on newly generated geometry or elements. Erroneous commands return red coloured feedback, containing an
error report.
A command consists of a command name, followed by a number of parameters. Together, they constitute the
signature of the command. The number and type of parameters depends on the particular command, and can be
zero or larger.
Commands can be divided into two types:
Global commands

Have a global scope (like the project or the geometry) that are not necessarily named in
the command, and may or may not have parameters. An example is the undo command.

Target commands

Have a local scope restricted to the selected (target) objects, such as geometric entities
and materials. An example of such command is the set command.

Command names consist of a simple string. Many commands have a short name in addition to the standard,
explicit long name (for example point and pt). Any command name can be prefixed with one underscore in
order to distinguish it from any objects bearing the same name (the commands undo and _undo are identical).
The application will always generate the commands with an underscore prefix. It is safe to omit the prefix in
hand written code. There are also commands that start with two underscores. These are mostly intended for
debugging, troubleshooting or advanced automation purposes. The underscores in those cases are not optional.
Command parameters can be of two different types:
References to objects Represented by strings containing the name of an object. The names of such objects may
not start with an underscore (_).
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Can be of many data types, such as strings, integers, floating point numbers,
enumerations and booleans.
String value parameters must be between single (') or double (") quotes, and may start
and end with either one, two or three of these quotes. Examples of valid string value
parameters are: "hello", "hello 'world'!", "Young's "modulus"".
Value

Floating point numbers must always use the dot decimal notation, even on systems that
normally use comma as decimal separator.
Enumerations may be represented either by a string value, or by the corresponding
integer index of that value.
Booleans are represented as True or False.
In most cases where a value is expected, a property of that type is also allowed - this is
indicated by a trailing single quote. For example when trying to set the x coordinate of a
point, this can be done asset point_1.x 5.2 or as set point_1.x point_2.x.

In some cases it is allowed to place parameters between parentheses, which is indicated by a trailing single
quote in the parameter signature of a command. For example a point can be made with the command point 1
2 3 or as point (1 2 3). The parentheses are optional and are mostly useful for legibility, but may in some
cases be necessary in order to distinguish between different types of calls to a given method.
In PLAXIS 3D, a global command is included that shows information on the commands that can be executed: cms.
This command lists the signatures of all commands available in PLAXIS 3D.
As an example, the signature for the delete command is shown here:
delete (del)
Material'
<1,...: Feature'>'
<1,...: Point' |Line' |GeoPolygon'>'
<1,...: Borehole'>'
Soillayer
In the first line, the command name and its abbreviation are shown. Each of the following lines shows a different
set of parameters that can be used with this command. In this example there are five different signatures for the
delete command. The delete command can be either used to delete a single material (referenced by its name),
a set of features, a set of geometric elements, a set of boreholes, or a single soil layer. Note that the signatures do
not allow a feature, a geometric element or a borehole to be deleted in one single call of delete.
Below are several examples of the delete command:
• delete SoilMat_1
• delete Volume_1 Volume_2
• delete (Volume_1 Volume_2)
Another example is the cylinder command:
cylinder (cyl)
Number' Number'
Number' Number' <Coords: Number' Number' Number'>'
Number' Number' <Coords: Number' Number' Number'>' <Coords: Number' Number'
Number'>'
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If we take a closer look at the bottommost line, the signature consists of two numbers and two sets of
coordinates. The first two parameters represent the radius and height parameters, respectively followed by the
position of the cylinder, and a vector representing the orientation of the cylinder.
An example of the cylinder command:
• cylinder 3 12 (0 0 0) (0 0 1)
• cylinder 3 12 (point_1.x point_1.y point_1.z) (0 0 1)
An extended overview and description of all available commands is accessible via the Help menu in the user
interface of the PLAXIS 3D Input program.

3.9.1 Indexing in commands
Array indexing syntax can be used in the command line. This consists of square brackets behind an object name,
followed by either an integer or a string and a matching closing bracket. Integer indexing is zero-based and
works on any listable object, i.e. any object on which you can use a filter or tabulate command. Both positive
and negative numbering is used in indexing. The positive numbering begins at the start of the list, in which 0 is
the first item from the list, while negative numbering starts from the end and goes backwards through the list. As
an example:
>line (1 2 0)(5 1 0)(5 3 0)(4 7 0)

#Create points with coordinates specified
in the brackets and lines connecting them

>tabulate Points "x y z"

#List the created points and their
coordinates

Object x y z
Point_1 1 2 0
Point_2 5 1 0
Point_3 5 3 0
Point_4 4 7 0
>move points[0] -1 -2 0

#Relocate point_1 to (0 0)

>move points[-1] -1 -2 0

#Relocate the last added point, point_4 to
(3 5)

>move points[-4] 1 2 0

#Relocate the first added point, point_1
to (1 2)

Note that the program indexes the entities in the order they are created. The indexing of features such as soil,
structural elements, loads or prescribed displacements, is NOT done according to the order of their assignment
to geometry but according to the order of creation of the geometric entities they are assigned to.
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3.9.2 Accessing Output commands in Input command line
The prefix /output allows redirecting commands to Output when they are entered in Input. This may be useful
for generating one-file scripts that also call Output, for example, selection of nodes for curves. Examples:
>/output addcurvepoint "Node" (-2.5 25 5)

#Adds curve point (-2.5 25 5) before
starting calculations in Input.

>/output update

#List the created points and their
coordinates

>/output getresults InitialPhase
"UTOT___R"

#Displays the minimum and maximum or
uniform value of the calculation results
of block 'UTOT___R' in the initial phase.

3.10 Plaxis Remote Scripting Interface
In PLAXIS 3D it is possible to design the model using Python scripting. This approach allows saving time when
many calculations of similar applications are needed. The user can use command line available in Input and
Output to run multiple commands in the Command runner, but it is also possible to use the remote scripting
interface and its Python wrapper. Both command runner and remote scripting allow the user to use commands
that are not exposed by the UI tools, as well as store and run macros using the extensive help (manuals and
references). The full list of commands with parameters information is available in the Command Reference
under the Help menu.

3.10.1 Anatomy of a command
Each command has a name and a target. Some commands may also require a parameter.

rename Point_1 "My Point"

command name
(mandatory)

target object
(mandatory)

parameter
(may be mandatory)

Figure 29: PLAXIS command
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g_i.Point_1.rename("MyPoint")

target object
(mandatory)

command name
(mandatory)

parameter
(may be mandatory)

Figure 30: Python equivalent in PLAXIS
A few examples of PLAXIS commands and their equivalents in Python:
Command: well Line_1
Python: g_i.well(g_i.line_g)
Command: tabulate (Line_1 Line_2) "First Second" "First=Point_1" }
Python: g_i.tabulate(g_i.Line_1, g_i.Line_2, "First Second", "First=Point_1")
Command: beam Line_1 "Material" BeamMat_1
Python: g_i.beam((g_i.Line_1, g_i.Line_2), "Material", g_i.Beammat_1)
Command: activate (Plate_1 Plate_2) (Phase_4 Phase_5)
Python: g_i.activate((g_i.Plate_1, g_i.Plate_2), (g_i.Phase_4, g_i.Phase_5))
Command: soil (Volume_2 Volume_3) "Material" SoilMat_1
Python: g_i.soil((g_i.Volume_2, g_i.Volume_3), "Material", g_i.SoilMat_1)
Command: rotateline (Point_1 Points[-2]) Line_1 45
Python: g_i.rotateline((g_1.Point_1, g_i.Points[-2]), g_i.Line_1, 45)
• Command name
A command represents the name of an action that is to be executed, and it is given as first word in the
command line as a global command (e.g. after g_i.) or as a specific target command (after some object) in the
scripting. It is a method that is to be implemented.
Python examples:
g_i.gotomesh()

#gotomesh is the command name

g_i.borehole(0, 0, 0)

#borehole is the command name

Point_1.echo()

#echo is the command name

• Target
The target is the object for which the method is to be implemented. It can be an object (group of objects, list),
global object, etc.
Python examples:
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g_i.gotomesh()

#the target is a global environment
object

g_i.Point_1.setproperties("x", 1, "y", 2, #the target is a global environment
"z", 0)
object
polycurve_g.close()

#the target is polycurve_g

• Parameter
Parameters represent the extra information passed to a command when it is called. In programming terms,
they are arguments to a method. In the Command line the parameters are listed after the target. In Python
scripting, parameters are supplied between the parentheses after the command's name. Some commands
may not need a parameter, and some may require one or more parameters.
Python examples:
g_i.gotoflow()

#gotoflow command called without
parameters

g_i.pointload(1, 0, 2, "Fx", 10)

#pointload command uses several
parameters to create a point load on the
point (1 0 2) and sets its force to 10

3.10.2 Geometry and calculation modes objects differences
Each object (line, line load, plate, beam, etc.) created in the Geometry mode (Soil, Structures) is named and stored
according to the general indexing rule (for more information see Indexing in commands (on page 58)). However,
when the mode is changed to the Calculation mode (Mesh, Water conditions, Staged construction), the entity gets
replaced by a different entity which may have fewer or more other properties and is stored differently. For
example, the line with name Polycurve_1 will get a new name in Calculation modes, which will now be
Polycurve_1_1, Polycurve_1_2, etc. This is done due to intersection: when changing the modes, the
geometric entity might be intersected by other objects, so the program will automatically intersect this entity,
splitting it into sub-objects.

3.11 Explorers
Explorers display information about the physical model, the calculation phases and their configuration.
Model explorer

Information related to all the objects in the physical model is given.

Selection explorer

Information related to the object (or group of objects) selected in the drawing area is
given. From a group selection, only the information valid for all the objects in the group.
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Phases explorer

A list of the calculation phases defined in the project is displayed. The Phases explorer
is available only in Calculation modes (on page 48). However, as phases are defined only
in the Phase definition modes (see notes of Calculation modes (on page 48)), it is greyed
out in the Mesh mode.

Note: The Model explorer and the Selection explorer are referred to as Object explorer.

3.11.1 Model explorer
Model explorer displays information related to the physical entities composing the model. It is automatically
updated as the model is modified (Figure 31 (on page 62)).

Figure 31: Layout of the Model explorer in different modes: Structures Mode
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Figure 32: Layout of the Model explorer in different modes: Staged construction Mode
The information displayed in the Object explorers varies according to the active mode. Information related to
geometry, such as location coordinates, is given in all modes, however it can only be edited in Geometry modes.
The visibility of the model components is indicated and can be modified in the Object explorers in all the modes
of the program. However, activation/deactivation is possible only in the Staged construction mode.
The information displayed in the Object explorers depends on the active mode. The information is grouped under
different categories.
Attributes library:The Attributes library contains global attributes that have been defined and that have been
(can be) assigned to individual objects. An example of such an attribute is a material data set with properties.
Other types of attributes are functions that describe time-dependent conditions, such as Dynamic multipliers or
Flow functions. These functions can be assigned to dynamic loads and hydraulic boundary conditions,
respectively, in order to describe the variation of a condition with time. Finally, the Attributes library contains
the set of water levels that have been created from the information in the boreholes, the soil clusters and the
user-defined water levels.
Dynamic multipliers

All the displacement and load dynamic multipliers defined in the project are listed under
Dynamic multipliers.

Flow functions

All the flow functions (Head functions and Discharge functions) defined in the project are
listed under Flow functions.

Materials

All the material sets assigned to the entities in the model are listed under Materials. The
identification and the colour representing the material data set are displayed.
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All the water levels created in the model are listed.
Water levels

• Borehole water levels: The water levels generated according to the water
conditions defined in the boreholes are listed.
• User water levels: The water levels created in the Flow conditions mode are listed.
Note that the Water levels subtree is available only in the Calculation (green) modes.

Since these attributes are Global, any change in such an attribute will affect the model as a whole. If it is the
intention to change an attribute only in a particular calculation phase, it is advised to duplicate the attribute
using the corresponding option in the right-hand mouse menu, and make the change in the copy.
Stratigraphy: The soil layers and boreholes created in the model are listed under Stratigraphy. For each
borehole, the x and y coordinates of each borehole and the Head level are given.
Information about boreholes is available in the Model explorer only in the Geometry modes. The values of
coordinates and Head can be modified in the corresponding cells.
Geometry: All the geometric entities created in the model are listed under Geometry. Note that when a
geometric entity is created, its sub-entities are automatically created by the program. When a line is created, the
first (start) point and the second (end) point are automatically created. New geometric entities are also
automatically created when a geometric entity is decomposed.
The available sub-groups :

Points

The points created in the model are listed. For each point, the coordinates of its location,
the features assigned and their properties are given. Features such as Point load, Point
prescribed displacement and Fixed-end anchor can be assigned to points. More
information on points is given in Create point (on page 97).

Lines

The lines created in the model are listed. For each line the coordinates of its first and
second points, the features assigned and their properties are given. Features such as
beam, embedded beam, line load, line prescribed displacement and node-to-node anchor
can be assigned to lines. More information on lines is given in Create line (on page 98).

Surfaces

The surfaces created in the model are listed. For each surface the coordinates of its
reference point, the local coordinate axes, the features assigned and their properties are
given. The flat surfaces created by either using the Create surface tool or by
decomposing imported volumes or surfaces are listed as polygons. The imported
surfaces are listed as surfaces. Features such as plates, surface loads or surface
prescribed displacements can be assigned to surfaces. More information on surfaces is
given in Create surface (on page 105).

Volumes

The volumes created or imported in the Structures mode are listed. For each volume the
coordinates of its reference point and the material data set assigned to it is given. Note
that the Import structural volume option is available only for GSE. More information on
volumes is given in Create volume (on page 107).

Soil volumes

The soil volumes generated according to the soil layers in boreholes or imported in the
Soil mode (Material properties and material database (on page 190)) and the material
data sets assigned are given. Note that the Import soil volume option is available only for
GSE.
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Polycurves

The polycurves created in the model are listed. For each polycurve the sections
composing it and their properties as well as the components of the vectors defining the
Direction axes of the polycurve are given. More information on polycurves is given in
Create polycurve (on page 99).

Note: In the Geometry modes, coordinates indicating the location of geometric entities are in the Model explorer.
It is possible to relocate the points by changing these coordinates. Note that this is not possible in the Calculation
modes, where geometry modifications are impossible ( Input program structure - Modes (on page 48)).
Note: In the Calculation modes, the Coarseness factor is given indicating the local refinement of the mesh at the
geometric entity. The mesh can be refined or coarsened locally by modifying this value.
Connections: All the connections created explicitly by the user in the Staged construction mode are listed. This
option is available in the Model explorer only in the Phase definition modes.
Beams: All the beams created in the model are listed. Information about the assigned material is given for each
beam.
Embedded beams: All the embedded beams created in the model are listed. Information about the assigned
material and the connection type is given for each embedded beam.
Soils: All the soils created in the model are listed. Information about the assigned material, volumetric strain and
water conditions is given for each soil.
Plates: All the plates created in the model are listed. Information about the assigned material is given for each
plate.
Geogrids: All the geogrids created in the model are listed. Information about the assigned material is given for
each geogrid.
Surface loads: All the surface loads created in the model are listed. The distribution and the values of the load
components can be defined.
Contractions: All the contractions created in the model are listed. The distribution and the values of the
contractions can be defined.
Surface prescribed displacement: All the surface prescribed displacements created in the model are listed.
The distribution and the values of the prescribed displacement components can be defined.
Line loads: All the line loads created in the model are listed. The distribution and the values of the load
components can be defined.
Line prescribed displacement: All the line prescribed displacements created in the model are listed. The
distribution and the values of the prescribed displacement components can be defined.
Point loads: All the point loads created in the model are listed. The values of the load components can be
defined.
Point prescribed displacement: All the point prescribed displacements created in the model are listed. The
values of the prescribed displacement components can be defined.
Interfaces: All the positive and negative interfaces created in the project are listed. Either the material of the
adjacent soil or a new material can be assigned. Permeability condition can be specified.
Node-to-node anchors: All the node-to-node anchors created in the model are listed. Information about the
assigned material is given for each node-to-node anchor.
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Fixed-end anchors: All the fixed-end anchors created in the model are listed. Information about the assigned
material is given for each fixed-end anchor. The components and the equivalent length can be defined for each
fixed-end anchor.
Surface groundwater flow BC's: All the surface groundwater flow boundary conditions created in the model
are listed. Information about the assigned behaviour (Seepage, Closed or Head), is given for each boundary
condition. The assigned behaviour can be changed by selecting the option in the Behaviour drop-down menu.
Wells: All the wells created in the model are listed. The behaviour (Extraction, Infiltration), the discharge (|
qwell|) and the minimum head (hmin) can be defined for each well.
Surface drains: All the surface drains created in the model are listed. The head can be defined for each surface
drain.
Line drains: All the line drains created in the model are listed. The head can be defined for each line drain.
Model conditions: The general boundary conditions of the model as a whole for each calculation phase can be
specified in the Model conditions subtree in Model explorer. The conditions at the extremities of the model are
considered. This makes it possible to make a quick selection of general boundary conditions that apply to the
model as a whole. The Model conditions subtree is available in the Calculation modes in the Input program.
Modification of the information given in the Model conditions subtree is possible only in the Flow conditions and
Staged construction modes. Note that any change in the model boundaries is applied only to the phase selected in
Phases explorer.
The options available are:

Deformations

A set of general fixities is automatically applied to the boundaries of the geometry model
for the selected calculation phase. More information on default fixities is given in Model
conditions (on page 389). The default general fixities are removed when the
corresponding option is set to False. In that case it is required to set the appropriate
boundary conditions manually.

Dynamics

The model conditions for a dynamic analysis can be defined at the extreme boundaries
of the model. The options available are None and Viscous. Besides the boundary
conditions, the relaxation coefficients (C1 and C2) can be defined for each phase. For
more information on boundary conditions for Dynamic calculations see Model
conditions (on page 389).

GroundwaterFlow

The model conditions for a groundwater flow calculation, a consolidation analysis or a
fully coupled flow-deformation analysis can be defined at the extreme boundaries of the
model. The options available are Open and Closed.

Precipitation

This option can be used to specify a general vertical recharge or infiltration (q) due to
weather conditions to all boundaries that represent the ground surface. Other types of
flow boundary conditions can be defined using the corresponding feature in the
Structures mode (Hydraulic conditions (on page 175)).
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This option can be used to specify a global acceleration to model dynamic forces in a
pseudo-static way. The input values of the x- and y-acceleration components are
expressed in terms of the normal gravity acceleration g
-a

g

r

r

r

PseudoStatic

r

(r = resulting direction)

Figure 33: Resulting force direction r due to combinations of gravity and pseudo-static
acceleration

Water

The global water level for a selected calculation phase can be assigned in the Water
subtree under Model conditions in Model explorer. More information of the usage of the
global water level is given in Global water level (on page 350).

Note: The reference level, href, is likely to coincide with the ground surface, but may also be taken above or below
the ground surface. In case href is below the ground surface, the temperature at the ground surface is set equal to
the reference temperature, as defined in the Constants tabsheet of the Project properties window ( Project
properties (on page 26)). The temperature distribution from the ground surface to href is then obtained from a
steady-state thermal flow calculation, whereas the temperature distribution below href is obtained from Tref and
the earth gradient.

3.11.2 Selection explorer
The Selection explorer displays information about the selection made in the drawing area. For multiple objects,
the common information is displayed. The structure of the Selection explorer is the same as the one of the Model
explorer.

3.11.3 Phases explorer
The Phases explorer is available in the Calculation modes in the Input program. It visualises the order of the
calculation phases and it provides information for each calculation phase (e.g. calculation status, calculation
type, loading type, etc.). Modification of the information given in the Phases explorer is possible only in the Flow
conditions and Staged construction modes. More information on the Phases explorer is given in Figure 34 (on
page 68).
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Figure 34: Phases explorer
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Ground modelling - Soil mode
The soil stratigraphy is defined in the soil mode using the Borehole feature of the program. When a new project
is created, the soil contour defined in the Project properties window is displayed in the drawing area.

Figure 35: View of a new project in the Soil mode

4.1 Adjustment of the soil contour
•

PLAXIS

The model contour can be defined using the options available in the side toolbar. To modify the model
contour click the Adjust soil contour button. The contour is defined in the drawing area. The buttons in the
expanded menu can be used to modify the model contour.
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•
•
•

Click the Move contour points/lines button and drag any point or line in the contour to a new location.
Click the Insert contour points button, click the contour where a new point is to be defined and drag it to
the desired position of the new point. The soil contour will be modified accordingly.
Click the Delete contour points button and click the contour point that is to be deleted.

Besides the expanded menu, the Surface points window pops up displaying the coordinates of the points
defining the model contour. Points defining the contour can be relocated by entering the coordinates of the new
location in the table. The options to move, insert and delete contour points are available in the menu appearing
as the contour point number is right clicked in the table. A more detailed description on Surface points window
is given in the Create surface (on page 105).

4.2 Creating boreholes
Boreholes are locations in the drawing area at which the information on the position of soil layers and the water
table is given. If multiple boreholes are defined, PLAXIS 3D will automatically interpolate between boreholes,
and derive the position of the soil layers from the borehole information. Each defined soil layer is used
throughout the whole model contour. In other words, all soil layers appear in all boreholes. The top and the
bottom boundaries of the layers may vary through boreholes, making it possible to define non-horizontal soil
layers of non-uniform thickness as well as layers that locally have a zero thickness.

4.2.1 Creating new boreholes
To create a borehole click Create borehole and click on its location in the drawing area. The Modify soil
layers window pops up (Figure 36 (on page 71)). Boreholes and soil layers can be modified in this window.
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Figure 36: Modify soil layers window
To add new boreholes in the Modify soil layers window:
• Click Boreholes (lower button) and select the Add option. The Add window pops up (Figure 37 (on page
71)).
• In the Add window define the position of the new borehole (x and y coordinates).
• Define the source borehole to copy initial layer boundaries from. By default, the source borehole is the
nearest one.

Figure 37: Add borehole window
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Note: A warning message appears in the Modify soil layers window when multiple boreholes are located at the
same position.

4.2.2 Creating multiple boreholes
To create multiple copies of existing boreholes organised in a rectangular pattern:
• In the Modify soil layers window, click Boreholes and select the Add array option. The Add borehole array
window pops up (Figure 38 (on page 72)).
• To select the source borehole click the corresponding check box. The thickness of the layers in the new
borehole is equal to that in the source borehole.
• Select the appropriate option in the Shape drop-down menu.
• Define the number of columns (and/or rows) and the distance between them. A detailed description of the
Array feature is given in Copy object - Array (on page 95).

Figure 38: Add borehole array window
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4.2.3 Editing boreholes
Boreholes are named consecutively by the program. Boreholes can be renamed in the Model explorer and in its
soil column in the Modify soil layers window. When changing the name, use just letters, digits, and the only
allowed special character (underscore ‘_’). The location of a borehole can be changed by specifying the
coordinates of the new location in its soil column in the Modify soil layers window.
To relocate a borehole in the Drawing area:
•

Click the Move borehole button in the side toolbar.
• In the drawing area select the borehole and drag and drop it to the new location.
The interpolation of layer boundaries is automatically adapted according to the new borehole position.
The display of the boreholes in the Modify soil layers window is managed using the options in the menu
appearing as the Boreholes button is clicked.
Add...

To create a new borehole.

Add array...

To create multiple boreholes organised in a rectangular pattern.

Select

The boreholes to be displayed in the Modify soil layers window are selected.

Show all

All the created boreholes are shown.

Hide all

All the created boreholes are hidden.

Invert visibility

The view of the Modify soil layers can be inverted to selected or unselected boreholes.

Sort by

The appearance order of the boreholes in the Modify soil layers window can be
arranged according to the Creation order, Name and Position.

4.3 Soil layers
The first borehole, created at the start of a new project, contains no soil layers. Soil layers in boreholes are
defined in the Modify soil layers window.
The Modify soil layers window contains the following items (Figure 36 (on page 71)):
Soil column

Graphs of all boreholes with indication of their locations, water head, layer boundary
levels and soil material.

Upper buttons

Buttons to add, insert or delete soil layers.

Soil layers tabsheet

Table showing the boundaries and the materials of the soil layers.

Water tabsheet

Table showing the water conditions in every layer and the top and bottom pressure
values per borehole in each layer boundary.
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Initial conditions
tabsheet

Table showing the name, material model and the initial stress ratio, K0x and K0x, for all
soil layers.

Preconsolidation
tabsheet

Table where pre-overburden pressure (POP) can be defined.

Surfaces tabsheet

This tabsheet enables the import of predefined top and bottom soil surfaces.

Field data tabsheet

This tabsheet enables the import of CPT measurements. More information on the usage
of CPT logs to generate the soil stratigraphy is given in Generating soil stratigraphy from
CPT logs (on page 82).

Bottom buttons

Buttons to add, select, visualize or sort boreholes, to open the material database and to
accept (Ok) the soil layers. Pressing Ok closes the Modify soil layers window.

4.3.1 Creating soil layers in boreholes
Soil layers are created using the top buttons in the Soil layers tabsheet.
Add

To add a new layer below the lowest layer in the model.

Insert

To insert a new layer above the selected one.

The thickness of the new layers is zero length units by default. The thickness of the top soil layer in a borehole
can be changed by modifying its Top and Bottom boundaries. The top boundary of an underlying layer is defined
by the lower boundary of the overlying layer. To change the thickness of such a layer, the user can alter the
Thickness option in the Zones of the soil layer under Stratigraphy tree in the Model explorer or simply by
changing the bottom boundary of this soil layer.
If a new borehole should contain a layer that does not exist yet, this additional soil layer may be added using the
Add or Insert buttons. In principle, this action creates a new soil layer in all existing boreholes, but the new layer
has a zero thickness in all the boreholes that have been defined earlier to ensure that existing layer distributions
are not influenced by this action. In the current borehole the layer thickness can be modified according to the
description given in the previous paragraph.
An existing layer may be removed by right-clicking it, either in the tabsheet or in the Soil column, and select the
option Delete in the appearing menu. It should be noted that the layer will be deleted in all the boreholes of the
project. If a layer is selected and the Delete button is clicked, the Delete soil layer window will appear (Figure
39 (on page 75)).
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Figure 39: Delete soil layer window

Assigning soil properties
If a certain soil layer does not exist at the position indicated by a model borehole, it should be assigned a zero
thickness (bottom level equal to top level) in the relevant borehole of the model.
Different soil layers will have different properties. Individual layer properties can be defined in material data
sets. Material data sets are contained in the material database. There are several ways to assign material
properties to a soil layer in the Modify soil layers window. You can:
• Click the Materials button. The Material sets window pops up. Drag and drop the material to the
corresponding layer either in the tabsheet or in the soil column.
• Click the material either in the Soil layers tabsheet or in the Initial conditions tabsheet. Select the material
from the drop-down menu of defined material sets.
• Right-click the soil layer in the tabsheet, point to Set material and then click the material you want to assign.
The colour of the layer in the geometry indicates the material set assigned. The procedure of assigning material
datasets to soil layers should be repeated until each layer has its appropriate data set. The names and colours of
the material data sets for all layers are shown in the Soil layers tabsheet. If the material data set of a layer is
changed in a borehole, the same change will be applied to the same layer in all other boreholes.
To assign material to soil layers in the drawing area in the Soil mode:
•

Click the Show materials button in the side toolbar. The Material sets window pops up.
• Drag and drop the material to the corresponding layer.

4.3.2 Defining water conditions
Groundwater and pore pressures play an important role in the soil behaviour. PLAXIS 3D is based on effective
stress principles, in which total soil stresses are divided into effective stresses (in the grain skeleton) and pore
pressures (in the pores of the soil). This requires a proper definition of water conditions. In many cases
groundwater flow can be neglected and the (steady-state) pore pressure distribution in the ground is more or
less known from in-situ soil investigation data. In this case the definition of water conditions can be conveniently
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related to the creation of boreholes, which forms the basis for a direct generation of pore pressures. In situations
where groundwater flow occurs, the pore pressure distribution is not necessarily a priori known, and it may be
required to perform a groundwater flow calculation in order to generate the pore pressures in the soil. More
details on groundwater flow calculations and the definition of hydraulic boundary conditions are given in
Hydraulic conditions (on page 175). The current section deals with the definition of water conditions in
boreholes for a direct generation of pore pressures.
The water conditions of the soil layers can be defined for each borehole in the Water tabsheet by selecting one
of the options available in the drop-down menu for each soil layer. There are two columns for each borehole
showing the values of the pore pressure distribution at the top (ptop), and the bottom (pbottom) of each soil layer.
Note that pressure is considered to be negative.

Figure 40: Water tabsheet of the Modify soil layers window
The options for water conditions are:

Head

The pore pressures are generated according to the specified head (phreatic level or
water level) in each borehole. The generated pore pressure distribution is visualised in
the soil column of the borehole. A head level lower than the top level of the layer, is
indicated by a positive value (suction) at the top (ptop). However, positive pore stresses
are not shown.

Hydrostatic

The pressure value at the top boundary of the soil layer is to be defined. The program
will calculate the pore pressure distribution in the soil layer accordingly, taking into
account the unit weight of water.

Interpolate

It enables linear vertical interpolation of the pore pressure distribution of the layer from
the pressure in the boundary with the layer above to the pressure in the boundary with
the layer below the current layer.
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Dry

To remove water pressures from a soil layer select the Dry option. The value of pore
pressure at the upper level of the layer (ptop) and the value of the pore pressure at the
bottom level of the layer (pbottom) will be zero and no pressure will be generated in the
layer.

User-defined

Positive and negative values can be assigned to the top and bottom levels of the soil
layer. The pore pressure distribution in the soil layer is interpolated linearly from these
values. However, in the borehole only negative pressure values will be visualised. Note
that PLAXIS 3D can deal with positive pore water stresses (suction) in calculations.
Defining a positive value at the top of the layer and a negative value at the bottom means
that there is a phreatic level in the layer.

The program generates water levels according to the information provided in the Water tabsheet. Water levels
can represent external water levels as well as phreatic levels in the soil. The water level created according to the
Head levels in the boreholes is automatically assigned as Global water level in the calculation phases. A more
detailed description is given in Flow conditions (on page 373).
By default, positive pore water stress (suction) in the unsaturated zone above the phreatic level is ignored.
However, PLAXIS 3D can deal with suction in calculations. This requires the selection of an appropriate soil
water retention curve in the material data set (Groundwater tabsheet (on page 248)). It also requires that
suction is allowed during the calculations (Flow control parameters (on page 371)).

4.3.3 Initial Conditions of Soil
The Initial conditions tabsheet in the Modify soil layers window offers (Figure 41 (on page 78)) shows the
soil model and the parameters. Double clicking one of these values in the Initial conditions tabsheet opens the
corresponding material dataset in the material database.
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Figure 41: Initial conditions tabsheet of the Modify soil layers window
The initial stresses in a soil body are influenced by the weight of the soil, the water conditions and the history of
its formation. This stress state can be generated using either the K0 procedure or Gravity loading. The generation
of initial state stresses is described in Initial stress generation (on page 328).
If the K0 procedure is used, proper K0 values need i.e. the initial ratio between horizontal effective stress and
vertical effective stress needs to be specified for all layers. Two K0 values can be specified, one for the x-direction
and one for the y-direction.

4.3.4 Preconsolidation
The way to generate initial preconsolidation stress is defined in the Preconsolidation tab in the Modify soil
layers window. It is on the POP or OCR data provided in the Initial tab in the material data set (Figure 42 (on
page 79) and Initial tabsheet (on page 264)). Preconsolidation is most relevant when using advanced
constitutive models that include preconsolidation pressure as a state parameter to distinguish between primary
loading behaviour and unloading or reloading behaviour. In addition, preconsolidation may also be used to
initialise a state parameter σ'1,max that is later used to account for the stress history to (re)initialise other (state)
parameters. This is, for example, the case with SHANSEP type models, which are available as user-defined soil
models in PLAXIS.
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Figure 42: Initial tabsheet in the Soil window
The POP values for each stress point are used for the initialisation of the preconsolidation stress ( σ'1,max), which
is initialised in the initial phase and kept updated over all calculation phases as a general state parameter). In the
SHANSEP NGI-ADP and the SHANSEP MC models, the undrained shear strength is calculated according to the
preconsolidation stress. In the Hardening Soil model, Hardening Soil model with small-strain stiffness, Soft Soil
model, Soft Soil Creep model, Modified Cam-Clay model and Sekiguchi-Ohta model, the yield surface is defined
consistently with the defined stress history of the soil. The POP (or OCR) is used to calculate the σ'1,max at the end
of the Initial phase calculation. In the subsequent calculation phases, σ'1,max is compared to the current σ'1,max
and updated if exceeded.
The two POP values are defined From material (Figure 43 (on page 80)), which means the preconsolidation
stress is calculated based on the information (OCR or POP) as defined in the material data sets.
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Figure 43: The Preconsolidation tabsheet of the Modify soil layers window
Note:
• All soil layers defining POPtop and POPbottomfor one borehole result in a POP variation only in vertical
direction.
• All soil layers defining different POPtop and POPbottom for multiple boreholes result in a POP variation both
vertically and horizontally.

4.3.5 Surfaces
By default, the ground level surface and the bottom layer of the soil are modelled using the information provided
by boreholes, as indicated by the From boreholes option in the Surfaces tabsheet (Figure 44 (on page 81)). The
surface level between two boreholes is linearly interpolated. Alternatively, predefined surfaces can be used to
define the top and bottom surfaces of the soil volume using a single borehole.
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Figure 44: Surfaces tabsheet of the Modify soil layers window
In order to use predefined surfaces, the Custom option in the Surfaces tabsheet is selected. Next by clicking on
the button Import an Import (top/bottom) soil surface window appears from which the desired surface can be
selected.
Once the surface is imported, it can be further converted to a NURBS surface, by selecting the checkbox Convert
to NURBS. The purpose of this option is to enable the conversion of a triangulated surface consisting of multiple
triangles into an effective parametric surface that is described as a NURBS surface (Non-uniform Rational Bspline). The NURBS surface is an approximation and it is generated along a grid. The user provided surface is
sampled along a grid and B-spline curves are generated in both directions along the grid. From the B-spline
curves the NURBS surface is generated. The grid points may be changed in both direction if the resulting surface
is not satisfactory.
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Figure 45: Importing of custom soil layers

4.3.6 Generating soil stratigraphy from CPT logs
Cone Penetration Tests (CPT) are commonly used in geotechnical engineering practice to determine the
stratigraphy and the type of materials, to estimate geotechnical parameters and to provide results for direct
geotechnical design.
The test offers continuous measurements of the cone resistance (qc) and the sleeve friction (fs) along the depth.
In the case of Cone Penetration Test with pore pressure measurement (CPTu) also the pore pressure (usually
behind the cone, u2) is measured.
In PLAXIS 3D, it is possible to load the data of a CPT test and use the Robertson method for the interpretation of
the soil stratigraphy or the CUR 3 layers system for data interpretation. The CPT-based chart (Robertson et al.,
1986 (on page 509)) is predictive of the soil behaviour type (SBT) and not directly of the soil classification
criteria based on grading and plasticity (USCS, Unified Soil Classification System) but there is often good
agreement between the two types of classification.
The soil stratigraphy in a borehole can be specified using available CPT logs. More information on the required
format is given in Appendix A.

Robertson Method
The Robertson classification is based on the non-normalised cone resistance which allows to identify 9 different
areas with different behaviour. A simplified approach to assign the SBT to each measurement point consists of
calculation of the index ISBT. This index allows to identify only the soil layers with SBT from 2 to 7 (Figure 46 (on
page 83)).

PLAXIS

82

PLAXIS 3D-Reference Manual

Ground modelling - Soil mode
Soil layers
To simplify the application of the CPT charts, the cone resistance and the friction ratio can be used to calculate
the SBT index, ISBT, where the index is the radius of the concentric circles that represent the boundaries between
the zones. Based on predefined ranges, it is possible to determine the SBT zone for each point.
The index ISBT is given by the following equation:

(

I SBT = 3.47 - log

( ))
qc
pa

2

+ (log (R f ) + 1.22)2

0.5

Eq. [1]

Figure 46: SBT chart based on cone resistance (qc/pa) and friction ratio Rf, showing contours of ISBT (after
Robertson et al., 1986)SBT chart based on cone resistance (qc/pa) and friction ratio Rf, showing contours of ISBT
(after Robertson et al., 1986)
Note:
• Note that the value of pa should be in the same units as the unit system selected in the Project properties
window.
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• Be careful when importing CPT data as simple text files, since the information (in terms of depth, qc and fs)
should be expressed in the same unit system as the one chosen in PLAXIS.
The soil layers can be subdivided considering the following intervals:
ISBT

Soil type

Description

ISBT > 3.60

2

Organic soil - peat

2.95 < ISBT < 3.60

3

Clays: clay to silty clay

2.60 < ISBT < 2.95

4

Silt mixture: clayey silt and silty
clay

2.05 < ISBT < 2.60

5

Sand mixtures: silty sand to sandy
silt

1.31 < ISBT < 2.05

6

Sands: clean sand to silty sands

ISBT < 1.31

7

Dense sand to gravelly sand

ISBT

Colour

ISBT>3.60
2.95<ISBT<3.60
2.60<ISBT<2.95
2.05<ISBT<2.60
1.31<ISBT<2.05
ISBT<1.31

Figure 47: Colour scheme adopted in PLAXIS 2DPLAXIS 3D representing different layers for different ISBTPLAXIS
3D representing different layers for different ISBT

Importing CPT data
To import CPT data:
• Create a borehole in the model corresponding to the location at which CPT data are available.
• Proceed to the Field data tabsheet by clicking the corresponding tab in the Modify soil layers window.
•
Add field data by clicking the green plus button and select the file containing the data in the Open Field
data window. The available logs are listed in the Field data tabsheet.
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•
Click the expansion button next to the borehole.
• Select the data to be considered from the Field data drop-down menu.
• Select the Interpretation method, either the Robertson option or the CUR 3 layers method. The CUR 3 layers
criteria are shown in Figure 47 (on page 84)
• Enter the minimal layer thickness (Minimal thickness option) to be considered in layer generation to avoid
multiple thin layers. The expanded Modify soil layers window is shown in Figure 49 (on page 86).
• Click Apply layers to subdivide the soil cluster into the layers shown in the borehole.

qc [MPa]

Sand

1.5

Silt

Peat

Clay

1.0

0.5

0.0

1.0

2.0

3.0

4.0

5.0

Rf=fs/qc[%]

Figure 48: Layering criteria for CUR 3 layers methodCUR 3 layers method
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Figure 49: CPT data in the Modify soil layers windowModify soil layers window
Note:
• When soil stratigraphy is generated from CPT logs the created layers will be applied to the whole model.
Boreholes can be used to modify the layer thicknesses at their location.
• However only one CPT log can be used in a project. Generation of layers resulting from a new CPT log will
overwrite the existing ones.

4.4 Importing soil layers
In the Soil mode, the geometry of the soil can be imported by clicking the Import soil button available in the
side toolbar or by selecting the Import soil option available in the Soil menu. Note that only surfaces and volumes
can be imported. When importing a geometry file, a list of possible file extensions are shown. The supported file
types are:
File extension

Description

*.dxf

AutoCAD interchange files.

*.brep

OpenCascade shape files.

*.step

3D STEP files.

*.stp

3D STP files.
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Figure 50: The Import soil volumes window
Before importing *.dxf files, the INSUNIT global variable should be set to the desired unit Table 1 (on page 87).
Table 1: Default drawing units for AutoCAD blocks

PLAXIS

Unit

INSUNIT value

Unitless

0

Inches

1

Feet

2

Miles

3

Millimeters

4

Centimeters

5

Meters

6

Kilometers

7

Microinches

8

Mils

9

Yards

10
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Unit

INSUNIT value

Angstroms

11

Nanometers

12

Microns

13

Decimeters

14

Decameters

15

Hectometers

16

Gigameters

17

After selecting the file, the Import soil volumes window pops up (Figure 50 (on page 87)), where the geometry
can be modified. It is possible to import only volumes by keeping the corresponding option checked in the
Import soil volumes window.

4.4.1 Scaling
The imported geometry can be scaled by defining a factor for scaling in all directions.

4.4.2 Axis transformation
The orientation of the imported geometry might need to be modified in order to be properly mounted in the
project.
Source vertical axis

It enables reorienting the imported geometry such that the vertical axes of the imported
geometry and the program coincide. The source vertical axis enables axis
transformation according to the right hand rule of rotation. Note that the vertical
direction in PLAXIS 3D is the z-axis.

Mirror y-axis

The geometry will be transformed such that the values of y coordinates will be changed
to -y; coordinates (effectively in the xz-plane).

Swap x-axis and yaxis

The geometry will be transformed such that the values of x coordinates will be changed
to y coordinates and vice versa.

4.4.3 Insertion point
When a geometric object is imported, its reference point can be chosen in three different ways:
Minimum of
imported model
boundaries

PLAXIS

The insertion point is automatically chosen as the minimum value of the model
boundaries.
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Maximum of
imported model
boundaries

The insertion point is automatically chosen as the maximum value of the model
boundaries.

Custom

The user can enter a specific value for the insertion point.

Redefining the location of the insertion point will relocate the reference point.

4.4.4 Bounding box
The coordinates of the box bounding the imported geometry are shown.
Note:
• Material properties of volumes or surfaces are not imported and need to be created in the material data base.
• A description of the feature and an instructional movie is given in Bentley Communities (https://
communities.bentley.com/products/geotechnical1/w/wiki/41123/plaxis).
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Geometric entities, structural elements and Soil boundary conditions are defined in the Structures mode. Click
the Structures tab to switch to this mode. The soil layers created in the mode will appear in the drawing area of
the Structures mode according to the default visibilities defined in the Visualization settings in the Options
menu, i.e. somewhat transparent. Boreholes cannot be modified in the Structures mode.

5.1 Assisting tools
The assisting tools enable modifying the geometry by changing the location or the orientation of the object in the
model or by creating higher objects with a higher dimension (from lines to surfaces or from surfaces to
volumes).

5.1.1 Selecting geometry components
When the Selection tool is active, a geometry component may be selected by clicking once on that component
in the geometry model. Multiple selection is possible by holding down the Ctrl key on the keyboard while
selecting the desired components.
In addition to selecting geometry components one by one by using the Selection tool, several geometry
components can be selected at once by using the Select multiple objects tool. A rectangle can be drawn in the
drawing area by clicking on the first corner of the desired rectangle and moving the cursor while holding down
the mouse button. After release of the mouse button, all visible geometry components in this rectangle will be
selected.
The order in which the rectangle is created influences the selection type. When you select from left to right, it
selects items completely within the box. When you select from right to left, it selects every item crossing the box
boundaries.
It is also possible to select multiple geometry components of one type (for example points, lines or surfaces) or
multiple structural elements of one type (for example node-to-node anchors, beams or plates) at once by
selecting the desired sub-tool from the menu that appears when the Select rectangle button is clicked.
Note:
Right-clicking can be used to select entities in the model. After right-clicking an entity or a multiple selections of
entities either in the drawing area or explorers, a menu appears displaying the name of the selection and
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different options depending on the selection. Clicking the name of the object in the menu copies it to clipboard.
The copied name can be used in the command line ( General information on command line (on page 56)).

5.1.2 Move object
A selection can be moved in the model. To move a selection:
• Select the objects to be relocated in the model (Selecting geometry components (on page 90))
•
Click the Move object button and drag the selection to the new location.

5.1.3 Rotate object
A selection can be rotated over a global axis around a rotation point. The Rotate object button is active only after
one or more objects have been selected.
To rotate a selection:
•

Click the Rotate object button. The Rotate selection window pops up. Note that the name of the window
varies according to the selection.
• Define the coordinates of the rotation point. The default rotation point is the object reference point. The
rotation point can be relocated by dragging it in the drawing area.
•
For cases where the rotation point is not visible, it is possible to drag the rotation point by clicking the
Drag point button in the Rotate object window and dragging it in the drawing area.
• Define the rotation angles. The rotation angles are positive for counterclockwise rotation. Alternatively, the
rotation may be defined by dragging one of the points on one of the circles.

Figure 51: Rotate object window for a line
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In the drawing area, the circle defined by rotation over the x-axis is marked in red colour. The circle defined by
rotation over the y-axis is marked in green colour. The circle defined by rotation over the z-axis is marked in
blue colour.

Figure 52: Rotation point and rotation axis for a selected line
Note: Note that the options to rotate or pan camera do not change the orientation of the objects in the model but
only the view.

5.1.4 Extrude object
Points, lines and surfaces can be extruded to create lines, surfaces and volumes correspondingly. The Extrude
object button is activated only after the selection of one or more such geometry entities.
The graphical definition of the extrusion is possible by dragging the entity. The coordinates defining the
direction of extrusion and its magnitude will change accordingly as the entity is dragged in the drawing area.
Note that the selected entity can only be dragged in the direction defined by its normal. Holding the Shift key
pressed while moving the mouse enables lateral movement. For a group of selections the dragging direction is
defined by the normal of the geometry entity clicked before dragging.
Extrusion
The extrusion of points, lines and surfaces can be defined in the Extrusion tabsheet in the Extrude object
window. As an example, the extrusion of a line is described.
To extrude a line:
• Select a line in the drawing area.
•
Click the Extrude object button. The Extrude window pops up as shown below.
• Define the components of the extrusion vector. The length of the extrusion vector is automatically calculated.
• If the length of the extrusion vector is redefined, the vector components are automatically recalculated
according to their previous values and the new length.
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Figure 53: Extrude object window for a point selection
Extrude surface - Skew
A volume can be created by extruding a surface. In addition to a normal extrusion, the extrusion can be defined
in the Skew tabsheet in the Extrude object window. Note that the Skew tabsheet is available only when a line or
a surface is extruded (see figure below).

This option enables defining the extrusion by entering the skew components in the first and second local axis
and the height of the extrusion in the direction of the third local axis
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Figure 54: Skew components
Extrusion along a predefined path
PLAXIS 3D enables the extrusion of a polycurve (Create polycurve (on page 99)) or a polygon (Create surface
(on page 105)) along a nonlinear path. A non-linear path can be defined using the Polycurve tool. A polygon
must be non-self-intersecting and flat to be valid for extrusion along a nonlinear path.
To extrude a polycurve/polygon along a nonlinear path:
•
•
•
•

Select the polycurve/polygon to be extruded.
Keep the Ctrl pressed and select the polycurve representing the extrusion path.
Click the right mouse button and select the Extrude option in the appearing menu.
The extruded geometry is created in the model. The original geometric entities are still available.

Revolve around axis
A volume can be created by revolution of a surface, and a surface can be created by revolution of a line. PLAXIS
3D enables the revolution of a surface or a line around an axis. A surface or line must produce non-selfintersecting results after revolution. A line or a surface must also be in-plane for revolution.
To revolve a line/surface around an axis:
• Select the line/surface required for revolution.
•
Click the Revolve object button. The Revolve window pops up as shown below.
• Define the components of the revolution Axis start, Axis end, and Rotation angle as required.
• Click Apply to create the volume/surface.
• It is possible to reset all settings to inital conditions by clicking on Reset.
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Figure 55: Revolve object window for a surface selection
Note: In case of revolution of a surface, then the axis of revolution should be in the same global plane as the
surface itself.

5.1.5 Copy object - Array
Multiple copies of a selection, arranged in a rectangular or rotated pattern, can be created in the Structures
mode.
• Select the source object(s) in the model. Multiple selections can be copied.
•
Click the Create array button. Note that the Create array button is active only after the selection is made.
The Create array window pops up where the pattern of the array can be defined.
• It is possible to choose a Rectangular or a Polar array pattern.
• For Rectangular array pattern, select the necessary option in the Shape drop-down menu. Enter the total
number of rows (or columns) after copying and define accordingly the distances between adjoining copies.
• For Polar array pattern, select the necessary option in the Plane drop-down menu. Enter the coordinates for
the center point, total number of items after copying, total angle over which the items are distributed equally
and whether the objects are to be rotated.

PLAXIS

95

PLAXIS 3D-Reference Manual

Modelling loads and structures - Structures mode
Geometric entities

Figure 56: Create array window, Rectangular array pattern

Figure 57: Create array window, Polar array pattern
Note: Note that when Array is used to create copies, besides the geometry entity itself, the assigned features and
properties are copied as well. Hence, it is advised to first assign the features and properties before copying
geometric entities.
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5.2 Geometric entities
The geometric entities are the basic components of the physical model. Features such as structures, loads etc.,
can be assigned to geometric entities or a geometric entity with a feature assigned to it can be created by
selecting the corresponding option available in the expanded menu of the geometric entity. The created entities
in the model are automatically named by the program. They can be renamed in the Object explorers.

Figure 58: The expanded menus for Create geometric entities
A geometric entity can be relocated by selecting it first using the Move tool in the toolbar or by changing the
coordinates location can be changed in the Object explorers.
There are two options of deleting entities in the model. To delete a geometric entity and all the features assigned
to it, right-click it and select the Delete option from the appearing menu. To delete only features assigned, rightclick it, click on the feature you want to delete in the appearing menu and click Delete.
Note: Note that using the Delete key, deletes the geometric entity and all the features assigned to it.

5.2.1 Create point
One of the basic input items for the creation of a geometry is a point. To create a point click the Create point
button in the side toolbar and then click at the location of the point. A Point load, Point prescribed displacement
and Fixed-end anchor feature can be assigned to a point.
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Figure 59: Point in the Selection explorer

5.2.2 Create line
Another basic input item for the creation of a geometry is a line. To create a line click the Create line button in
the side toolbar and then click at the location of the first and the second point of the line in the drawing area.
Optionally, additional points may be created resulting in a chain of lines. After creating the last (end) point of the
line, right-click or use the Esc key to stop drawing. When a line is created, its first and second points are also
created.
A Beam, Embedded beam, Line load, Line prescribed displacement, Node-to-node anchor, Well and Line drain can
be assigned to a line.
Note: A node-to-node anchor or an embedded beam cannot be assigned to a line to which other features are
assigned.

Figure 60: Line in the Selection explorer

Local coordinate system
A local coordinate system for lines is defined automatically by the program. Defining a local coordinate system
for a line element is required in order to define the material properties of structural elements having orthotropic
material behaviour and to show the forces in the Output program. The local coordinate system can be modified
in the Object explorers.
For lines, the first local axis always corresponds to the axial line direction. The Automatic axis function defines
automatically the second axis of the line according to the global coordinate system. When the Manual option in
the Axis function drop-down menu in the Object explorers (Figure 60 (on page 98)) is selected, the user has to
define the direction of the second axis. In both cases the third axis is determined automatically from the first and
the second axis according to the right hand rotation rule.
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5.2.3 Create NURBS Curve
NURBS (Non-uniform rational basis spline) curve is a collection of points that forms curves which are flexible
and precise. Nurbs curves can be extruded using the Extrude object option to generate surfaces. This option is
especially useful while modelling pipelines or tunnels.
To create a NURBS curve:
•

Click the Create NURBS curve button from the lines option in the side toolbar.
• Click the location where the NURBS curve is to be inserted. The NURBS curve table is displayed with the coordinates of the NURBS curve points. The table also displays options to import / open a text file with the
NURBS curve points.

5.2.4 Create polycurve
A polycurve is a collection of lines and arcs that form a single continuous curve. Each line and arc composing the
polycurve is defined as a segment. The starting point of each new segment is the end point of the previous
segment.
To create a polycurve:
•
Click the Create polycurve button in the side toolbar.
• Click the location where the polycurve is to be inserted. The Polycurve designer window is displayed.
The Polycurve designer window consists of a toolbar and two tabsheets where the properties of the polycurve
are defined and a preview area showing the created polycurve.
1. Definition of polycurve shape
The general shape settings of a polycurve are defined in the General tabsheet of the Polycurve designer
window.
◦ Shape
The available types for the shape of a polycurve are:
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Figure 61: General tabsheet of the Shape designer window
◦ Polycurve layout in the model
The general properties of the polycurve in the model are defined using the options available in the Shape
tabsheet.
• The coordinates of the insertion point can be defined in the Object explorer. By default the coordinates of
the location clicked in the model before the Shape designer window is displayed are shown. As the
coordinates are changed the polycurve will be relocated.
• The Orientation axis 1 and the Orientation axis 2 define a plane in which the polycurve is drawn.
• By default the insertion point is the starting point of the first segment of the polycurve. The Offset to begin
point group can be used to specify offset distances from the orientation axis when insertions point (origin
of the orientation axis) and the starting point of the first segment of the polycurve do not coincide.
2. Definition of polycurve segments
The segments of a polycurve can be defined in the Segments tabsheet of the Shape designer window.
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Figure 62: Segments tabsheet of the Shape designer window
A new segment is added to the last segment in a polycurve by clicking the Add segment button available
in the toolbar. The last point of the last segment in the polycurve is the first point of the newly added
segment. The newly created segment is displayed in the segment list shown below.
Note: A segment can be selected by clicking it in the list. A selected segment is highlighted in the list and in
the Display area.

Figure 63: Segment list displaying the segments composing the polycurve
•

•

A new segment is inserted before a selected segment in a polycurve as the Insert segment button is
clicked. The last point of the newly inserted segment becomes the first point of the previously selected
segment. The indices of the segments are updated according to their position in the list.
A selected segment in a polycurve is deleted as the Delete segment button is clicked. The indices of the
segments are updated according to their position in the list.

General properties of segments

PLAXIS

101

PLAXIS 3D-Reference Manual

Modelling loads and structures - Structures mode
Geometric entities
Type

To define the type of the segment. The options available are Line and Arc. For a Line
segment the length of the segment should be specified. For an Arc segment the radius
and the segment angle should be specified as depicted below.

Segment angle

Radius

Figure 64: Properties of Arc segment
When specifying a negative radius for an Arc segment, the arc will be mirrored in the line described by the
tangent vector. Note that when the Circular shape option is selected, the created polycurve consists only of
one Arc segment with a Segment angle value of 360°.
Relative start angle

To define the value of the angle between the start tangent of the next segment and the
end tangent of the previous segment as shown below.

Radius

Arc only. The value of the radius for an arc segment.

Length

Line only. The value of the line segment length.
Tangent to segment 2

Tangent to segment 1

Segment 2

Relative start angle

Segment 1

Figure 65: Description of Relative start angle
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Additional properties available in Model explorer
Segment angle

The value of the arc length expressed in degrees.

Start angle

The value of the angle between the start tangent of the segment and the global
tangent.

Δ1

The horizontal increment of the line formed by the start and end point of the segment.
Δ1 is in local polycurve space (defined by the orientation axes), not global model
space.

Δ2

The horizontal increment of the line formed by the start and end point of the segment.
Δ2 is in local polycurve space (defined by the orientation axes), not global model
space.

Figure 66: Properties of polycurve segment in Model explorer
The rest of parameters are read-only and cannot be edited.
Note: When modelling arcs using derived parameters Δ1 and Δ2, there will often be two solutions for the
same absolute x or y value. In those situations, program will always take the shortest segment. To design
those ambiguous cases correctly, use the remaining parameters.
To extend the polycurve to the symmetry axis click the corresponding button in the toolbar of the Shape
designer window. A new segment is added connecting the last point of the polycurve to the axis of
symmetry.
To close the polycurve by mirroring the existing segments, click the Symmetrically close polycurve button
in the toolbar of the Shape designer window. This is only possible when one half is completed up to the
symmetry axis.
To close the polycurve click the corresponding button in the toolbar of the Shape designer window. A
new segment is created connecting the last point of the polycurve to the first one.
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3. Modification of polycurve
Modification of a polycurve is possible in the Model explorer after closing the Polycurve designer window.

Figure 67: Polycurves in Object explorer
The menu appearing when a polycurve is right-clicked either in the model or in the Object explorer displays
the following specific options for polycurves:
•
•
•
•
•
•
•
•
•
•
•
•
•

Add segment
Extend polycurve to orientation axis 2
Close polycurve symmetrically in orientation axis 2
Close
Create beam
Create line prescribed displacement
Create line load
Delete
Create surface
Merge equivalent geometric objects
Snap
Extend to symmetry axis
Decompose into segments

Note: Complex geometries can be created by extruding a polycurve or a polygon along a predefined path
(Extrude object (on page 92)).
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5.2.5 Create surface
The third basic input item for the creation of a geometry is a surface. To create a surface click Create surface
and then on the locations of the points that define the surface.
The first point defined in the surface is the reference point of the surface. After the first point is created, the user
may draw a line by entering another point. After the first line is created, the user may draw a surface by entering
another point. As the third surface point is defined, the Surface points window pops up.

Figure 68: Surface points window
Note:
• The plane of the created polygon is displayed in the model as the third point is defined. The program allows
creation of new points located only in this plane by clicking.
• To add new points out of the plane, right-click the points in the Surface points window and select either the
Insert point or the Add point option.
The points defining the surface and their coordinates are listed in the Surface points window. Crossing lines are
indicated in the Plane state option. Existence of crossing lines indicates that no valid surface can be created.
When there are no crossing lines, the condition of the Plane state is OK. The options to define the plane of the
surface are:
First points

The first three points in the Surface points window define the surface plane. Values in
the error column indicate whether the surface is in or out of the defined plane.

Best fit

Best fit of surface points is considered to define a plane surface that fits the best to the
defined points. The error column is not applicable.

The points defining the surface can be projected to the plane of the surface by clicking Project points to plane in
the Surface points window. The creation of a surface is finished by clicking on the selection tool in the side tool
bar.

PLAXIS

105

PLAXIS 3D-Reference Manual

Modelling loads and structures - Structures mode
Geometric entities
Note:
• Note that the points and the lines defining a surface are not shown in the Model explorer.
• The points and lines defining the surface can be added to the model by selecting the Decompose into outlines
option from the right mouse button menu.

Figure 69: Surface in Model explorer
A Plate, Geogrid, Interfaces, Surface load, Surface prescribed displacement, Contraction, Surface groundwater flow
boundary condition and Surface drain can be assigned to a surface (either created or imported).

Modification of surfaces
The points defining surfaces can be modified using the options available in the menu that appears when the
point ID is right-clicked in the Surface points window. Using these options a point can be added, inserted or
deleted.
The points defining the surface can be relocated by changing their coordinates in the corresponding cells in the
Surface points window.
Note that the options to modify the points defining a surface are available in the Create surface submenu and
they are selectable after the surface to be modified is double clicked first.

Figure 70: Create surface menu
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Local coordinate system
A local coordinate system for surfaces is defined automatically by the program. Defining a local coordinate
system for a surface element is required in order to define the material properties of structural elements having
orthotropic material behaviour and to show the forces in the Output program.
For the Automatic axis function, the first and second local axes lie in the plane of the surface, whereas the third
axis is perpendicular to the plane of the surface (Material data sets for plates (on page 292) of the Material
Models Manual). The first axis is automatically assigned as follows:
• If the normal is parallel to the global z axis, the first axis points the global x-axis direction.
• If the normal is not parallel to the global z axis, the first axis is then Axis1= n × z (cross product of the unit
vector of z pointing upwards and the normal).
When the Manual option in the Axis function drop-down menu in the Object explorers is selected, the user has to
define the direction of the first axis. The third axis is determined by the normal and the second axis is
determined as Axis2= n × z. The coordinate system does not have to be orthogonal.
Note: In case of a straight tunnel it is convenient to use the direction of the tunnel as the direction of the first
axis. The direction of the second axis is determined automatically from the first and third axis according to the
right hand rule.

Imported surfaces
Predefined surfaces can be imported in the Structures mode (Importing geometry (on page 112)). The
geometry of an imported surface can be modified after being decomposed into outlines.
Note: Volumes can be created by extruding a polygon along a predefined path created using the Polycurve or
NURBS curve feature (Extrude object (on page 92)).

5.2.6 Create volume
In PLAXIS 3D volumes can be created by extruding surfaces (Extrude object (on page 92)). Import volume feature
enables usage of predefined volumes (Importing geometry (on page 112)). Note that the soil volumes generated
according to the soil layers defined in the Modify soil layers window and the volumes imported in the Soil
mode are listed under Soil volumes in the Geometry subtree of the Model explorer. The volumes created by
extruding surfaces or that are imported in the Structures mode are listed under Volumes in the Geometry
subtree.
Note: The surfaces and the outlines defining a volume created or imported in the Structures mode can be added
to the model by selecting the Decompose into surfaces or Decompose into outlines option respectively from the
right mouse button menu.
Soil and interfaces material data sets, Volumetric strain and Water conditions can be assigned to volumes.
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5.2.7 Advanced geometric modelling options
Advanced options for modifying geometric entities in the model are available in the menu appearing as the
entity (or multiple entities) is (are) selected by right-clicking in the Object explorer or the drawing area.
Note: Multiple entities can be selected by keeping the Ctrl key pressed while clicking on the entities.

Feature assignment to existing geometric entity
When the geometric entity is already available in the model (e.g. a surface) it is advised to assign a feature to it
(e.g. plate) without recreating the geometry in order to prevent the model from being unnecessarily large and
complicated. An overview of the features assignable to geometric entities is given in table below.
Table 2: Assignable features
Loads
Point

Line

Surface

Load

Load

Load

Prescribed displacement

Prescribed displacement

Prescribed displacement

Volumes
Volume strain

Assignable structures and conditions
Geogrid

Fixed-end anchor

Beam

Plate

Node to node anchor

Interface (Positive/
Negative)

Embedded beam

Contraction

Well

Surface drain

Line drain

Surface groundwater flow
boundary condition

To assign a feature to an existing geometric entity:
• Right click the geometric entity either in the Object explorer or in the drawing area.
• In the appearing menu select the option corresponding to the feature that is to be assigned.
Note:
• Note that Volume strain can be assigned to soil clusters only in the Phase definition modes.
• If an embedded beam or a node-to node anchor is assigned to a line in the model, no other features can be
assigned to it.
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Invert normal
The Invert normal option is available for surfaces in the right mouse button menu. Note that the location of an
interface relative to the surface to which it is assigned depends on the type of the interface (positive or negative)
and the normal of the surface. If the normal of a surface is inverted, the assigned interface will automatically be
applied to the other side of the surface.
• Using the buttons in the side toolbar
• Assigning the feature to an existing geometric entity
• Using the command line

Merge equivalent geometric objects
There are different options to create a feature:
• Using the buttons in the side toolbar.
• Assigning the feature to an existing geometric entity.
• Using the command line.
Consider the case when a geometric entity (e.g. a line) already exists in the model. If a node-to-node anchor is
created at (nearly) the same position as the existing line, a new line will be added with the Node-to-node anchor
feature. This means that, in principle, two lines will exist at that position; one with the Node-to-node anchor
feature and one without. PLAXIS 3D allows for merging equivalent objects in order to remove unnecessary
objects from the model. The way this works depends on which option has been selected to create the node-tonode anchor.
• If the above option 2 is used, no new line is created, and the Node-to-node anchor feature is directly assigned
to the existing line.
• If the above options 1 and 3 are used, the existing line and the new line with the Node-to-node anchor feature
will both exist in the Structures mode.
In the latter case it may be desired to already merge equivalent objects in the Structures mode (in order to
manually remove unnecessary objects from the model). This can be done by right-clicking on Geometry, Points,
or Lines or Surfaces in the Model explorer and selecting Merge equivalent geometric objects from the appearing
menu, or by using the corresponding command (see command reference), for example:
mergeequivalents geometry
The merge equivalent geometric objects command may also be used to merge objects that are not
exactly located at the same position, but very close to each other. By default, the distance tolerance is 0.001
length units, equal to the standard snap distance (see below), but the user can include the distance tolerance in
the command, for example:
mergeequivalents geometry 0.2
When similar geometric objects were created not exactly at the same position but less than 0.2 length units
apart, they will be merged into a single object by this command. Any feature assigned to one of the original
objects will be assigned to the remaining single object.
Note:
• Boreholes cannot be merged.
• Features that are sensitive to local axes need to be checked by the user after the merging.
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• If an embedded beam or a node-to node anchor is assigned to a line in the model it cannot be merged to
equivalent lines to which other features are assigned.

Snap
Drawing imperfections such as disconnected or overlapping geometric entities can lead to intersection or
meshing difficulties. The Snap feature enables the correction of such imperfections in a range of 0.001 length
units. The default value of snapping distance can be temporarily modified when snapping is performed using the
corresponding command (see Command reference).

Decompose
The Decompose option enables decomposing the selected geometric entity into lower entities. A surface is
decomposed into outlines and a volume is decomposed into surfaces. An example of decomposition of a surface
into outlines is given in the Chapter Loading of Suction Pile of the 3D Tutorial Manual.

Intersect and recluster
A multiple selection of geometric entities can be intersected by selecting the corresponding option in the right
mouse menu. The Figure 71 (on page 110) displays two surfaces before and after intersecting.

Before intersection

After intersection

Figure 71: Example of intersection of surfaces

Combine
A multiple selection of geometric entities can be combined (merged/fused together) by selecting the
corresponding option in the right-click mouse menu (RMB). The figure below displays two volumes before and
after combining. After combining different entities into one new entity, the original entities do not exist
anymore.
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Before combining

After combining

Figure 72: Example of combination of volumes

Group
The Group option in the right mouse menu enables creating groups of entities in the model. The created group
will be listed under the Groups subtree in the Model explorer. Grouping enables modification of the common
properties of the group at the same time. After grouping different entities into a group, the original entities still
exist.

Loft polycurves
The Loft polycurves option can be used to create a surface between two or more different cross sections. To use
the loft polycurves option: select the corresponding polycurves from the Model explorer or Structures window
→ Right click and select Loft polycurves option from the menu that appears. The lofted surfaces will be listed
under the Surfaces subtree in the Model explorer. This functionality is especially useful when the user wants to
model a tunnel with varying cross sections along its axis.

Figure 73: Creating a surface between two polycurves using Loft polycurves option
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Blend surfaces
The blend surfaces option can be used to connect two or more surfaces. To use the blend surface option: select
the corresponding surfaces from the Model explorer or Structures window. Right click and select Blend surfaces
option from the menu that appears. If the surfaces that are blended have identical properties, the blended
surface is assigned with the same properties, the non-identical properties are left unassigned. This functionality
can be used to connect two or more tunnels that have different cross-sections and / or non-aligned axes.

Figure 74: Connecting two surfaces using Blend surfaces option

5.3 Importing geometry

Figure 75: Import... menu
In the Structures mode, the geometry of the soil can be imported by clicking the Import structures button
available in the side toolbar under the Import... button or by selecting the option available in the Structures
menu.
Note that only surfaces and volumes can be imported. A detailed description on how geometry is imported is
given in Importing soil layers (on page 86). When importing a geometry file, a list of possible file extensions are
shown. The supported file types are:
Table 3: Supported file types
Extension

File Type

*.dxf

AutoCAD interchange files.
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Extension

File Type

*.brep

OpenCascade shape files.

*.step

3D STEP files.

*.stp

3D STP files.

After selecting the file, the Import structures window pops up, where the geometry can be modified. It is
possible to import only surfaces or volumes by keeping the corresponding option checked in the Import
structures window.

Figure 76: The Import structures window

5.3.1 Importing point clouds
The user can import surfaces using the point cloud feature available in GUI. The supported file type is .txt (a
plain text file). The program detects a best-fit plane as the reference plane.
The NURBS surface is generated with default generation parameters. After the import, the surface can be
selected and the generation properties can be changed. Changing any property will trigger the regeneration of
the surface. Selection explorer shows the following properties for a NURBS Surface.
x,y,z
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Definition of local axes of surface.
• Automatic: The axes follow the right-hand rule. Axis1 and Axis2 always define the
tangential plane of the surface. Axis3 is perpendicular to this plane. The direction of
Axis1 and Axis2 within the tangential plane are defined based on these rules:
Axis Function

• If Axis3 is parallel to the z-axis then Axis1 points to +x-axis and Axis2 points to +yaxis.
• If Axis3 is not parallel to the z-axis then Axis1 is perpendicular to the plane
defined by Axis3 and the z-axis. Axis2 is defined as the vector product of Axis3
and Axis1.
• Manual: Axis1 is defined by the user. Axis3 is always the normal. Axis2 is calculated
as the vector product of Axis3 and Axis1.

Min/Max degree

The minimum/maximum degree of the polynomials. This concerns the polynomials that
join the points (setting both min and max values to 1 only allows for linear functions,
and if set between 1 and 3, it allows for lines, parabolas and cubic functions).

Number of grid
points rows

The number of grid rows where the point cloud is sampled.

Number of grid
points columns

The number of grid columns where the point cloud is sampled. The rows and columns
refer to the underlying grid used to define the NURBS surface. The more rows and
columns you use, the more control you have over the surface and the more flexible your
surface will be, but the heavier and thus less workable your surface will become.

Continuity

• C0: Only geometric continuity
• G1: For each point on the curve, the tangent vectors "on the right" and "on the left"
are co-linear with the same orientation
• G2: For each point on the curve, the normalized normal vectors "on the right" and
"on the left" are equal
• C2: Continuity of the second derivative. The "C2" curve is also "G2" but, in addition,
the main directions of the curves also match.
• C3: Continuity of the third derivative.

Status

The status reported by the generator tool.

The importpointcloud command can be used from the command line too with more parameters to fine tune
how the import is done. For more information on how to use this command, see Command Reference.
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Figure 77: Imported point cloud file

5.3.2 Importing IFC files
The user can also import Industry Foundation Classes (IFC) data using files with .ifc extension. It is possible to
import data using Import structures... tool in the side toolbar of the Structures mode.
To change filtering properties and import, for example, only walls included in the IFC file, the user can use
command importifc.
The supported types are:
•
•
•
•
•
•
•
•

ifcroof
ifcslab
ifcfooting
ifcpile
ifcbeam
ifcplate
ifcwall
ifccolumn

Examples of using importifc command:
importifc "structures" "C: directory
\3.ifc" "ifcslab"

#imports only slab structures into a
project

importifc "structures" "C: directory
\3.ifc" "ifcwall"

#imports only wall data into a project
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importifc "structures" "C: directory
\3.ifc" "ifcroof"

#imports only roof data into a project

Note: When using incorrect types or trying to import the structures that do not exist in a file, the program shows
warning messages.
To see more examples and parameters description, see importifc in Concrete model.

Figure 78: Imported IFC data
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5.4 Loads
Loads are features that can be assigned to geometric entities. Loads can be assigned to existing geometric
entities by right-clicking the entity and selecting the corresponding option in the appearing menu. Alternatively,
the options available in the Create load menu can be used. To assign loads to existing geometry entities:
•

Select the button corresponding to the load from the menu appearing when the Create load is selected
Figure 79 (on page 117).
• Drag the tool (keep the left mouse button down) and drop it on the geometric entity.

A geometric entity can be created and a load can be assigned to it simultaneously using the options available in
the menu displayed as the Create load button is selected in the side toolbar. This provides a faster definition of
loads. Instead of creating the geometric entity and then assigning a load to it, the process is completed in one
step. The process is similar to the creation of a geometric entity with the difference that the load is assigned to it
as well.

Figure 79: The Create load menu
Although the input values of loads are specified in the Structures mode, the activation, deactivation or change of
loads may be considered in the framework of Staged construction (Changing loads (on page 383)).
On a part of the geometry where both fixities and loads are applied and active, the fixities have priority over the
loads during calculations. Hence, it is not useful to apply loads on a fixed geometric entity. However, it is possible
to apply a load in the free directions.
The Load subtree in the Object explorers consists of two parts where the static and the dynamic components of
the load can be defined respectively.
1. Static load
The distribution and the components of the static load are assigned in the first part of the Load subtree. Note
that the Distribution option is not available for Point loads.
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Figure 80: Static point load in the Object explorers
2.

Dynamic load
The distribution and the components of the dynamic load is assigned in the second part of the Load subtree.
Note that the Distribution option is not available for Point loads. Besides the Distribution and the components
of the load, Multipliers can be defined for each of the load components separately. One of the available
multipliers defined in Attributes library (Definition of multipliers (on page 125)) can be selected from the
drop-down menu. The view of the dynamic load in the Object explorers is given in figure below.

Figure 81: Dynamic point load in the Object explorers
Note: Note that a bending moment value can be specified only for Point loads.

PLAXIS

118

PLAXIS 3D-Reference Manual

Modelling loads and structures - Structures mode
Loads

5.4.1 Point load
A point load can be created using the Create point load button. The input values of a point load are given in
the unit of force. The default value of point loads is one unit in negative z-direction. The x-, y- and z-components
of a point load as well as an optional bending moment can be defined or modified in the Object explorers. If a
different magnitude value is assigned to the absolute load, the program calculates the individual components
accordingly, assuming the initial load direction.

Figure 82: Point load in the Selection explorer
Note:
• Bending moments can only be applied to plates, beams or embedded beams.
• Bending moments applied to nodes that do not belong to the plates, beams or embedded beams are not
included in the calculation.
• Plates and soil elements do NOT sustain torsion.
• If torsion is applied to beams/embedded beams, users should ensure that the attached elements have the
ability to sustain torsion as well. As an example, if torsion is applied to the start point of a beam, the end point
should be connected to a beam or an embedded beam and NOT a plate or the surrounding soil.
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5.4.2 Line load
A line load can be created using the Create line load button. The input values of a line load is given in the unit
of force per length per length of out-of-plane. The default value of a line load is one unit in negative z-direction. If
a different magnitude value is assigned to the absolute load, the program calculates the individual components
accordingly, assuming the initial load direction.

Figure 83: LineDistributed load in the Selection explorer
The distribution options for a line load are:
Uniform

To create a uniform line load.

Linear

A linearly varying line load is created by defining the components and the magnitude of
the force at the start and at the end points of the line representing it.

5.4.3 Surface load
A surface load can be created using the Create surface load button. The input values of a surface load are
given in the unit of force per area (for example kN/m2). Surface loads may consist of a x-, y- and/or z-component.
The magnitude is automatically calculated by the program. If a different magnitude value is defined, the
components are calculated accordingly.
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Figure 84: Surface load in Selection explorer
The options to define a surface load are:
Uniform

To create a uniformly distributed surface load.

x-aligned increment

To create a linearly distributed surface load varying in x-direction.

y-aligned increment

To create a linearly distributed surface load varying in y-direction.

z-aligned increment

To create a linearly distributed surface load varying in z-direction.

Vector aligned
increment

To create a linearly distributed load varying in a specified direction.

Free increment

To create a general load varying in all directions.

Perpendicular

To create a uniformly distributed load perpendicular to the surface.

Perpendicular,
vertical increment

To create a load perpendicular to the surface varying in the direction of gravity (-z) by
defining the components and the magnitude of the load at the reference point and its
increment in the negative z-direction.

5.5 Prescribed Displacements
Prescribed displacements are special conditions that can be imposed to the model to control the displacements
at certain locations. Prescribed displacements can be assigned to existing geometric entities by right clicking the
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entity and selecting the corresponding option in the appearing menu. Alternatively, the options available in the
Create prescribed displacement menu can be used. To assign prescribed displacements to existing geometry
entities:
•

Select the button corresponding to the prescribed displacement from the menu appearing when the
Create prescribed displacement button is selected.
• Drag the tool (keep the left mouse button down) and drop it on the geometric entity.

Figure 85: Create prescribed displacement menu
Although the input values of prescribed displacements are specified in the Structures mode, the activation,
deactivation or change of values may be considered in the framework of Staged construction (Changing
geometry configuration (on page 381)).
On a geometric entity where both prescribed displacements and loads are applied and active, the prescribed
displacement has priority over the load during calculations. If both prescribed and fixed displacement are
assigned to a line, the fixed displacement will be taken into consideration. However, when not all the
displacement directions are fixed, it is possible to apply a load in the free directions.
Note: Prescribed displacements should be interpreted as specified total displacements at the end of the phase
instead of additional (incremental) phase displacements. If no prescribed displacement increment should be
applied in a phase, the value assigned to the prescribed displacement should be equal to the one in the previous
phase. Assigning 0 to the value will implicitly apply an incremental prescribed displacement with the same value
but in the opposite direction resulting in a zero displacement at the end of the phase.
The Prescribed displacement subtree in the Object explorers consists of two parts where the static and the
dynamic components of the prescribed displacement can be defined respectively.

5.5.1 Static prescribed displacement
The distribution and the components of the static prescribed displacement are assigned in the first part of the
Prescribed displacements subtree. Note that the Distribution option is not available for the Point prescribed
displacements.

5.5.2 Dynamic prescribed displacement
Dynamic Multipliers can be defined for each of the static prescribed displacement components, to apply the
prescribed displacement as a function of (dynamic) time in a dynamic calculation. One of the available dynamic
multipliers defined in Attributes library (Definition of multipliers (on page 125)) can be selected from the dropdown menu. The view of the dynamic prescribed displacement in the Object explorers is given in figure below.
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Figure 86: Dynamic prescribed displacement in the Object explorers

5.5.3 Point prescribed displacement
A point prescribed displacement can be created using the Create point prescribed displacement button. The
input of point prescribed displacements in the geometry model is similar to the creation of points (Create point
(on page 97)).
The default point prescribed displacement is free in x and y directions and it has a prescribed value of -1 unit in
the z-direction. The options for the components of point prescribed displacements are Free, Fixed and Prescribed.
These options can be selected and the displacement value can be defined if the Prescribed option is selected in
the Object explorers..

5.5.4 Line prescribed displacement
In order to define prescribed displacements, the Create line prescribed displacement option should be
selected from the menu appearing as the Create prescribed displacement button is clicked.
The default line prescribed displacement is free in x and y directions and it has a prescribed value of -1 in zdirection. The options for the components of line prescribed displacements are Free, Fixed and Prescribed. These
options can be selected in the Model explorer. Either a uniform or a linearly varying prescribed displacement can
be assigned to a line. When the Linear option is selected in the Distribution drop-down menu, the displacement
value at the start of the line (the first point) and at the end of the line (the second point) can be defined.

5.5.5 Surface prescribed displacement
In order to define surface prescribed displacements, the Create surface prescribed displacement option
should be selected from the menu appearing as the Create prescribed displacement icon is clicked.
The Distribution options to define a surface prescribed displacement are:
Uniform

A uniformly distributed surface prescribed displacement is defined.

x-aligned increment

A linearly distributed surface prescribed displacement varying in x-direction is defined.
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y-aligned increment

A linearly distributed surface prescribed displacement varying in y-direction is defined.

z-aligned increment

A linearly distributed surface prescribed displacement varying in z-direction is defined.

Vector aligned
increment

A linearly distributed surface prescribed displacement varying in a specified direction is
defined.

Free increment

A general surface prescribed displacement varying in all the directions is defined.

Perpendicular

A uniformly distributed prescribed displacement perpendicular to the surface is defined.

Perpendicular,
vertical increment

A prescribed displacement perpendicular to the surface varying in z direction is created
by defining the components and the magnitude of the displacement at the reference
point and its increment in z direction.

5.5.6 Surface contraction
Surface contraction can be used to simulate a volume loss around a tunnel lining or to apply a contraction to a
surface in general. Contraction is specified as a strain without any unit associated.
The entered value of contraction is not always entirely applied, depending on the stiffness of the surrounding
clusters and objects. The specified Cref is applied gradually during the calculation phase (via ΣMstage) as a
shrinkage strain. In principle, the shrinkage strain does not cause any stress changes by itself. However, due to
any surrounding restraints, the applied strain may not be equal to the input contraction, resulting in stress
variation.
In order to define a contraction on surfaces, the Create surface contraction, the Create line contraction
option should be selected from the menu appearing when the Create prescribed displacement icon is clicked in
the side toolbar. Surface contraction may also be defined directly in the Tunnel designer.
Surface contraction should be interpreted as specified total contraction at the end of the phase instead of
additional (incremental) phase contraction. If no contraction increment should be applied in a phase, the value
assigned to the contraction should be equal to the one in the previous phase. If a contraction was already applied
in the previous phase, assigning 0 to the value will implicitly apply a contraction with the same value but in the
opposite direction resulting in a zero contraction at the end of the current phase.
Note:
• For tunnels, the applied contraction is equal to the tunnel contraction to simulate small volume loss ( ≈3%
volume contraction).
• When contraction is used to simulate the volume loss around a tunnel, the value of surface contraction to be
applied is equal to the volume loss as a percentage of the tunnel volume.
• In geogrid elements, a negative contraction can be used to simulate thermal expansion.
The options to define a surface contraction are:
Constant
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Axial increment

A linear contraction varying in the local Axis1-direction is defined (Figure 87 (on page
125)). The Axis1-direction is defined for each slice as shown in Figure 87 (on page
125) . The value of the contraction is then applied in the local Axis2-direction. When
applied in the tunnel designer, the reference value is taken from the front of each slice.
For all other cases, the reference value is defined according to the global axis.

L
Rear

Front

Axis1

Slices
Figure 87: Definition of Axis1 while using Axial increment during surface contraction in tunnel slices, while using
the tunnel designer

5.6 Dynamic loading
In PLAXIS 3D, a dynamic load is specified by means of an input value and a multiplier. The actual dynamic value
at each time step equals to the input value times the multiplier. Dynamic multipliers can be assigned to the
dynamic component of a load (Loads (on page 116)) or to a prescribed displacement (Prescribed Displacements
(on page 121)). The dynamic multipliers to be applied in the model can be defined in the Dynamic multipliers
subtree under the Attributes library in the Model explorer.

Figure 88: Dynamic multipliers branch in the Model explorer
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5.6.1 Definition of multipliers
The multipliers can be defined in the Multipliers window that pops up when the Dynamic multipliers subtree
under the Attributes library in the Model explorer is right-clicked and the Edit... option is selected in the
appearing menu. The window consists of two tabsheets, i.e Displacement multipliers and Load multipliers
where the multipliers applicable to the prescribed displacements and to the loads can be defined respectively.
The buttons available under the multipliers tabs can be used to add new multipliers or to delete the selected
multiplier in the list. When a new multiplier is added, the options to define it are displayed.
Name

The name of the multiplier can be defined.

Signal

The type of the signal can be assigned. The options available are Harmonic and Table.
More information on definition of a harmonic multiplier and definition of the multipliers
in a table is given in Harmonic signal (on page 126) and Signal from table (on page 127)
respectively.

Type

The options Displacements, Velocities and Accelerations are available. Note that the Type
drop-down menu is available only for displacement multipliers. For Load multipliers the
type does not need to be specified.

Drift correction

It is used to correct the displacement drift. Due to the integration of the accelerations
and velocities, a drift might occur in the displacements. When selected, the displacement
drift is corrected by applying a low frequency motion from the beginning of the
calculation and by correcting the acceleration accordingly.

5.6.2 Harmonic signal
In PLAXIS 3D harmonic loads are defined as:
^F
^ sin ωt + ϕ
F = M

(

)

0

Eq. [2]

in which:
^ : Amplitude multiplier
M

^ : Input value of the load
F
ω : 2πf with f Frequency in Hz
ϕ0 : Initial phase angle in degrees
^F
^ is the amplitude of the dynamic load).
(M
Note: A dynamic load can also suddenly be applied in a single time step or sub step (block load). In case of a
Harmonic load multiplier, a block load can be modelled by setting the Amplitude multiplier equal to the
^F
^ . In
magnitude of the block load, the Frequency to 0 Hz and Initial phase angle to 90° giving the relation F = M
case of a Load multiplier from data file, a block load can directly be defined.
Figure below shows the Multipliers window where a Harmonic signal is defined and plotted.
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Figure 89: Definition and display of a Harmonic signal in the Dynamic multipliers window

5.6.3 Signal from table
Besides a harmonic signal there is also the possibility to define a signal by specifying the values in the table that
appears when the corresponding option is selected in the Signal drop-down menu. It is possible to choose
Displacements, Velocities or Accelerations from a drop down menu for the Data type of a signal. If Accelerations
are chosen as the data type then the signal can be transformed using Scaling type options. For more information
refer Input accelerograms (on page 130). The table consists of Time and Multiplier columns where Time relates
to the Dynamic time in the project. The buttons in the toolbar can be used to modify the table.
•
Click the Add row button in the toolbar to add a new row in the table.
•

Click the Insert button to insert a new row before the selected row in the table.

•
Click the Delete button to delete the selected row in the table.
The values can be defined by clicking the cell in the table and by typing the value.
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Figure 90: Dynamic multipliers window

Importing data for signals
Besides defining the signal in the table, there is also the possibility to read data from a file with a digitised
load signal using the Open button in the toolbar. PLAXIS enables reading data from files in plain ASCII or in SMC
format.
Note: PLAXIS assumes the data file is located in the current project directory when no directory is specified in
the Dynamic loading window.
A signal, either defined in a table or received from a file and modified, can be saved using the Save button in
the toolbar enabling the usage of the signal in other projects or validating the effect of the modifications in the
current project.
A signal, either defined in a table or received from a file and modified, can be copied using the Copy button in
the toolbar.
Copied data from other applications (using Ctrl+c) can be imported by using the Paste button. The Import
data window appears as shown below. The starting row of the data to be imported can be defined in the From
row cell. The data can be parsed as Plain text files or Strong motion CD-ROM files (SMC). The data and the plot is
displayed in the Dynamic multipliers window after pressing OK.
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Figure 91: Import data window for dynamic multipliers
ASCII file
An ASCII file can be created by the user with any text editor. In every line a pair of values (Dynamic time and
corresponding multiplier) is defined, leaving at least one space between them. The time should increase in each
new line. It is not necessary to use constant time intervals.
If the time steps in the dynamic analysis are such that they do not correspond with the time series given in the
file, the multipliers at a given (Dynamic) time will be linearly interpolated from the data in the file. If the Dynamic
time in the calculation is beyond the last time value in the file a constant value, equal to the last multiplier in the
file, will be used in the calculations.
SMC file
In addition, it is possible to use earthquake records in SMC-format as input for earthquake loading. The SMC
(Strong Motion CD-ROM) format is currently used by the U.S. Geological Survey National Strong-motion Program
to record data of earthquakes and other strong vibrations. This format uses ASCII character codes and provides
text headers, integer headers, real headers, and comments followed by either digitised time-series coordinates
or response values. The header information is designed to provide the user with information about the
earthquake and the recording instrument.
Most of the SMC files contain accelerations, but they may also contain velocity or displacement series and
response spectra. It is strongly recommended to use corrected earthquake data records, i.e. time series, that are
corrected for final drift and non-zero final velocities. SMC files should be used in combination with prescribed
boundary displacements at the bottom of a geometry model.
The strong motion data are collected by the U.S. Geological Survey and are available from the National
Geophysical Data Center (NGDC) of the National Oceanic and Atmospheric Administration. Information on NGDC
products is available on the World-wide Web at http://www.ngdc.noaa.gov/hazard.
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Note: The time value in dynamic multipliers always refers to the global dynamic time (in seconds) in the whole
list of calculation phases, rather than to the time interval of an individual phase. This means that in series of
continuing dynamic calculation phases each phase will only use its consecutive part of the dynamic multiplier.

5.6.4 Input accelerograms
If a signal has the data type as Accelerations, it is possible to scale the input accelerogram using the following
options from the drop-down menu:

Figure 92: Import data window for dynamic multipliers
Note: Note that if the model is created using the Command line, the user must make sure to transform the
multiplier, otherwise the transformed multiplier values will not be taken into account during calculation.
Scaling factor

The input multipliers can be transformed by specifying a value. Click to get the newly
transformed multipliers.

A desired maximum value of the multiplier can be specified. Click to get the newly
transformed multipliers. The scaling factor is calculated as the ratio between the desired
Maximum multiplier
maximum value and the maximum value of the multiplier (in absolute value). All the
multipliers are then multiplied by this resulting scaling factor.
A user should click on the Transform* button as shown below, after modifying a value for either the Scaling
factor or Maximum multiplier. PLAXIS then computes the transformed multiplier, and a new column is generated
Transformed multiplier.
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Figure 93: Input accelerograms tranformation
In the table, the column Transformed multiplier contains the transformed multiplier values. If the table is
modified, the multiplier should be transformed again, as the transformation is not updated automatically. The
asterisk * after Transform indicates that the table was modified after the last transformation action.
Note: Note that the Transformed multiplier only contains the values obtained by applying the scaling factor and
not the drift correction.
When the input data type is Accelerations, the signal can be viewed as Accelerations, Velocities or
Displacements, by selecting the corresponding option in the drop-down list below the graph. The input
accelerogram signal can be visualised in the lower panel in different representative charts: Fourier spectra,
Response spectra and Arias intensity. The original multiplier is displayed in grey, and the transformed multiplier
is displayed in blue. Both the original multiplier in grey and transformed multiplier in blue are displayed in the
Signal tab.
Fourier spectra
In this tab, the input multiplier can be visualised as a Fourier amplitude spectrum (default) or a power spectrum
using the drop-down menu. The spectra are created using the transformation in Hz, starting from the time acceleration multiplier.
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Figure 94: Fourier spectra for input accelerograms
Response spectra
In this tab, the input multiplier can be visualised as a PSA (default) and Relative displacement response spectrum.
It is possible to set these parameters while using this tab :
• Damping ratio is expressed in %, has a default value of 5.000 % and a range of [0, 100].
• Max. period is expressed in s, has a default value of 10.00 s and a range of [0.1, 1000].
The signal can be viewed with a logarithmic x-axis by clicking on the check box.
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Figure 95: Response spectra for input accelerograms
Arias intensity
In this tab, the input multiplier can be visualised as Arias intensity. It is possible to view it in percentage by
clicking on the check box Show Arias intensity in percentage.

Figure 96: Arias intensity for input accelerograms
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5.7 Moving loads
In PLAXIS 3D, a moving load is specified by assigning a path and a movement function to a load. A Point
movement and Line movement can be added by right clicking on a point load or line load and selecting Add point
movement or Add line movement respectively. A Movement can be applied to both static and dynamic part of
Point and Line loads. A moving load has two features namely : Path and Movement function. A Movement function
is applied on a predefined line which acts as the Path.

5.7.1 Path
A Path is necessary for defining moving loads. A path is a predefined line, over which a line load or point load can
have a movement function applied (see figure below).

Figure 97: Assigning a Path to a moving load in the Selection explorer

5.7.2 Definition of movement functions
A Movement function can be defined when the Movement function subtree under the Attributes library in the
Model explorer is right-clicked and the Edit... option is selected in the appearing menu.
All Movement functions can be shown and edited by using the menu Structures > Show movement functions.
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Figure 98: Movement function branch in the Model explorer
The buttons available under the movement functions can be used to add new functions or to delete the selected
function in the list. When a new movement function is added, the options to define it are displayed.
Name

The name of the movement function can be defined.

Signal

The type of the signal can be assigned. The options available are Harmonic, Table and
Linear. More information on definition of a harmonic function, definition of a function in
a table and definition of a movement function is given in Harmonic signal (on page 135),
Signal from table (on page 136), Linear (on page 138).

In the lower panel, it is possible to view the Signal as both a Velocity and the relative Position of the load (Figure
99 (on page 136)).

5.7.3 Harmonic signal
In PLAXIS a harmonic movement is defined as:
V = V 0 + A sin (ωt )

Eq. [3]

where:

V 0 Initial velocity
A Amplitude of the movement function
ω 2πf with f = Frecuency in Hz
Figure below shows the Movement function window where a Harmonic signal is defined and plotted.
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Figure 99: Movement function harmonic signal definition window

5.7.4 Signal from table

Figure 100: Movement functions with a signal defined by a Table.
Besides a harmonic signal there is also the possibility to define a signal by specifying the values in the table that
appears when the corresponding option is selected in the Signal drop-down menu. The table consists of Time
and Velocity columns where Time relates to the Dynamic time in the project. The buttons in the toolbar can be
used to modify the table.
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•
Click the Add row button in the toolbar to add a new row in the table.
•

Click the Insert button to insert a new row before the selected row in the table.

•
Click the Delete button to delete the selected row in the table.
The values can be defined by clicking the cell in the table and by typing the value.
Importing data for signals
Besides defining the signal in the table, there is also the possibility to read data from a .txt file with a
digitised signal using theOpen button in the toolbar.
A signal, either defined in a table or received from a file and modified, can be saved using the Save button in
the toolbar enabling the usage of the signal in other projects or validating the effect of the modifications in the
current project.
A signal, either defined in a table or received from a file and modified, can be copied using the Copy button in
the toolbar.
Copied data from other applications (using Ctrl+C) can be imported by using the Paste button. The Import
data window appears (Figure 101 (on page 137)). The data and the plot is displayed in the Movement
functions window after pressing OK.

Figure 101: Import data window for movement functions
Clicking the Open .txt file button on the right hand side of the window will open the Open window where the
file can be selected. The file can be created with any text editor. For every line a pair of values (time and
corresponding velocity) must be defined, leaving at least one space between them. Note that PLAXIS 3D only
supports the English notation of decimal numbers using a dot. The resulting graph of the input data is shown in
the Velocity tabsheet of the Movement function window.
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5.7.5 Linear
This option can be used to describe a linear movement in time. For a linear variation of velocity, the input of the
following parameters are required:
Initial velocity

This parameter is the initial velocity, specified in unit of length per time. Hence, together
with the acceleration this parameter determines the rate of the velocity increase or
decrease.

Acceleration

This parameter represents the acceleration for the movement function, expressed in
unit of length per unit of time, squared.

Figure 102: Linear signal for velocity for the movement function

5.8 Structural elements
The creation of a structure is similar to the creation of the corresponding geometric entities. To create
structures:
•

Select the button corresponding to the structure from the menu appearing when the Create structure
button is selected.
• Define the structure in the same way the corresponding geometric entity is defined.
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Figure 103: Create structure menu
Note that the assignment of structures to existing geometric entities is possible by right-clicking the geometric
entity either in the drawing area or in the Object explorers and selecting the corresponding option in the
appearing menu. Assignment of materials to structures is described in Assigning material data sets to geometry
components (on page 317).
Structures can be activated, de-activated or the assigned material data sets can be modified in calculation
phases.

5.8.1 Fixed-end anchors
A fixed-end anchor is a point element that is attached to a structure at one side and fixed 'to the world' at the
other side. Fixed-end anchors can be used to simulate piles in a simplified way, i.e. without taking into account
pile-soil interaction. Alternatively, fixed-end anchors can be used to simulate anchors or props to support
retaining walls. The length of the plotted T is arbitrary and does not have any particular physical meaning.
The creation of a fixed-end anchor is similar to the creation of a geometry point (Create point (on page 97)). The
default direction is (1, 0, 0), which is in positive x-direction. The direction of the fixed-end anchor is defined
starting from the fixed-end anchor connection point in the fixed-end anchor direction. The user may enter the
fixed-end anchor direction by specifying the individual x-, y- and z-components. The length defined by the
individual components is defined as the equivalent length of the fixed-end anchor.
The Equivalent length parameter of a fixed-end anchor is defined as the distance between the anchor connection
point and the fictitious point in the longitudinal direction of the anchor where the displacement is assumed to be
zero. For example: In the case of a symmetric excavation that is supported by a propped retaining wall, a fixedend anchor may be used to stimulate the prop. In this case, the equivalent length of the fixed-end anchor is half
the excavation width. The direction and equivalent length of a fixed-end anchor may be changed in the Object
explorers. Changing the equivalent length will change the individual direction components while retaining the
anchor direction.
Only one fixed-end anchor can be created at a single geometry point, which means that this point can only be
supported in one direction. In the case that more support directions in a single point are required, the following
options exist:
• If the point is to be supported in both horizontal and vertical direction, a fixed-end anchor (spring support)
can be used in one direction whereas a point fixity can be applied at the same point to fix the other direction
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(while the anchor direction is set free). Disadvantage of this solution is that the anchor features (spring
support, pre-stressing, resulting force, etc.) are not available for a point fixity.
• If the point is to be supported in two arbitrary directions, a node-to-node anchor may be used instead of a
second fixed-end anchor, provided that the node-to-node anchor is at the other node connected to a model
boundary that is fixed in the anchor direction. This may not necessarily lead to the right equivalent anchor
length. Hence, the anchor stiffness EA needs to be adjusted such that the ratio EA/L gives the required value.
Example (see Figure 104 (on page 140)): The basement corner is to be supported by spring supports in xand y-direction, considering fixed-end anchors, both with an equivalent length of 2m. Since only one fixedend anchor can be used for a single geometry point, the vertical support is modelled by means of a node-tonode anchor that is connected to the bottom of the model (which is fully fixed). However, the length of the
node-to-node anchor is 4m in this case, which is twice as large as the desired equivalent length of 2m. That
means that a new anchor material data set needs to be created for the node-to-node anchor in which the
anchor stiffness EA is increased by a factor 2 in order to have the same EA/L as for the fixed-end anchor.

Figure 104: Representation of connection of fixed-end anchor and node-to-node anchor
Anchor material properties
The material properties of fixed-end anchors are contained in Anchors material data sets (Material data sets for
anchors (on page 314)) and can be conveniently assigned using drag-and-drop, the Object explorers or the right
hand mouse button menu in the drawing area (Assigning material data sets to geometry components (on page
317)).

5.8.2 Node-to-node anchors
Node-to-node anchors can be used to model a spring connection between two points. Typical applications
include the modelling of a cofferdam.
The creation of a node-to-node anchor is similar to the creation of a geometry line (Create line (on page 98)).

PLAXIS

140

PLAXIS 3D-Reference Manual

Modelling loads and structures - Structures mode
Structural elements
Since a node-to-node anchor is a line-based entity rather than a point-based entity, different node-to-node
anchors can be connected to the same geometry point, provided that they do not fully coincide.
Anchor material properties
The material properties of node-to-node anchors are contained in Anchors material data sets and can be
conveniently assigned using drag-and-drop, using the Object explorers or the right hand mouse button menu in
the drawing area (Assigning material data sets to geometry components (on page 317)).
Note: A node-to-node anchor cannot be assigned to a line to which other features are assigned.

5.8.3 Beams
Beams are structural objects to model slender (one-dimensional) structures with a significant flexural
rigidity (bending stiffness) and an axial stiffness. The creation of a beam is similar to the creation of a geometry
line (Create line (on page 98)).
Beam elements
After meshing beams are composed of 3-node line elements (beam elements) with six degrees of freedom per
node: three translational degrees of freedom (ux, uy and uz) and three rotational degrees of freedom ( φx, φy and
φz). The beam elements are based on Mindlin's beam theory (Bathe, 1982 (on page 508)). This theory allows for
beam deflections due to shearing as well as bending. In addition, the element can change length when an axial
force is applied. Element stiffness matrices are based on the properties as defined in the material data sets and
numerically integrated from the four Gaussian integration points (stress points) along the length of the element
and numerically integrated from the 4 (2x2) Gaussian integration points over the cross section of the element.
These 4 stress points are located at a distance
3deq2
6

3deq3
6

in the local 3-direction of the beam and at a distance of

in the local 2-direction of the beam, where:
deq3 = 12
deq2 = 12

I3
A
I2

Eq. [4]

A

Details about the element formulation are given in the Scientific Manual.
When a beam element is connected to another structural element, they share all degrees of freedom in the
connected node, which implies that the connection is rigid (moment connection) unless a (custom) Connection is
defined (Definition of connections (on page 384)).
When a beam extends to the model boundary, additional boundary conditions for the rotational degrees of
freedom are automatically applied (Model conditions (on page 389)).
Beam material properties
The material properties of beams are contained in Beams material data sets (Material set (on page 302)) and
can be conveniently assigned using drag-and-drop, the Object explorers or the right hand mouse button menu in
the drawing area (Assigning material data sets to geometry components (on page 317)).
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5.8.4 Embedded beams
An embedded beam is a structural object (such as a pile, rock bolt or grout body) composed of beam elements
that can be placed in arbitrary direction in the sub-soil and that interacts with the sub-soil by means of special
interface elements. The interaction may involve a skin resistance as well as a foot resistance. The skin friction
and the tip force are determined by the relative displacement between the soil and the pile. Although an
embedded beam does not occupy volume, a particular volume around the pile (elastic zone) is assumed in which
plastic soil behaviour is excluded. The size of this zone is based on the (equivalent) pile diameter according to
the corresponding embedded beam material data set. This makes the pile behave almost like a volume pile.
However, installation effects of piles are not taken into account and the pile-soil interaction is modelled at the
centre rather than at the circumference.
Note: The embedded beams are suitable for pile types that cause a limited disturbance of the surrounding soil
during installation. This may include some types of bored piles (e.g. displacement screw piles), but not most of
the technologies for replacement piles or displacement piles. The installation effect has a significant influence on
the soil stress ratio (K0) and the pile skin resistance (Tskin). In such a case, it's necessary to properly evaluate
these factors in order to simulate the pile installation effect.
The creation of a pile is similar to the creation of a geometry line. The point of connection of the pile to the
surrounding geometry and the type of the connection can be specified in the Object explorers.
The behaviour options available for Embedded beam are:
Pile

The Embedded beam is set to Pile.

Rock bolt

The Embedded beam is set to Rock bolt.

Grout body

The Embedded beam is set to Grout body.

Depending on the Embedded beam behaviour for Pile and Rock bolts, the connection point may be indicated as:

Top/Bottom

In the case the Embedded beam is a Pile, the connection point from the dropdown menu can be specified in the Selection explorer as Top or Bottom. Top
refers to the point on the embedded beam that has the highest z-coordinate in
the model. In the rare case of an exactly horizontal embedded beam defined as a
Pile, Top refers to the point with the minimum x-coordinate. In case z-coordinate
and x-coordinate are the same, the point that has the minimum y-coordinate is
considered the Top.

First/Second

In the case the Embedded beam is a Rock bolt, the connection point from the
drop- down menu can be specified in the Selection explorer as First or Second.
First refers to the first point of the corresponding geometry line, as listed in the
Selection explorer when the embedded beam is selected, whereas second refers
to the second point of the corresponding geometry line.

In the case of the pile connection point coinciding with soil elements, the connection behaviour is as follows:
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Free

The Connection point is free to move and rotate relative to the surrounding soil.
The pile and the surrounding soil interact only through the special interface
elements.

Hinged

The displacement at the connection point of the pile is directly coupled with the
displacement of the soil element in which the pile connection point is located,
which means that they undergo exactly the same displacement. However, their
rotation may be different.

Rigid

The displacement and rotation at the pile connection point are both coupled with
the displacement and rotation of the soil element in which the pile top is located,
provided that this element has rotational degrees of freedom. This option only
applies if the pile connection point coincides with structural elements like plates
or beams.

In the case of the pile connection point coinciding with structural elements (without interface elements) the
connection behaviour is as follows:

Free

The Connection point is free to move and rotate relative to the surrounding soil
and the structural element. The pile interacts with the surrounding soil and the
structural elements only through the special interface elements. Note that the
structural elements are not free to move and rotate relative to the surrounding
soil.

Hinged

The displacement at the connection point of the pile is directly coupled with the
displacement of the structural element and/or the surrounding soil in which the
pile connection point is located, which means that they undergo exactly the same
displacement.

Rigid

The displacement and rotation at the pile connection point are both coupled with
the displacement and rotation of the structural and/or soil element in which the
pile top is located.

In the case of the pile connection point coinciding with structural elements which interaction with the
surrounding soil is modelled using interfaces, the connection behaviour is as follows:

Free

The Connection point is free to move and rotate relative to the surrounding soil.
The pile interacts with the surrounding soil and the structural elements only
through the special interface elements. In the same way, the structural element
interacts with the surrounding soil through the defined interface elements. This
is the default option in the program.

Hinged

The displacement at the connection point of the pile is directly coupled with the
displacement of the structural element in which the pile connection point is
located, which means that they undergo exactly the same displacement. Note
that the structural element interacts with the surrounding soil through the
defined interface elements.
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Rigid

The displacement and rotation at the pile connection point are both coupled with
the displacement and rotation of the structural element in which the pile top is
located. Note that the structural element interacts with the surrounding soil
through the defined interface elements.

The options specified for the embedded beam in the Object explorers are valid for the connection of the anchorpile connection to the surrounding soil.
When an anchor is present in the model, the user can select the option Grout body for the behaviour of
embedded beams. At the position of an embedded beam connection point, the anchor will be automatically
connected to the embedded beam connection point and not to the corresponding point in the soil element. The
connection type is intrinsically set to Free (i.e. free from the surrounding soil volume).
Note:
• When embedded beams penetrate a volume cluster with linear elastic material behaviour, the specified value
of the shaft resistance is ignored. The reason for this is that the linear elastic material is not supposed to be
soil, but part of a structure. The connection between the pile and the structure is supposed to be rigid to
avoid, for example, punching of piles through a concrete deck.
• An alternative option for this is between an embedded beam and a volume cluster structure, the beam could
be elongated into the structure for a certain length. To avoid mesh-dependent results for the internal forces
of the embedded beam (linked to the elongation length), the user could insert an elastic plate at the volume
cluster side where the connection with the embedded beam takes place. The beam can be now linked to the
plate without elongating it in the volume cluster structure.

Embedded beam elements
An embedded beam consists of beam elements with special interface elements providing the interaction
between the beam and the surrounding soil.
After meshing, the beam elements are 3-node line elements with six degrees of freedom per node: Three
translational degrees of freedom (ux, uy and uz) and three rotational degrees of freedom ( φx, φy and φz). Element
stiffness matrices are numerically integrated from the four Gaussian integration points (stress points). The
element allows for beam deflections due to shearing as well as bending. In addition, the element can change
length when an axial force is applied.
The special interface elements are different from the regular interface elements as used along walls or volume
piles. Therefore, at the position of the beam element nodes, virtual nodes are created in the soil volume element
from the element shape functions. The special interface forms a connection between the beam element nodes
and these virtual nodes, and thus with all nodes of the soil volume element.
Pile forces (structural forces) are evaluated at the beam element integration points and extrapolated to the beam
element nodes. These forces can be viewed graphically and tabulated in the Output program. Details about the
embedded beam element formulations are given in the Scientific Manual.

Embedded beam material properties
The material properties of embedded beam are contained in Embedded beamsEmbedded beam rows material
data sets (Material set (on page 307)) and can be conveniently assigned using drag-and-drop, the Object
explorers or the right hand mouse button menu in the drawing area (Assigning material data sets to geometry
components (on page 317)).
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More information regarding the material properties of the embedded beam is given in Interaction properties:
bearing capacity (on page 311).

5.8.5 Plates
Plates which are actually shell elements are structural objects used to model thin two-dimensional
structures in the ground with a significant flexural rigidity (bending stiffness). The creation of a plate is similar
to the creation of a geometry surface (Create surface (on page 105)).

Plate elements
After meshing plates are composed of 6-node triangular plate elements with six degrees of freedom per node:
three translational degrees of freedom (ux, uy and uz) and three rotational degrees of freedom ( φx, φy and φz).
The plate elements are based on Mindlin's plate theory (Bathe, 1982 (on page 508)). This theory allows for plate
deflections due to shearing as well as bending. In addition, the element can change length when an axial force is
applied. Element stiffness matrices are based on the properties as defined in the material data sets and
numerically integrated from the three pairs of Gaussian integration points (stress points). Within each pair,
3

stress points are located at a distance 6 d above and below the plate centre-line.
It is important to note that a change in d will change the distance separating the stress points. If this is done
when existing forces are present in the plate element, it would change the distribution of bending moments,
which is unacceptable. For this reason, d must remain unchanged. Details about the element formulation are
given in the Scientific Manual.

Plate properties
The material properties of plates are contained in Plates material data sets (Material set (on page 292)) and can
be conveniently assigned using drag-and-drop, the Object explorers or the right hand mouse button menu in the
drawing area (Assigning material data sets to geometry components (on page 317)).
Structural forces are evaluated at the plate element integration points (Scientific Manual) and extrapolated to
the element nodes. These forces can be viewed graphically and tabulated in the Output program. Details about
the material properties are given in the Material Models Manual - Chapter 18 - 3D Embedded beam.

5.8.6 Geogrids
Geogrids are slender structures with an axial stiffness but with no bending stiffness. Geogrids can only
sustain tensile forces and no compression. These objects are generally used to model soil reinforcements.

Figure 105: Applications in which geogrids are used
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Geogrid elements
After meshing, geogrids are composed of 6-node triangular surface elements with three translational degrees of
freedom per node (ux, uy and uz). Element stiffness matrices are based on the properties as defined in the
material data sets and numerically integrated from the three Gaussian integration points (stress points). The
element can change length when a tension force is applied. Details about the element formulation are given in
the Scientific Manual. When a geogrid element is connected to another structural element, they share the
translational degrees of freedom in the connecting node(s).

Geogrid elements
The basic material parameter is the axial stiffness EA. In addition the tension force can be limited to allow for the
simulation of tension failure. Axial forces can be viewed graphically and tabulated in the Output program. Details
about the material properties are given in Material set (on page 297) and Reference Manual.
When using geogrid elements in PLAXIS 3D for modelling of true geogrids, note that most such applications
require the use of updated mesh calculations to take membrane effects into account. Most applications also
require the use of anisotropic properties to avoid unrealistic shear deformations.

5.8.7 Interfaces
Interfaces are joint elements to be added to plates or geogrids to allow for a proper modelling of soil-structure
interaction. Interfaces may be used to simulate, for example, the thin zone of intensely shearing material at the
contact between a plate and the surrounding soil. Interfaces can be created next to plate or geogrid elements or
between two soil volumes.
An interface can be created using the Create interface option available in the menu displayed when the
Create structure button in the side toolbar is clicked. The creation of an interface is similar to the creation of a
surface (Create surface (on page 105)). In this case a surface with an interface assigned to it will be created.
When the geometric entity (surface) is already available in the model it is advised to assign an interface to it
without recreating the geometry in order to prevent the model from being unnecessarily large and unwieldy.
Assignment of features to existing geometric entities is described in Advanced geometric modelling options (on
page 107).
Distinction is made between a positive interface (the side of the surface at the positive local z-direction) and a
negative interface (the side of the surface at the negative local z-direction).
Note: The sign of an interface is only used to enable distinguishing interfaces at either side of a surface, but it
does not affect its behaviour.
Interfaces can be activated or de-activated in calculation phases using Staged construction as Loading input.

Interface properties
The interfaces created in the model are listed in the Interfaces subtree in the Object explorers. Properties such as
Material mode, permeability condition and Virtual thickness factor, available for each interface in the Object
explorers can be assigned to an interface in the model (Figure 106 (on page 147)).
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Figure 106: Interfaces in the Selection Exploter
Material mode
The material properties of an interface can be assigned according to the mode specified in the selected interface
subtree in the Object explorers. As an example, consider a typical application of interfaces such as the interaction
between a diaphragm wall and the soil, which is intermediate between smooth and fully rough. The options
available are:
From adjacent soil

The roughness of the interaction is modelled by choosing a suitable value for the
strength reduction factor (Rinter) specified in the Interface tabsheet of the material set
assigned to the surrounding material. Optionally, a residual strength (Rinter,residual) can
be specified if the interface strength is reached. This factor relates the interface strength
(wall friction and adhesion) to the soil strength (friction angle and cohesion). Note that
by default the From adjacent soil option is selected for the Material mode parameter. For
detailed information on the material properties of interfaces see Interfaces tabsheet (on
page 257).

Custom

A material dataset can be assigned directly to an interface when the Custom option is
selected. Note that the strength reduction factor of the selected material is by default set
to one.

Permeability
By default structural elements such as Plates and Geogrids are permeable. Impermeability can be introduced by
assigning an interface to the geometric entity, besides the structural element. In principle, interface
permeabilities (cross permeability and parallel permeability) are defined in the corresponding material data set
( Interfaces tabsheet (on page 257)). However, note that for an interface a checkbox is available in the Objects
explorers, to make the interface either Active in flow or Inactive in flow. This has consequences for the actual
interface permeability being used in a calculation phase (Table 4 (on page 147)). In Flow only calculations no
structural element needs to be assigned to the geometric entity as deformations will not be taken into account.
Hence, it is sufficient to use only interfaces to block the flow. Note that the end points of an interface are always
permeable.
Table 4: Resulting settings for permeabilities in Interfaces
Setting in material database
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Cross permeability

Parallel
permeability

Impermeable

Infinite cross
resistance (or zero
permeability)

Infite cross
permeability (or
zero resistance)

No output of flow qn
available.

Semi-permeable

Input value of
Infite cross
hydraulic resistance permeability (or
used ( Interfaces
zero resistance)
tabsheet (on page
257))

Output of flow qn
available when
active.

Fully permeable

Infite cross
permeability (or
zero resistance)

Infite cross
permeability (or
zero resistance)

No output of flow qn
available.

Drainage
conductivity

Input value of
drainage
conductivity used (
Interfaces tabsheet
(on page 257) )

Zero parallel flow

Output of discharge
Q1 available when
active.

Virtual interface thickness
Each interface has assigned to it a 'virtual thickness' which is an imaginary dimension used to define the
material properties of the interface. The higher the virtual thickness is, the more elastic deformations are
generated. In general, interface elements are supposed to generate very little elastic deformations and therefore
the virtual thickness should be small. On the other hand, if the virtual thickness is too small, numerical illconditioning may occur. The virtual thickness is calculated as the Virtual thickness factor times the global
element size. The global element size is determined by the global coarseness setting for the mesh generation (
Global settings (on page 321)). The default value of the Virtual thickness factor is 0.1. This value can be changed
in the Object explorers. In general, be careful when changing the default factor. However, if interface elements are
subjected to very large normal stresses, it may be required to reduce the Virtual thickness factor. Further details
of the significance of the virtual thickness are given in Interfaces tabsheet (on page 257).

Interface elements
After meshing, interfaces are composed of 12-node interface elements. Interface elements consist of pairs of
nodes, compatible with the 6-noded triangular side of a soil element or plate element. In some output plots,
interface elements are shown to have a finite thickness, but in the finite element formulation the coordinates of
each node pair are identical, which means that the element has a zero thickness.
The stiffness matrix for triangular interface elements is based on the properties as defined in the material data
sets and obtained by means of Gaussian integration using 6 integration points. The position of these integration
points (or stress points) is chosen such that the numerical integration is exact for linear stress distributions. For
more details about the element formulation reference, see Scientific Manual.
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nodes
stress points

Figure 107: Distribution of nodes and stress points in interface elements and their connection to soil elements
At interface ends interface element node pairs are 'degenerated ' to single nodes. Also when structural elements
are connected perpendicular to each other (for example, a plate is connected to a beam), interface element node
pairs are locally 'degenerated' to single nodes to avoid a disconnection between both structural elements.

Interfaces around corner points
Figure 108 (on page 149) and Figure 109 (on page 149) show that problems of soil-structure interaction may
involve points that require special attention. Corners in stiff structures and an abrupt change in boundary
condition may lead to high peaks in the stresses and strains. Volume elements are not capable of reproducing
these sharp peaks and will, as a result, produce non-physical stress oscillations. This problem can be solved by
making use of interface elements as shown in Figure 109 (on page 149).

Figure 108: Inflexible corner point, causing poor quality stress results

Figure 109: Flexible corner point with improved stress results
Figure 109 (on page 149) shows that the problem of stress oscillation may be prevented by specifying additional
interface elements inside the soil body. These elements will enhance the flexibility of the finite element mesh
and will then prevent non-physical stress results. However, these elements should not introduce an unrealistic
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weakness in the soil. Therefore special attention should be made to the properties of these interface elements (
Interfaces tabsheet (on page 257)).
At interface ends, interface element node pairs are 'degenerated' to single nodes. When an interface exists on
only one side of a structure, the interface end node is collapsed to the corresponding structure node. As a result,
there exists only one node at that location. When interfaces are assigned on both sides of a structure the end
nodes of the interfaces are collapsed, however the collapsed node is not the corresponding structure node. As a
result, there exist two nodes at that specific location, the structure node and the node shared by both interfaces.
The interactions between the structure and the surrounding soil at that node is controlled by a combined effect
of both interfaces. Also when structural elements are connected perpendicular to each other (for example, a
plate is connected to a beam), interface element node pairs are locally 'degenerated' to single nodes to avoid a
disconnection between both structural elements, connecting them rigidly. A description on how to define a nonrigid connection is given in Definition of connections (on page 384). Additional theoretical details on this special
use of interface elements is provided by Goodman, Taylor & Brekke (1968) (on page 509) and Langen &
Vermeer (1991) (on page 510) .

5.8.8 Rigid bodies
When modelling soil-structure interaction problems, the structures are usually much stiffer and stronger than
the soil. In many situations it is still relevant to model structures with their actual stiffness and strength
properties in order to calculate realistic deformations and structural forces in those structures. Moreover,
contact stresses between soil and structures are influenced by their relative stiffnesses; for example contact
stresses behind a soil retaining wall can vary from 'passive' (Kp) to 'active' (KA), depending on the stiffness of the
wall and the stiffness of wall supports (struts, anchors).
In situations where deformations of structures and structural (internal) forces are not supposed to be relevant
in output data, these structures may simply be modelled as 'stiff' structures, with an arbitrary stiffness that is
sufficiently large compared to the stiffness of the soil. However, considering an arbitrarily large stiffness may
deteriorate the condition of the global stiffness matrix, and should therefore be used with care. As an alternative
to this, PLAXIS 3D provides the option to create so-called 'rigid body' objects based on predefined geometry
components (surfaces and volumes).
Examples where rigid bodies may be used are the following:
•
•
•
•

Rigid foundation plate (footing, mud mat)
Rigid wall
Bucket foundation
Spud can (foundation for jack-up platform legs)

To create a rigid body object in the Structures mode, create the required geometry components first; then
(multi-) select the corresponding surfaces and volumes that are to be included in the rigid object, and select the
Create rigid body option from the context menu. Multiple rigid bodies may be created in this way in a PLAXIS 3D
model. The rigid bodies will appear in the Model explorer. Each rigid body has a Reference point associated to it
and it should be given a combination of forces / moments and/or displacements / rotations in x, y and zdirection (Figure 110 (on page 151)), in order to apply external forces and to set its boundary conditions.
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Figure 110: Rigid body in the Selection explorer
The reference point of a rigid body can be an arbitrary point (independent from existing geometry points),
defined by its three coordinates (x y z). Upon mesh generation, this point will NOT appear as mesh node.
However, during calculations, the reference point is associated with six independent degrees-of-freedom (ux, uy,
uz, φx, φy, φz) and six corresponding force components (Fx, Fy, Fz, Mx, My, Mz) in the global system of equations.
During calculations, all stiffness components related to any of the nodes involved in the rigid body's surface(s)
and volume(s) will be transformed into stiffness components related to the movement of the rigid body
reference point, while the original nodal degrees-of-freedom are linked to the movement of the rigid body
reference point. In a similar way, during dynamic calculations, mass components related to any node of the rigid
body will be transformed into mass components related to the rigid body reference point. In this way, the rigid
body itself will not deform (it will move, but not deform) and therefore it is not possible to calculate internal
stresses and structural forces. On the other hand, contact stresses and forces between the rigid body and the soil
are properly calculated, as long as there are interface elements between the rigid body and the soil.

Conditions
Since the reference point involves separate degrees-of-freedom that are independent from the rest of the finite
element model, boundary conditions need to be specified for all six degrees-of-freedom of a rigid body. These
boundary conditions may involve a Force condition (Force or Moment) or a Displacement condition (Displacement
or Rotation). It is possible to add dynamic boundary conditions to rigid bodies by adding multipliers when the
Translation Condition is selected as Displacement. This is only possible in Dynamic calculation phases. Note that
the Moment and Rotation conditions refer to a moment or rotation around the corresponding axis, where a
positive value corresponds to a clock-wise rotation when looking into the axis positive direction. The type of
condition for each of the degree-of-freedom must be selected by the user. The user is responsible for selecting
rigid body conditions that are compatible with the boundary conditions of the full finite element model.
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Instead of or in addition to conditions in the reference point, external loads (point loads, line loads or distributed
loads) may be defined at a rigid body in the geometry. Considering half a symmetric model of a rigid plate, while
the y=0 plane is the symmetry plane (Figure 111 (on page 152)), the plate can only move in x- and z-direction
and rotate around the y-axis. Hence, in this case the user has to make sure that uy=0, φx=0 and φz=0 are specified
as conditions for the rigid body, while the remaining three components can be set as desired.

Figure 111: Rigid body

Limitations
The rigid body element in PLAXIS 3D is an advanced feature. The user has to be aware of the limitations of this
feature and is responsible for setting the right conditions to ensure the consistency of the model.
Incompatibilities in the conditions of the rigid body are not checked by the PLAXIS 3D user-interface. In addition
to the aforementioned example where appropriate symmetry conditions have to be applied at the rigid body
reference point, there are some other limitations related with the use of rigid bodies during calculations.
• Note that prescribed displacements that are applied on nodes as a part of an active rigid body, are not taken
into account during the calculation. Instead, prescribed displacements that need to be applied to a rigid body
have to be specified as Displacement conditions at the rigid body reference point.
• In case a rigid body is used in dynamic calculations, the user has to ensure that the location of its reference
point coincides with the centre-of-gravity of the rigid body, considering all mass components of the nodes
involved. If the reference point does not coincide with the centre of gravity, out-of-balance forces might
develop which may not be solved during the calculation. Note that if a rigid body is directly connected to the
surrounding soil (i.e. it shares the same nodes in the boundary between the rigid body and the soil), the
boundary nodes of the rigid body contain weight components of the surrounding soil elements, and it might
be difficult to identify the exact location of the centre-of-gravity. In that case it is recommended to add
interface elements around the rigid body to ensure that only weight components of the rigid body itself are
considered.
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5.9 Tunnels
The Create tunnel in the side (vertical) toolbar can be used to create arbitrary shaped tunnels which are to
be included in the geometry model. A tunnel shape consists of a tunnel cross section, composed of arcs and lines,
optionally supplied with features such as lining (plates), interfaces, loads, prescribed displacements,
contractions, groundwater flow boundary conditions, etc.
The tunnels available in the model are listed in the Tunnels subtree in the Model explorer. The geometry and the
properties of a tunnel can be defined in the Tunnel explorer window.
Note:
• Note that it is not possible to undo/redo actions carried out to define a tunnel cross-section when the Tunnel
designer window is closed.
• The Tunnel designer window can be reopened by right-clicking on one of the available tunnels in the Object
explorers and selecting the Edit option in the appearing menu.

5.9.1 Tunnel designer
Once the Create tunnel button is clicked in the side toolbar, the user needs to select the tunnel insertion point in
the geometry. After that, the Tunnel designer window appears.
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Figure 112: The General tabsheet of the Cross-section mode
The Tunnel designer contains the following items:
Tunnel menu

It contains the File menu that enables loading predefined tunnels as well as saving newly
created ones.

Main toolbar

It contains buttons that enable loading predefined tunnels, saving new tunnels and
arranging the view in the display area.

Mode bar

It contains two separate modes where the cross-section is defined and properties are
assigned to its components.

Display area

It displays the defined geometry and it indicates the assigned properties. The slice is
automatically updated after any change done in the modes in the left side. The
supporting tools under the display area can be used to simplify the definitions and
modification of the slice.

Feedback panel

It provides feedback on the quality of the defined cross section.

The design of a tunnel cross section is done in two separate modes, Cross-section and Properties. The geometric
shape of the tunnel cross-sections can be defined in the Cross-section mode, whereas in the Properties mode
features can be assigned to existing cross-section elements.
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5.9.2 Definition of tunnel cross section geometry
The tunnel cross section is a collection of lines and arcs. Each line and arc composing the cross-section is defined
as a segment.
1. General
The general shape settings of a tunnel are defined in the General tabsheet.
Shape: The available types for the shape of a tunnel are:
Free

Allows to create a tunnel cross section composed of lines and arc segments.

Circular

Allows to create a circular tunnel.

Template

Allows to split tunnels into separate tunnels (Tunnel splitting tool (on page 166)).

Whole or half
tunnel

Allows to create a whole tunnel or a half one.

Layout of the tunnel in the model: The general properties of a tunnel in the model are defined using the
options in the General tabsheet.
• The coordinates of the insertion point can be defined in the Object explorers. By default the coordinates of
the location clicked in the model before the Tunnel designer window is displayed are shown. As the
coordinates are changed, the tunnel will be relocated.
• By default the insertion point is the starting point of the first segment of the tunnel cross section. The
Offset to begin point group can be used to specify offset distances from the orientation axis when the
insertion point (origin of the orientation axis) and the starting point of the first segment of the cross
section do not coincide.
• The Orientation axis 1 and the Orientation axis 2 define the orientation of the tunnel in the model.
2. Definition of segments
The segments of a cross section can be defined in the Segments tabsheet of the Tunnel designer window
(Figure 113 (on page 156)).
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Figure 113: The Segments tabsheet of the Cross-section mode
A new segment is added to the last segment in a tunnel cross-section by clicking the Add segment button
available in the side toolbar. The last point of the last segment is the first point of the newly added segment.
The newly created segment is displayed in the segment list Figure 113 (on page 156).
Note: A segment can be selected by clicking it either in the list or in the display area. A selected segment is
highlighted in the list and in the display area.
A new segment is inserted before a selected segment in a tunnel cross-section as the Insert segment
button is clicked. The last point of the newly inserted segment becomes the first point of the previously
selected segment. The indices of the segments are updated according to their position in the list.
A selected segment in a cross-section is deleted as the Delete segment button is clicked. The indices of the
segments are updated according to their position in the list.
In the Subsections tabsheet, the points and segments can be right-clicked and the suitable option to create a
subsection turns on in the side bar. This feature allows to create a new subsection starting from the end point
and angle of the selected elements.
When a point is selected, it generates an horizontal straight line. When a point is selected, the option Add
subsection from point is also available right-clicking in the Slice drawing area.
When a point and a segment are selected, it generates a straight line with a start angle equal to the
tangent of the selected segment in the selected point. When a point and a segment are selected, the option
Add directed subsection from point is also available right-clicking in the Slice drawing area.
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When two points are selected, it generates a straight line connecting the chosen points. When two points
are selected, the option Add subsection between points is also available right-clicking in the Slice drawing area.
Editable segments properties
Segment type

The options available are Line and Arc. For a Line segment the length of the segment
should be specified. For an Arc segment the radius and the segment angle should be
specified (Figure 114 (on page 157)).

Relative start angle

The value of the angle between the start tangent of the next segment and the end
tangent of the previous segment (Figure 115 (on page 158)).

Radius

Arc only. The value of the radius for an arc segment.

Length

Line only. The value of the line segment length.

Segment angle

The value of the arc length expressed in degrees.

Start angle

The value of the angle between the start tangent of the segment and the global
tangent.

Δ1

The horizontal increment of the line formed by the start and end point of the segment.
Δ1 is in local polycurve space (defined by the orientation axes), not global model
space.

Δ2

The vertical increment of the line of formed by the start and end point of the segment.
Δ2 is in local polycurve space (defined by the orientation axes), not global model
space.

The rest of parameters are read-only and cannot be edited.
Note: When modelling arcs using derived parameters Δ1 and Δ2, there will often be two solutions for the
same absolute x or y value. In those situations, PLAXIS will always take the shortest segment. To design those
ambiguous cases correctly, use the remaining parameters.

Segment angle

Radius

Figure 114: Properties of Arc segment
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When specifying a negative radius for an Arc segment, the arc will be mirrored in the line described by the
tangent vector. Note that when the Circular shape option is selected, the created cross-section consists only
of one Arc segment with a Segment angle value of 360° or 180°, depending on whether the whole tunnel or
only half of it is being defined.
Tangent to segment 2

Tangent to segment 1

Segment 2

Relative start angle

Segment 1

Figure 115: Description of Relative start angle
•
•
•

To extend the cross-section to the symmetry axis click the corresponding button in the toolbar. A new
segment is added connecting the last point of the cross-section to the axis of symmetry.
To close the cross-section by mirroring the existing segments, click the Symmetric close button in the
toolbar. This is only possible when one half is completed up to the axis of symmetry.
To close the cross-section click the corresponding button in the toolbar. A new segment is created
connecting the last point of the cross-section to the first one.

3. Definition of tunnel sub-clusters
The subdivision of a tunnel cross-section into different subsections can be subdivided in the Subsections
tabsheet. In this way the various subsections for a NATM tunnel or a sequential excavation tunnelling process
can be defined (e.g. top heading, bench, invert, side drift). Essentially the geometric properties of the lines
and arcs as well as the buttons in the side toolbar are the same as in the Segments tabsheet. There is no
closure requirement for the geometry defined in the Subsections tabsheet. A sub-section may conveniently
start from an existing geometry point, but sub-sections may also be defined independently.
To intersect the defined geometry:
• Select the geometric entities to be intersected.
•
Click the Intersect button.
•
Delete the redundant parts after the intersection.
To define thick tunnel lining:
•
Click the Generate thick lining button in the side toolbar in the Subsections tabsheet. The Generate
thick lining window pops up.
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• Specify the thickness of the lining in the appearing window. A positive value will give an extra line outside
of the current geometry contour. The reverse is true for a negative thickness value. Note that when the
tunnel is included in the geometry model, a subcluster will be created for the thick lining. A proper
material should be assigned to it, as it is done for the soil clusters.

Figure 116: The Generate thick lining window

5.9.3 Import tunnel geometry
Existing tunnel geometry can be imported in the Segments tabsheet in the Cross section mode of the
Tunnel designer window. The program supports *. pntl, *.dxf, *.step, *.stp and *.brep files. *.pntl files can also be
exported and saved (Importing geometry (on page 112)). For an imported geometry to be a valid cross section
the following requirements must be met:
• It must contain a polyline, or circle, defining the outer boundary of the tunnel. This may consist of line
segments of both line and arc types. The component of the outer boundary will be listed as segments.
• If the imported geometry contains more than one polycurve, the polycurve with the largest bounding box is
imported as the cross-section and the others as subsections.
• Entities of incompatible types are omitted from the import.

5.9.4 Definition of tunnel trajectory
The trajectory (path) of the tunnel in the model can be created in the corresponding tabsheet in the Tunnel
designer.

General
The general shape settings of a tunnel trajectory are defined in the General tab of the Trajectory tabsheet.
Layout of the trajectory in the model: The general properties of the trajectory of a tunnel in the model are
defined using the options in the General tabsheet.
• The coordinates of the insertion point can be defined in the Object explorers. By default the coordinates of the
location clicked in the model before the Tunnel designer window is displayed are shown. As the coordinates
are changed, the tunnel will be relocated.
• By default the insertion point is the starting point of the first segment of the tunnel cross section. The Offset
to begin point group can be used to specify offset distances from the orientation axis when the insertion point
(origin of the orientation axis) and the starting point of the first segment of the cross section do not coincide.
• The Orientation axis 1 and the Orientation axis 2 define the orientation of the trajectory in the model.
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Segments
The number of segments the Trajectory must contain is defined in the Segments tabsheet.

Figure 117: Definition of Segments in a trajectory
Definition of segments: The segments of a cross section can be defined in the Segments tab of the Trajectory
tabsheet (Figure 118 (on page 161)).
•

•

•
•

A new segment is added to the trajectory of a tunnel by clicking the Add segment button available in the
side toolbar. The last point of the last segment is the first point of the newly added segment. The newly
created segment is displayed in the segment list.
A new segment is inserted before a selected segment to the trajectory of a tunnel as the Insert segment
button is clicked. The last point of the newly inserted segment becomes the first point of the previously
selected segment. The indices of the segments are updated according to their position in the list.
A selected segment in a trajectory is deleted as the Delete segment button is clicked. The indices of the
segments are updated according to their position in the list.
Import a polycurve to define the trajectory of the tunnel. The polycurve can only contain lines and arcs
positioned on the XY-plane. The program supports *.dxf, *.step, *.stp and *.brep files (Importing geometry (on
page 112)).

Slices
The number of slices for the tunnel trajectory may be defined in the Slices tab of the Trajectory tabsheet.
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Figure 118: Definition of Segments in a trajectory
Definition of slices: A new slice is automatically created when a segment is added to the trajectory.
Slicing method: The available types for slicing methods are:
Length

Allows to create slices based on Slice length. This can be done by setting a particular
value to the length. The slicing can start from the beginning or the end of the segment,
which can be selected from the dropdown menu of Starting from.

Number

Allows to create slices based on Number of slices in a selected segment.

•

•

•
•

To merge specific slice groups, multi-select consecutive slice groups of interest and then click on the
button Merge slice groups on the left side of the drawing panel. The merged slicing group now has properties
which have been copied from the first slice group.
To merge all slice groups click on the button Merge all slice groups. The resulting slice group has
properties which have been copied from the first slice group. This action is possible only if all the slicing
group have similar properties with respect to slicing method and slice length.
To reset all slicing for every slice group of the segment click on the button Reset slicing on the left side of
the drawing panel. It removes all properties and resets them to the original state.
To unmerge slice groups, click on the button Unmerge slice groups on the left side of the drawing panel.

5.9.5 Properties

PLAXIS

161

PLAXIS 3D-Reference Manual

Modelling loads and structures - Structures mode
Tunnels
Features can be assigned to the tunnel segments and subsections in the Properties mode by right-clicking the
segment and selecting the corresponding option in the appearing menu.
The features available in the Slice panel are:
Create surface load

To assign a surface load to the selected segment (or subsection).

Create surface
prescribed
displacement

To assign a surface prescribed displacement to the selected segment (or subsection).

Create surface
contraction

To assign a surface contraction to the selected segment (or subsection).

Create surface drain

To assign a surface drain to the selected segment (or subsection).

Create plate

To model a tunnel shield or a shotcrete lining using the Plate feature.

Create geogrid

To model a temporary support or a shotcrete lining using the Geogrid feature.

Interfaces

To model the interaction of the tunnel lining with the surrounding soil (rock) in the
selected segment.

Groundwater flow
boundary conditions

To assign boundary conditions for flow to the selected segment (or subsection).

Create rigid body

To assign a rigid body to the selected segment.

The features available in the Plane panel are:
Create beam

To assign a beam to the line or polycurve between two adjacent segments. This feature
can be used to define girders (ribs, wailings etc.) along the perimeter or around the
cross section of a tunnel at slice boundaries.

Load options for tunnel segments
Loads can be added to individual tunnel segments in the Properties tabsheet of the tunnel designer. To do so,
right-click the corresponding tunnel segment in the right drawing area and select Create surface load from the
appearing menu.
The information required to define a load assigned to a segment in the tunnel consists of load distribution, load
value and the point of reference (in case of linear loads).
The distribution options for loads are:
Uniform

To create a uniform distributed load.

Linear

A linearly varying distributed load is created by defining the components and the
magnitude of the force at the start and at the end points of the tunnel segment (or
subsection). The start and end points are determined by their order of definition.

Perpendicular

To create a uniformly distributed load perpendicular to the selected segment (or
subsection). The value of the load ( σn) needs to be specified.
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Perpendicular,
vertical increment

To create a load perpendicular to the selected segment varying with depth by defining
the components and the magnitude of the load at the reference point with respect to the
global system of axes (z-axis) and its increment with depth. The values of the reference
load ( σn,ref) and the load increment ( σn,inc) as well as the reference vertical coordinate
need to be specified.

Reinforcements
Reinforcements can be added to tunnels as Rock bolts or Umbrella arches. They are modelled by means of
embedded beams. They can be added to tunnels in the Properties tabsheet of the tunnel designer. This can be
done by following these steps:
• Click on the Reinforcements tab of the Properties mode.
•
In the drawing area, (multi) select the required segments and click on the Define reinforcement on the left
panel to add a reinforcement. Alternatively, right-click on the selected segments and select the Create
reinforcement option (Figure 119 (on page 163)). By default, the option is set to Rock bolt. In the lower left
panel, the created reinforcement can be viewed and the properties can be assigned.
• The configuration of a reinforcement may be set to Rock bolt or Umbrella arch.
• For more information about material properties of rock bolts refer Material set (on page 307).
•
It is possible to delete a reinforcement, by clicking on the Delete button in the drawing area.

Figure 119: Creation of Reinforcements in the Properties tabsheet
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Rock bolts are drawn in a counter clockwise direction from the starting point at the beginning of the segment (or
subsection). It is possible to reverse this direction, by clicking on the check box Reversed in lower left panel. Note
that the Offset and Spacing are also reversed accordingly.
Input parameters required when the configuration is set to Rock bolts are Material, Apply strength reduction and
the following as described below:
Length of rock bolt

Length of the rock bolt perpendicular to the tunnel contour.

Offset from segments Each rock bolt can have an offset from the tunnel contour. This is particularly useful
when the tunnel has a thick lining.
Distribution

Rock bolts can be added in both breadth and depth of a tunnel trajectory. The
distribution of these rock bolts is possible by choosing Number, Spacing or Custom from
a drop down menu. When the option Custom is selected, both spacing and offset
parameters can be specified.

Number

Number of rock bolts in breadth or depth of a tunnel trajectory.

Offset

Distance from the first tunnel point to the first rock bolt along the tunnel contour.

Figure 120: Rock bolt parameters
Input parameters required when the configuration is set to Umbrella arch (Figure 120 (on page 164)) are
Material, Apply strength reduction and the following as described below :
Length of rock bolt

PLAXIS
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Offset from segments Umbrella arch rock bolts can have an offset from the tunnel contour.
Angle

Angle of rock bolts in an umbrella arch with respect to the out of plane direction. The
angle of rock bolts for an umbrella arch can have values greater than 0° and lesser than
180°.

Distribution

Rock bolts can be added in both breadth and depth directions which correspond to
latitudinal and longitudinal directions respectively. The distribution of these rock bolts
is possible by choosing Number, Spacing or Custom from a drop down menu. When the
option Custom is selected, both spacing and offset parameters can be specified.

Number

Number of rock bolts in breadth or depth of a tunnel trajectory (Figure 122 (on page
166)).

Offset

Distance from the first tunnel point to the first rock bolt along the tunnel contour.

Figure 121: Rock bolts in breadth and depth of a tunnel
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Figure 122: Umbrella arch rock bolt properties
Note: Rock bolts for tunnels may also be added using the Embedded beam feature and Polar array in Input.
However, it is suggested to create it in the Tunnel designer for more accuracy.

5.9.6 Tunnel splitting tool
A tunnel can be split into multiple separate tunnels using the Splitting tool. For example in NATM tunnels, they
can be split into crown, base and invert (base). Once they are split into separate tunnels, they can have their own
sequencing definition to create the separate (sub)parts of the tunnel (Sequencing (on page 171)). This can be
done by first creating a complete tunnel and then using the splitting action as described below.
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Figure 123: Tunnel splitting tool
The splitting tool can be accessed by first choosing the option Template for Shape type in the General tabsheet of
the tunnel designer. When the Template shape type is selected, the Properties and Sequencing mode tabs are
removed, leaving the Geometry modes of Cross-section and Trajectory. If a cross-section has already been defined,
it will remain but any specified properties and sequencing definition will be reset.
A new mode is now introduced as Splitting mode.
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Figure 124: Tunnel splitting mode
In the Splitting mode different tunnel parts can be created which will represent separate parts of a split tunnel.
Each of these tunnel parts will be shown in the corresponding tree in the left panel. Each tunnel part will contain
one or more references to curves in the cross-section. Curves can be added or removed from tunnel parts. New
tunnel parts can be created using the buttons on the right hand drawing panel.
•
•
•
•

To add a new tunnel part, click on the Add tunnel part (including selected parts) button.
To delete a tunnel part, click on the tunnel part in the left panel and then click on the Delete tunnel part
button.
Curves can be added to an already created tunnel part(s) by first selecting curve(s) in the left panel and
then clicking on the Add curve(s) to tunnel part button.
Curves can be deleted from an already created tunnel part(s) by first selecting curve(s) in the right panel
and then clicking on the Delete curve(s) from tunnel part button. Some tunnel part curves can be part of
multiple tunnel parts. Then, a user will have to select a tunnel part, then select a number of tunnel part
curves, and then press delete curve from tunnel part button.

If a Tunnel part is selected in the left hand input panel, then all the cross-section curves in the tunnel part will be
highlighted in the visualisation panel.
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Figure 125: Selection of Tunnel part and cross-section curves
If cross-section curve(s) are selected in the right hand visualisation panel, then the Add tunnel part (including
selected curves) is activated and can be then used to make a new tunnel part.
Note: When a cross-section curve which is not a part of a Tunnel part is selected, it is then possible to select an
existing Tunnel part without losing the selection. Now, the Add curve (s) to tunnel part button is activated and
can be used to add the curve to the selected tunnel part.
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Figure 126: Adding a cross-section curve to an existing Tunnel part
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Figure 127: Adding a new Tunnel part from cross-section curves
Note:
• A tip is displayed in the right hand panel of the splitting tool when some of the cross-section curves have not
been assigned to a tunnel part. However it is still possible to split tunnel.
• Note that only curves which are not yet in the Tunnel part will be added.
• It is recommended to define the geometry of trajectory before the splitting action is performed to have an
efficient workflow.
The Feedback panel displays all the errors, hints and warnings. All errors must be solved before proceeding to
split a tunnel. Hints and warnings do not block the process of splitting a tunnel.
A tunnel can be split by clicking the Split tunnel button on the right bottom of the tool. If changes are made to the
template (parent) tunnel, these changes will be regenerated towards the split-off (child) tunnels, once the split
tunnel command is executed again (e.g. by pressing the split tunnel button).
Each individual split tunnels still needs to get a proper definition for the properties (e.g. interfaces, plate
elements, loads, etc), trajectory with slicing and tunnel sequencing, and then needs to be generated before it
actually appears in the geometry of the model. Using the tunnel splitting tool, it is possible to create more
complex tunnel excavations than the default tunnel designer, since the user can control the sequencing and
progression in staged construction separately for each individual part.

5.9.7 Sequencing
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The construction of a tunnel can be regarded as a 'train' of construction steps ('tunnel train') that is advancing as
a continuous process or in sections of a certain length. In the numerical modelling of tunnel construction, the
advancement of the construction process always has to be discretised in sections. Therefore, the Tunnel Designer
allows for a division of the full tunnel path (Trajectory) into sections, which are called 'slices'.
In order to simplify the definition of calculation phases in Staged Construction to account for the advancement of
the 'tunnel train', the Tunnel Designer includes facilities to define the necessary steps. These steps can be defined
in the Sequencing tabsheet of the Tunnel Designer.

Figure 128: Sequencing tabsheet
The Sequencing tabsheet consists of a left panel, in which various steps can be defined, and a right panel showing
a graphical section of the model with different tabs for the 'Rear' (Plane Rear) cross section, the 'Slice' (= volume
section), and the 'Front' (Plane Front) cross section. The 'Slice' tab can be used to define operations on volumes
and surfaces in the tunnel advancement direction, whereas the 'Rear' and 'Front' tabs can be used to define
operations on surfaces and lines in cross sections perpendicular to the tunnel advancement direction. The
buttons in the middle are used to select one or more objects in the right panel, or to create and delete steps in
the left panel.

Excavation method
The General settings of the Sequencing tabsheet allows to choose the Excavation method. There are two available
options: TBM and NATM.

Figure 129: Excavation methods
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TBM: The front of the tunnel moves forward during each advancement step.
NATM: The front of the tunnel can be fixed or delayed for a specified number of steps:
Slices in active scope

Slices in active scope works similar to a 'caterpillar '. It allows to fix the front for the
defined number of steps while the back moves forward.

Delayed steps

Allows to delay the advancement from moving into the next slice for the defined number
of steps.

Definition of steps
In principle, 'steps' are associated with the subsequent sections of the tunnel train, numbered from the first
section in the front towards the back of the tunnel train.
Click the Add tunnel phase step button to create a first step (Step_1_1). While this step is selected in the left
panel, make the necessary settings in the right panel to model the changes that are required when the first
section of the tunnel train is entering into the soil. This can involve, for example, a combination of
• some excavation (de-activation of soil volume in the slice)
• a TBM or tunnel lining to be installed (activation of plate in the slice)
• and optionally a face pressure applied at the tunnel heading (surface load in the front plane).
If the tunnel train consists of more construction steps, click the Add tunnel phase step button again to
introduce the next step (Step_1_2). Initially, the settings of this step are copied from the previous step. This is OK
if the situation as defined in the first step persists for another section length (or more). However, if the next step
(section) involves changes with respect to the previous step (section), the required changes shall be made in the
right panel.
The process of defining steps shall be continued until the full tunnel train has been defined.
A step can be deleted by clicking on the Remove tunnel phase step button on the left panel of the drawing
canvas.
Click the Add tunnel phase routine button to add a new routine (Step_2_1).
Initially, the settings of this routine are copied from the previous routine. Routines can deal with differences in
the configuration of a same step.
A routine can be deleted by clicking on the Remove tunnel phase routine button on the left panel of the
drawing canvas.

NATM examples
In order to model a sequential excavation tunnel in which the 'tunnel train' consists of six sections of equal
length:
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Figure 130: Sequential excavation tunnel
•
•
•
•
•
•

Top heading excavation (unsupported excavation) (1 section)
Top heading (secured with shotcrete lining) (2 sections)
Bench excavation (unsupported) (1 section)
Bench (secured with shotcrete lining) (2 sections)
Invert excavation (unsupported) (1 section)
Invert (secured with shotcrete lining) (1 section, but in fact all sections behind this one will be the same)

Hence, the 'tunnel train' consists of 8 sections. In order to advance the tunnel train over one section in a new
calculation phase, define a total of 8 steps:
•
•
•
•
•
•
•
•

Step_1_1: Excavate top heading
Step_1_2: Install top lining
Step_1_3: (no change)
Step_1_4: Excavate bench
Step_1_5: Install middle lining
Step_1_6: (no change)
Step_1_7: Excavate invert
Step_1_8: Install bottom lining

In this case Slices in active scope can be set to 8, in this way the front of the tunnel is fixed for 8 steps and then it
moves to the next slice. If different steps are required for the top heading, the bench and the invert, three
different tunnels can be defined assigning different steps and excavation properties.
With these settings, it is easy to define the calculation phases for the construction of the tunnel in multiple stages
(Advancing a tunnel (on page 388)).
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Note: It is highly recommended to start tunnel advancements in a phase subsequent to the Initial Phase, as
otherwise the staged construction process may be disrupted. Particularly, during tunnel sequencing, the Initial
Phase is referred to as the initial state, and it may not be possible to revert modifications after the initial state
has been modified.

5.10 Hydraulic conditions
As an alternative to a direct generation of pore pressures based on the water conditions in the boreholes and the
soil clusters, the pore pressure distribution may be calculated on the basis of a groundwater flow calculation or a
fully coupled flow-deformation analysis. This requires the definition of groundwater flow boundary conditions,
which are termed Hydraulic conditions. Hydraulic conditions may also include special conditions that can be
imposed to the model to control the pore pressure at certain locations in the case of groundwater flow
calculations or fully coupled flow-deformation analysis.
The creation of a hydraulic condition is similar to the creation of a geometric entity. The options available in
the menu displayed as the Create hydraulic conditions button is selected in the side toolbar (Figure 131 (on page
175)), provide a faster definition of conditions.

Figure 131: The Create hydraulic conditions menu
Instead of creating the geometric entity and then assigning a hydraulic condition to it, the whole process is
completed in one step. To assign hydraulic conditions to existing geometry entities:
• Right-click the geometric entity either in the drawing area or in the Object explorers.
• In the appearing menu point to Create and select the hydraulic condition by clicking on the corresponding
option.
Note that the assignment of hydraulic conditions is also possible by right-clicking the geometric entity either in
the drawing area or in the Object explorers and selecting the corresponding option in the appearing menu.
Although the input values of hydraulic conditions are specified in the geometry model, the activation,
deactivation or change of values may be considered in the framework of Staged construction (Changing
geometry configuration (on page 381)).
In addition to the specific boundary conditions as considered here, global model conditions for the model as a
whole in terms of 'open' and 'closed' boundaries as well as precipitation conditions can be defined for each
calculation phase in the Model conditions subtree in the Model explorer (Model conditions (on page 389)). Note
that specific hydraulic conditions have priority over global model conditions.
For transient groundwater flow and fully coupled flow-deformation analysis, hydraulic conditions can be
defined as a function of time using so-called Flow functions (Flow functions (on page 184)).
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5.10.1 Well
In order to define a well, the Create well option should be selected from the menu appearing as the Create
hydraulic conditions button is clicked. The creation of a well in the geometry model is similar to the creation of a
line (Create line (on page 98)). Wells are used to prescribe lines inside the geometry model where a specific flux
(discharge) is extracted from or infiltrated into the soil. The properties of a well can be modified in the Selection
explorer (Figure 132 (on page 176)).

Figure 132: Well definition in the Selection explorer
The required properties of a well are:
Behaviour

The behaviour of the well needs to be specified. The available options are Extraction
(taking water from the ground) and Infiltration (bringing water into the ground).

|Qwell|

The discharge of the well.

hmin

The minimum possible head in the well. When the groundwater head reduces below the
hmin level no further extraction will occur. As a habit, hmin may be set equal to the bottom
level of the well in the ground.

This option is only relevant for groundwater flow calculations and fully coupled flow-deformation analysis.
Wells can be activated or de-activated in calculation phases.
Note:
• When a well intersects multiple soil layers the prescribed flux for each soil layer is a function of the saturated
permeability and the intersected depth.
• Note that the saturated permeability is specified in the Flow parameters tabsheet of the material dataset.

PLAXIS

176

PLAXIS 3D-Reference Manual

Modelling loads and structures - Structures mode
Hydraulic conditions

5.10.2 Line drain
In order to define a line drain, the Create line drain option should be selected from the menu appearing as
the Create hydraulic conditions button is clicked. The creation of a drain in the geometry model is similar to the
creation of a geometry line (Create line (on page 98)). Line drains are used to prescribe lines inside the geometry
model where (excess) pore pressures are reduced.
Together with the creation of a line drain, the input of the properties of the drain is required. This option is only
relevant for consolidation analysis, groundwater flow calculations or fully coupled analysis. In such calculations,
the pore pressure in all nodes of the drain is reduced such that it is equivalent to the given head. If the drain is a
Normal drain, pore pressures lower than the equivalent to the given head are not affected by the drain. If the
drain is a Vacuum drain, the Head parameter can be used to define an 'underpressure' in the ground, equivalent
to the process of vacuum consolidation. Drains can be activated or de-activated in calculation phases. The
properties of a line drain can be modified in the Object explorers (Figure 133 (on page 177)).
The input required for a drain depends on the option selected in the Behaviour drop-down menu. The options
available are:

Normal

When the Normal option is selected for the drain behaviour, the input of a groundwater
head (h) is required. This option is only relevant for groundwater flow calculations or
fully coupled analysis. In such calculations, the pore pressure in all nodes of the drain is
reduced such that it is equivalent to the given head. Pore pressures lower than the
equivalent to the given head are not affected by the drain. In consolidation analysis,
drains reduce the excess pore pressure to zero and the specified head is ignored.

Vacuum

When the Vacuum option is selected for the drain behaviour, the input of a groundwater
head (h) is required. The Head should be used to define the 'underpressure' in the
ground due to the process of vacuum consolidation. This option is only relevant for
consolidation analysis, groundwater flow calculations or fully coupled analysis. In such
calculations, the pore pressure in all nodes of the drain is reduced such that it is
equivalent to the given head. Note that in contrast to Normal drains, pore pressures
lower than the equivalent to the given head ARE affected by the Vacuum drain.

Figure 133: Normal line drain definition in the Selection explorer
Drains can be activated or de-activated in calculation phases. The properties of a line drain can be modified in
the Object explorers.
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5.10.3 Surface drain
In order to define a surface drain, the Create surface drain option should be selected from the menu
appearing as the Create hydraulic conditions button is clicked. The creation of a drain in the geometry model is
similar to the creation of a surface (Create surface (on page 105)). Surface drains are used to prescribe surfaces
inside the geometry model where (excess) pore pressures are reduced.
Together with the input of the properties of the drain is required. This option is only relevant for consolidation
analysis, groundwater flow calculations or fully coupled analysis. In such calculations, the pore pressure in all
nodes of the drain is reduced such that it is equivalent to the given head. Pore pressures lower than the
equivalent to the given head are not affected by the drain. Drains can be activated or de-activated in calculation
phases. The properties of a line drain can be modified in the Object explorers (Figure 134 (on page 178)).
The input required for a drain depends on the option selected in the Behaviour drop-down menu. The options
available are:

Normal

When the Normal option is selected for the drain behaviour, the input of a groundwater
head (h) is required. This option is only relevant for groundwater flow calculations or
fully coupled analysis. In such calculations, the pore pressure in all nodes of the drain is
reduced such that it is equivalent to the given head. Pore pressures lower than the
equivalent to the given head are not affected by the drain. In consolidation analysis,
drains reduce the excess pore pressure to zero and the specified head is ignored.

Vacuum

When the Vacuum option is selected for the drain behaviour, the input of a groundwater
head (h) is required. This option is only relevant for consolidation analysis, groundwater
flow calculations or fully coupled analysis. In such calculations, the pore pressure in all
nodes of the drain is reduced such that it is equivalent to the given head. Note that in
contrast to Normal drains, pore pressures lower than the equivalent to the given head
are affected by the Vacuum drain.

Figure 134: Normal surface drain definition in the Selection explorer
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Figure 135: Vacuum surface drain definition in the Selection explorer

5.10.4 Surface flow boundary conditions
In order to define a surface flow boundary condition, the Create surface groundwater flow boundary
condition option should be selected from the menu appearing as the Create hydraulic conditions button is clicked.
The creation of a surface flow boundary condition in the geometry model is similar to the creation of a surface
(Create surface (on page 105)).
The behaviour of the surface flow boundary conditions can be specified by selecting the corresponding option in
the Selection explorer (Figure 136 (on page 179)).

Figure 136: Options for the behaviour of Surface groundwater flow boundary conditions
Note:
• The boundary conditions at the extremities of the model can be conveniently specified in the Model
conditions subtree in the Model explorer. By default the bottom of the model is set to Closed, preventing flow
across it, whereas the three remaining boundaries are set to Open (Seepage).
• In a calculation phase the hydraulic conditions defined using the Surface flow boundary conditions feature
always prevail over the Model conditions. As an example, if a surface flow boundary conditions is placed on
the top surface and precipitation is specified in Model conditions only the behaviour specified for the surface
flow boundary condition will be considered, ignoring the precipitation.
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• In a fully coupled analysis the water conditions assigned in any internal geometry are taken into account at
the calculation step 0 (i.e beginning of the calculation). In the subsequent calculation steps, PLAXIS ignores
the specified water conditions settings and performs the flow calculation based on the outcome of the
previous step.
• The Closed condition is always applicable only on the external boundaries of the model. If a Closed condition
is applied on an internal geometry, PLAXIS 3D ignores it.

Seepage
A Seepage boundary is a boundary where water can flow in or out freely. It is generally used at the ground
surface above the phreatic level or above the external water level (in the case of an inclined surface, such as a
dam or a dike).
If a surface flow boundary is set to Seepage and is completely above the (external) water level, then the seepage
condition applies to this boundary. This means that water inside the geometry may flow freely out of this
boundary.
If a boundary is Seepage and completely below the (external) water level, the free boundary condition
automatically turns into a groundwater head condition. In that case the magnitude of the groundwater head in
each boundary node is determined by the vertical distance between the boundary node and the water level.
The pore pressure is zero where a (external) water level crosses a geometry boundary surface. The part of the
geometry surface above the transition line is treated as a boundary above the water level, whereas the part of
the geometry surface below the transition line is treated as a boundary below the water level. Hence, different
conditions can apply to such a geometry boundary surface. This is possible because, in general, a
geometrysurface consists of many nodes and the actual information on boundary conditions as used by the
calculation program is contained in the boundary nodes rather than in geometry surfaces.
Note: Note that a boundary that is explicitly set to Seepage will NOT automatically turn into an Infiltration
boundary when precipitation is specified.

Closed
When the Closed option is assigned to a boundary, no flow can occur across it. Flow, in this case, refers to
groundwater flow (in groundwater flow calculations and fully coupled flow-deformation analysis) as well as
dissipation of excess pore pressure (in consolidation calculations).
Note: The Closed condition is always applicable only on the external boundaries of the model. In case it's
required an impermeable surface inside the soil (e.g. the cut-off of a dam), an appropriate interface element
should be inserted.

Head
In addition to the automatic setting of hydraulic conditions based on the general phreatic level in Model
conditions (Flow boundary conditions (on page 379)), a prescribed groundwater head may be entered manually
to the Groundwater flow boundary conditions defined by the user in the model. If a groundwater head is
prescribed at an outer geometry boundary, external water pressures will be generated for that boundary. The
deformation analysis program will treat external water pressures as traction loads and they are taken into
account together with the soil weight and the pore pressures. Figure 137 (on page 181) shows the options
available for the definition of head in Object explorers.
The options available for variation of head along the boundary are:
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Uniform

A uniform value of the head (href) is specified along the boundary.
A linear variation of the head along the boundary is specified. The parameters required
to specify a linear variation are:

Linear

• href: The reference head value at the specified reference level.
• hinc,y: Increment value specifying the change of the head with depth.
• zref: The reference value for which the reference head value is specified. If this value
is lower than the top of the boundary, the head value below this level is changed
according to the hinc,z value (h = href + zref - zhinc,z).

Figure 137: Head definition in the Selection explorer
The options available for Time dependency of Head assigned to a surface flow boundary condition are:
Constant

The head in the boundary does not change with time.

Time dependent

The head in the boundary varies with time. This option is only available for transient
flow and fully coupled flow-deformation analysis. The flow function representing the
time dependency can be selected from the drop-down menu. Information on Flow
functions is available in Flow functions (on page 184).

Inflow
Inflow to the model through a boundary can be specified by selecting the corresponding Behaviour option in the
Object explorer. Figure 138 (on page 182) shows the options available for the definition of inflow.
The options available for the distribution of the inflow discharge along the boundary are:
Uniform
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A linear variation of the head along the boundary is specified. The parameters required
to specify a linear variation are:
•
Linear

| qref | : The reference discharge value at the specified reference level.

• qinc,z: Increment value specifying the rate of variation of discharge along the
boundary.
• zref: The reference value for which the reference head value is specified. If this value
is lower than the top of the boundary, the discharge value below this level is changed
according to the qinc,z value.

Figure 138: Inflow definition in the Selection explorer
The options available for Time dependency of the discharge are:
Constant

The discharge does not change with time.

Time dependent

The discharge in the boundary varies with time. varies with time. This option is only
available for transient flow and fully coupled flow-deformation analysis. The flow
function representing the time dependency can be selected from the drop-down menu.
Information on Flow functions is available in Flow functions (on page 184).

Outflow
Outflow from the model through a boundary can be specified by selecting the corresponding option for
Behaviour in the Object explorers Figure 139 (on page 183).
The options available for the distribution of the outflow discharge along the boundary are:
Uniform
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A linear variation of the discharge along the boundary is specified. The parameters
required to specify a linear variation are:
•
Linear

| qref | : The reference discharge value at the specified reference level.

• qinc,z: Increment value specifying the rate of variation of discharge along the
boundary.
• zref: The reference value for which the reference head value is specified. If this value
is lower than the top of the boundary, the discharge value below this level is changed
according to the qinc,z value.

Figure 139: Outflow definition in the Selection explorer
The options available for variation of discharge with time are (Time dependency):
Constant

The discharge does not change with time.

Time dependent

The discharge in the boundary varies with time. varies with time. This option is only
available for transient flow and fully coupled flow-deformation analysis. The flow
function representing the time dependency can be selected from the drop-down menu.
Information on Flow functions is available in Flow functions (on page 184).

Infiltration
Apart from the automatic generation of infiltration boundary conditions from precipitation (Flow boundary
conditions (on page 379)), infiltration conditions may also be specified manually for geometry boundaries
above the water level. Infiltration boundary condition is a conditional inflow. The parameters required for an
infiltration boundary are:
q

Recharge (infiltration), specified in the unit of length per unit of time. Negative values
can be used to model evapotranspiration (evaporation + transpiration).

ψmax

Maximum pore pressure head, relative to the elevation of the boundary, specified in the
unit of length (default 0.1 length units).
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ψmin

Minimum pore pressure head, relative to the elevation of the boundary, specified in the
unit of length (default -1.0 length units).

The options available for variation of discharge with time (Time dependency) are:
Constant

The head in the boundary does not change with time

Time dependent

The discharge in the boundary varies with time. varies with time. This option is only
available for transient flow and fully coupled flow-deformation analysis. The flow
function representing the time dependency can be selected from the drop-down menu.
Information on Flow functions is available in Flow functions (on page 184).

Note: Note that a negative value of infiltration represents Evaporation.

Figure 140: Infiltration definition in the Selection explorer

5.11 Flow functions
Flow functions describing the variation with time of quantities such as Head and Discharge can be defined in the
corresponding subtree under the Attributes library in the Model explorer.

Figure 141: Flow functions subtree in Model explorer
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Flow functions can be assigned to Water levels or Groundwater flow boundary conditions. Note that timedependent conditions can be defined for all behaviour options except for Seepage and Closed.
Note: Flow functions cannot be assigned to non-horizontal water levels.
Functions can be defined in the corresponding window that pops up when the Flow functions subtree is rightclicked and the Edit option is selected in the appearing menu. The window consists of two tabsheets, i.e Head
functions and Discharge functions, where the functions applicable to head and discharge can be defined
respectively as shown below.

Figure 142: Flow functions window
The buttons available under the function tabs can be used to add new functions or to delete the function selected
in the list. When a new function is added, the options to define it are displayed.
Name

The name of the flow function can be defined.

Signal

The type of the signal can be assigned, The options available are Linear, Harmonic and
Table.

The options available in the Signal drop-down menu are described in the following sections.

5.11.1 Harmonic
This option can be used when a condition varies harmonically in time. The harmonic variation of the water level
is generally described as:
y (t ) = y0 + Asin (ω0t + φ0) with
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in which A is the amplitude (in unit of length), T is the wave period (in unit of time) and φ0 is the initial phase
angle. y0 is the centre of the harmonic variation, not necessarily equal to the water level at the end of the
previous phase ( y'0). In fact the later is equal to:
y ′ 0 = y0 + Asin (φ0)

Eq. [6]

Figure 143 (on page 186) shows the Flow functions window where a Harmonic signal is defined and plotted.

Figure 143: Definition and display of a Harmonic signal in the Flow functions window

5.11.2 Signal from table
Besides a harmonic signal there is also the possibility to define a signal by specifying the values in the table that
appears when the corresponding option is selected in the Signal drop-down menu. The table consists of Time
and Head columns. The buttons in the toolbar can be used to modify the table.
•
Click the Add row button in the toolbar to add a new row in the table.
•

Click the Insert button to insert a new row before the selected row in the table.

•
Click the Delete button to delete the selected row in the table.
The values can be defined by clicking the cell in the table and by typing the value.
Importing data for signals
Besides defining the signal in the table, there is also the possibility to read data from a file with a digitised
signal using the Open button in the toolbar.
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Note: PLAXIS 3D assumes the data file is located in the current project directory when no directory is specified.
A signal, either defined in a table or received from a file and modified, can be saved using the Save button in
the toolbar enabling the usage of the signal in other projects or validating the effect of the modifications in the
current project.
A signal, either defined in a table or received from a file and modified, can be copied using the Copy button in
the toolbar.
Copied data from other applications (using Ctrl+c) can be imported by using the Paste button. The Import
data window appears (Figure 144 (on page 187)). The starting row of the data to be imported can be defined in
the From row cell. The data and the plot is displayed in the Flow functions window after pressing OK.

Figure 144: Import data window for flow functions
Clicking the Open .txt file button on the right hand side of the window will open the Open window where the
file can be selected. The file must be an ASCII file that can be created with any text editor. For every line a pair of
values (actual time and corresponding water level value) must be defined, leaving at least one space between
them. Note that PLAXIS 3D only supports the English notation of decimal numbers using a dot. The resulting
graph of the input data is shown in the Graph tabsheet of the Time dependent condition window.

5.11.3 Linear
This option can be used to describe the increase or decrease of a condition linearly in time. For a linear variation
of groundwater head, the input of the following parameters are required:

ΔHead

This parameter, specified in unit of length, represents the increase or decrease of the
water level in the time interval for the current calculation phase. Hence, together with
the time interval this parameter determines the rate of the water level increase or
decrease.

t

This parameter represents the time interval for the calculation phase, expressed in units
of time. Note that the time interval specified for a function does not effect the duration of
a phase as defined in the Phases window.

For a linear variation of discharge infiltration, inflow or outflow the input of the following parameters are
required for the discharge in the corresponding tabsheet:
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This parameter, specified in unit of volume per unit of time, represents the increase or
decrease of the specific discharge in the time interval of the current calculation phase.

ΔDischarge

Note: The time value in flow functions always refers to the global time in the whole list of calculation phases
rather than to the time interval of an individual phase. This means that in a series of consecutive flow
calculations each phase will only use its corresponding part of the flow function.

5.11.4 Flow functions in consecutive phases
A flow function can be assigned as an attribute to Groundwater flow boundaries or to Water levels. PLAXIS 3D
ensures the continuity of the flow functions in consecutive phases when the corresponding options are selected
in the Phase definition modes.

5.11.5 Function continuity for boundaries
Besides the options described in Surface flow boundary conditions (on page 179), two new options are added
for boundary conditions in the Phase definition mode (Figure 145 (on page 188)). These options are:
Constant value from
previous phase

The condition of the boundary in the current phase is a continuation of the state reached
at the end of the previous phase and it will not change during the calculation of the
phase.

Maintain function
from the previous
phase

The condition of the boundary in the current phase is equal to the state reached in the
previous phase. PLAXIS 3D enables continuity of the state at the boundary according to
the flow function assigned to the boundary in the previous phase. The accumulated time
from the previous phases is used as an offset to enter the flow function for the current
phase.

Figure 145: Options for boundary condition behaviour in Phase definition modes

5.11.6 Function continuity for water levels
The continuity of the flow functions assigned to water levels in consecutive phases can be maintained by using
the options available in the pop up menu displayed when the water level is right-clicked. These options are:
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Create the reached
water level

When this option is selected a new water level is created at the position reached at the
end of the previous phase. The location of the water level will be constant in the current
phase.

Create the reached
water level and
continue

When this option is selected a new water level is created at the position reached at the
end of the previous phase. The location of the water level in the current phase will
change from that point on according to the flow function assigned to the original water
level in the previous phase. PLAXIS 3D ensures the continuity of the flow function,
whereby the accumulated time from previous phases is used as an offset to enter the
flow function for the current phase.
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Material properties and material database
In PLAXIS 3D, soil properties and material properties of structures are stored in material data sets. There are six
different types of material sets grouped as data sets for soil and interfaces, beams, embedded beams, plates,
geogrids anchors. All data sets are stored in the material database. From the database, the data sets can be
assigned to the soil clusters or to the corresponding structural objects in the geometry model.
The material database can be activated by selecting the option Show materials in the Soil menu of the Soil
mode or in the Structures menu of the Structures mode. Another way to activate the material database is by
clicking on the Show materials button available in the Soil, Structures and Staged construction modes. As a
result, the Material sets window appears showing the contents of the project material database. The window
can be expanded to show the global database by clicking the Show global button in the upper part of the window.
The Material sets window displaying the material defined in the current project and the ones available in a
selected global database is shown in Figure 146 (on page 190).

Figure 146: Material sets window showing the project and the global database
The database of a new project is empty. The global database can be used to store material data sets in a global
folder and to exchange data sets between different projects.
At both sides of the window (Project materials and Global materials) there are two drop-down menus and a
tree view. The Set type can be selected from the drop-down menu on the left hand side. The Set type parameter

PLAXIS

190

PLAXIS 3D-Reference Manual

Material properties and material database
determines which type of material data set is displayed in the tree view (Soil and interfaces, Plates, Geogrids,
Beams, Embedded beams, Anchors).
The data sets in the tree view are identified by a user-defined name. The data sets for Soil and interfaces can be
ordered in groups according to the material model, the material type or the name of the data set by selecting this
order in the Group order drop-down menu. The None option can be used to discard the group ordering.
The small buttons between the two tree views can be used to copy individual data sets from the project database
to the selected global database or vice versa.
•

To copy the selected project material set to the global database.

•

To copy all the project material sets of the specified type to the global database.

•

To copy the selected global material set to the project database.

The location of the selected global database is shown below its tree view. The buttons below the tree view of the
global database enable actions in the global database.
Select

To select an existing global database.

Delete

To delete a selected material data set from the selected global database.

By default, the global database for soil and interface data contains the data sets of all the tutorials and it is
contained in the file 'SoilMat.matdb'. This file is compatible with other PLAXIS 3D database files for soil and
interfaces and is stored in the installation folder of PLAXIS 3D. Material data sets for structural elements will be
contained in separate files. Similarly, the global data bases for are contained in the files 'PlateMat3D.matdb',
'GeogridMat.matdb', 'BeamMat.matdb', 'EmbeddedPileMat.matdb' and 'AnchorMat3D.matdb' respectively.
Note that besides the global material files (*.matdb), it is possible to select project material files (*.plxmat) and
legacy project material files (*.mat) as global database.
In addition, databases with data sets of standard sheet-pile wall profiles are available from the PLAXIS
Knowledge Base (publication Material parameter datasets for sheetpiles and beams).
Note:
A new global database can be created by clicking the Select button, defining the name of the new global database
and clicking Open.
The project data base can be managed using the buttons below the tree view of the project database.

New

To create a new data set in the project. As a result, a new window appears in which the
material properties or model parameters can be entered. The first item to be entered is
always the Identification, which is the user-defined name of the data set. After
completing a data set, it will appear in the tree view, indicated by its name as defined by
the Identification.

Edit

To modify the selected data set in the project material database.

SoilTest

To perform standard soil lab tests. A separate window will open where several basic soil
tests can be simulated and the behaviour of the selected soil material model with the
given material parameters can be checked ( Simulation of soil lab tests (on page 271)).

Copy

To create a copy of a selected data set in the project material database.
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Delete

To delete a selected material data set from the project material database.

Note:
In a Material dataset window (Material properties and material database (on page 190)) it is possible to go
through the options with arrows and/or Enter. When a property such as Material model or Drainage type, is
reached, the drop-down menu can be activated by pressing the Space key. Arrows and /or letters can be used to
make a selection, that is finalised by pressing Enter.

6.1 Modelling soil and interface behaviour
The material properties and model parameters for soil clusters are entered in material data sets Figure 147 (on
page 192). The properties in the data sets are divided into five tabsheets: General, Parameters, Groundwater,
Interfaces and Initial.

6.1.1 General tabsheet
The General tabsheet contains the type of soil model, the drainage type and the general soil properties such as
unit weights. Several data sets may be created to distinguish between different soil layers. A user may specify
any identification title for a data set in the General tabsheet of the Soil window. It is advisable to use a
meaningful name since the data set will appear in the database tree view by its identification.
For easy recognition in the model, a colour is given to a certain data set. This colour also appears in the database
tree view. PLAXIS 3D selects a unique default colour for a data set, but this colour may be changed by the user.
Changing the colour can be done by clicking on the colour box in the General tabsheet.

Figure 147: General tabsheet of the Soil window
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Material model
Soil and rock tend to behave in a highly non-linear way under load. This non-linear stress-strain behaviour can
be modelled at several levels of sophistication. Clearly, the number of model parameters increases with the level
of sophistication. PLAXIS 3D supports different models to simulate the behaviour of soil and other continua. The
models and their parameters are described in detail in the Material Models Manual. A short discussion of the
available models is given below:
Linear elastic model: This model represents Hooke's law of isotropic linear elasticity. The linear elastic model
is too limited for the simulation of soil behaviour. It is primarily used for stiff structures in the soil.
Mohr-Coulomb model (MC): This well-known linear elastic perfectly-plastic model is used as a first
approximation of soil behaviour in general. It is recommended to use this model for a first analysis of the
problem considered. A constant average stiffness is estimated for the soil layer. Due to this constant stiffness,
computations tend to be relatively fast and a first estimate of deformations can be obtained.
Hardening Soil model (HS): This is an advanced model for the simulation of soil behaviour. The Hardening Soil
model is an elastoplastic type of hyperbolic model, formulated in the framework of shear hardening plasticity.
Moreover, the model involves compression hardening to simulate irreversible compaction of soil under primary
compression. This second-order model can be used to simulate the behaviour of sands and gravel as well as
softer types of soil such as clays and silts.
Hardening Soil model with small-strain stiffness (HSsmall): This is an elastoplastic type of hyperbolic model,
similar to the Hardening Soil model. Moreover, this model incorporates strain dependent stiffness moduli,
simulating the different reaction of soils from small strains (for example vibrations with strain levels below 10-5)
to large strains (engineering strain levels above 10-3).
Soft soil model (SS): This is a Cam-Clay type model that can be used to simulate the behaviour of soft soils like
normally consolidated clays and peat. The model performs best in situations of primary compression.
Soft Soil Creep model (SSC): This is a second order model formulated in the framework of viscoplasticity. The
model can be used to simulate the time-dependent behaviour of soft soils like normally consolidated clays and
peat. The model includes logarithmic primary and secondary compression.
Joined Rock model (JR): This is an anisotropic elastic-perfectly plastic model where plastic shearing can only
occur in a limited number of shearing directions. This model can be used to simulate the anisotropic behaviour
of stratified or jointed rock.
Modified Cam-Clay model (MCC): This well-known critical state model can be used to simulate the behaviour
of normally consolidated soft soils. The model assumes a logarithmic relationship between the void ratio and the
mean effective stress.
NGI-ADP model (NGI-ADP): The NGI-ADP model may be used for capacity, deformation and soil-structure
interaction analysis involving undrained loading of clay-type materials. Distinct anisotropic shear strengths may
be defined for different stress paths.
UDCAM-S (UDCAM-S): The UDCAM-S model is a derived NGI-ADP model to deal with undrained soil
behaviour and degradation of the strength and stiffness in cyclic loading of clay or very low permeable silty soils.
It implements a pre-processing procedure called Cyclic accumulation and optimisation tool ( Cyclic accumulation
and optimisation tool (on page 233)) to obtain the degraded parameter set based on the type of analysis.
Hoek-Brown model (HB): This well-known elastic perfectly-plastic model is used to simulate the isotropic
behaviour of rock. A constant stiffness is used for the rock mass. Shear failure and tension failure are described
by a non-linear strength curve.
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UBC3D-PLM (UBC3D-PLM): This is an advanced model for the simulation of liquefaction behaviour in
dynamic applications. The model includes accumulation of irreversible strains during cyclic loading. In
combination with undrained behaviour it accumulates pore pressures, which may eventually lead to
liquefaction.
Concrete model (Concrete): The Concrete modelis an advanced elastoplastic model for concrete and
shotcrete structures. It simulates the time-dependent strength and stiffness of concrete, strain hardeningsoftening in compression and tension as well as creep and shrinkage. The failure criterion involves a MohrCoulomb yield surface for deviatoric loading, which is combined with a Rankine yield surface in the tensile
regime.
User-defined Soil Models (UDSM): With this option it is possible to use other constitutive models than the
standard PLAXIS 3D models. For a detailed description of this facility, reference is made to the Material Models
Manual. Links to existing UDSM as well as all models are available on the PLAXIS Knowledge Base.

Drainage type
In principle, all model parameters in PLAXIS 3D are meant to represent the effective soil response, i.e. the
relationship between the stresses and the strains associated with the soil skeleton. An important feature of soil
is the presence of pore water. Pore pressures significantly influence the (time-dependent) soil response. PLAXIS
3D offers several options to enable incorporation of the water-skeleton interaction in the soil response. The
most advanced option is a Fully coupled flow-deformation analysis. However, in many cases it is sufficient to
analyse either the long-term (drained) response or the short-term (undrained) response without considering
the time-dependent development of pore pressures. In the latter case (undrained), excess pore pressures are
generated as a result of stress changes (loading or unloading). The dissipation of these excess pore pressures
with time can be analysed in a Consolidation calculation.
The simplified water-skeleton interaction, as considered in a Plastic calculation, a Safety analysis or a Dynamic
analysis, is defined by the Drainage type parameter. PLAXIS 3D offers a choice of different types of drainage:
Drained behaviour: Using this setting no excess pore pressures are generated. This is clearly the case for dry
soils and also for full drainage due to a high permeability (sands) and/or a low rate of loading. This option may
also be used to simulate long-term soil behaviour without the need to model the precise history of undrained
loading and consolidation.
Undrained behaviour: This setting is used for saturated soils in cases where pore water cannot freely flow
through the soil skeleton. Flow of pore water can sometimes be neglected due to a low permeability (clays)
and/or a high rate of loading. All clusters that are specified as undrained will indeed behave undrained, even if
the cluster or a part of the cluster is located above the phreatic level.
Distinction is made between three different methods of modelling undrained soil behaviour. Method A is an
undrained effective stress analysis with effective stiffness as well as effective strength parameters. This method
will give a prediction of the pore pressures and the analysis can be followed by a consolidation analysis. The
undrained shear strength (su) is a consequence of the model rather than an input parameter. It is recommended
to check this shear strength with known data. To consider this type of analysis, the Undrained (A) option should
be selected in the Drainage type drop-down menu.
Method B is an undrained effective stress analysis with effective stiffness parameters and undrained strength
parameters. The undrained shear strength su is an input parameter. This method will give a prediction of pore
pressures. However, when followed by a consolidation analysis, the undrained shear strength (su) is not
updated, since this is an input parameter. To consider this type of analysis, the Undrained (B) option should be
selected in the Drainage type drop-down menu.
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Method C is an undrained total stress analysis with all parameters undrained. This method will not give a
prediction of pore pressures. Therefore it is not useful to perform a consolidation analysis. The undrained shear
strength (su) is an input parameter. To consider this type of analysis, the Undrained (C) option should be selected
in the Drainage type drop-down menu.
More information about modelling undrained behaviour can be found in Modelling undrained behaviour (on
page 268) and the Material Models Manual.
Non-porous behaviour: Using this setting neither initial nor excess pore pressures will be taken into account in
clusters of this type. Applications may be found in the modelling of concrete or structural behaviour. Non-porous
behaviour is often used in combination with the Linear elastic model. The input of a saturated weight is not
relevant for non-porous materials or intact rock.
In a consolidation analysis or a fully coupled flow-deformation analysis it is the permeability parameter in the
Flow tabsheet that determines the drainage capacity of a layer rather than the drainage type. Still, the drainage
type has influence on the applied compressibility of water in a consolidation analysis or a fully coupled flowdeformation analysis. For more information see Appendix C.
Note:
The Drainage type setting is only considered in a Plastic calculation, a Safety analysis or a Dynamic analysis.
When a Consolidation analysis, a Fully coupled flow-deformation analysis or a Dynamic with Consolidation
analysis is performed, the Drainage type is ignored and the soil response is determined by the Permeability of the
material.

Saturated and unsaturated weight (γsat and γunsat)
The saturated and the unsaturated weights, entered as a force per unit volume, refer to the total unit weight of
the soil skeleton including the fluid in the pores. The unsaturated weight γunsat applies to all material above the
phreatic level and the saturated unit weight γsat applies to all material below the phreatic level, where the
phreatic level itself is generally defined as the level where the steady-state pore pressure is zero (psteady = 0).
Only in the case of a fully coupled flow-deformation analysis, the phreatic level is defined as the level where the
current pore water pressure is zero (pwater = 0). This means that during a fully coupled flow-deformation
analysis the position of the phreatic level and hence the material weight can change.
For non-porous material only the unsaturated weight is relevant, which is just the total unit weight. For porous
soils the unsaturated weight is obviously smaller than the saturated weight. For sands, for example, the
saturated weight is generally around 20 kN/m3 whereas the unsaturated weight can be significantly lower,
depending on the degree of saturation.
Note that soils in practical situations are never completely dry. Hence, it is advisable not to enter the fully dry
unit weight for γunsat. For example, clays above the phreatic level may be almost fully saturated due to capillary
action. Other zones above the phreatic level may be partially saturated. PLAXIS 3D can deal with partially
saturated soil behaviour above the phreatic level. However, the unit weight of soil is always defined here by
γunsat, irrespective of the degree-of-saturation.
Weights are activated by means of Gravity loading or K0 procedure in the Calculation mode, which is always the
first calculation phase (Initial phase) (see Initial stress generation (on page 328)).

Advanced general properties
Additional properties for advanced modelling features can be defined in the Advanced subtree in the General
tabsheet (Figure 147 (on page 192)).
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Void ratio (einit, emin, emax ): The void ratio, e, is related to the porosity, n (e = n / (1-n)). This quantity is used in
some special options. The initial value einit is the value in the initial situation. The actual void ratio is calculated
in each calculation step from the initial value and the volumetric strain Δεv. These parameters are used to
calculate the change of permeability when input is given for the ck value (in the Flow tabsheet). In addition to
einit, a minimum value emin and a maximum value emax can be entered. These values are related to the maximum
and minimum density that can be reached in the soil. When the Hardening Soil model or Hardening Soil model
with small-strain stiffnessis used with a certain (positive) value of dilatancy, the mobilised dilatancy is set to
zero as soon as the maximum void ratio is reached (this is termed dilatancy cut-off). For other models this
option is not available. To avoid the dilatancy cut-off in the Hardening Soil modelor Hardening Soil model with
small-strain stiffness, the option may be deselected in the Advanced general properties subtree.
Rayleigh α and β: Material damping in dynamic calculations is caused by the viscous properties of soil,
friction and the development of irreversible strains. All plasticity models in PLAXIS 3D can generate irreversible
(plastic) strains, and may cause material damping. However, this damping is generally not enough to model the
damping characteristics of real soils. For example, most soil models show pure elastic behaviour upon unloading
and reloading which does not lead to damping at all. There is one model in PLAXIS 3D that includes viscous
behaviour, which is the Soft Soil Creep model. Using the model in dynamic calculations may lead to viscous
damping, but also the Soft Soil Creep model hardly shows any creep strain in load / reload cycles. There is also
one model in PLAXIS 3Dthat includes hysteretic behaviour in loading / reload cycles, which is the Hardening Soil
model with small-strain stiffness (Material Models Manual - Chapter 7). When using this model, the amount of
damping that is obtained depends on the amplitude of the strain cycles. Considering very small vibrations, even
the Hardening Soil model with small-strain stiffness does not show material damping, whereas real soils still
show a bit of viscous damping. Hence, additional damping is needed to model realistic damping characteristics of
soils in dynamic calculations. This can be done by means of Rayleigh damping.
Rayleigh damping is a numerical feature in which a damping matrix C is composed by adding a portion of the
mass matrix M and a portion of the stiffness matrix K:
C = α M +β K

Eq. [7]

The parameters α and β are the Rayleigh coefficients and can be specified in the corresponding cells in the
Parameters tabsheet of the Soil window shown in Figure 148 (on page 197).
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Figure 148: Damping parameters in the General tabsheet
α is the parameter that determines the influence of mass in the damping of the system. The higher α is, the more
the lower frequencies are damped. β is the parameter that determines the influence of stiffness in the damping
of the system. The higher β is, the more the higher frequencies are damped. In PLAXIS 3D, these parameters can
be specified for each material data set for soil and interfaces as well as for material data sets for plates. In this
way, the (viscous) damping characteristics can be specified for each individual material in the finite element
model.
Despite the considerable amount of research work in the field of dynamics, little has been achieved yet for the
development of a commonly accepted procedure for damping parameter identification. Instead, for engineering
purposes, some measures are made to account for material damping. A commonly used engineering parameter
is the damping ratio ξ. The damping ratio is defined as ξ = 1 for critical damping, i.e. exactly the amount of
damping needed to let a single degree-of-freedom system that is released from an initial excitation u0, smoothly
stop without rebouncing.
Considering Rayleigh damping, a relationship can be established between the damping ratio ξ and the Rayleigh
damping parameters α and β:
α + βω 2 = 2ωξ and ω = 2πf

Eq. [8]

where ω is the angular frequency in rad/s and f is the frequency in Hz (1/s).
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u
Overdamped(ξ>1)
Critically damped(ξ=1)

t

Underdamped(ξ<1)

Figure 149: Role of damping ratio ξ in free vibration of a single degree-of-freedom system
Solving this equation for two different target frequencies and corresponding target damping ratios gives the
required Rayleigh damping coefficients:
α = 2ω1ω2

ω1ξ2 − ω2ξ1
ω12 − ω22

and β = 2

ω1ξ1 − ω2ξ2
2
2
ω1 − ω2

Eq. [9]

For example, when it is desired to have a target damping of 8% at the target frequencies f = 1.5 Hz and 8.0 Hz, the
corresponding Rayleigh damping ratios are α = 1.2698 and β = 0.002681. From Figure 150 (on page 198) it can
be seen that within the range of frequencies as defined by the target frequencies the damping is less than the
target damping, whereas outside this range the damping is more than the target damping.

Figure 150: Rayleigh damping parameter influence
In order to calibrate the frequencies corresponding to Target 1 and Target 2, different procedures can be found
in literature. In particular, Hudson, Idriss & Beirkae (1994) (on page 509) and Hashash & Park (2002) (on page
509) suggest to select the first target frequency as the first natural frequency of the soil deposit f1, while the
second target frequency is the closest odd integer larger than the ratio fp/f1, i.e. the predominant frequency of
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the input motion (that can be determined from the input Fourier spectrum) over the natural frequency of the
soil. The natural frequency of the soil deposit of thickness H is related to its geometry and stiffness according to
the following equation:
f1 =

Vs
4H

Eq. [10]

where vs is the shear wave velocity in the soil deposit, that is a function of the shear stiffness modulus G.
Amorosi, Boldini & Ellia (2010) (on page 508) suggest to consider the frequency interval characterised by the
highest energy content that can be evaluated by plotting the Fourier spectrum at different depths of the soil
deposit and the amplification function between the surface and the base level. It has been demonstrated that this
procedure overcomes the errors that can occur with the previous procedure for increasing values of the ratio
fp/f1 and of the soil deposit thickness.
More generally, the two frequencies are identified through an iterative procedure.
It is suggested not to use the simplified Rayleigh formulation, i.e. the small strain viscous damping effects are
assumed to be proportional only to the stiffness of the soil deposit:
C = β K

(not recommended)

Eq. [11]

where β = 2 ξ/ω1 and ω1 is the angular frequency of the first natural mode of the soil column. It has been noticed
that the simplified Rayleigh formulation may lead to an underestimation of the site response, especially when
the natural frequency of the soil deposit and the predominant frequency of the input motion are far from each
other, resulting in overestimation of damping in the high-frequency range.
The damping parameters (α and β) can be automatically calculated by the program when the target damping
ratio (ξ) and the target frequencies (f) are specified in the panel displayed in the General tabsheet when one of
the cells corresponding to the damping parameters is clicked. Figure 151 (on page 200) shows the damping
ratio as a function of the frequency.
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Figure 151: Input of ξ and f

6.1.2 Parameters tabsheet
The Parameters tabsheet contains the stiffness and strength parameters of the selected soil model. These
parameters depend on the selected soil model as well as on the selected drainage type.

Linear Elastic model (LE)
The Parameters tabsheet for the Linear Elastic model(drained behaviour) is shown in Figure 152 (on page
201).
The model involves two elastic stiffness parameters, namely the effective Young's modulus E' and the effective
Poisson's ratio γ'.
E'

Effective Young's modulus

ν'

Effective Poisson's ratio

[kN/m2]
[-]

During the input for the Linear Elastic model the values of the shear modulus G and the oedometer modulus Eoed
are presented as auxiliary parameters (alternatives).
G
Eoed

PLAXIS

Shear modulus, where G = E'/2(1 + ν' )

[kN/m2]
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Note:
• Optional drainage types when the Linear Elastic model is selected are: Drained, Undrained (A), Undrained (C),
and Non-porous.
• In the case of Undrained (A) or Non-porous drainage types, the same parameters are used as for drained
behaviour.
• In the case of Undrained (C) drainage type, an undrained Young's modulus (Eu) and undrained Poisson's ratio
(γu) are used.

Figure 152: Parameters tabsheet for the Linear Elastic model(drained behaviour)
Note that the alternatives are influenced by the input values of E' and ν'. Entering a particular value for one of
the alternatives G or Eoed results in a change of the Young's modulus E'.
It is possible for the Linear Elastic model to specify a stiffness that varies linearly with depth. Therefore, the
increment of stiffness per unit of depth, E'inc, can be defined. Together with the input of E'inc the input of zref
becomes relevant. For any z-coordinate above zref} the stiffness is equal to E'ref. For any z-coordinate below zref
the stiffness is given by:
E ′ (z ) = E ′ + (zref − z ) E ′ inc ; z < zref

Eq. [12]

The Linear Elastic model is usually inappropriate to model the highly non-linear behaviour of soil, but it is of
interest to simulate structural behaviour, such as thick concrete walls or plates, for which strength properties
are usually very high compared with those of soil. For these applications, the Linear Elastic model will often be
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selected together with Non-porous type of material behaviour in order to exclude pore pressures from these
structural elements.
Note:
When embedded beams penetrate a volume cluster with linear elastic material behaviour, the specified value of
the shaft resistance is ignored. The reason for this is that the linear elastic material is not supposed to be soil, but
part of the structure. The connection between the pile and the structure is supposed to be rigid to avoid, for
example, punching of piles through a concrete deck.
Beside the parameters related to strength and stiffness of the soil, the velocities of wave propagation in soil
can be defined in the Parameters tabsheet of the Soil window when the Dynamics module of the program is
available. These velocities are:
Vs

Shear wave velocity, where V s =

Vp

Compression wave velocity, where V p =

[m/s]

G0 / ρ
E/ρ

[m/s]

where ρ = γ / g.
Note:
• Note that the wave velocities are influenced by the input values of E' and ν'. Entering a particular value for
one of the wave velocities results in a change of the Young's modulus.
• Velocities of wave propagation in soil can be defined only for models with stress independent stiffness.

Mohr-Coulomb model (MC)
The linear-elastic perfectly-plastic model with Mohr-Coulomb failure contour (in short the Mohr-Coulomb
model) requires a total of five parameters (two stiffness parameters and three strength parameters), which are
generally familiar to most geotechnical engineers and which can be obtained from basic tests on soil samples.
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Figure 153: Parameters tabsheet for the Mohr-Coulomb model (drained behaviour)
The stiffness parameters of the Mohr-Coulomb model (drained behaviour) are:
E'

Effective Young's modulus

ν'

Effective Poisson's ratio

[kN/m2]
[-]

Note:
• Optional drainage types when Mohr-Coulomb model is selected are: Drained, Undrained (A), Undrained (B),
Undrained (C), and Non-porous.
• In the case of Undrained (A) or Non-porous drainage types, the same parameters are used as for drained
behaviour.
• In the case of Undrained (B) drainage type, φ = φu = 0, ψ = 0 and the undrained shear strength su is used
instead of the effective cohesion (c').
• In the case of Undrained (C) drainage type all parameters are undrained. i.e. Eu, νu and su as undrained
Young's modulus, undrained Poisson's ratio and undrained shear strength respectively, and φ = ψ = 0.
Instead of using the Young's modulus as a stiffness parameter, alternative stiffness parameters can be entered.
These parameters, the relations and their standard units are listed below:
G
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Eoed

[kN/m2]

Oedometer modulus, where Eoed = E'(1-ν')/(1+ν')(1 - 2ν')

Note that the alternatives are influenced by the input values of E' and ν'. Entering a particular value for one of
the alternatives G or Eoed results in a change of the Young's modulus E'.
Stiffness varying with depth can be defined in Mohr-Coulomb model by entering a value for E'inc which is the
increment of stiffness per unit of depth. Together with the input of E'inc the input of zref becomes relevant. For
any z-coordinate above zref} the stiffness is equal to E'ref. For any z-coordinate below zref the stiffness is given by:
E ′ (z ) = E ′ + (zref − z ) E ′ inc ; z < zref

Eq. [13]

The strength parameters for the Mohr-Coulomb model are:
c'ref

[kN/m2]

Effective cohesion

φ'

Effective friction angle

[°]

ψ

Dilatancy angle

[°]

A cohesion varying with depth can be defined in Mohr-Coulomb model by entering a value for c'inc which is the
increment of effective cohesion per unit of depth. Together with the input of c'inc the input of zref becomes
relevant. For any z-coordinate above zref the cohesion is equal to c'ref. For any z-coordinate below zref the
cohesion is given by:
c ′ (z ) = c ′ ref + (zref − z )c ′ inc ; z < zref

Eq. [14]

In some practical problems an area with tensile stresses may develop. This is allowed when the shear stress is
sufficiently small. However, the soil surface near a trench in clay sometimes shows tensile cracks. This indicates
that soil may also fail in tension instead of in shear. Such behaviour can be included in a PLAXIS 3D analysis by
selecting the Tension cut-off option. When selecting the Tension cut-off option the allowable tensile strength may
be entered. The default value of the tensile strength is zero.
Note:
• Note that the wave velocities are influenced by the input values of E' and ν'. Entering a particular value for
one of the wave velocities results in a change of the Young's modulus.
• Velocities of wave propagation in soil can be defined only for models with stress independent stiffness.

Hardening Soil model (HS)
The Parameters tabsheet for the Hardening Soil modelis shown in Figure 154 (on page 205).
Note:
• Optional drainage types when Hardening Soil model is selected are: Drained, Undrained (A), and Undrained
(B).
• In the case of Undrained (A) drainage type, the same parameters are used as for drained behaviour.
• In the case of Undrained (B) drainage type, φ = φu = 0 , ψ = 0 and the undrained shear strength su is used
instead of the effective cohesion (c').
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Figure 154: Parameters tabsheet for the Hardening Soil model(drained behaviour)
The stiffness parameters of the Hardening Soil model are:
E50ref

Secant stiffness in standard drained triaxial test

[kN/m2]

Eoedref

Tangent stiffness for primary oedometer loading

[kN/m2]

Eurref

Unloading / reloading stiffness (default Eurref = 3E50ref)

[kN/m2]

m

Power for stress-level dependency of stiffness

[-]

Instead of entering the basic parameters for soil stiffness, alternative parameters can be entered. These
parameters are listed below:
CC

Compression index

[-]

Cs

Swelling index or reloading index

[-]

Initial void ratio

[-]

einit

In addition, advanced parameters can be defined for stiffness (it is advised to use the default setting):
νur
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pref

Reference stress for stiffnesses (default pref = 100 kN/m2)

K0nc

K0-value for normal consolidation (default K0nc = 1 - sin(φ))

[kN/m2]
[-]

The strength parameters of the present hardening model coincide with those of the non-hardening MohrCoulomb model:
c'ref

[kN/m2]

Effective cohesion

φ'

Effective friction angle

[°]

ψ

Dilatancy angle

[°]

In addition, advanced parameters can be defined for strength:
[kN/m3]

c'inc

As in Mohr-Coulomb model (default cinc = 0)

zref

Reference level

[m]

Rf

Failure ratio qf / qa (default Rf = 0.9)

[-]

Tension cut- To be selected when tension cut-off is considered
off

[-]

Tensile
strength

[kN/m2]

The allowable tensile strength

In some practical problems an area with tensile stresses may develop. This is allowed when the shear stress is
sufficiently small. However, the soil surface near a trench in clay sometimes shows tensile cracks. This indicates
that soil may also fail in tension instead of in shear. Such behaviour can be included in a PLAXIS 3D analysis by
selecting the Tension cut-off option. When selecting the Tension cut-off option the allowable tensile strength may
be entered. The default value of the tensile strength is zero.

Hardening Soil model with small-strain stiffness (HSsmall)
Compared to the standard HS model, the Hardening Soil model with small-strain stiffness requires two
additional stiffness parameters as input: γ0.7 and G0ref. The Parameters tabsheet for the Hardening Soil model
with small-strain stiffness is shown in Figure 155 (on page 207).
Note:
• Optional drainage types when Hardening Soil model with small-strain stiffness is selected are: Drained,
Undrained (A), and Undrained (B).
• In the case of Undrained (A) drainage type, the same parameters are used as for drained behaviour.
• In the case of Undrained (B) drainage type, φ = φu = 0, ψ = 0 and the undrained shear strength su is used
instead of the effective cohesion (c').

PLAXIS

206

PLAXIS 3D-Reference Manual

Material properties and material database
Modelling soil and interface behaviour

Figure 155: Parameters tabsheet for the Hardening Soil model small(drained behaviour)
All other parameters, including the alternative stiffness parameters, remain the same as in the standard
Hardening Soil model. In summary, the input stiffness parameters of the Hardening Soil model with small-strain
stiffness are listed below:
Parameters for stiffness:
E50ref

Secant stiffness in standard drained triaxial test

[kN/m2]

Eoedref

Tangent stiffness for primary oedometer loading

[kN/m2]

Eurref

Unloading / reloading stiffness (default Eurref = 3E50ref)

[kN/m2]

m

Power for stress-level dependency of stiffness

[-]

Alternative parameters for stiffness:
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einit

Initial void ratio

[-]

Advanced parameters for stiffness:
νur

Poisson's ratio for unloading-reloading (default ν = 0.2)

pref

Reference stress for stiffnesses (default pref = 100 kN/m2)

K0nc

K0-value for normal consolidation (default K0nc = 1 - sin(φ))

[-]
[kN/m2]
[-]

Parameters for strength:
c'ref

[kN/m2]

Effective cohesion

φ'

Effective friction angle

[°]

ψ

Dilatancy angle

[°]

Advanced parameters for strength:
[kN/m3]

c'inc

As in Mohr-Coulomb model (default cinc = 0)

zref

Reference level

[m]

Rf

Failure ratio qf / qa (default Rf = 0.9)

[-]

Tension cut- To be selected when tension cut-off is considered
off

[-]

Tensile
strength

[kN/m2]

The allowable tensile strength

Parameters for small strain stiffness:
γ0.7

Shear strain at which Gs = 0.722 G0

[-]

G0ref

Reference shear modulus at very small strains (ε < 10-6)

[kN/m2]

In some practical problems an area with tensile stresses may develop. This is allowed when the shear stress is
sufficiently small. However, the soil surface near a trench in clay sometimes shows tensile cracks. This indicates
that soil may also fail in tension instead of in shear. Such behaviour can be included in a PLAXIS 3D analysis by
selecting the Tension cut-off option. When selecting the Tension cut-off option the allowable tensile strength may
be entered. The default value of the tensile strength is zero.
Hysteretic damping
The elastic modulus ratio is plotted as a function of the shear strain (γ) in a side pane when specifying the smallstrain stiffness parameters (Modulus reduction curve). The Hardening Soil model shows typical hysteretic
behaviour when subjected to cyclic shear loading. In dynamic calculations this leads to hysteretic damping. The
damping ratio is plotted as a function of the cyclic shear strain γC. Details are given in Brinkgreve, Kappert &
Bonnier (2007) (on page 508).
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Figure 156: Effect of small strain stiffness parameters on damping
Note:
Note that the Modulus reduction curve and the Damping curve are based on fully elastic behaviour. Plastic strains
as a result of hardening or local failure may lead to significant lower stiffness and higher damping.

Soft Soil model (SS)
The Parameters tabsheet for the Soft Soil model is shown in Figure 157 (on page 210).
Note:
• Optional drainage types when Soft Soil modelis selected are: Drained and Undrained (A).
• In the case of Undrained (A) drainage type, the same parameters are used as for drained behaviour.
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Figure 157: Parameters tabsheet for the Soft Soil model (drained behaviour)
The parameters for stiffness are:
λ*

Modified compression index

[-]

κ*

Modified swelling index

[-]

Alternative parameters can be used to define stiffness:
CC

Compression index

[-]

Cs

Swelling index or reloading index

[-]

Initial void ratio

[-]

einit

The parameters for strength are:
c'ref

[kN/m2]

Effective cohesion

φ'

Effective friction angle

[°]

ψ

Dilatancy angle

[°]

Advanced parameters (use default settings):
νur

Poisson's ratio for unloading-reloading (default ν = 0.15)

[-]

K0nc

K0-value for normal consolidation (default K0nc = 1 - sin(φ))

[-]

K0nc- related parameter

[-]

M

PLAXIS

210

PLAXIS 3D-Reference Manual

Material properties and material database
Modelling soil and interface behaviour
Tension cut- To be selected when tension cut-off is considered
off
Tensile
strength

[-]
[kN/m2]

The allowable tensile strength

In some practical problems an area with tensile stresses may develop. This is allowed when the shear stress is
sufficiently small. However, the soil surface near a trench in clay sometimes shows tensile cracks. This indicates
that soil may also fail in tension instead of in shear. Such behaviour can be included in a PLAXIS 3Danalysis by
selecting the Tension cut-off option. When selecting the Tension cut-off option the allowable tensile strength may
be entered. The default value of the tensile strength is zero.

Soft Soil Creep model (SSC)
The Parameters tabsheet for the Soft Soil Creep model is shown in Figure 158 (on page 211).
Note:
• Optional drainage types when Soft Soil Creep model is selected are: Drained and Undrained (A).
• In the case of Undrained (A) drainage type, the same parameters are used as for drained behaviour.

Figure 158: Parameters tabsheet for the Soft Soil Creep model (drained behaviour)
The parameters for stiffness are:

PLAXIS

λ*

Modified compression index

[-]
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Modified swelling index

[-]
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The parameter taking time effect into account is:
μ*

Modified creep index

[-]

Alternative parameters can be used to define stiffness:
CC

Compression index

[-]

Cs

Swelling index or reloading index

[-]

Cα

Secondary compression index

[-]

einit

Initial void ratio

[-]

The parameters for strength are:
c'ref

[kN/m2]

Effective cohesion

φ'

Effective friction angle

[°]

ψ

Dilatancy angle

[°]

Advanced parameters (use default settings):
νur

Poisson's ratio for unloading-reloading (default ν = 0.15)

[-]

K0nc

K0-value for normal consolidation (default K0nc = 1 - sin(φ))

[-]

K0nc- related parameter

[-]

M

Tension cut- To be selected when tension cut-off is considered
off
Tensile
strength

[-]
[kN/m2]

The allowable tensile strength

In some practical problems an area with tensile stresses may develop. This is allowed when the shear stress is
sufficiently small. However, the soil surface near a trench in clay sometimes shows tensile cracks. This indicates
that soil may also fail in tension instead of in shear. Such behaviour can be included in a PLAXIS 3D analysis by
selecting the Tension cut-off option. When selecting the Tension cut-off option the allowable tensile strength may
be entered. The default value of the tensile strength is zero.

Joined Rock model (JR)
The Parameters tabsheet for the Joined Rock model is shown in Figure 159 (on page 213).
Note:
• Optional drainage types when Joined Rock model is selected are: Drained and Non-porous.
• In the case of Non-porous drainage type, the same parameters are used as for drained behaviour.
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Figure 159: Parameters tabsheet for the Joined Rock model
Parameters for stiffness:
E1

Young's modulus for rock as a continuum

ν1

Poisson's ratio for rock as a continuum

[kN/m2]
[-]

Anisotropic elastic parameters 'Plane 1' direction (e.g. stratification direction):
E2

Young's modulus perpendicular to 'Plane 1' direction

[kN/m2]

G2

Shear modulus perpendicular to 'Plane 1' direction

[kN/m2]

ν2

Poisson's ratio perpendicular to 'Plane 1' direction

[-]

Parameters for strength:
Strength parameters in joint directions (Plane i=1, 2, 3):

PLAXIS

ci

Cohesion

φi

Friction angle

[kN/m2]
[°]
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ψi

Dilatancy angle

[°]

σt,i

Tensile strength

[kN/m2]

Definition of joint directions (Plane i=1, 2, 3):
n

Number of joint directions (1≤n≤3)

[-]

α1,i

Dip angle (Visualized in the side panel)

[°]

α2,i

Dip direction

[°]

In some practical problems an area with tensile stresses may develop. This is allowed when the shear stress is
sufficiently small. However, the soil surface near a trench in clay sometimes shows tensile cracks. This indicates
that soil may also fail in tension instead of in shear. Such behaviour can be included in a PLAXIS 3D analysis by
selecting the Tension cut-off option. When selecting the Tension cut-off option the allowable tensile strength may
be entered. The default value of the tensile strength is zero.

Modified Cam-Clay model (MCC)
This is a critical state model that can be used to simulate the behaviour of normally consolidated soft soils. The
model assumes a logarithmic relationship between the void ratio and the mean effective stress. The Parameters
tabsheet for the Modified Cam-Clay model is shown in Figure 160 (on page 214).
Note:
• Optional drainage types when Modified Cam-Clay model is selected are: Drained and Undrained (A).
• In the case of Undrained (A) drainage type, the same parameters are used as for drained behaviour.

Figure 160: Parameters tabsheet for the Modified Cam-Clay model (drained behaviour)
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Parameters for stiffness:
λ

Cam-Clay compression index

[-]

κ

Cam-Clay swelling index

[-]

νur

Poisson's ratio

[-]

einit

Initial void ratio for loading/unloading

[-]

Parameters for strength:
M

Tangent of the critical state line

[-]

Coefficient of lateral stress in normal consolidation derived from M. The

K 0nc

relationship between M and K 0nc is given in the Material Models Manual Chapter
10- Parameters of the soft soil creep model.

[-]

NGI-ADP model (NGI-ADP)
The NGI-ADP model may be used for capacity, deformation and soil-structure interaction analysis involving
undrained loading of clay-type materials. The Parameters tabsheet for the NGI-ADP model is shown in Figure
161 (on page 216).
Note:
Optional drainage types when NGI-ADP model is selected are: Drained, and Undrained (C).
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Figure 161: Parameters tabsheet for the NGI-ADP model
Parameters for stiffness:
Gur

/ suA

Ratio unloading/reloading shear modulus over (plane strain) active shear strength

[-]

γfC

Shear strain in triaxial compression (|γfC = 3/2 ε1C|)

[%]

γfE

Shear strain in triaxial extension

[%]

Shear strain in direct simple shear

[%]

γfDSS

Parameters for strength:
suA, ref
suC,TX/suA
zref

PLAXIS

[kN/m2/m]

Reference (plane strain) active shear strength
Ratio triaxial compressive shear strength over (plane strain) active shear strength
(default = 0.99)

[-]

Reference level

[m]

su,incA

Increase of shear strength with depth

[kN/m2/m]

suP/suA

Ratio of (plane strain) passive shear strength over (plane strain) active shear
strength

216

[-]

PLAXIS 3D-Reference Manual

Material properties and material database
Modelling soil and interface behaviour
τ0/suA
suDSS/suA

Initial mobilization (default = 0.7)

[-]

Ratio of direct simple shear strength over (plane strain) active shear strength

[-]

Advanced parameters:
ν'

Effective Poisson's ratio

[-]

νu

Undrained Poisson's ratio

[-]

UDCAM-S model
The UDCAM-S model can be used for capacity, deformation and soil-structure interaction analysis involving
undrained loading of clay-type materials for the design of offshore structures. The Parameters tabsheet for the
UDCAM-S model is shown in Figure 162 (on page 218). The parameters are obtained from the Cyclic
accumulation and optimisation tool, which can be accessed by clicking on the corresponding button in the righthand panel.
Note:
Optional drainage types when UDCAM-S model is selected are: Undrained (B) and Undrained (C).
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Figure 162: Parameters tabsheet for the UDCAM-S model
Parameters for stiffness:
Gmax/τC

Ratio unloading/reloading shear modulus over (plane strain) active shear strength

[-]

γfC

Shear strain in triaxial compression

[%]

γfE

Shear strain at failure in triaxial extension

[%]

Shear strain at failure in direct simple shear

[%]

γfDSS

Parameters for strength:

PLAXIS

τrefC

Degraded reference shear strength in triaxial compression

[kN/m2]

zref

Reference level

τincC

Increase of degraded triaxial compression shear strength with depth

τE/τC

Ratio of degraded triaxial compression shear strength triaxial extension over
degraded triaxial compression shear strength

[m]
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τ0/τC
τDSS/τC

Initial mobilisation

[-]

Ratio of degraded direct simple shear strength over degraded triaxial compression
shear strength

[-]

Advanced parameters:
ν'

Effective Poisson's ratio

[-]

νu

Undrained Poisson's ratio

[-]

Hoek-Brown model (HB)
The Parameters tabsheet for the Hoek-Brown model is shown in Figure 163 (on page 220). The Hoek-Brown
parameters can be obtained from the tools available in the right-hand panel.
Note:
• Optional drainage types when Hoek-Brown model is selected are: Drained and Non-porous.
• In the case of Non-porous drainage type, the same parameters are used as for drained behaviour.
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Figure 163: Parameters tabsheet for the Hoek-Brown model (drained behaviour)
The stiffness parameters of the Hoek-Brown model are:
Erm

Rock mass Young's modulus

ν

Poisson's ratio

[kN/m2]
[-]

The side panel supports the selection of the Hoek-Brown parameters. The Hoek-Brown parameters are:
[kN/m2]

|σci|

Uni-axial compressive strength of the intact rock (>0)

mi

Material constant for the intact rock

[-]

GSI

Geological Strength Index

[-]
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D

Disturbance factor which depends on the degree of disturbance to which the rock
mass has been subjected

[-]

ψmax

Dilatancy at zero stress level

[°]

σψ

Poisson's ratio

[kN/m2]

UBC3D-PLM model
The Parameters tabsheet for the UBC3D-PLM model is shown in Figure 164 (on page 222).
Note:
Drainage types when UBC3D-PLM model is selected are: Drained and Undrained A. The other undrained
calculations are not available due to the effective stress nature of the model.
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Figure 164: Parameters tabsheet for the UBC3D-PLM model
The stiffness parameters of the UBC3D-PLM model are:

PLAXIS

k B*e

Elastic bulk modulus factor

[-]

kG*e

Elastic shear modulus factor

[-]

kG* p

Plastic shear modulus factor

[-]

me

Elastic bulk modulus index

[-]

ne

Elastic shear modulus index

[-]
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np

Plastic shear modulus index

pref

Reference pressure

[-]
[kN/m2]

Note:
The implicit Poisson's ratio that is defined based on keB and keG is suitable for dynamic calculation, but it does
not generate a proper initial stress state if the initial stress condition is established by gravity loading procedure.
In such a case the user should define another material set for the stress initialization step with proper
characteristics.
Parameters for strength:
φcv

Constant volume friction angle

[°]

φp

Peak friction angle

[°]

c

Cohesion

[kN/m2]

σt

Tension cut-off and tensile strength

[kN/m2]

Advanced parameters for strength and stiffness:
Rf

Failure ratio

[-]

(N1)60

Corrected SPT value

[-]

fdens

Densification factor

[-]

fEpost

Post-liquefaction stiffness factor

[-]

Concrete model
The Parameters tabsheet for the Concrete model are shown in Figure 165 (on page 224).
Note:
Drainage types when Concrete model is selected are: Drained, in case of semi-permeable walls, and Non-porous,
which is the general approach for concrete structural elements.
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Figure 165: Parameters tabsheet for the Concrete model
Parameters for stiffness:
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E28

Young's modulus for rock as a continuum

[kN/m2]

E1 / E28

Time-dependency ratio of elastic stiffness

[-]

Poisson's ratio

[-]

ν

Parameters for strength in compression:
[kN/m2]

fc,28

Young's modulus for rock as a continuum

fc0n

Normalised failure strength

[-]

fcfn

Normalised initially mobilised strength

[-]

fcun

Normalised residual strength

[-]

Gc,28

Compressive fracture energy of cured concrete at thydr

φmax

Maximum friction angle

[°]

Dilatancy angle

[°]

ψ

[kN/m]

Time-dependency of compressive strength:
fc,1 / fc,28
thydr

Time-dependency of compressive strength
Time for full hydration

[-]
[day]

Parameters for tensile strength :
ft,28

Uniaxial tensile strength of cured concrete at thydr

ftun

Ratio of residual vs. peak tensile strength

Gt,28

Tensile fracture energy of cured concrete at thydr

[kN/m2]
[-]
[kN/m]

Parameters for ductility:
εpcp,1h

Uniaxial plastic failure strain at 1h (negative value)

[-]

εpcp,8h

Uniaxial plastic failure strain at 8h (negative value)

[-]

εpcp,24h

Uniaxial plastic failure strain at 24h (negative value)

[-]

Normalised residual strength

[-]

a

Parameters for creep:

φ cr

PLAXIS

Ratio between creep and elastic strains
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cr
t50

Time for 50% of creep strains

[day]

Parameters for shrinkage:

ε∞shr
cr
t50

Safety factor for compressive strength
Time for 50% of shrinkage strains

[-]
[day]

Safety factor:
γfc

Safety factor for compressive strength

[-]

γft

Safety factor for tensile strength

[-]

Note:
• When simulating shotcrete the tensile strength is essential for tunnel stability. Neglecting or considering low
values of it could result in unrealistic failure.
• The creep history is adjusted for the stress state at first activation of the concrete cluster, such that no creep
strains are produced by initial stresses. The state variables are taken over if the previous material was also
defined with the Concrete model, in which case creep will also continue. If a reset of state variables is desired,
a nil step with a different material (e.g. linear elastic) is required.

User defined soil model (UDSM)
The Parameters tabsheet shows two drop-down menus; the top combo box lists all the DLLs that contain valid
User-defined Soil Model and the next combo box shows the models defined in the selected DLL. Each UD model
has its own set of model parameters, defined in the same DLL that contains the model definition.
When an available model is chosen PLAXIS 3D will automatically read its parameter names and units from the
DLL and fill the parameter table below. For a detailed description of this facility, reference is made to the
Material Models Manual.
Note:
Available drainage types when User defined soil model is selected are: Drained, Undrained (A) and Non-porous.

Advanced parameters for Undrained behaviour and Coupled Analysis
The advanced parameters available in the Parameters tabsheet can be used to model the Undrained behaviour
of soils and the properties of the pore water in coupled analysis. The advanced parameters for the Undrained
behaviour shows three drop-down menus (Figure 166 (on page 227)) namely Standard, Manual - Stiffness
dependent Kw and Manual - Constant Kw. By default, the solid material of the soil (i.c the grains) is supposed to be
incompressible (αBiot = 1) and the undrained Poisson's ratio is taken as 0.495. This is the Standard behaviour.
Alternatively, one can select Manual - Stiffness dependent Kw; here the Skempton's B-parameter can be specified,
Kw and Kw,ref/n are calculated accordingly. In the most advanced third option Manual - Constant Kw, the
compressibility of the solid material is considered and one can select αBiot together with Kw and νu; Skempton B
and Kw,ref/n are calculated accordingly.
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Skempton-B A parameter that determines which portion of a change in mean stress is carried
by the pore water

[-]

νu

Undrained Poisson's ratio

[-]

αBiot

Biot alpha pore pressure coefficient

[-]

Kw

Bulk modulus of water

[-]

Kw,ref / n

The corresponding reference bulk stiffness of the pore fluid

[kN/m2]

Cv,ref

Consolidation coefficient (Mohr-Coulomb modelonly)

[m2/day]

More detailed information is available in the Material Models Manual.

Figure 166: Advanced parameters for Undrained Behaviour

6.1.3 Hoek-Brown pre-processing tool
The Hoek-Brown model is the most used failure criterion for rock masses, nevertheless there are some
uncertainties regarding the input parameters that require a consolidated experience (Hoek, Carranza-Torres &
Corkum (2002); Hoek (2007)). For this reason, PLAXIS 3D implements in the Parameters tabsheet of the HoekBrown model a pre-processing tool to guide the user in the determination of the rock mass strength and stiffness
parameters. PLAXIS 3D sign convention is adopted, i.e. compressive stresses are considered to be negative. The
pane contains the following tabsheets:
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• Analysis: shows the Hoek-Brown failure envelope in the plane of principal effective stresses σ'3 - σ'1, in order
to visualise the effects of changing of rock mass parameters on the failure envelope. For more information
about the Hoek-Brown modeland its formulation, refer Material Models Manual.
• The second tabsheet is specific to determine the selected parameter.
Uni-axial compressive strength of intact rock |σci|
The uni-axial compressive strength of intact rock |σci| can be checked based on the estimation methods generally
executed in the field. Alternatively, a range can be selected and PLAXIS 3Dautomatically set the parameter to the
middle value of the range. In case the upper bound limit of 250 MPa is selected, the parameter is set to 250 MPa.
Table 5 (on page 228) reports the range of compressive strength for each category with a qualitative description
of the strength behaviour to field test.
Table 5: |σci| tabsheet values
Field estimate

Examples

Strength [MPa]

Only chipping is possible with a geological
hammer

Chert, diabase, fresh basalt, gneiss,
granite, quartzite

|σci| ≥ 250

Fracturing requires many blows of a
geological hammer

Amphibolite, basalt, gabbro, gneiss,
granodiorite, limestone, marble,
rhyolite, sandstone, tuff

100 ≤ |σci| ≤ 250

Limestone, marble, phyllite,
sandstone, schist, shale

50 ≤ |σci| ≤ 100

Claystone, coal, concrete, schist, shale,
siltstone

25 ≤ |σci| ≤ 50

Firm blow with the point of a geological
hammer leaves shallow indentation; peeling
with a pocket knife is possible, but difficult

Chalk, potash, rocksalt

5 ≤ |σci| ≤ 25

Firm blow with the point of geological
hammer leads to crumbling; peeling with a
pocket knife is possible

Highly weathered or altered rock

1 ≤ |σci| ≤ 5

Stiff fault gouge

0.25 ≤ |σci| ≤ 1

Fracturing requires more than one blow of a
geological hammer
Fracturing is possible with a single blow
from a geological hammer, but cannot be
scraped or peeled with a pocket knife

Thumbnail leaves indentation
Intact rock parametermi

The intact rock parameter mi can be estimated based on the rock type.
Table 6: Values of the constant mi for intact rock (Marinos & Hoek (2001), Wyllie & Mah (2004))

PLAXIS

Name

Rock type

Texture

mi

mi \pm

Agglomerate

Igneous

Coarse

19

3

Amphibolites

Metamorhpic

Medium

26

6
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Name

Rock type

Texture

mi

mi \pm

Andesite

Igneous

Medium

25

5

Anhydrite

Sedimentary

Fine

12

2

Basalt

Igneous

Fine

25

5

Breccia

Igneous

Medium

19

5

Breccia

Sedimentary

Coarse

19

5

Chalk

Sedimentary

Veryfine

7

2

Claystones

Sedimentary

Veryfine

4

2

Conglomerates

Sedimentary

Coarse

21

3

Crystallinelimestone

Sedimentary

Coarse

12

3

Dacite

Igneous

Fine

25

3

Diabase

Igneous

Fine

15

5

Diorite

Igneous

Medium

25

5

Dolerite

Igneous

Medium

16

5

Dolomites

Sedimentary

Veryfine

9

3

Gabbro

Igneous

Coarse

27

3

Gneiss

Metamorhpic

Fine

28

5

Granite

Igneous

Coarse

32

3

Granodiorite

Igneous

Coarse,Medium

29

3

Greywackes

Sedimentary

Fine

18

3

Gypsum

Sedimentary

Medium

8

2

Hornfels

Metamorhpic

Medium

19

4

Marble

Metamorhpic

Coarse

9

3

Marls

Sedimentary

Veryfine

7

2

Metasandstone

Metamorhpic

Medium

19

3

Mictriclimestones

Sedimentary

Fine

9

2

Migmatite

Metamorhpic

Coarse

29

3
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Name

Rock type

Texture

mi

mi \pm

Norite

Igneous

Coarse,Medium

20

5

Obsidian

Igneous

Veryfine

19

3

Peridotite

Igneous

Veryfine

25

5

Phyllites

Metamorhpic

Fine

7

3

Porphyries

Igneous

Coarse,Medium

20

5

Quartzites

Metamorhpic

Fine

20

3

Rhyolite

Igneous

Medium

25

5

Sandstones

Sedimentary

Medium

17

4

Schists

Metamorhpic

Medium

12

3

Shales

Sedimentary

Veryfine

6

2

Siltstones

Sedimentary

Fine

7

2

Slates

Metamorhpic

Veryfine

7

4

Spariticlimestones

Sedimentary

Medium

10

2

Tuff

Igneous

Fine

13

5

Geological Strength Index GSI
The GSI tabsheet allows to choose between two rock types: General Figure 167 (on page 231) and Flysch Figure
168 (on page 232). An intact rock is equivalent to GSI = 100, whereas a soil structure is in proximity to GSI = 0.
Based on the selected rock type, the GSI can be chosen taking the structure and the surface conditions of the rock
mass into account. An hint box at the bottom of the chart displays the rock characteristics for the selected GSI.
Note:
The GSI charts allows only integer values. If a higher accuracy is required, a decimal value can be manually put in
the Input tabsheet of the material set.
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Figure 167: GSI chart for General rock type
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Figure 168: GSI chart for Flysch rock type

Disturbance factor (D)
The disturbance factor D depends on the amount of disturbance of the rock as a result of mechanical processes
in open excavations, tunnels or mines, such as blasting, tunnel boring, machine driven or manual excavation. No
disturbance is equivalent to D = 0, whereas severe disturbance is equivalent to D = 1. The D tabsheet allows a
direct estimation of the disturbance factor for tunnel Table 7 (on page 233) and slopes Table 8 (on page 233).
In blast damaged rock, there are two main issues when applying the disturbance factor D:
• Choose a suitable value: a large number of factors can influence the degree of disturbance (quality of the rock
mass and the excavation/blasting, loading sequence, lateral confinement produced by different radii of
curvature of slopes as compared with their height, the level of strain in the failure zone, etc.). For this reason,
the disturbance factor D is inferred on the basis of engineering experience and research Table 7 (on page
233)Table 8 (on page 233).
• Define the extent of the damaged zone: the disturbance factor D should only be applied to the actual zone of
damaged rock in order to avoid underestimation of the strength and stability of the overall rock mass greatly.
The thickness T of the blast damaged zone depends upon the design of the blast (Hoek & Karzulovic, 2000).
In the case of bench blasting in open pit mines and civil engineering slopes, Table 8 (on page 233) contains
suggested values, where H is the height of the slope. In the case of tunnels excavated by drill and blast
methods, for very high quality controlled blasting the damage to the tunnel wall is negligible due to a welldesigned blasting pattern, detonation sequence and accurate drilling control. In contrast, the lack of a good
blast design and absence of any control on the drilling can result in significant damage.
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Table 7: Distrubance factor D, guidelines for tunnels
Description

D

Tunnel excavation by TBM or blasting of excellent quality

0.0

Tunnel excavation by hand or using a mechanical process rather than blasting, in poor quality
rock. There are no squeezing problems leading to floor heave, or these are mitigated using a
temporary invert

0.0

Tunnel excavation by hand or using a mechanical process rather than blasting, in poor quality
rock. There are unmitigated squeezing problems leading to floor heave

0.5

Tunnel excavation using blasting of very poor quality, leading to severe local damage

0.8

Table 8: Disturbance factor D, guidelines for slopes
Description

D

Slope created using controlled, small scale blasting of good quality

0.7

Slope created using small scale blasting of poor quality

1.0

Slope in very large open pit mine, created using mechanical excavation in softer rocks

0.7

Slope in very large open pit mine, created using heavy production blasting

1.0

Table 9: Damaged thickness T, guidelines for bench blasting in open pit mines and civil engineering slopes
Description

T

Large production blast, confined and with little or no control

2.0 to 2.5 H

Production blast with no control but blasting to a free face

1.0 to 1.5 H

Production blast, confined but with some control, e.g. one or more buffer rows

1.0 to 1.2 H

Production blast with some control, e.g. one or more buffer rows, and blasting to a free face

0.5 to 1.0 H

Carefully controlled production blast with a free face

0.3 to 0.5 H

6.1.4 Cyclic accumulation and optimisation tool
The Cyclic accumulation and optimisation tool is used to determine the UDCAM-S model parameters. The model
is especially suited for the foundation design of offshore structures subjected to a design storm (i.e. a
combination of a wave, wind loading, and currant). The stiffness and strength of saturated soils under cyclic
loading are different from the static case: they may increase due to strain rate effects or reduce due to
degradation processes, as pore pressure build up and destructuration. The soil beneath structures subjected to
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cyclic loading experiences different behaviour following different stress paths. For a general stress path, the
behaviour may be interpolated between triaxial compression (TxC), triaxial extension (TxE) and direct simple
shear (DSS) conditions.
The Cyclic accumulation and optimisation tool offers the possibility to check the effect of a specified input load
history for a specific soil type and, through an accumulation and interpolation procedure, it provides stressstrain curves for the different characteristic stress paths. The UDCAM-S model parameters are optimised in
order to match the stress-strain curves.
The tool is suitable only for clay and low permeable silts in undrained condition since the effect of drainage is
not taken into account. The accumulation procedure is based on the cyclic shear strains.
Note:
In addition to the cyclic shear strain accumulation procedure, the pore pressure accumulation and average shear
strain accumulation procedures can be found in literature. The reason for using different procedures is that the
development of one of these parameters may be more prominent than the others, depending on soil type, static
and cyclic shear stresses, etc. (Andersen, 1991 (on page 508)). The cyclic shear strain accumulation procedure
has been extensively used for clays, while the pore pressure accumulation procedure has been used for sands
since drainage is likely to occur during the complete load history (even though not within each cycle) in this type
of soils. In principle, the pore pressure accumulation procedure could also be used for clays. In practice,
however, accurate laboratory measurement of pore pressure is harder to perform in clays than in sand. Since
drainage is not likely to occur during the cyclic load history in clays, it is preferable to use the cyclic strain
accumulation procedure (Andersen, 2004 (on page 508)).

Starting the tool
To start the tool, the Cyclic accumulation and optimisation tool is clicked from the side panel in the Parameters
tabsheet of the UDCAM-S model . The window consists of two blue tabs and one orange tab, see Figure 169 (on
page 235) for an overview.
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Figure 169: Cyclic accumulation and optimisation tool
The first blue tabsheet, Cyclic accumulation, gives information regarding the input load history and the soil type.
The second blue tabsheet, Stress-strain curves, gives information about the stress-strain curves for different
stress paths. The orange tabsheet Parameter optimisation, allows the user to optimise the UDCAM-S model
parameters.
Above the tabsheets there are Load and Save buttons (see Figure 170 (on page 235)) to load or save the app
state. Saving and loading the app state is useful when running the same or similar calculations again, after the
project has been closed and reopened. Also, similar calculations in different projects can be done more easily by
loading a previously saved state.

Figure 170: Load and save app state
The state is saved in the JSON file format with the .json extension. All the settings and data on the tabsheet, like
table values and graph data are saved and can be loaded back into the tool.

Cyclic accumulation
In the design process of offshore structures, the design load is often a storm which can be transformed or
idealised into packages or parcels. Each parcel corresponds to a number of cycles at a load constant amplitude.
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The maximum cyclic load and the number of cycles at each load level are determined from a time record of loads.
The counting procedure to obtain the number of cycles can be done following different methods (e.g. the
rainflow-counting algorithm (Matsuishi & Endo (1968) (on page 509))) or the recently developed method, for
more information see Noren - Cosgriff, Josatd & Madshus (2015) (on page 509)).
The effect of the design storm on the soil deposit can be described through the equivalent number of cycles Neq
associated to the last applied normalised load amplitude F/Fmax and the soil cyclic contour diagram. The
equivalent number of cycles Neq is calculated at failure for capacity calculations. If it is found to be conservative,
the same value may also be used in stiffness calculations.
Note:
It is assumed here that Neq is representative for all the elements in the selected soil volume. Even though this
assumption may underestimate the effect of the stress redistribution and progressive failure, it has been shown
that the results are in good agreement with the ones from the model tests (Andersen, Puech & Jardine, 2013 (on
page 508)) and can certainly be used for stiff shallow foundations like offshore structures, while for monopiles
and piles this is generally not correct.
The cyclic contours (Figure 171 (on page 236)) are a set of curves where each of them represents the locus of
points characterised by the same cyclic shear strain. They can be visualized in a chart with the number of cycles
on the x-axis (in a logarithmic scale) and τcyc/su on the y-axis. Each point of the contour is then characterised by
a certain number of cycles and a normalised shear stress that induce a defined cyclic shear deformation in the
soil. The contours are defined for DSS tests with the average stress τa equals to 0 (for Drammen clay).

Figure 171: Contour diagram for DSS test for Drammen Clay with OCR = 4
Four lines limit the contours:
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• Each contour line starts with a point at N equal to 1 and an ending point at N equal to the number of cycles
above which all the contours are assumed to become horizontal (i.e. τcyc is constant). This leads to two
vertical boundaries, N = 1 and N = Nmax.
• The first contour is always defined at zero stress level, i.e. the contour line at the base where τcyc/su is equal
to zero and γcyc = 0%.
• The last contour represents the locus of points corresponding to γ equal to the cyclic shear strain at failure
(typically 15%).
Contour diagram data
The cyclic behaviour of clays depends on OCR, as well as the other index properties such as Plasticity Index, clay
content, water content, etc. NGI has extensively studied the cyclic behaviour of Drammen clays, realizing contour
diagrams from DSS tests. These contour data for Drammen clay with OCR equal to 1, 2, 4, 10, 20 and 40 are
available in the tool and can be selected from the drop-down menu.
In the case of other clays, it is possible to upload custom contours. In general, the contours can be determined by
different tests at different average shear stress levels, τa. For Drammen clay, Neq was found to be relatively
independent of τa and the type of test (Andersen, Kleven & Heien, 1988 (on page 508)) and the shear strain at
failure was taken as 15%.
Note: When uploading custom contours, a specific data format has to be used. For more information, see Cyclic
accumulation Tool - Contour File Formats.
By moving the mouse over any line in the contour chart, a hint box appears showing the value of γcyc that
describes that contour and the corresponding Ncycles and τcyc/su values.
Note:
• The shear strain at a given degree of shear strength mobilisation, τ / su, increases with increasing OCR,
meaning that the normalised secant modulus, G/su, decreases with increasing OCR for a given degree of
strength mobilisation. However, the absolute value of the stiffness will increase with increasing OCR for given
consolidation stress and strength mobilisation but significantly less than the increase in shear strength
(Andersen, 2015 (on page 508)).
• Even though in most cases the strength of the soil under cyclic loading may be reduced compared to the static
value, because of the degradation process, the cyclic shear strength can also be higher than the static shear
strength (i.e. τcy / su > 1) for a low number of cycles in some cases. The reason for this is that the clay strength
is rate dependent. Since the cyclic tests are typically run with a load period of 10 seconds and the monotonic
tests are brought to failure in about 2 hours, the cyclic strength may thus be higher than the static shear
strength (Andersen, 2007 (on page 508)).
Load ratio (F/Fmax)
The idealised load history, described by a series of parcels, is specified in a table that consists of four columns.
The first one indicates the number of the load parcel, the second one represents the load ratio value F / Fmax for
each parcel, the third one shows the corresponding number of cycles and the last one is the output of the
calculation performed in this tabsheet (i.e. the stress ratio). The load ratio F/Fmax refer to pure cyclic loading
condition (horizontal force, vertical force or bending moment). The user should define which load direction is
more crucial for the model and calculate consequently F/Fmax. For capacity analysis, when F is equal to Fmax (i.e.
the load ratio is equal to 1), failure has been reached and the shear strain is equal to its failure value γf. The
normalized shear strength τ/su at γf corresponds to its maximum value. A linear relationship between the load
and the shear stress is assumed, so that:

( )

τ
su max

PLAXIS

= χF

F
max

Eq. [15]
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where χ is the scaling factor automatically calculated during the strain accumulation procedure. At the end of the
accumulation procedure, the maximum stress ratio τ/su is displayed in the corresponding column in the Figure
172 (on page 238) .
The buttons in the toolbar can be used to modify the Figure 172 (on page 238).

Figure 172: Input table for load parcels of the cyclic accumulation and optimisation tool
•
Click the Add row button in the toolbar to add a new row in the table.
•

Click the Insert button to insert a new row before the selected row in the table.

•
Click the Delete button to delete the selected row in the table.
The values can be defined by clicking the cell in the table and by typing the value. A maximum of 100 load
parcels can be entered. The load ratio can be defined as any positive value larger than zero; its maximum value is
1. The number of cycles is a positive integer larger than zero.
As soon as a parcel is specified in the table, the graph "Load ratio vs N cycles'' at the bottom of the same tab will
be updated. There is an option to choose for a logarithmic representation on the y-axis. See an example of where
a series of parcels were defined in Figure 173 (on page 239).
•

•

PLAXIS

If the data for the load parcels exists in a file, it can be loaded by clicking the Open file. Any delimited
tabular text file or an excel spreadsheet file can be loaded. When the selected file is opened, a window pops
up where the user can choose the columns to extract the data from, see Figure 172 (on page 238). Also, the
field separator (delimiter) and start row can be defined. A preview of what is going to be imported is shown.
A load history, defined in the table, can be copied using the Copy button in the toolbar.
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•

Copied data from other applications (using Ctrl+c) can be imported by using the Paste button.

Figure 173: Automatic update of Load ratio graph when specifying parcels
Note:
If a load parcel is characterized by a number of cycles larger than the maximum value represented in the
contours diagram, it is advised to decompose it into two or more load parcels with slightly different load ratios
and lower number of cycles such that their sum is equal to the initial total Ncycles.
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Figure 174: Import load parcels settings dialog
To start the strain accumulation procedure, click the Calculate button. Prior to the calculation, the tool performs
some consistency checks on the input data to ensure that both the load parcel table and the contour diagram are
defined.
At the end of the calculation, the box of the equivalent number of cycles Neq is updated with the value resulting
from the strain accumulation procedure. The last accumulation up to failure is now visible in the contour
diagrams together with the locus of the end points for each accumulation (i.e. for all scaling factors used in the
process).
Cyclic accumulation tab possible errors
The errors that may occur in the Cyclic accumulation tab are listed in Calculation warning and errors in PLAXIS
(on page 578).

Stress-strain curves
The Stress-strain curves tabsheet allows to determine the stress-strain curves for different stress paths. The
curves are determined based on contour diagrams for different laboratory test types at a given equivalent
number of cycles. It is possible to choose among several Drammen clay contours (for OCR = 1, 2, 4, 10, 20 and
40) or to upload custom diagrams.
Note: When uploading custom contour diagrams, a specific data format has to be used. Please see Cyclic
accumulation for more information
The Drammen clay contours have been built as result of a large DSS and triaxial cycling testing programme
(Andersen et al, 1988 (on page 508)). Each point in the diagram is described by the average and cyclic shear
stresses, τa and τcyc, under which the tests were run, normalised with respect to the static undrained shear
strength in triaxial compression suC, together with the number of cycles and the corresponding value of the
average and cyclic shear strain at failure. For Drammen clay, failure is considered to be reached when either γa
or γcyc is equal to 15%. The total maximum shear stress τf, cyc that can be mobilized is given by the sum of the
average and the cyclic shear stress. In each diagram, the cyclic shear strength is determined for a case with a
constant cyclic shear stress during the cyclic load history. In reality, during a storm, the cyclic shear stress varies
from one cycle to the next one. The value of Neq is therefore essential to use these diagrams. By grouping the test
results for selected number of cycles, it has been established contour diagrams for N = 1, 10, 100, 1000. The
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Stress-strain curves tabsheet automatically interpolates the contours for the desired Neq, representative of the
real cyclic load history.

Figure 175: Stress-strain curves tabsheet, with contour diagrams for Drammen clay with OCR = 4.
By default, the equivalent number of cycles is copied from the Cyclic accumulation tabsheet. The contour
diagrams for DSS and triaxial tests are selected to be consistent with the chosen ones to perform the strain
accumulation procedure. If a custom contour has been chosen, it is necessary to upload a custom contour for the
strain interpolation procedure (describe format of the file). This can be done by setting Neq determination>
Manual. Then the option Contour diagrams will enable to Select contour diagrams by selecting Custom contours
from the drop-down list.
Note:
For an advanced use of the tool, it is possible to select the Manual option from the Neq determination drop-down
menu. This allows to manually enter a value for Neq or to modify the existing one, as well as selecting another
contour diagram from the list in the corresponding drop-down menu.
If the Soil behaviour is Anisotropic, i.e. the stress-strain curves are determined both for DSS and for triaxial tests,
it is generally expected that the anisotropy ratios τDSS/τC and τE/τC are different from 1. On the contrary, when
choosing the Isotropic option in the corresponding drop-down menu, the strain interpolation is performed for
the DSS test only and the anisotropy ratios are all equal to 1.
Two different scaling factors can be used to scale the y-axis of the DSS and triaxial diagrams, respectively.
The stress-strain curves are determined by specifying the ratio of the cyclic shear stress to the average shear
stress for each test condition (DSS, TXC, TXE) according to the desired failure mode and loading condition. When
a stress ratio different from zero is defined, the path line is automatically updated in the corresponding chart.
Note that the starting point of the path line is always on the x-axis (τcyc/suC and γcyc equal to zero) but it does not
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always coincide with the origin of the diagram: it is represented by the intersection point between the x-axis and
the contour line that corresponds to γa = 0%. For the DSS test, when the average strain is equal to zero also
τa/suC is equal to zero, while for the triaxial tests, the intersection generally occurs at τa/suC different from zero.
In fact, it corresponds to the initial in situ mobilization τ0/suC.
Note:
The contour diagram shows that the maximum cyclic shear strength is mobilized when large cyclic shear strains
occur and when the average shear stress is small. On the contrary, the maximum average shear strength is
mobilized when the average shear stress approaches the static shear strength and large average shear strains
occur. For average shear stresses between zero and the static shear strength, the failure mode is a combination
of average and cyclic shear strains.
The stress ratios should be defined such that (Δτcyc / Δτa)DSS is representative of the failure mode or, in case of
difference between the application direction of the cyclic and average load (e.g. one acts mostly in the horizontal
direction and the other one mainly in the vertical), it is advised to calculate τcyc/τa as the ratio between stresses
representative for the boundary value problem. The stress ratios for the triaxial stress may be chosen in order to
have strain compatibility with the DSS test, i.e. similar average and cyclic shear strains must be reached. As
shown in the chart, since each stress ratio represents the inclination of the corresponding stress path line, a
negative value must be entered for (Δτcyc/Δτa)TXE and a positive one for the others.
For establishing stress-strain curves, it is possible to choose among three load types:
• Cyclic load: the calculation follows the actual ratio between τcyc and τa (inclined path), but only the
relationship between τcyc and γcyc is considered.
• Average load: the calculation follows the actual ratio between τcyc and τa (inclined path), but only the
relationship between τa and γa is considered.
• Total load: the calculation considers the total strength, (τcyc + τa) and the total shear strain, (γcyc + γa).
To start generating stress-strain curves, click the Calculate button. Prior to the calculation, the tool performs
some consistency checks on the input data to ensure that both a valid equivalent number of cycles (larger than
0) and a contour diagram have been selected.
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Figure 176: Stress-strain curves tabsheet displaying results after calculation
The Target curves chart shows the stress-strain curves for all tests (e.g. only DSS if the isotropic behaviour has
been chosen) and for the selected load type. On the x-axis the shear strain γ is plotted in percentage, while the yaxis corresponds to the normalised shear strength τ / suC. The curves are used as input to the third and last
tabsheet Parameter optimisation.

Parameter optimisation
In the Parameter optimisation tabsheet (Figure 177 (on page 244)) the UDCAM-S model optimised parameters
can be determined by simulating undrained DSS, TxC, and TxE tests on one material point. The optimisation
procedure is based on the Particle Swarm Algorithm that allows to find the parameter values resulting in a
stress-strain curve that matches the target one. The laboratory test conditions are determined based on the
Static properties table.
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Figure 177: Parameter optimisation tabsheet
The parameters with their standard units are listed below.
Static properties:
su,refC
yref

[kN/m2]

Reference undrained triaxial compression TxC shear strength
Reference depth

[m]

su,incC

Increase of TxC shear strength with depth

τ0/suC

Initial mobilization

[-]

Ratio of the undrained compression shear strength over the current vertical
effective stress

[-]

Lateral earth pressure coefficient at rest

[-]

suC / σ'yy
K0

[kN/m2/m]

The initial mobilization is determined based on the contour diagrams in the Stress-strain curves tabsheet: it
corresponds to the value of τa / suC at the intersection point between the x-axis (γcyc = 0%) and the contour line
for γa equal to 0%.
The K0 determination option is set by default to automatic. This means that the value of K0 used to determine the
initial stress condition of the test is determined based on the following equation:

(

K0 = 1 − 2

PLAXIS

τ0 suC
suC σ ′ yy

)

Eq. [16]
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Note:
If in the Stress-strain curves tabsheet the user has selected the Cyclic load type, the initial mobilisation and the
undrained shear strength normalised by the vertical effective stress cannot be modified and are equal to 0 and 1,
respectively.
In the Parameter ranges table it is required to define the minimum and maximum value that should be
considered for each parameter during the optimisation procedure. The ranges can be estimated based on the
target charts.
Double-clicking on one of the graphs opens the selected chart in a bigger window (Figure 178 (on page 245)).
This window shows the selected diagram, the table of the data points that are used to plot it as well as the
tangent and the secant values of the plot. Note that the point to be taken into consideration for the calculation of
the tangent and the secant values can be determined by clicking on the plot. The secant and the tangent are
useful for the back-calculation of stiffness parameters from stress-strain diagrams. The corresponding secant
and tangent values are indicated below the table. The graph or the data can be copied to the clipboard by
selecting the corresponding option in the drop-down menu displayed when the Copy button is clicked. The
diagram can be zoomed in or out using the mouse by first clicking and holding the left mouse button in the
diagram area and then moving the mouse to a second location and releasing the mouse button. Moving the
mouse from the left upper corner to the right lower corner zooms the diagram to the selected area, whereas
moving the mouse from the right lower corner to the left upper corner resets the view. The zoom action can also
be undone using the Zoom out option on the toolbar. The wheel button of the mouse can be used for panning:
click and hold the mouse wheel down and move the diagram to the desired position.

Figure 178: Chart displaying target, optimised, secant and tangent curves, and corresponding table of values.
Parameter ranges:
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Gmax/τC

Ratio of the initial shear modulus to the cyclic compression shear strength

[-]

γfC

Shear strain at failure in triaxial compression

[%]

γfE

Shear strain at failure in triaxial extension

[%]

γfDSS

Shear strain at failure in direct simple shear

[%]

τC/suC

Ratio of the cyclic compression shear strength over the undrained static
compression shear strength

[-]

τE/suC

Ratio of the cyclic extension shear strength over the undrained static compression
shear strength

[-]

The initial shear modulus defines the tangent value of the stress strain curves at the initial shear stress
(Anderson, 2004 (on page 508)). For high loading levels, the area where G is equal to Gmax is very limited and
therefore not governing. For most problems, Gmax/suC has to be chosen to fit the stress-strain curve in the actual
strain range of interest. In the case of isotropic behaviour, γfC and γfE are set equal to the optimised γfDSS, while
the ratios τDSS/τC and τE / τC are equal to 1.
To run the optimisation procedure, click the Calculate button.
The results are shown both in the Parameter ranges table and in the charts. The optimum values of the
parameters used to obtain the best fit to the test data are shown in the Optimal value column of the table. If the
optimum value is equal to the minimum or maximum value, it might be that the best value lies outside the
specified range. The last column of the table shows the sensitivity of each parameter. A sensitivity of 100%
means that the parameter has a high influence on the simulated test results, whereas a low sensitivity means
that the parameter has a low influence on the simulated test results.
The optimised curves are shown in the corresponding test graph. As explained above, each chart can be opened
in a larger window by double-clicking it. Also for the optimised curve the table with the data points and the
possibility to draw the secant and tangent lines are available.
The optimal values are used to determine the optimised parameters used in the UDCAM-S model and shown in
the Optimised parameters table (Figure 177 (on page 244)).
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Figure 179: Optimised Parameters for Cyclic accumulation and optimisation tool
The parameters with their standard units are listed below.
Derived parameters:
Gmax/τC

Ratio of the initial shear modulus to the cyclic compression shear strength

[-]

γfC

Shear strain at failure in triaxial compression

[%]

γfE

Shear strain at failure in triaxial extension

[%]

γfDSS

Shear strain at failure in direct simple shear

[%]

τrefC

Cyclic compression shear strength

yref

Reference depth

τincC

Increase of the cyclic shear strength with depth

τE/τC

Ratio of the cyclic extension shear strength over the cyclic compression shear
strength

[-]

τ0/τC

Cyclic mobilization

[-]

Ratio of the cyclic DSS shear strength over the cyclic compression shear strength

[-]

τDSS/τC

[kN/m2]
[m]
[kN/m2]

For more information about the parameters of the UDCAM-S model , reference is made to Material Models
Manual - Chapter 14.
To copy the Optimised parameters table to the material database, click the Copy parameters.
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Possible errors of Parameter optimisation tab
For more information on the errors that may occur in the Parameter optimisation tab, refer to Table 27 (on page
586).

6.1.5 Groundwater tabsheet
Flow parameters are required when dealing with problems that involve flow of pore water in saturated or
unsaturated soils, i.e. when using Groundwater flow, Consolidation or Fully coupled flow-deformation types of
calculation. When considering steady-state groundwater flow or consolidation of fully saturated soil layers, only
the soil's (saturated) permeability is a relevant parameter. However, when considering unconfined flow,
seepage, transient (time-dependent) flow or fully coupled flow-deformation analysis, partially saturated soil
behaviour becomes an issue and needs to be described in more detail. This requires, amongst other things, the
selection of a so-called soil-water retention curve relating the suction (positive pore water stress) in the
unsaturated zone to the degree of saturation.
PLAXIS 3D incorporates functions to describe the flow behaviour in the unsaturated zone, among which the
famous Mualem-Van Genuchten functions. In order to enable an easy selection of the unsaturated flow
parameters in these functions, predefined data sets are available for common types of soil. These data sets can
be selected based on standardised soil classification systems.
Note:
Although the predefined data sets have been created for the convenience of the user, the users remain at all
times responsible for the model parameters that they use. Note that these predefined data sets have limited
accuracy.

Hydraulic data sets and models
The program provides different data sets and models to model the flow in the saturated zone in soil. The data
sets available in the program are:
Standard: This option allows for a simplified selection of the most common soil types (Coarse, Medium, Medium
fine, Fine and Very fine non-organic materials and Organic material) and is based on the Hypres topsoil
classification series (Wosten, Lilly, Nemmes & Bas, 1999 (on page 510)).
When one of the soil type options is selected, the particle fractions are automatically defined and the soil type is
indicated in the soil texture triangle (Figure 180 (on page 249)). The particle fractions can also be defined by
clicking on the corresponding location in the soil texture triangle or by directly typing the values.
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Figure 180: Groundwater parameters for Standard data set (Wösten, Lilly, Nemmes & Bas, 1999)
Hypres: The Hypres series is an international soil classification system (Wosten, Lilly, Nemmes & Bas, 1999 (on
page 510)). The hydraulic models available for Hypres data set are the Van Genuchten model and the
Approximate Van Genuchten (see Material Models Manual - Chapter 19).
A distinction can be made between Topsoil and Subsoil. In general, soils are considered to be subsoils. The Type
drop-down menu for the Hypres data set includes Coarse, Medium, Medium fine, Fine, Very fine and Organic soils.
Note:
Only soil layers that are located not more than 1 m below the ground surface are considered to be Top soils.
The selected soil type and grading (particle fractions) is indicated in the soil texture triangle. As an alternative,
the user can also select the type of soil by clicking one of the sections in the triangle or by manually specifying
the particle fraction values (Figure 181 (on page 250)).
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Figure 181: Groundwater parameters for Hypres data set (Wösten, Lilly, Nemmes & Bas, 1999)
The predefined parameters for both the Van Genuchten model as well as the Approximate Van Genuchten model
are shown in Table 10 (on page 250) and Table 11 (on page 251).
Table 10: Hypres series with Van Genuchten parameters (Wösten, Lilly, Nemmes & Bas, 1999)
Topsoil:

θr

θs

Ksat (m/day)

ga (1/m)

gl (-)

gn (-)

coarse

0.025

0.403

0.6

3.83

1.25

1.3774

medium

0.01

0.439

0.121

3.14

-2.3421

1.1804

medium fine

0.01

0.43

0.0227

0.83

-0.5884

1.2539

fine

0.01

0.52

0.248

3.67

-1.9772

1.1012

very fine

0.01

0.614

0.15

2.65

2.5

1.1033

coarse

0.025

0.366

0.7

4.3

1.25

1.5206

medium

0.01

0.392

0.108

2.49

-0.7437

1.1689

Subsoil:
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Subsoil:
medium fine

0.01

0.412

0.04

0.82

0.5

1.2179

fine

0.01

0.481

0.085

1.98

-3.7124

1.0861

very fine

0.01

0.538

0.0823

1.68

0.0001

1.073

organic

0.01

0.766

0.08

1.3

0.4

1.2039

Table 11: Hypres series with Approximate Van Genuchten parameters
Topsoil

ψs(m)

ψk (m)

coarse

-2.37

-1.06

medium

-4.66

-0.5

medium fine

-8.98

-1.2

fine

-7.12

-0.5

very fine

-8.31

-0.73

coarse

-1.82

-1

medium

-5.6

-0.5

medium fine

-10.15

-1.73

fine

-11.66

-0.5

very fine

-15.06

-0.5

organic

-7.35

-0.97

Subsoil:

USDA: The USDA series is another international soil classification system (Carsel & Parrish, 1988 (on page
509)). The hydraulic models available for USDA data set are the Van Genuchten model and the Approximate Van
Genuchten (see Material Models Manual).
The Type drop-down menu for the USDA date set includes Sand, Loamy sand, Sandy loam, Loam, Silt, Silt loam,
Sandy clay loam, Clay loam, Silty clay loam, Sandy clay, Silty clay and Clay. The selected soil type and grading
(particle fractions) are different from the Hypres data sets and can be visualised in the soil texture triangle. As an
alternative, the user can also select the type of soil by clicking one of the sections in the triangle or by manually
specifying the particle fraction values (Figure 182 (on page 252)).
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Figure 182: Groundwater parameters for USDA data set (Carsel & Parrish, 1988)
The parameters for the Van Genuchten and the Approximate Van Genuchten models are shown in Table 12 (on
page 252) and Table 13 (on page 253) .
Table 12: USDA series with Van Genuchten parameters, gl = 0.5 (Carsel & Parrish, 1988)
Soil type

θr (-)

θs (-)

Ksat (m/day)

ga (1/m)

gn (-)

sand

0.045

0.43

7.13

14.5

2.68

loamy sand

0.057

0.41

3.5

12.4

2.28

sandy loam

0.065

0.41

1.06

7.5

1.89

loam

0.078

0.43

0.25

3.6

1.56

silt

0.034

0.46

0.6

1.6

1.37

silty loam

0.067

0.45

0.108

2

1.41

sandy clay loam

0.1

0.39

0.314

5.9

1.48

clayey loam

0.095

0.41

0.624

1.9

1.31

silty clayey loam

0.089

0.43

0.168

1

1.23
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Soil type

θr (-)

θs (-)

Ksat (m/day)

ga (1/m)

gn (-)

sandy clay

0.1

0.38

0.288

2.7

1.23

silty clay

0.07

0.36

0.00475

0.5

1.09

clay

0.068

0.38

0.0475

0.8

1.09

Table 13: USDA series with Approximate Van Genuchten parameters
Soil type

ψs (m)

ψk (m)

sand

-1.01

-0.5

loamy sand

-1.04

-0.5

sandy loam

-1.2

-0.5

loam

-1.87

-0.6

silt

-4

-1.22

silty loam

-3.18

-1.02

sandy clay loam

-1.72

-0.5

clayey loam

-4.05

-0.95

silty clayey loam

-8.23

-1.48

sandy clay

-4.14

-0.55

silty clay

-31.95

-0.95

clay

-21.42

-0.6

Note:
In Table 10 (on page 250) to Table 12 (on page 252)the symbols θr and θs stand for the residual and the
saturated water content correspondingly. Based on van Genuchten (1980) (on page 510), the effective degree of
saturation is calculated as Seff = (θ-θr)/(θs- θr), in which θ is the water content.
In PLAXIS 3D, the effective degree of saturation is calculated as Seff = (S- Sr) / (Ss-Sr) (see Conventional and
unsaturated soil behaviour in PLAXIS (on page 519)) , in which S is the degree of saturation, Sr the residual
degree of saturation and Ss the saturated degree of saturation. Considering that S = θ / n and under the
assumption that Ss = θs / n = 1, Sr could be derived from Table 10 (on page 250) to Table 12 (on page 252) as Sr =
θr / θs.
Staring: The Staring series is a soil classification system which is mainly used in The Netherlands (Wosten,
Veerman, DeGroot & Stolte, 2001 (on page 510)). The hydraulic models available for Staring data set are the Van
Genuchten model and the Approximate Van Genuchten (see the Material Models Manual - Chapter 19 ).
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Figure 183: Groundwater parameters for Staring data set (Wösten, Veerman, DeGroot & Stolte, 2001)
A distinction can be made between Topsoil and Subsoil. In general, soils are considered to be subsoils. The Type
drop-down menu for the Staring series (Figure 183 (on page 254)) contains the following subsoils (Wosten,
Veerman, DeGroot & Stolte, 2001 (on page 510)):
Non-loamy sand (O1), Loamy sand (O2), Very loamy sand (O3), Extremely loamy sand (O4), Coarse sand (O5),
Boulder clay (O6), River loam (O7), Sandy loam (O8), Silt loam (O9), Clayey loam (O10), Light clay (O11), Heavy
clay (O12), Very heavy clay (O13), Loam (O14), Heavy loam (O15), Oligotrophic peat (O16), Eutrophic peat (O17)
and Peaty layer (O18), and the following topsoils: Non-loamy sand (B1), Loamy sand (B2), Very loamy sand (B3),
Extremely loamy sand (B4), Coarse sand (B5), Boulder clay (B6), Sandy loam (B7), Silt loam (B8), Clayey loam (B9),
Light clay (B10), Heavy clay (B11), Very heavy clay (B12), Loam (B13), Heavy loam (B14), Peaty sand (B15), Sandy
peat (B16), Peaty clay (B17) and Clayey peat (B18).
The selected soil type and grading (particle fractions) are different from the Hypres and the USDA data sets. The
parameters of the hydraulic model for the selected soil type are displayed in the Soil tab at the right side of the
Flow parameters tabsheet.
Note:
Only soil layers that are located not more than 1 m below the ground surface are considered to be Top soils.
User defined: The User defined option enables the user to define both saturated and unsaturated properties
manually. Please note that this option requires adequate experience with unsaturated groundwater flow
modelling. The hydraulic models available are:
Van Genuchten

PLAXIS

This well-known and widely accepted model requires direct input of the residual
saturation Sres, the saturation at p = 0, Ssat and the three fitting parameters gn, ga and gl
(see Material Models Manual- Chapter 19).

254

PLAXIS 3D-Reference Manual

Material properties and material database
Modelling soil and interface behaviour
Spline

The Spline function requires direct input of the capillary height ψ (in unit of length), the
relative permeability Kr (-), and the degree of saturation Sr (-). Data for the Spline
function can be entered by clicking the Table tab. The degree of saturation at saturated
conditions Ssat equals the value assigned to Sr at ψmax (e.g. -ψ = 0 m) and the residual
degree of saturation Sres equals the minimum value assigned to Sr at ψmin (e.g -ψ = 20 m).
During the calculations, the flow calculation kernel employs 'smooth' relationships
based on a spline function between Kr-ψ and Sr-ψ.

Saturated

When the Saturated option is selected, no extra data input is required. During the
calculations, PLAXIS 3D will continuously use the saturated permeabilities for soil layers
where a Saturated data set was assigned.

Figure 184: Groundwater parameters for User defined data set

Saturated permeabilities (kx, ky and kz)
Coefficients of permeability (hydraulic conductivity) have the dimension of velocity (unit of length per unit of
time). The input of permeability parameters is required for consolidation calculations. In such calculations, it is
necessary to specify the coefficient of permeability for all drained or undrained clusters, including almost
impermeable layers, except for fully impervious layers with a non-porous drainage type. PLAXIS 3D allows for
the anisotropic permeability of soils where the anisotropy directions coincide with the principal axes x, y and z.
Note that the input field for permeabilities are greyed out when the Non-porous option is selected.
One of the advanced features is to account for the change of permeability during a consolidation analysis. This
can be applied by entering a proper value for the change of permeability parameter ck and the void ratio's einit,
emin and emax in the General tabsheet of the Soil window.
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In case of a Standard, Hypres or USDA data set, values for the permeability can be automatically set by either
selecting the From data set option or From grain size distribution.
When a predefined soil data set is chosen or the user specifies the individual particle fractions manually,
assuming the soil has a log-normal function of particle size distribution, then the geometric mean particle
diameter dg and a geometric standard deviation σg can be calculated as:
d g = exp (mcl ln (dcl ) + msi ln (dsi ) + msaln (dsa))
3

3

i=1

i=1

σg = exp ∑ mi ln (di )2 − ( ∑ mi ln (di ))

2 2

Eq. [17]
Eq. [18]

where mcl, msi and msa are particle fractions for clay, silt and sand ; dcl, dsi and dsa are particle size limits
separating clay, silt and sand respectively (i.e. dcl = 2 μm , dsi = 50 μm, dsa = 2 mm)
According to Aukenthaler, Brinkgreve & Haxaire (2016) (on page 508) The Specific surface area (SSA) can be
approximated using the geometric mean particle diameter in mm:
SSA = 3.89d g −0.905
From the above, the hydraulic conductivity of saturated soils (permeabilities) can be obtained from the soil
texture and porosity of the soil using the following relation:
k x = k y = k z = K sat

(

K sat = 4 × 10−5

)

0.5
1.3b
1 − θsat

× exp ( − 6.88mcl − 3.63msi − 0.025)

Eq. [19]

b = d g −0.5 + 0.2g
where
θsat

=

dg
σg

=
=

volumetric water content of saturated soil which is equal to the porosity
of the soil ( n ( n = e / ( 1 + e )) .
the geometric mean particle diameter.
the geometric standard deviation.

The available options from the drop-down menu for Flow parameters are:
None

This is the default option, and the user must provide values for permeabilities.

From data set

The values of kx, kykz are obtained from the selected data set.

From grain size
distribution

The values for kx, kykz are obtained from particle size distribution as explained above.
The value for θsat is calculated internally using the equation, θsat = e / (1+e).

Unsaturated zone (ψunsat)
ψunsat (in unit of length relative to the phreatic level) sets the maximum pressure head until which the MualemVan Genuchten functions are used for calculation of relative permeability and degree of saturation. The negative
sign indicates suction. Above the level of ψunsat, the value of Kr and S remains constant. In this way a minimum
degree of saturation (Smin) is guaranteed (Figure 185 (on page 257)). It is used to limit the relative permeability
Kr and degree of saturation for high unsaturated zones.
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Figure 185: Relative permeability vs. Degree of saturation
By default a very large value is assigned to ψunsat (= 104). This value is only an indication that the unsaturated
zone is by default unlimited.

Volumetric specific storage (Ss)
The specific storage Ss of a saturated aquifer is defined as the volume of water that a unit volume of aquifer
releases from storage under decline in hydraulic head.
For groundwater flow calculations in which there is no deformation, we can assume that:
Ss = γwater ×

( )
n
Kw

Eq. [20]

Change of permeability (ck)
This advanced feature is to account for the change of permeability during a consolidation analysis. This can be
applied by entering a proper value for the ck parameter and the void ratio's. On entering a real value, the
permeability will change according to the formula:
log

( )=
k
k0

Δe
ck

Eq. [21]

where Δe is the change in void ratio, k is the permeability in the calculation and k0 is the input value of the
permeability in the data set (= kx and kz). Note that a proper input of the initial void ratio einit, in the General
tabsheet is required. It is recommended to use a changing permeability only in combination with the Hardening
Soil model, Hardening Soil model with small-strain stiffness, Soft Soil model or the Soft Soil Creep model. In that
case the ck-value is generally in the order of the compression index Cc. For all other models the ck-value should
be left to its default value of 1015.

6.1.6 Interfaces tabsheet
The properties of interface elements are related to the soil model parameters of the surrounding soil. The
required parameters to derive the interface properties are defined in the Interfaces tabsheet of the Soil
window. These parameters depend on the material model selected to represent the behaviour of the
surrounding soil. In case the Linear Elastic model, the Mohr-Coulomb model, the Hardening Soil model, the
Hardening Soil model with small-strain stiffness, the UBC3D-PLM model, the Soft Soil model, the Soft Soil Creep
model, the Joined Rock model or the Hoek-Brown model, the NGI-ADP model or the UDCAM-S model has been
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selected as the Material model, the strength reduction factor Rinter is the main interface parameter (see Figure
186 (on page 258)). In case of the Modified Cam-Clay model, the interface parameters required are the effective
cohesion c'ref, the effective friction angle φ' and the dilatancy angle ψ'. In case of the User-defined Soil Model, the
tangent stiffness for primary oedometer loading Eoedref, the effective cohesion c'ref, the effective friction angle φ',
the dilatancy angle ψ' and the parameters UD-Power and UD-Pref are required as interface parameters. For more
information on the interface parameters required for the User-defined Soil Model (see theMaterial Models
Manual - Chapter 17 - Input of UD model parameters via user-defined.

Figure 186: Interfaces tabsheet of the Soil window

Stiffness
The user may assign two distinct material sets to each interface set and use different interface stiffness values to
define material properties properly.
Kn/Ks: Kn/Ks stiffness option allows inserting Kn and Ks values.
Kn

Elastic interface normal stiffness

kN/m3

Ks

Elastic interface shear stiffness

kN/m3

Standard: By default, stiffness is set to standard. The shear and compression moduli are related by the
expressions:
1 − νi

Eoed ,i = 2Gi 1 − 2ν

i

Gi =

2
Rint
er Gsoil

≤ Gsoil

Eq. [22]

νi = 0.45
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When using user-defined material model, the user inserts the interface stiffness in the form of a power law
formulation with Eoedref along with UD-pref and UD-Power.

Interface strength
In case of the Linear Elastic model, the Mohr-Coulomb model, the Hardening Soil model, the Hardening Soil
model with small-strain stiffness, the UBC3D-PLM model, the Soft Soil model, the Soft Soil Creep model, the
Joined Rock model or the Hoek-Brown model, the interface strength is defined by the parameter Rinter. The
interface strength can be set using the following options:
Rigid: This option is used when the interface should not have a reduced strength with respect to the strength in
the surrounding soil. For example, extended interfaces around corners of structural objects (Figure 108 (on page
149)) are not intended for soil-structure interaction and should not have reduced strength properties. The
strength of these interfaces should be assigned as Rigid (which corresponds to Rinter = 1.0). As a result, the
interface properties, including the dilatancy angle ψi, are the same as the soil properties in the data set, except
for Poisson's ratio νi (see further).
Manual: The value of Rinter can be entered manually if the interface strength is set to Manual. In general, for real
soil-structure interaction the interface is weaker and more flexible than the surrounding soil, which means that
the value of Rinter should be less than 1. Suitable values for Rinter for the case of the interaction between various
types of soil and structures in the soil can be found in the literature. In the absence of detailed information it may
be assumed that Rinter is of the order of 2/3. A value of Rinter greater than 1 would not normally be used.
When the interface is elastic then both slipping (relative movement parallel to the interface) and gapping or
overlapping (i.e. relative displacements perpendicular to the interface) could be expected to occur.
The magnitudes of the interface displacements are:
Elastic gap displacement =

σn
KN

=

Elastic slip displacement =

τ
KS

=

σn ti
Eoed ,i
τti
Gi

Eq. [23]
Eq. [24]

where Gi is the shear modulus of the interface, Eoed,i is the one-dimensional compression modulus of the
interface, ti is the virtual thickness of the interface generated during the creation of interfaces in the geometry
model (Interfaces (on page 146)), KN is the elastic interface normal stiffness and KS is the elastic interface shear
stiffness.
Note:
Note that a reduced value of Rinter not only reduces the interface strength, but also the interface stiffness.
It is clear from these equations that, if the elastic parameters are set to low values, the elastic displacements may
be excessively large. If the values of the elastic parameters are too large, however, this can result in numerical illconditioning of the stiffness matrix. The key factor in the stiffness is the virtual thickness. This value is
automatically chosen such that an adequate stiffness is obtained.
Manual with residual strength: When the limit value of the interface strength as defined by Rinter is reached,
the interface strength may soften down to a reduced value as defined by Rinter,residual. Definition of the Rinter,residual
is possible when the Manual with residual strength option is selected for the interface strength.
Interface strength (Rinter): An elastic-plastic model is used to describe the behaviour of interfaces for the
modelling of soil-structure interaction. The Coulomb criterion is used to distinguish between elastic behaviour,
where small displacements can occur within the interface, and plastic interface behaviour when permanent slip
may occur. For the interface to remain elastic the shear stress τ is given by:
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| τ | < − σn tan (φi ) + ci

Eq. [25]

where σn is the effective normal stress.
For plastic behaviour τ is given by:

| τ | = − σn tan (φi ) + ci

Eq. [26]

where φi and ci are the friction angle and cohesion of the interface. The strength properties of interfaces are
linked to the strength properties of a soil layer. Each data set has an associated strength reduction factor for
interfaces Rinter. The interface properties are calculated from the soil properties in the associated data set and
the strength reduction factor by applying the following rules:
ci = Rintercsoil
tan (φi ) = Rintertan (φsoil ) ≤ tan (φsoil )

ψi = 0 for Rinter < 1, otherwise ψi = ψsoil

Eq. [27]
Eq. [28]

In the Hardening Soil model, the Hardening Soil model with small-strain stiffness and the UBC3D-PLM model,
φsoil is always referred to the failure-peak value of φ chosen as input parameter.
In addition to Mohr-Coulomb's shear stress criterion, the tension cut-off criterion, as described before (see
Parameters tabsheet (on page 200)), also applies to interfaces (if not deactivated):
σn < σt,i = Rinterσt ,soil

Eq. [29]

where σt,soil is the tensile strength of the soil.
Interface strength in undrained condition: When the drainage condition is Undrained (B) or Undrained (C),
the calculation is performed with undrained strength parameters. For the interface to remain elastic the shear
stress τ is given by:

| τ | < su

Eq. [30]

where su is the undrained shear strength.
For plastic behaviour τ is given by:

| τ | = su

Eq. [31]

The interface property is calculated from the soil property in the associated data set and the strength reduction
factor Rinter by applying the following rule:
su,i = Rintersu,soil

Eq. [32]

when su,i is the undrained shear strength of the interface and su,soil is the undrained shear strength of the soil.
The tension cut-off criterion applies as in calculation with effective parameters for strength.
In the NGI-ADP model (and UDCAM-S model), su,soil is equal to suDSS (and τDSS), taking the increase with depth
into account. For more information about the NGI-ADP model, reference is made to the Chapter 13 of the
Material Models Manual.
Residual interface strength (Rinter, residual): When the Manual with residual strength option is selected the
parameter Rinter, residual can be specified. The interface strength will reduce to the residual strength as defined by
(Rinter, residual) and the strength properties of the soil, as soon as the interface strength is reached.
Consider gap closure: When the interface tensile strength is reached a gap may occur between the structure
and the soil. When the load is reversed, the contact between the structure and the soil needs to be restored
before a compressive stress can developed. This is achieved by selecting the Consider gap closure option in the
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Interfaces tabsheet of the Soil window. If the option is NOT selected, contact stresses will immediately develop
upon load reversal, which may not be realistic.
Interfaces using the Hoek & Brown model : When using the Hoek-Brown model as a continuum model to
describe the behaviour of a rock section in which interface elements are used, equivalent interface strength
properties φi, ci and σt,i are derived from this model. The general shear strength criterion for interfaces as well
as the tensile strength criterion are still used in this case:

| τ | ≤ − σn tan (φi ) + ci
σn ≤ σt,i

Eq. [33]

Eq. [34]

Starting point for the calculation of the interface strength properties is the minor principal effective stress σ'3 in
the adjacent continuum element. At this value of confining stress the tangent to the Hoek-Brown contour is
calculated and expressed in terms of φ and c:
sin(φ) =
c=

f̄ ′
2 + f̄ ′

1 − sin(φ )
2cos (φ )

( f̄ +

2σ ′ 3sin (φ )
1 − sin (φ )

Eq. [35]

)

where

(

f̄ = σci mb
f̄ ′ =

(

−σ ′3
σci

+s

−σ ′3
amb mb σ
ci

)

a

+s

)

Eq. [36]

a−1

and a, mb, s and σci are the Hoek-Brown model parameters in the corresponding material data set. The interface
friction angle φ'i and adhesion c'i as well as the interface tensile strength σt,i are now calculated using the
interface strength reduction factor Rinter:
tan (φi ) = Rintertan (φ )
ci = = Rinterc
σt,i = Rinterσt =

sσci
Rinter m
b

Eq. [37]

For more information about the Hoek-Brown model and an explanation of its parameters, reference is made to
Chapter 4 of the Material Models Manual.
Interfaces using the Modified Cam-Clay model If the Modified Cam-Clay model is selected in the Parameters
tabsheet to describe the behaviour of the surrounding soil, the following parameters are required to model the
interface behaviour:
[kN/m2]

cref

Cohesion of the interface

φi

Internal friction angle of the interface

[°]

ψi

Dilatancy angle of the interface

[°]

When the interface is elastic then both slipping (relative movement parallel to the interface) and gapping or
overlapping (i.e. relative displacements perpendicular to the interface) could be expected to occur.
The magnitudes of these displacements are:
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Elastic gap displacement =

σn
KN

=

Elastic slip displacement =

τ
KS

=

σn ti
Eoed ,i
τti
Gi

Eq. [38]
Eq. [39]

where Gi is the shear modulus of the interface, Eoed,i is the one-dimensional compression modulus of the
interface and ti is the virtual thickness of the interface, generated during the creation of interfaces in the
geometry model (Interfaces (on page 146)). KN is the elastic interface normal stiffness and KS is the elastic
interface shear stiffness. The shear and compression moduli are related by the expressions:
Eoed ,i =
Gi =

σn
3 (1 − νi )
λ (1 + νi ) (1 + e0)

3(1 − 2νi )
σn
2(1 + νi ) λ (1 + e0)

Eq. [40]

νi = 0.45

Real interface thickness (δinter )
The real interface thickness δinter is a parameter that represents the real thickness of a shear zone between a
structure and the soil. The value of δinter is only of importance when interfaces are used in combination with the
Hardening Soil model. The real interface thickness is expressed in the unit of length and is generally of the order
of a few times the average grain size. This parameter is used to calculate the change in void ratio in interfaces for
the dilatancy cut-off option. The dilatancy cut-off in interfaces can be of importance, for example, to calculate the
correct bearing capacity of tension piles.

Groundwater
In situations involving groundwater flow, consolidation or fully coupled flow-deformation analysis, interface
elements can contribute to the flow of groundwater and thereby influence the pore pressure distribution.
Therefore, interface permeabilities are relevant in such situations. It is also important for the modelling of flow
through a system of joints or faults in low permeable rocks when analysing groundwater flow, pore pressures
and seepage for applications in rock.
Flow in interface elements may involve flow across the element as well as flow in the interface longitudinal
direction. Therefore, distinction is made in Cross permeability, defined by means of the Hydraulic resistance, and
Parallel permeability, defined by means of the Drainage conductivity.
The cross permeability can be set using the following options:
Impermeable: This is the default option. This option sets the interface to have a zero cross permeability
(infinite cross resistance), provided the interface is active in flow as defined by the interface settings in the
model explorer. Note that there is no output of groundwater flow qn available.
Semi-permeable: In this case the interface has a specific non-zero hydraulic resistance, expressed in the unit of
time (hydraulic delay), provided the interface is active in flow as defined by the interface settings in the model
explorer. The output program will show the amount of groundwater flow qn crossing the interface.
Fully permeable: In this case the interface has an infinite cross permeability (zero cross resistance),
irrespective whether it is active in flow as defined by the interface settings in the model explorer. Note that there
is no output of groundwater flow available when choosing this option.
Hydraulic resistance and Drainage conductivity: The hydraulic conductivity or resistance of interfaces is not
only defined by permeability, but also by the 'thickness' of the structure or the soil-structure interaction zone.
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However, this 'thickness' is not always a well-defined quantity. Therefore, the hydraulic properties of interfaces
are defined by two quantities that have a well-defined meaning:
• Hydraulic resistance: to define the hydraulic conductivity across the interface or structure
• Drainage conductivity: to define the hydraulic conductivity in the interface longitudinal direction

Figure 187: Hydraulic and drainage conductivity
Hydraulic resistance: The hydraulic resistance defines the permeability across the interface (perpendicular to
the interface longitudinal direction).
Considering a semi-permeable wall with a thickness d and permeability k, the hydraulic resistance is defined by
d/k, expressed in the unit of time. Considering Darcy's law, q = k Δφ/dl, where k is the cross permeability and
Δφ/Δ l is the gradient of the groundwater head across the wall, which is the difference between the groundwater
head left and right of the wall over the wall thickness (Δφ / d). Hence, for a given hydraulic resistance d/k, the
specific discharge q = k Δφ /d = Δφ /(d/k). To determine d/k, one needs to measure the average discharge q
through a wall (per unit of area) for a given head difference Δφ, so d/k = Δφ/q.
Note that, for the hydraulic resistance, the actual thickness d, and the permeability, k, do not really matter. The
hydraulic resistance represents, practically, the ratio of the thickness of the wall for the cross permeability.
Drainage conductivity: The drainage conductivity defines the permeability in the interface longitudinal
direction parallel to the local axes (drainage capacity), provided the interface is active in flow as defined by the
interface settings in the model explorer. The drainage conductivity is expressed in the unit of volume (water
volume that is transported in the interface longitudinal direction) per unit of time per unit of width in the out-ofplane direction. The default value is zero, which means that there is no drainage capacity in the interface.
Considering a semi-permeable gap with a thickness d and permeability k between two impermeable media, the
drainage conductivity is defined by the product of d and k (dk), expressed in the unit of volume per unit of time
per unit of width in the out-of-plane direction. This quantity defines the total amount of water that is
transported through the gap (drain) per unit of time per unit width. Considering Darcy's law, as listed above, the
gradient is now defined by the difference in groundwater head over the length of the gap (in longitudinal
direction) divided by the gap length, such that q = k Δφ / L. The total amount of water Q is q times the thickness d
times the unit width b, where b = 1 length unit for a plane strain application, so Q/b = dk Δφ / L. In order to
determine dk, one needs to measure the total discharge Q/b through the gap (per unit of width in the out-ofplane direction) for a given head difference Δφ and a given length of the gap L, such that dk = (Q/b) (L/Δφ).
Note that, for the drainage conductivity, the actual thickness, d, and permeability, k, do not really matter. The
drainage conductivity represents, practically, the product of the thickness of the wall and the cross permeability.
Practical remarks: The interface elements are generally at both sides of a wall: for example, in the case of an
excavation where the wall is to some extent permeable. In such a case it is suggested to assign the appropriate
interface permeability to the 'outside' (soil side) of the wall, whereas the interface at the 'inside' (side that is
excavated) is made fully permeable, even along the embedded part of the wall below the excavation. Similarly
for a semi-permeable tunnel lining: the appropriate interface permeability should be given to the interface at the
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outside of the tunnel lining, whereas the interface at the inside (which will be excavated) should be fully
permeable. Hence, this requires an additional material data set to be defined which should be assigned directly
to the interface.

Interfaces below or around corners of structures
When interfaces are extended below or around corners of structures to avoid stress oscillations (Interfaces (on
page 146)), these extended interfaces are not meant to model soil-structure interaction behaviour, but just to
allow for sufficient flexibility. Hence, when using Rinter< 1 for these interface elements an unrealistic strength
reduction is introduced in the ground, which may lead to unrealistic soil behaviour or even failure. Therefore it
is advised to create a separate data set with Rinter = 1 and to assign this data set only to these particular interface
elements. This can be done by right-clicking the interface in the drawing area and selecting the corresponding
soil data set from the Set material options in the right mouse button menu.

6.1.7 Initial tabsheet
The Initial tabsheet contains parameters to generate the initial stresses (K0 procedure) (Figure 188 (on page
264)).

Figure 188: Soil window (Initial tabsheet of the Mohr-Coulomb model)
The K0-values can be defined automatically by selecting the option Automatic in the K0 determination drop-down
menu or manually by selecting the option Manual.

K0-values
In general, two K0-values can be specified, one for the x-direction and one for the y-direction:
K 0,x = σ ′
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The checkbox can be used to set the K0,y value equal to the K0,x value.
The default K0-values are then in principle based on Jaky's formula:
K 0 = 1 − sin (φ )

Eq. [42]

For advanced models (Hardening Soil model, Hardening Soil model with small-strain stiffness, Soft Soil model,
Soft Soil Creep model, Modified Cam-Clay model) the default value is based on the K0nc model parameter and is
also influenced by the OCR-value and POP-value in the following way:

K 0,x = K 0, y = K 0nc OCR −

νur
1 − νur

(OCR − 1) +

K 0nc POP −

νur
POP
1 − νur

| σ ′ 0zz |

Eq. [43]

The POP-value will result in a stress-dependent K0 value within the layers and thus the K0-values are hidden
when automatic K0 determination is chosen (e.g. Figure 189 (on page 265)).

Figure 189: Soil window (Initial tabsheet of the Hardening Soil model
Be careful with very low or very high K0-values, since these values might bring the initial stress in a state of
failure. For a cohesionless material it can easily be shown that to avoid failure, the value of K0 is bounded by:
1 − sin (φ )
1 + sin (φ )

< K0 <

1 + sin (φ )
1 − sin (φ )

Eq. [44]

OCR and POP
When using advanced models (Hardening Soil model, Hardening Soil model with small-strain stiffness, Soft Soil
model, Soft Soil Creep model, Modified Cam-Clay model) an initial preconsolidation stress has to be determined.
In the engineering practice it is common to use a vertical preconsolidation stress, σp, but PLAXIS 3D needs an
equivalent isotropic preconsolidation stress, ppeq to determine the initial position of a cap-type yield surface. If a
material is overconsolidated, information is required about the Over-Consolidation Ratio (OCR), i.e. the ratio of
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the greatest effective vertical stress previously reached, σp (see Figure 190 (on page 266)), and the in-situ
effective vertical stress, σ'zz0.
OCR =

σp
σ ′

Eq. [45]

0
zz

Using OCR

Using POP

Figure 190: Illustration of vertical preconsolidation stress in relation to the in-situ vertical effective stress
It is also possible to specify the initial stress state using the Pre-Overburden Pressure (POP) as an alternative to
prescribing the over-consolidation ratio. The Pre-Overburden Pressure is defined by:
POP =

| σ p − σ ′ 0zz |

Eq. [46]

These two ways of specifying the vertical preconsolidation stress are illustrated in Figure 190 (on page 266).
The preconsolidation stress σp is used to compute the equivalent preconsolidation pressure ppeq which
determines the initial position of a cap-type yield surface in the advanced soil models. The calculation of ppeq is
based on the principal stress history (σ'1,max, σ'2, σ'3). The actual determination of ppeq depends on the
constitutive model being used.
The principal stress history is initialised in the Initial phase (K0-procedure or Gravity loading) based on the
Cartesian effective stress components and the pre-overburden pressure (POP) or over-consolidation ratio (OCR)
defined in the boreholes or data set. From this, Cartesian preconsolidation stress levels are calculated based on
the following equations:
σ′

xx,c

= K 0nc OCRσ ′

σ′

yy,c

= OCRσ ′

yy

K 0nc OCRσ

σ′

zz,c

=

σ′

xy,c

=σ′

yy

′

Eq. [47]
yy

xy

nc is the K

nc
where K0
0-value associated with normally consolidated states of stress. K0 is a model parameter in
nc
advanced constitutive models and estimated in simple models (K0 = 1-sinφ). Models that do not have φ as input
parameter use K0nc=0.5 (φ=30°).

The Cartesian stress components (σ'xx,c, σ'yy,c, σ'zz,c, σ'xy,c) are transformed to principal stress components
(σ'1,max, σ'2, σ'3) and the maximum major principal stress, σ'1,max, is kept as a general state parameter which is
available for succeeding phases. In subsequent phases, σ'1,max is updated if the major principal stress is larger
than the current one.
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If, in later calculation phases, the soil behaviour is changed to an(other) advanced material model, the equivalent
preconsolidation pressure ppeq is initialised according to the current (updated) principal stress history (σ'1,max,
σ'2, σ'3).
Table 14: K0 behaviour
Material Model

K0

Linear Elastic model

0.5

Mohr-Coulomb model

1- sin φ

Hardening Soil model

Hardening Soil model with small-strain stiffness

UBC3D-PLM model

K 0nc OCR −

νur
1 − νur

(OCR − 1)

K 0nc OCR −

νur
1 − νur

(OCR − 1)

1- sin φp

Soft Soil model

Soft Soil Creep model

K 0nc OCR −

νur
1 − νur

(OCR − 1)

K 0nc OCR −

νur
1 − νur

(OCR − 1)

Joined Rock model

0.5

Modified Cam-Clay model

K 0nc OCR −

νur
1 − νur

(OCR − 1)

NGI-ADP model

Calculated by the kernel

UDCAM-S model

Calculated by the kernel

Hoek-Brown model

0.5

Sekiguchi-Ohta model (Inviscid)

Sekiguchi-Ohta model (Viscid)

Concrete model

νur
1 − νur

(OCR − 1)

K 0nc OCR −

νur
1 − νur

(OCR − 1)

1- sin φmax

User-defined Soil Model
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6.2 Modelling undrained behaviour
In undrained conditions, no water movement takes place. As a result, excess pore pressures are built up.
Undrained analysis is appropriate when:
• Permeability is low or rate of loading is high.
• Short term behaviour has to be assessed.
Different modelling schemes are possible in PLAXIS 3D to model undrained soil response in a Plastic calculation,
a Safety analysis or a Dynamic analysis. The modelling scheme depends on the selection of the Drainage type
parameter (General tabsheet (on page 192)). More details about these methods are in the Material Models
Manual - Chapter 2.
Note:
The Drainage type setting is only considered in a Plastic calculation, a Safety analysis or a Dynamic analysis.
When a Consolidation analysis, a Fully coupled flow-deformation analysis or a Dynamic with consolidation analysis
is performed, the Drainage type is ignored and the soil response is determined by the saturated permeability of
the material that is specified in the Flow parameters tabsheet of the material datase.
Note:
The modelling of undrained soil behaviour is even more complicated than the modelling of drained behaviour.
Therefore, the user is advised to take the utmost care with the modelling of undrained soil behaviour.
Before considering the consequences of a particular selection of the drainage type parameter for undrained soil
behaviour, first a general description is given of the various modelling possibilities:
1. Undrained effective stress analysis with effective stiffness parameters
A change in total mean stress in an undrained material during a Plastic calculation phase gives rise to excess
pore pressures. PLAXIS 3D differentiates between steady-state pore pressures and excess pore pressures, the
latter generated due to small volumetric strain occurring during plastic calculations and assuming a low (but
non-zero) compressibility of the pore water. This enables the determination of effective stresses during
undrained plastic calculations and allows undrained calculations to be performed with effective stiffness
parameters. This option to model undrained material behaviour based on effective stiffness parameters is
available for all material models in the PLAXIS 3D. The undrained calculations can be executed with effective
stiffness parameters, with explicit distinction between effective stresses and (excess) pore pressures.
2. Undrained effective stress analysis with effective strength parameters
Undrained effective stress analysis can be used in combination with effective strength parameters φ' and c' to
model the material's undrained shear strength. In this case, the development of the pore pressure plays a
crucial role in providing the right effective stress path that leads to failure at a realistic value of undrained
shear strength (cu or su). However, note that most soil models are not capable of providing the right effective
stress path in undrained loading. As a result, they will produce the wrong undrained shear strength if the
material strength has been specified on the basis of effective strength parameters. Another problem is that
for undrained materials effective strength parameters are usually not available from soil investigation data.
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The advantage of using effective strength parameters in undrained loading conditions is that after
consolidation a qualitatively increased shear strength is obtained, although this increased shear strength
could also be quantitatively wrong, for the same reason as explained before.
3. Undrained effective stress analysis with undrained strength parameters
Especially for soft soils, effective strength parameters are not always available, and one has to deal with
measured undrained shear strength (cu or su) as obtained from undrained tests. Undrained shear strength,
however, cannot easily be used to determine the effective strength parameters φ' and c'. Moreover, even if
one would have proper effective strength parameters, care has to be taken as to whether these effective
strength parameters will provide the correct undrained shear strength in the analysis. This is because the
effective stress path that is followed in an undrained analysis may not be the same as in reality, due to the
limitations of the applied soil model.
In order to enable a direct control on the shear strength, PLAXIS 3D allows for an undrained effective stress
analysis with direct input of the undrained shear strength (Undrained (B)).

6.2.1 Undrained (A)
The Drainage type Undrained (A) enables modelling undrained behaviour using effective parameters for stiffness
and strength. The characteristic features of method Undrained (A) are:
• The undrained calculation is performed as an effective stress analysis. Effective stiffness and effective
strength parameters are used.
• Pore pressures are generated, but may be inaccurate, depending on the selected model and parameters.
• Undrained shear strength su is not an input parameter but an outcome of the constitutive model. The
resulting mobilised shear strength must be checked against known data.
• Consolidation analysis can be performed after the undrained calculation, which affect the shear strength.
Undrained (A) drainage type is available for the following models: Linear Elastic model, Mohr-Coulomb model,
Hardening Soil model, Hardening Soil model with small-strain stiffness, UBC3D-PLM model, Soft Soil model, Soft
Soil Creep model, Modified Cam-Clay model and UDSM.

6.2.2 Undrained (B)
The Drainage type Undrained (B) enables modelling undrained behaviour using effective parameters for stiffness
and undrained strength parameters. The characteristic features of method Undrained (B) are:
•
•
•
•
•

The undrained calculation is performed as an effective stress analysis.
Effective stiffness parameters and undrained strength parameters are used.
Pore pressures are generated, but may be highly inaccurate.
Undrained shear strength su is an input parameter.
Consolidation analysis should not be performed after the undrained calculation. If consolidation analysis is
performed anyway, su must be updated.

Undrained (B) drainage type is available for the following models: Mohr-Coulomb model, Hardening Soil model,
Hardening Soil model with small-strain stiffness, and UDCAM-S model. Note that when using Undrained (B) in
the Hardening Soil model or Hardening Soil model with small-strain stiffness, the stiffness moduli in the model
are no longer stress-dependent and the model exhibits no compression hardening.
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6.2.3 Undrained (C)
The Drainage type Undrained (C) enables simulation of undrained behaviour using a total stress analysis with
undrained parameters. In that case, stiffness is modelled using an undrained Young's modulus Eu and an
undrained Poisson ratio νu, and strength is modelled using an undrained shear strength cu (su) and φ = φu = 0°.
Typically, for the undrained Poisson ratio a value close to 0.5 is selected (between 0.495 and 0.499). A value of
exactly 0.5 is not possible, since this would lead to singularity of the stiffness matrix. The disadvantage of this
approach is that no distinction is made between effective stresses and pore pressures. Hence, all output
referring to effective stresses should now be interpreted as total stresses and all pore pressures are equal to
zero. Note that a direct input of undrained shear strength does not automatically give the increase of shear
strength with consolidation. The characteristic features of method Undrained (C) are:
•
•
•
•
•

The undrained calculation is performed as a total stress analysis.
Undrained stiffness parameters and undrained strength parameters are used.
Pore pressures are not generated.
Undrained shear strength su is an input parameter.
Consolidation analysis should not be performed after the undrained calculation. If consolidation analysis is
performed anyway, su must be updated.

Undrained (C) drainage type is available for the following models: Linear Elastic model, Mohr-Coulomb model,
NGI-ADP model and UDCAM-S model.
Note:
For Undrained (B) and Undrained (C) an increased shear strength with depth can be modelled using the
advanced parameter su,inc.

6.2.4 Undrained behaviour for unsaturated soil
As aforementioned, the build-up of pore pressures plays a crucial role in undrained analyses, especially
Undrained A and Undrained B. Excess pore pressures are generated assuming very low compressibility of pore
fluids. This is only valid for fully saturated soils where voids are filled by water. In unsaturated soils, the porous
space is filled by both water and air. It is thus expected that the compressibility of pore fluid is much higher
compared to saturated soils, and thereby a lower excess pore pressure.
On physical grounds, water in unsaturated soils co-exists with air under the form of water meniscus due to the
capillary effect (surface tension). The excess pore pressure is governed by three factors: the compressibility of
water, compressibility of air and surface tension (suction) effect. The latter is related to the Soil-Water retention
curve (defined in Groundwater tabsheet (on page 248)).
In PLAXIS, we assume that the air pressure is always constant, namely excess air pressure and air
compressibility are not considered (see Appendix Definition of stresses and related quantities (on page 519) ).
With this in mind, the undrained analysis only means that the water phase is undrained, while air phase is
always drained. Excess pore pressure in undrained behaviour for an unsaturated zone is generated following
two cases:
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• If Ignore suction (on page 520) is not chosen , the suction effect is considered. Excess pore pressure is
governed by an ''unsaturated bulk modulus of pore fluid'' which takes into account both the compressibility
of water and Soil-Water retention curve (see Table 22 (on page 527)). This fluid bulk modulus usually is
much smaller than the water bulk modulus of water.
• If Ignore suction is chosen, the suction effect is neglected, and soil behaves like a saturated soil. Excess pore
pressure is only governed by the compressibility of water in a similar way as saturated soil and is generally
much higher than the case of considering suction. This might probably result in a stiffer undrained volume
change behaviour, but a lower shear strength due to a higher pore pressure build-up. This is certainly
dependent on the constitutive model used.
Note:
The behaviour of unsaturated soil is more realistic but also more complicated than saturated soil. The user is
advised to take the utmost care with the modelling as well as Soil-Water retention curve input parameters.

6.3 Simulation of soil lab tests
The SoilTest option is a quick and convenient procedure to simulate basic soil lab tests on the basis of a single
point algorithm, i.e. without the need to create a complete finite element model. This option can be used to
compare the behaviour as defined by the soil model and the parameters of a soil data set with the results of
laboratory test data obtained from a site investigation. It also offers the possibility to optimise model parameters
such that a best fit is obtained between the model results and the lab test data. The SoilTest facility works for any
soil model, both standard soil models as well as user-defined models.
The SoilTest option is available from the Material sets window if a soil data set is selected (see Figure 191 (on
page 272)). Alternatively, the SoilTest option can be reached from the Soil dialog.
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Figure 191: Material sets window showing the project and the global database
Once the SoilTest option has been selected, a separate window will open (Figure 192 (on page 273)). This
window contains a menu, a toolbar and several smaller sections. The various items are described in more detail
below.
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Menu bar

Toolbar

Test

Plot area

Material

Figure 192: SoilTest window showing drained triaxial test input
1. Main menu
The menus available in the menu bar are:
File

To open, save and close a soil test data file (*.vlt).

Test

To select the test that will be simulated. The options available are Triaxial,
CycTriaxial, Oedometer, CRS, DSS, PMT,CDSS, and General.

Results

To select the configuration of diagrams to display.

Kernel

Kernel used for calculation (3D always for PLAXIS 3D and 2D for PLAXIS 2D).

2. Toolbar
The toolbar allows for loading, saving and running of soil test results and opening the PLAXIS SoilTest Settings window to set the configuration of the results. It also contains the parameter optimisation feature
(Parameter optimisation (on page 284)). The soil test calculation kernel is a reduced version of the finite
element kernel. They, however, share the same constitutive model implementations, i.e. the same stress
calculations.
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3. Material properties
The Material properties box displays the name, material model and parameters of the currently selected
data set. Transferring of material parameters to and from the material database is possible. To copy the
modified parameters to the material database:
•

Click the Copy material button in the Material properties box.
• In the program open the Material sets window and either select the corresponding material set or click
New.
•
In the Soil window click Paste material button. The parameters will be copied in the material
database. In the same way it is also possible to copy material from material database to soil test.

4. Test area
The type of test and the testing conditions are defined in the test area. The test options available are Triaxial,
CycTriaxial, Oedometer, CRS, DSS, CDSS, PMT and General. As one of these options is selected by clicking the
corresponding tab, the testing conditions can be defined in the tabsheet. A more detailed description of the
tests is given in the following sections.
5. Run
The Run button starts the currently selected test.
6. Test configurations
The Test configurations button can be used to add and manage different soil test configurations. A test
configuration contains information about the test type and the values of test input parameters. To save a test
configuration select the Save option in the menu displayed as the Test configuration button is clicked. The
Manage option can be used to manage the test configurations available. When the Manage option is selected,
the Manage configuration window pops up. Note that the name of the window indicates the test to which
the configuration belongs (Figure 193 (on page 274)).

Figure 193: Manage configurations window for triaxial tests
The name and the location of the configuration file is indicated in the Filename and Path respectively in the
Manage configurations window.
7. Set as default
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The Set as default button saves the current input parameters as the default parameters. These will be
initialised as such the next time the SoilTest window is opened.
8. Loaded tests
When previously saved tests of the current type have been opened from the File menu, the Loaded tests
window lists all these tests within each tabsheet. The results of all loaded tests are shown together with the
results of the current test. The Delete button can be used to remove the selected test from the list of loaded
tests. It does not remove the soil test file (*.vlt) from disk.
9. Results
The results of the test are displayed in the predefined diagrams in the results area.

6.3.1 Triaxial test
The Triaxial tabsheet contains facilities to define different types of triaxial tests. Before specifying the test
conditions, a selection can be made between different triaxial tests options.

Triaxial test - Options
Drained / undrained In the latter case, undrained soil conditions and zero drainage are assumed (similar as
triaxial test
when the Drainage type has been set to Undrained (A) or Undrained (B), see Modelling
undrained behaviour (on page 268)), irrespective of the drainage type setting in the
material data set.
Triaxial
compression /
triaxial extension
test

In the former case the axial load is increased; in the latter case the axial load is
decreased.

Isotropically
consolidated / K0consolidated test

In the latter case the K0-value (ratio of lateral stress over axial stress) can be specified to
set the initial stress state.

Triaxial test - Conditions
The following test conditions can be defined:
Initial effective
stress
|σ'xx|
Maximum strain

The absolute value of the isotropic cell pressure at which the sample is consolidated,
entered in units of stress. This sets the initial stress state. In the case of a K0consolidated test, this value represents the initial lateral stress, σxx'; the initial vertical
stress, σyy', is defined as σxx' / K0
The absolute value of the axial strain that will be reached in the last calculation step.

|εyy|
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Duration

Time increment (only relevant for time-dependent models; consolidation is not
considered).

Number of steps

The number of steps that will be used in the calculation.

|vertical precons.
stress|

The vertical preconsolidation pressure to which the soil has been subjected. If the soil is
normally consolidated this value should be set equal to the initial stress state, i.e. zero.
From the vertical preconsolidation stress the program calculates the isotropic
preconsolidation stress based on the K0nc loading path (see the Material Models Manual Chapter 2- The initial preconsolidation stress in advanced models). This option is only
available for the advanced soil models.

Mobilized relative
shear strength

The option to activate the mobilized relative shear strength is only available for the
Hardening Soil model and Hardening Soil model with small-strain stiffness to set the
initial shear hardening contour. This option can be deactivated (isotropic stress state) or
deactivated (failure state).

Note:
During a laboratory consolidated undrained triaxial test (CU test) a backpressure is applied to make sure that
the sample is fully saturated. Then the sample is consolidated by using a constant cell pressure and back
pressure. Note that the value assigned to the Initial effective stress in the SoilTest should be the effective stress at
the start of the test, which is equal to the cell pressure minus the back pressure at the start of the test.

6.3.2 Cyclic triaxial test
The CycTriaxial tabsheet contains facilities to define different types of cyclic triaxial tests. Before specifying the
test conditions, a selection can be made between different cyclic triaxial tests options.

Cyclic triaxial test - Options
Drained / undrained In the latter case, undrained soil conditions and zero drainage are assumed (similar as
triaxial test
when the Drainage type has been set to Undrained (A) or Undrained (B), see Modelling
undrained behaviour (on page 268)), irrespective of the drainage type setting in the
material data set.
Isotropically
consolidated / K0consolidated test

In the latter case the K0-value (ratio of lateral stress over axial stress) can be specified to
set the initial stress state.

Cyclic triaxial test - Conditions
The following test conditions can be defined:
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|Vertical precons.
stress|

The vertical preconsolidation pressure to which the soil has been subjected. If the soil is
normally consolidated this value should be set equal to the initial stress state, i.e. zero.
From the vertical preconsolidation stress the program calculates the isotropic
preconsolidation stress based on the K0nc loading path (see the Material Models Manual Chapter 2- The initial preconsolidation stress in advanced models). This option is only
available for the advanced soil models.

Mobilized relative
shear strength

This option is only available for the Hardening Soil model and Hardening Soil model
with small-strain stiffness to set the initial shear hardening contour. This value must be
between 0 (isotropic stress state) and 1 (failure state).

Initial effective
stress

The absolute value of the isotropic cell pressure at which the sample is consolidated,
entered in units of stress. This sets the initial stress state. In the case of a K0consolidated test, this value represents the initial lateral stress, σxx'; the initial vertical
stress, σyy', is defined as σxx' / K0

|σ'xx|
Initial axial stress
increment
Δσ'yy

After applying the initial cell pressure, it is possible to use an axial stress increment
(negative for compression or positive for extension) before performing the cycles
(Figure 194 (on page 278)). This is applied in one calculation phase.

Duration

Time increment (only relevant for time-dependent models; consolidation is not
considered).

Number of cycles

This defines the number of load cycles for the test. Each cycle gives a total of 3
calculation phases (applying +1 × amplitude, -2 × amplitude, +1 × amplitude).

Number of steps per This defines the number of steps per quarter cycle. The total number of steps applied in
quarter cycle
the whole calculation process is: (1 + 4 × number of cycles) × number of steps per
quarter cycle.
Test control

This option allows the user to define whether the test is stress-controlled or straincontrolled. In the case of strain-control (which is the default), the user needs to specify a
strain amplitude, whereas in the case of stress- control, the input of a stress amplitude is
required.

Axial strain Δεyy /
Axial stress Δσyy
amplitude

The user needs to specify a value for the axial strain or axial stress amplitude (Figure
194 (on page 278)), depending on the test control.

Note:
• During a consolidated undrained triaxial test (CU test) in a laboratory, a backpressure is applied to make sure
that the sample is fully saturated. Then the sample is consolidated by using a constant cell pressure and back
pressure. Note that the value assigned to the Initial effective stress in the SoilTest should be the effective
stress at the start of the test, which is equal to the cell pressure minus the back pressure at the start of the
test.
• Unlike the triaxial test, the option for the load direction (compression or extension) is not available since the
stress/strain increment is applied in both directions.
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σ'xy

Cycle

axial stress
amplitude ∆σxy

initial axial stress
increment ∆σ'xy

t
duration per cycle

Figure 194: Cyclic triaxial test conditions

6.3.3 Oedometer test
The Oedometer tabsheet contains facilities to define a one-dimensional compression (oedometer) test. The
following settings can be defined:
|Vertical precons.
stress|

The vertical preconsolidation pressure to which the soil has been subjected. If the soil is
normally consolidated this value should be set equal to the initial stress state, i.e. zero.
From the vertical preconsolidation stress the program calculates the isotropic
preconsolidation stress based on the K0nc loading path (see the Material Models Manual Chapter 2- The initial preconsolidation stress in advanced models). This option is only
available for the advanced soil models.

Mobilized relative
shear strength

This option is only available for the Hardening Soil model and Hardening Soil model
with small-strain stiffness to set the initial shear hardening contour. This value must be
between 0 (isotropic stress state) and 1 (failure state).

Phases

Lists the different phases of the oedometer test. Each phase is defined by a Duration (in
units of time), a vertical Stress increment (in units of stress) and a Number of steps. The
initial state is always assumed to be stress free. The given stress increment will be
reached at the end of the given duration in the given number of steps. The input values
can be changed by clicking in the table. A negative stress increment implies additional
compression, whereas a positive stress increment implies unloading or tension. If a
period of constant load is desired, enter the desired duration with a zero stress
increment.

Add

Adds a new phase to the end of the Phases list.

Insert

Inserts a new phase before the currently selected phase.

Remove

Removes the currently selected phase from the Phases list.
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6.3.4 CRS
The CRS tabsheet contains facilities to define a constant rate-of-strain compression test. The following settings
can be defined:
|Vertical precons.
stress|

The vertical preconsolidation pressure to which the soil has been subjected. If the soil is
normally consolidated this value should be set equal to the initial stress state, i.e. zero.
From the vertical preconsolidation stress the program calculates the isotropic
preconsolidation stress based on the K0nc loading path (see the Material Models Manual Chapter 2- The initial preconsolidation stress in advanced models). This option is only
available for the advanced soil models.

Mobilized relative
shear strength

This option is only available for the Hardening Soil model and Hardening Soil model
with small-strain stiffness to set the initial shear hardening contour. This value must be
between 0 (isotropic stress state) and 1 (failure state).

Phases

Lists the different phases of the CRS test. Each phase is defined by a Duration (in units of
time), a vertical Strain increment (in %) and a Number of steps. The initial state is always
assumed to be stress free. The given strain increment will be reached at the end of the
given duration in the given number of steps. The input values can be changed by clicking
in the table. A negative strain increment implies additional compression, whereas a
positive strain increment implies unloading or tension. If a period of zero strain is
desired, enter the desired duration with a zero strain increment.

Add

Adds a new phase to the end of the Phases list.

Insert

Inserts a new phase before the currently selected phase.

Remove

Removes the currently selected phase from the Phases list.

6.3.5 DSS
The DSS tabsheet contains facilities to define a direct simple-shear test. Before specifying the test conditions, a
selection can be made between different test options.

DSS - Options
Drained / undrained In the latter case, undrained soil conditions and zero drainage are assumed (similar as
triaxial test
when the Drainage type has been set to Undrained (A) or Undrained (B), see Modelling
undrained behaviour (on page 268)), irrespective of the drainage type setting in the
material data set.
Isotropically
consolidated / K0consolidated test
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DSS - Conditions
The following settings can be defined:
|Vertical precons.
stress|

The vertical preconsolidation pressure to which the soil has been subjected. If the soil is
normally consolidated this value should be set equal to the initial stress state, i.e. zero.
From the vertical preconsolidation stress the program calculates the isotropic
preconsolidation stress based on the K0nc loading path (see the Material Models Manual Chapter 2- The initial preconsolidation stress in advanced models). This option is only
available for the advanced soil models.

Mobilized relative
shear strength

This option is only available for the Hardening Soil model and Hardening Soil model
with small-strain stiffness to set the initial shear hardening contour. This value must be
between 0 (isotropic stress state) and 1 (failure state).

Initial stress |σyy|

The absolute value of the initial vertical stress at which the sample is consolidated,
entered in units of stress. In the case of an isotropically consolidated test, the initial
lateral stress is equal to the initial vertical stress. In the case of a K0-consolidated test,
the initial lateral stress is equal to K0σyy.

Duration

Time increment (only relevant for time-dependent models; consolidation is not
considered).

Number of steps

The number of steps that will be used in the calculation.

Maximum shear
strain |γxy|

The maximum value of shear strain (entered in reached in the last calculation step.

6.3.6 CDSS
The CDSS tabsheet contains facilities to define a cyclic direct simple-shear test. Before specifying the test
conditions, a selection can be made between different test options.

CDSS - Options
Drained / undrained In the latter case, undrained soil conditions and zero drainage are assumed (similar as
triaxial test
when the Drainage type has been set to Undrained (A) or Undrained (B), see Modelling
undrained behaviour (on page 268)), irrespective of the drainage type setting in the
material data set.
Isotropically
consolidated / K0consolidated test

In the latter case the K0-value (ratio of lateral stress over axial stress) can be specified to
set the initial stress state.

CDSS - Conditions
The following settings can be defined:
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|Vertical precons.
stress|

The vertical preconsolidation pressure to which the soil has been subjected. If the soil is
normally consolidated this value should be set equal to the initial stress state, i.e. zero.
From the vertical preconsolidation stress the program calculates the isotropic
preconsolidation stress based on the K0nc loading path (see the Material Models Manual Chapter 2- The initial preconsolidation stress in advanced models). This option is only
available for the advanced soil models.

Mobilized relative
shear strength

This option is only available for the Hardening Soil model and Hardening Soil model
with small-strain stiffness to set the initial shear hardening contour. This value must be
between 0 (isotropic stress state) and 1 (failure state).

Initial stress |σyy|

The absolute value of the initial vertical stress at which the sample is consolidated,
entered in units of stress. In the case of an isotropically consolidated test, the initial
lateral stress is equal to the initial vertical stress. In the case of a K0-consolidated test,
the initial lateral stress is equal to K0σyy.

Initial static shear
σxy

The initial static shear defines an initial shear stress component, leading to an initial
principal stress rotation, which will form an offset to the shear stress increments that
result from cyclic loading. The initial static shear is applied as a first calculation phase in
the test. Irrespective of the test option (drained or undrained), this first phase is always
applied under drained conditions.

Duration

Time increment Δt as indicated in Figure 195 (on page 282) (only relevant for timedependent models; consolidation is not considered).

Number of cycles

This defines the number of load cycles for the test. Each cycle gives a total of 3
calculation phases (applying +1 × amplitude, -2 × amplitude, +1 × amplitude, Figure 195
(on page 282)).

Number of steps per This defines the number of steps per quarter cycle. The total number of steps applied in
quarter cycle
the whole calculation process is: (1 + 4 × number of cycles) × number of steps per
quarter cycle.
Duration per cycle

The duration per cycle expressed in days.

Test control

This option allows the user to define whether the test is stress-controlled or straincontrolled. In the case of strain-control (which is the default), the user needs to specify a
strain amplitude, whereas in the case of stress- control, the input of a stress amplitude is
required.

Shear strain Δγxy /
Shear stress Δσxy
amplitude

The user needs to specify a value for the shear strain or shear stress amplitude,
depending on the test control. In order to apply a particular cyclic stress ratio, CSR =
Δσxy / σyy , the user needs to define the appropriate Initial stress σyy , set the Test control
to Stress, and input the Shear stress amplitude as Δσxy = CSR σyy.
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σxy

Time ∆t

shear stress
amplitude σxy

initial stress ∆σyy
Cycle

t
Figure 195: Cyclic DSS test conditions
Note:
Note that cycle boundaries and phase boundaries do not match except when t = 0 and t = Δt

6.3.7 General
The General tabsheet contains facilities to define arbitrary stress and strain conditions. The following settings
can be defined:
Type of test

The type of the test, whether Drained or Undrained can be specified.

|Vertical precons.
stress|

The vertical preconsolidation pressure to which the soil has been subjected. If the soil is
normally consolidated this value should be set equal to the initial stress state, i.e. zero.
From the vertical preconsolidation stress the program calculates the isotropic
preconsolidation stress based on the K0nc loading path of the Material Models Manual Chapter 2 - The initial pre-consolidation stress in advanced models. This option is only
available for the advanced soil models.

Mobilized relative
shear strength

This option is only available for the Hardening Soil model and Hardening Soil model
with small-strain stiffness to set the initial shear hardening contour. This value must be
between 0 (isotropic stress state) and 1 (failure state).
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Phases

Lists the initial stress conditions and the stress/strain conditions in the subsequent
phases of the test. In the initial phase it should be indicated for each direction whether a
stress increment or a strain increment is defined for that direction (applies to all
phases). Each phase is defined by a Duration (in units of time) and a Number of steps,
followed by the applied stress or strain increments. The given stress or strain increment
will be reached at the end of the given duration in the given number of steps. The input
values can be changed by clicking in the table. A negative stress or strain increment
implies additional compression, whereas a positive stress or strain increment implies
unloading or tension.

Add

Adds a new phase to the end of the Phases list.

Insert

Inserts a new phase before the currently selected phase.

Remove

Removes the currently selected phase from the Phases list.

6.3.8 Results
The Results window shows several predefined typical diagrams to display the results of the current test in
terms of stress and strain quantities. Double-clicking one of the graphs opens the selected diagram in a larger
window (Figure 196 (on page 284)). This window shows the selected diagram, the table of the data points that
are used to plot this diagram as well as the tangent and the secant values of the plot. Note that, the point to be
taken into consideration for the calculation of the tangent and the secant values can be determined by clicking
on the plot. The diagram or the data can be copied to the clipboard by selecting the corresponding option in the
drop-down menu displayed when the Copy button is clicked.
Note:
• The failure line is indicated by a dashed line in the plot.
• In plots where deviatoric stress q is considered, the failure line is always shown for the compression point.
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Figure 196: Results diagram
The diagram can be zoomed in or out using the mouse by first clicking and holding the left mouse button in the
diagram area and then moving the mouse to a second location and releasing the mouse button. Moving the
mouse from the left upper corner to the right lower corner zooms the diagram to the selected area, whereas
moving the mouse from the right lower corner to the left upper corner resets the view. The zoom action can also
be undone using the Zoom out option on the toolbar. The wheel button of the mouse can be used for panning:
click and hold the mouse wheel down and move the diagram to the desired position.
The secant and the tangent are useful for the back-calculation of stiffness parameters from stress-strain
diagrams. The corresponding secant and tangent values are indicated below the table. The secant and the
tangent can be computed interactively on the chart:
• By clicking one point, a line is drawn from the origin of the curve to the point.
• By pressing Ctrl and clicking a second point: a line is drawn between the first and second point. The secant
determines the inclination of the line. The tangent is determined with respect to the second point.
• By keeping Ctrl pressed, the user clicks the third point: the first point is deselected and a new line is
drawn between the second and the third point.
• By pressing Shift and clicking the third point: the second point is deselected and a new line is drawn
between the first and the third point.
• By clicking any point in the proximity of the curve without pressing Ctrl, any selected point is deselected and
a new line is drawn according to the current behaviour (from the origin to the point).
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6.3.9 Parameter optimisation
The soil test facility can be used to optimise model parameters such that a best fit is obtained between the model
results and the results of real soil lab tests. This option can be selected from the toolbar.
Click the Parameter optimisation button in the toolbar. The Parameter optimisation window will appear,
showing different colour tabs according to the various steps to follow in the parameter optimisation process
(Figure 197 (on page 285)). The first tab (Select parameters) is active.

Figure 197: Parameter optimisation window
Note:
Note that it is possible to optimise parameters for both native and User-defined Soil Model.

Select parameters
The Select parameters tab shows the parameters of the selected material data set that could participate in the
optimisation process. Click on the square in front of the parameter(s) that need(s) to be optimised (Figure 198
(on page 286)). The more parameters are selected, the more time the optimisation process will take. For the
selected parameters, minimum and maximum values need to be specified. The optimisation algorithm will
search for optimum values within this range. If the optimised value turns out to be equal to the minimum or
maximum value, it might be that the best value lies outside the specified range.
Note that parameters may influence only specific parts of a test. For example, consider an oedometer test with a
loading and unloading part, modelled with the Hardening Soil model. The loading part will be dominated by the
parameter Eoedref, whereas the unloading part will be dominated by the parameter Eurref. In order to obtain a best
fit, the optimisation may be performed in separate runs; one to optimise Eoedref based on the loading part and
one to optimise Eurref based on the unloading part of the test.
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Figure 198: Selection of the parameters in the Select parameters tabsheet

Select curves
The Select curves tab enables selection and uploading of real soil lab test data and corresponding test conditions.
Alternatively, synthetic test data may be used in the form of other PLAXIS 3D soil test results. In this way it is
possible to optimise, for example, parameters of the Mohr-Coulomb model against simulated tests using the
Hardening Soil model.
Initially, the window shows a tree with the five standard test types (Triaxial, CycTriaxial, Oedometer, CRS, DSS,
CDSS, and General). For each test type, different test conditions can be defined, which can be taken into account
in the optimisation process. By default, the Current model test is available as test conditions for each test type.
The Current model test contains the test conditions as previously defined for that test (Figure 199 (on page
286)).

Figure 199: Selection of the test curves in the Select curves tabsheet
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•

•
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New test conditions can be defined by selecting the New test configuration option from the tool bar. This
will introduce a new test under the selected test, for which the test conditions can be defined in the righthand panel (Figure 200 (on page 287)).
All test data can be saved, by clicking on Save to file button. The test data will be saved to an XML file with
a default file extension of *.vlo.xml.
In both cases (Current model test and a new test) corresponding test data need to be selected and
uploaded using the Import curve option. Another possibility is to upload test conditions together with the test
data in case it is stored in the format of a PLAXIS 3Dsoil test project (<test>.vlt).

Figure 200: Custom test definition in the Select curves tabsheet
Hence, there are different ways to define test conditions and to select the external test data. The possibilities are
summarized below:
• If the test data corresponds to one of the Current model test conditions, the corresponding line should be
selected in the tree and the Import curve option should be used to upload the test data (Figure 201 (on page
288)). The test data are assumed to be stored in a text file (<data>.txt) and should contain two columns,
separated by a Space, Tab, Comma, Colon (:), Semicolon (;) or arbitrary character. The separator is to be
indicated at the top of the Import test data window. The meaning of the values in each column has to be
selected from the drop down list below the column. Here, a selection can be made amongst various stress and
strain quantities. Moreover, the basic units of the test data quantities need to be selected from the drop down
lists in the Units group. By pressing OK the data is read and visualised in a diagram, and the curve is listed in
the tree under the Current model (test) conditions.
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Figure 201: Import test data window
• If the test data corresponds to other than one of the current model test conditions, first new test conditions
need to be defined. Select the appropriate test type and click the New test configuration button. The test
conditions of the data to be uploaded can be defined in the right-hand panel. Subsequently, the Import curve
option should be used to upload the test data. The test data are assumed to be stored in a text file (<data>.txt)
and should contain two columns (see explanation before). The meaning of the values in each column has to
be selected from the drop down list below the column. Moreover, the basic units of the test quantities need to
be selected from the drop down lists in the Units group. By pressing OK the data is read and a visualised in a
diagram, and the curve is listed in the tree under the Custom (test) conditions (Figure 202 (on page 288)).

Figure 202: Display of the imported test curves
• If the test data together with the test conditions are stored in the format of a PLAXIS soil test project
(<test>.vlt), the Open file option should be used. After selection of a valid PLAXIS soil test project, the test
conditions are listed under the corresponding test type in the tree, and the available test data curves are
listed under the test conditions (Figure 203 (on page 289)). This option should typically be used to fit

PLAXIS

288

PLAXIS 3D-Reference Manual

Material properties and material database
Simulation of soil lab tests
current model parameters to synthetic data previously produced in the PLAXIS soil test facility and stored in
<test>.vlt format.

Figure 203: Importing data from SoilTest
Note:
• When a line representing test conditions is selected in the tree, the corresponding test conditions are shown
on the panel at the right-hand side.
• When a line representing test data is selected in the tree, the corresponding curve is visualised in the
diagram, and a table of corresponding data points is shown at the right-hand side of the diagram.
• A sub-set of test data to be used in the optimisation process can be selected in the table at the right-hand side
by clicking on the corresponding cells, using the standard multi-select convention (using Shift for ranges and
Ctrl for individual values). The selected values are indicated as 'thick' lines in the curve whereas non-selected
values are indicated as 'thin' lines.
• Always select all data corresponding to a complete phase of the test (for example, if it is the user's intention to
optimise parameters based on the unloading phase in an oedometer test that involves both loading and
unloading, select the full range of unloading test data).
• A line in the tree (either test conditions or test data) can be removed by selecting that line and clicking the
red cross in the toolbar.
All test data to be used in the optimisation process need to be selected in the tree by clicking the square in front
of the corresponding line (if not already selected). The corresponding test conditions are automatically selected.

Multiple phases
In the case of an Oedometer, CRS or General test, the SoilTest facility allows for multiple phases. However, the
parameter optimisation facility can only deal with one complete phase at a time. Therefore, after importing the
test data, the desired calculation phase needs to be selected from the drop down list above the test data curve,
together with the corresponding part of the test data in the column at the right-hand side. Note that the full
range of data corresponding to this test phase is selected. In this way it is possible, for example, to optimise a
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primary loading stiffness against the first (loading) phase in an oedometer test and the unloading stiffness
against the second (unloading) phase. Note that the test data needs to be selected for each phase.

Settings
The Settings tab enables the accuracy selection of the optimisation process (Figure 204 (on page 290)). Three
levels of search intensity are available: Coarse and quick, Moderate, Thorough. In addition, the relative tolerance
of the search algorithm can be selected. The default value is 1E-3. Note that a more rigorous optimisation may
give more accurate results, but also requires more calculation time. The calculation time also depends on the
number of parameters to be optimised, as selected in the first tab. The optimisation process is based on a
'particle swarm' algorithm. This algorithm can overcome local minima in the optimisation process.

Figure 204: Settings window

Resulting parameters
The Resulting parameters tab shows the optimum values of the parameters used to obtain the best fit to the
selected test data in addition to the minimum and maximum values and the reference values in the material data
set (Figure 205 (on page 290)). If the optimum value is equal to the minimum or maximum value, it might be
that the best value lies outside the specified range. Finally, the table shows the sensitivity of the selected
parameters. A sensitivity of 100% means that the parameter has a high influence on the simulated test results,
whereas a low sensitivity means that the parameter has a low influence on the simulated test results. Note that a
low sensitivity also means that the test may not be suitable to optimise that parameter and, as a result, the
suggested optimum value may not be accurate. Therefore it is better to do separate optimisations for different
parameters based on relevant sections of test data curves rather than one optimisation with multiple
parameters based on the full data curves.

Figure 205: Resulting parameters window
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A button is available to copy the optimised parameters to the material data set. This should only be done
after it has been properly validated that the optimised parameters are indeed better than the original
parameters, considering the use of the material data set in the finite element model.
Note that the parameters optimised for soil lab tests may not be the best parameters for the practical application
as considered in the finite element model.

Resulting charts
The Resulting charts tab shows the results of the selected tests (Figure 206 (on page 291)).
For each test, three curves are visible:
Optimisation target

This curve represents the uploaded test data.

Optimisation results This curve represents the simulated test with optimised parameters.
Reference
simulation

This curve represents the simulated test with original parameters. It has no meaning in
the optimisation process, but just shows how good or bad the existing material data set
would fit the uploaded test data for the selected test conditions without optimisation.

Figure 206: Resulting charts window

Limitations
The Parameter optimisation facility should be used with care. Note that parameters optimised for soil lab tests
may not be the best parameters for the practical application as considered in the finite element model. This is
because the application may involve stress levels, stress paths and strain levels which might be significantly
different from the ones that occur in the soil lab tests.
Furthermore, the parameter optimisation facility has the following limitations:
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• The experimental curve should be given in the order where the first column is a prescribed value, and the
second is the computed one.
• It is not possible to automatically optimise test data curves that consist of multiple phases (for example
loading and unloading phases). Such curves need to be uploaded for each phase and the corresponding part
of the curves (phase) needs to be selected in order to perform the optimisation.
• The optimisation process itself is a numerical procedure which may involve numerical errors. The user
remains responsible for validating the outcome of the optimisation process and the use of optimised model
parameters in applications. The parameter optimisation is based on curve fitting. It is not possible to fit
envelopes such as the failure line in a p-q diagram. As a consequence, it is not possible to find the optimised
friction angle or cohesion from a p-q diagram.

6.4 Material data sets for plates
In addition to material data sets for soil and interfaces, the material properties and model parameters for plates
are also entered in separate material data sets. A data set for plates generally represents a certain type of plate
material, and can be assigned to the corresponding (group of) plate elements in the geometry model.

Figure 207: Plate window

6.4.1 Material set
Several data sets may be created to distinguish between different types of plates. Figure 207 (on page 292)
shows the Plate window. The material data set is defined by:
Identification
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meaningful name since the data set will appear in the database tree view by its
identification.
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Comments

A user may write down comments related to the material data set.

Colour

Colour can be used as a distinction tool in the model.

Material type

There are three available options, describing the material type of a plate. These options
are Elastic and Elastoplastic. The availability of the parameters defined in the Properties
box depends on the selected material type.

6.4.2 Mechanical properties
The properties required for plates can be grouped into general properties and stiffness properties for Elastic
plates. If the Elastoplastic type is chosen, the plastic properties are also required.

General properties
A plate has two general properties:
d

The (equivalent) thickness (in the unit of length) is the material cross section area of the
plate across its major axial direction per 1 m width. For massive plates without a
particular profile this is just the plate thickness, but for plates that have a certain profile
(such as sheet-pile walls or sandwich plates), the thickness is relatively small and should
be properly calculated from the above definition.

γ

The unit weight is the unit weight of the material from which the plate is composed. The
product γ·d determines the distributed weight of the plate.

Note:
In a finite element model, plates are superimposed on a continuum and therefore 'overlap' the soil. Especially for
massive structures, to calculate accurately the total weight of soil and structures in the model, the unit weight of
the soil should be subtracted from the unit weight of the plate material.

Stiffness properties
Plate stiffnesses will be linear. PLAXIS 3D allows for orthotropic as well as anisotropic material behaviour in
plates, which is defined by the following parameters:

PLAXIS

E1

Young's modulus in first axial direction.

E2

Young's modulus in second axial direction.

G12

In-plane shear modulus.

G13

Out-of-plane shear modulus related to shear deformation over first direction.

G23

ut-of-plane shear modulus related to shear deformation over second direction.

ν12

Poisson's ratio.
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These parameters appear in the following (approximate) relationships for structural forces:
N1
N2
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Eq. [48]

ε2

E 2d

G12d

0

0

γ12

0

kG13d

0

*
γ13

0

k G23d

*
γ23

0
E1d

M 11

ν12E 2d ε1

E1d

3

12
ν12E2d3

ν12 E2d
12
E2d

12

12

0

0

3

3

Eq. [49]

0

κ11
κ22

0
G12d
12

3

Eq. [50]

κ12

Where k represents the modification factor to the shear modulus and is taken equal to 5/6.
Figure 208 (on page 295) visualises the plate's local system of axes and the major quantities. The local system of
axes in a plate element is such that the first and the second local axis lie in the plane of the plate whereas the
third axis is perpendicular to the plane of the plate.
If the Isotropic option is checked the input is limited to E1 and ν12, where as E2 = E1 and G12 = G13 = G23 = E / 2(1 +
ν12).
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Figure 208: Definition of positive normal forces (N), shear forces (Q) and bending moments (M) for a plate based on
local system of axes

Strength properties: Elastoplastic
Elastoplastic plates are defined by the following parameters:
Yield stress σy,11

Yield stress parameter in first axial direction.

Yield stress σy,22

Yield stress parameter in second axial direction.

W11

Plastic section modulus in first axial direction.

W22

Plastic section modulus in second axial direction.

If the Isotropic box is checked, then σy,11 = σy,22 and W11 = W22.
In order to obtain the plastic axial forces Np, the equivalent yield stresses are calculated:
σ y,11,eq = σ y,11 / 3
σ y,22,eq = σ y,22 / 3
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The plastic properties are calculated as follows:
N p,1,eq = d σ y,11,eq

Eq

N p,2,eq = d σ y,22,eq

Eq

M p,11 = W 11 σ y,11

Eq

M p,22 = W 22 σ y,22

Eq

The resulting yiel surfaces are a diamond shape in the N1-M11 plane and in the N2 - M22 plane. The two directions
are treated separately.
Note:
1. If the plate is primarily subjected to bending moments (or it is expected to fail in bending), the plastic
bending moment Mp is the most important parameter and it should be properly evaluated using the real σy
and W values as input parameters. In this case, the plastic axial force Np is calculated based on the equivalent

/

/

/

/

yield stress σy,eq and will not match the real Np of the plate: N N p,eq = ( N Np) ( 3d 2 ) (6W ) (Figure
209 (on page 296)).
2. If the plate is primarily subjected to axial forces (or it is expected to fail in tension/compression), the plastic
axial force Np should be properly evaluated by scaling the yield stresses such that Np,eq will be equal to the
real Np of the plate cross section. In this case, the plastic bending moment resulting from this operation Mp,eq
will not match the real plastic bending moment Mp of the plate: M
(Figure 6.59).

/ M p,eq = (M / Mp) / (

3d 2 )

/ (6W )

Figure 209: Plate primarily subjected to: bending moments (on the left) and axial forces (on the right)

Prevent punching
In reality vertical loads on walls for example, as a result of vertical components of anchor forces are sustained by
the shaft friction and the tip resistance. A certain amount of resistance is offered by the soil under the tip,
depending on the thickness or the cross section area of the tip.
Slender walls are often modelled as plates. Due to the zero thickness of the plate elements vertical plates (walls)
have no end bearing. The effects of end bearing can still be considered in the calculation when the corresponding
option is selected in the material data set. In order to consider end bearing at the bottom of plates, a zone in the
soil volume elements surrounding the bottom of the plate is identified where any kind of soil plasticity is
excluded (elastic zone). The size of this zone is determined as Deq = 12EI / EA.
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It is not the idea that this end bearing represents the true end bearing capacity of the wall. It just presents
unrealistic vertical movement of penetration of the wall into deeper layers. The value of end bearing cannot be
prescribed by the user, and it is neither theoritically determined by PLAXIS 3D.
Note:
Note that sheet pile walls have very little end bearing, considering that the thickness of the steel is much less
than Deq, when modelling them as plates. Hence, the end bearing option shall not be used for sheet pile walls. It is
always advised to check the introduced tip-resistance does not exceed the expected end bearing, especially for
cases where the equivalent plate thickness does not represent the true physical thickness.
More information about the behaviour and structural forces in plates can be found in the Material Models
Manual - Chapter 18 - 3D plates.

6.5 Material data sets for geogrids
In addition to material data sets for soil and interfaces, the material properties and model parameters for
geogrids are also entered in separate material data sets. Geogrids are flexible elastic elements that represent a
grid or sheet of fabric. Geogrids cannot sustain compressive forces. A data set for geogrids generally represents a
certain type of geogrid material, and can be assigned to the corresponding (group of) geogrid elements in the
geometry model.

6.5.1 Material set
Several data sets may be created to distinguish between different types of geogrids or geosynthetics. Figure 210
(on page 298) shows the Geogrid window. The material data set is defined by:
Identification

A user may specify any identification title for a data set. It is advisable to use a
meaningful name since the data set will appear in the database tree view by its
identification.

Comments

A user may write down comments related to the material data set.

Colour

Colour can be used as a distinction tool in the model.

Material type

There are four available options, describing the material type of a plate. These options
are Elastic, Elastoplastic, Elastoplastic (N-ε) and Visco-elastic (time-dependent). The
availability of the parameters defined in the Properties box depends on the selected
material type.
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Figure 210: Geogrid window

6.5.2 Mechanical Properties
The properties required for geogrids can be grouped into stiffness properties and strength properties in case of
elastoplastic behaviour.

Isotropic
Different stiffnesses in-plane and out-of-plane may be considered. The latter is most relevant for 3D or
axisymmetric models when modelling geogrids with an anisotropic pattern. If this is not the case, the Isotropic
option may be selected to ensure that both stiffness are equal.

Stiffness properties
For elastic behaviour, the axial stiffness EA should be specified. PLAXIS 3D allows for orthotropic as well as
anisotropic material behaviour in geogrids, which is defined by the following parameters:
EA1

The normal elastic stiffness in 1-direction (in-plane).

EA2

The normal elastic stiffness in 2-direction.

GA

In-plane shear stiffness (anisotropic behaviour).

The axial stiffness EA is usually provided by the geogrid manufacturer and can be determined from diagrams in
which the elongation of the geogrid is plotted against the applied force in a longitudinal direction. The axial
stiffness is the ratio of the axial force F per unit width and the axial strain (Δl/l where Δl is the elongation and l is
the original length):
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EA =

F
Δl / l

Eq. [53]

If the Isotropic option is checked the input is limited to EA1 where as EA2 =EA1 and GA = EA1 / 2.

Strength properties: Elastoplastic
Strength parameters are required in case of elastoplasticity:
Np,1

The maximum force in 1-direction.

Np,2

The maximum force in 2-direction.

The maximum axial tension force Np is specified in units of force per unit width. If Np is exceeded, stresses are
redistributed according to the theory of plasticity, so that the maxima are complied with. This will result in
irreversible deformations. Output of axial forces is given in the nodes, which requires extrapolation of the values
at the stress points. Due to the position of the stress points in a geogrid element, it is possible that the nodal
values of the axial force may slightly exceed Np.
If the Isotropic option is checked the input is limited to Np,1 where as Np,2 =Np,1.

Strength properties: Elastoplastic (N-ε)
A non-linear N-ε diagram may be specified in case of elastoplasticity (N-ε):
N1-eps1

The N-ε diagram in 1-direction.

N2-eps2

The N-ε diagram in 2-direction.

The user can add both N-ε diagrams, by specifying values as a table or importing a text file containing values
(Figure 211 (on page 300)). The axial tension force is specified in units of force per unit width. The first part of
the N-ε diagram is used to calculate the EA value.
If the Isotropic option is checked the input is limited to N1 -eps1 where as N2-eps2 =N1-eps1.
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Figure 211: Geogrid window

Time-dependent properties: Visco-elastic (time-dependent)
The parameters are based on a visco-elastic perfectly-plastic Kelvin-Voigt model in each direction, which allows
for time-dependent behaviour.

F

u
Figure 212: Force versus displacement showing EAshort and EAlong
Considering one Kelvin-Voigt element (see Figure 213 (on page 301)),
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Figure 213: Kelvin-Voigt single element representation
E A0 = E Ashort
1
E A0

+

E A1 =

1
E A1

(

=

1
E Along

1
1
1
−
E Along
E A0

Eq. [54]

)

η = E A1 × Retardation time
where η is viscous damping, EA0 and EA1 are internal stiffness used in the geogrid material model.

Figure 214: Displacement versus time in a Creep test
Retardation time can be obtained from a creep test in which a force F is applied, using the following equations
(see Figure 214 (on page 301)):
tretardation =

η1
E1

E Ashort =

F
ushort

E Along =

1
E Ashort

ushort =
ulong =

Eq. [55]

F
E Ashort
F
E Along

The short-term and long-term stiffnesses can be obtained from the same creep test by measuring the
corresponding displacement u at the short and long time, respectively.
Parameters which are required for time dependent visco-elasticity are (Figure 215 (on page 302)):

PLAXIS

301

PLAXIS 3D-Reference Manual

Material properties and material database
Material data sets for beams
EA1,short

Elastic stiffness during initial (instantaneous) strain increment in 1-direction.

EA2,short

Elastic stiffness during initial (instantaneous) strain increment in 2-direction.

EA1,long

Elastic stiffness during (infinitely) long strain increment in 1-direction.

EA2,long

Elastic stiffness during (infinitely) long strain increment in 1-direction.

Np,1

The maximum force in 1-direction.

Np,2

The maximum force in 1-direction.

Retardation time

The time where a linear extrapolation of the initial creep rate intersects the long-term
displacement line.

Figure 215: Geogrid window

6.6 Material data sets for beams
In addition to material data sets for soil and interfaces, the material properties and model parameters for beams
are also entered in separate material data sets. A data set for beams generally represents a certain type of
material or beam profile, and can be assigned to the corresponding (group of) beam elements in the geometry
model.
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6.6.1 Material set
Several data sets may be created to distinguish between different types of beams. Figure 216 (on page 303)
shows the Beam window. The material data set is defined by:
Identification

A user may specify any identification title for a data set. It is advisable to use a
meaningful name since the data set will appear in the database tree view by its
identification.

Comments

A user may write down comments related to the material data set.

Colour

Colour can be used as a distinction tool in the model.

Material type

There are two available options, describing the material type for beams. These options
are Elastic and Elastoplastic. The availability of the parameters defined in the Properties
box depends on the selected material type.

Figure 216: Beam window

6.6.2 Beam properties
The properties required for beams are:
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Young's modulus.

γ

Unit weight of the beam material.
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Note:
• In a finite element model, beams are superimposed on a continuum and therefore 'overlap' the soil.
Especially for Solid structures, to calculate accurately the total weight of soil and structures in the model, the
unit weight of the soil should be subtracted from the unit weight of the beam material. For partially
overlapping beams the reduction of the unit weight should be proportional.
• Please note that when reducing the unit weight, the axial forces in the beam may not be realistic.

Geometric properties
A beam requires several geometric parameters used to calculate additional properties:
Beam type

Either a Predefined or a User defined type can be selected.

Predefined beam type

A list of predefined types is available (Solid circular beam, Circular tube, Solid
rectangular beam). After entering the required data, the parameters A, I3, I2 and
W3 (or W2) are filled automatically (Table 15 (on page 305)) accordingly to the
material type.

Diameter

The beam diameter is to be defined for Solidolid circular beam and Circular tube
predefined beam types. The beam diameter determines the size of the elastic
zone in the soil around the beam in which plastic soil behaviour is excluded.

Height

The beam height is to be defined for a Solid rectangular beam predefined beam
type. The beam height is recalculated into an equivalent diameter.

Width

The beam width is to be defined for a Solid rectangular beam predefined beam
type. The beam width is recalculated into an equivalent diameter.

Thickness

The wall thickness needs to be defined for a Circular tube predefined beam type.

Figure 217: Height is measured in local direction 2 and Width in local direction 3, for a Solid rectangular beam
Alternatively, a user-defined type may be defined by means of the beam cross section area, A, and its respective
moments of inertia I3 and I2:
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A

The cross section area is the actual area (in the unit of length squared)
perpendicular to the beam axis. For beams that have a certain profile (such as
steel beams), the cross section area can be found in tables that are provided by
steel factories.

I3

Moment of inertia against bending around the third axis.
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I2

Moment of inertia against bending around the second axis.
Torsion moment of inertia (bending around the first axis) The torsion moment of
inertia, J, is implicitly calculated from the formulas below.
For Solid rectangular cross sections where a is half the width of the cross section
and b is half the height of the cross section:
J =

J

1
12

( ab )2 + 1ab 3
1.2

Eq. [56]

For Solid circular cross sections where D is the cross section diameter:
J =

1
πD 4
32

Eq. [57]

For user-defined cross sections where A is the cross section area:
J =

1 3 2
π A
2

Eq. [58]

Torsion also involves the shear modulus G, which is assumed to be half the
Young's modulus E, i.e. G = E / 2

Strength properties: Elastoplastic
Yield stress σy

Yield stress parameter for a beam

Yield direction

Yield direction for a beam which can be either in Local direction 2 or Local
direction 3.

W2

Plastic section modulus when the Yield direction is in local direction 2.

W3

Plastic section modulus when the Yield direction is in local direction 3.

Note:
The yield stress parameter σy makes no distinction between compression and extension.
Table 15: Formulas used for predefined beam types

Solid circular beam

Circular tube
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A

π × diameter2/4

I3

π × diameter4/64

I2

π × diameter4/64

W3

π × diameter3/32

W2

π × diameter3/32

A

π × ((diameter)2 - (diameter-2× thickness)2)/4
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I3

π × ((diameter)4 - (diameter-2× thickness)4)/64

I2

π × ((diameter)4 - (diameter-2× thickness)4)/64

W3

π × ((diameter)4 - (diameter-2× thickness)4)/(32×
diameter)

W2

π × ((diameter)4 - (diameter-2× thickness)4)/(32×
diameter)

A

width × height

I3

width × height3/12

I2

height × width3/12

W3

width × height2/6

W2

height × width2/6

Solid rectangular beam

The definition of various quantities according to the beam's local system of axes are visualised in Figure 218 (on
page 306) .

2
3

3

3

3
1

2

2
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1
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I2 M2 κ2

I3M3κ3

ENε

Figure 218: Definition of moment of inertia (I), positive bending moment (M), positive curvature (κ) and stiffness
(E) for a horizontal beam based on local system of axes
Based on the input parameters A, I2, I3 and σy, the equivalent properties are calculated:
h 2,eq = 12
h 3,eq = 12

I3
A
I2

Eq. [59]

A

Aeq = h 2,eq h 3,eq
W 2,eq =

3
6

Aeq h 2,eq

W 3,eq =

3
6

Aeq h 3,eq
W2

σ y,eq = σ y W
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2,eq

Eq. [60]

If local direction 2 is selected
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W3

σ y,eq = σ y W

3,eq

If local direction 3 is selected

Eq. [62]

Based on the equivalent parameters, the plastic properties are calculated:
N p,eq = Aeq σ y,eq
M p,3,eq = W 3,eq σ y,eq

Eq. [63]

M p,2,eq = W 2,eq σ y,eq
More information about the behaviour and structural forces in beams can be found in the Material Models
Manual - Chapter 18 - 3D beam.

6.7 Material data sets for embedded beams
Properties and model parameters for embedded beams are entered in separate material data sets. Embedded
beams can be used to model different types of slender structures that interact with the surrounding soil/rocks
such as piles, ground anchors or rock bolts. A data set for embedded beams generally represents a certain type
of embedded beam, including the pile/rock bolt material and geometric properties, as well as the interaction
properties with the surrounding soil or rock (bearing capacity).
Note that the embedded beam material data set does not contain so-called 'p-y curves', nor equivalent spring
constants. In fact, the stiffness response of an embedded beam subjected to loading is the result of the specified
embedded beam length, equivalent radius, spacing, stiffness and bearing capacity as well as the stiffness of the
surrounding soil.
Note:
In contrast to what is common in the Finite Element Method, the bearing capacity of an embedded beam is
considered to be an input parameter rather than the result of the finite element calculation. The user should
realise the importance of this input parameter. Preferably, the input value of this parameter should be based on
representative pile load test or pull out test data. Moreover, it is advised to perform a calibration in which the
behaviour of the embedded beam is compared with the behaviour as measured from the test. When embedded
beams are used in a row, the group action must be taken into account when defining their bearing capacity.

PLAXIS

307

PLAXIS 3D-Reference Manual

Material properties and material database
Material data sets for embedded beams

6.7.1 Material set

Figure 219: Embedded beam window
Several data sets may be created to distinguish between different types of embedded beams or spacings. Figure
219 (on page 308) shows the Embedded beam row window.
The material data set is defined by:
Identification

A user may specify any identification title for a data set. It is advisable to use a
meaningful name since the data set will appear in the database tree view by its
identification.

Comments

A user may write down comments related to the material data set.

Colour

Colour can be used as a distinction tool in the model.
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Material type

There are two available options, describing the material type for embedded beams.
These options are Elastic and Elastoplastic. The availability of the parameters defined in
the Properties box depends on the selected material type.

6.7.2 Beam properties
The properties required for embedded beams are:
E

Young's modulus.

γ

Unit weight of the beam material.

Note:
• In a finite element model, embedded beams are superimposed on a continuum and therefore ' overlap' the
soil. Especially for Solid structures, to calculate accurately the total weight of soil and structures in the model,
the unit weight of the soil should be subtracted from the unit weight of the embedded beams material.
• Please note that when reducing the unit weight, the axial forces in the embedded beams may not be realistic.

Geometric properties
An embedded beam requires several geometric parameters used to calculate additional properties:
Beam type
Predefined beam
type

Diameter

Width
Thickness

Either a Predefined or a User defined type can be selected.
A list of predefined types (Solid circular beam, Circular tube, Solid square beam). After
entering the required data, the parameters A, I3, I2, W3 and W2 are filled automatically
(Table 16 (on page 310) accordingly to the material type).
The embedded beam diameter is to be defined for Solid circular beam and Circular tube
predefined embedded beam types. The embedded beam diameter determines the size of
the elastic zone in the soil around the embedded beam in which plastic soil behaviour is
excluded. This makes the embedded beam behave almost like a volume pile.
The embedded beam width is to be defined for a Solid square beam predefined beam
type. The embedded beam width is recalculated into an equivalent diameter.
The wall thickness needs to be defined for a Circular tube predefined beam type.

Alternatively, a user-defined type may be defined by means of the embedded beam cross section area, A, and its
respective moment of inertia I3 and I2:

A

PLAXIS

The cross section area is the actual area (in the unit of length squared) perpendicular to
the embedded beam axis (direction 1) where embedded beam material is present. For
embedded beams that have a certain profile (such as steel beams), the cross section area
can be found in tables that are provided by steel factories.
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I2

Moment of inertia against bending around the second axis.

I3

Moment of inertia against bending around the third axis.

If the Predefined beam types are adopted, I3 is equal to I2.
From the embedded beam geometric properties, an equivalent radius for the elastic zone, Req, is determined:
Req = max { A / π, 2I avg / A} where I avg = ( I 2 + I 3) / 2

Eq. [64]

Strength properties: Elastoplastic
Yield stress σy

Yield stress parameter for a beam

Yield direction

In user-defined beam type, the yield direction can be either in Local direction 2 or Local
direction 3

W2

Plastic section modulus when the Yield direction is in local direction 2

W3

Plastic section modulus when the Yield direction is in local direction 3

If the Predefined beam types are adopted, W3 is equal to W2.
Note:
The yield stress parameter σy makes no distinction between compression and extension.
Table 16: Formulas used for predefined emdebbed beam types

Solid circular beam

Circular tube

PLAXIS

A

ϖ × diameter2/4

I3

ϖ × diameter4/64

I2

ϖ × diameter4/64

W3

ϖ × diameter3/32

W2

ϖ × diameter3/32

A

ϖ × ((diameter)2 - (diameter-2× thickness)2)/4

I3

ϖ × ((diameter)4 - (diameter-2× thickness)4)/64

I2

ϖ × ((diameter)4 - (diameter-2× thickness)4)/64

W3

ϖ × ((diameter)4 - (diameter-2× thickness)4)/(32×
diameter)

W2

ϖ × ((diameter)4 - (diameter-2× thickness)4)/(32×
diameter)
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Solid rectangular beam

A

width × height

I3

width × height3/12

I2

height × width3/12

W3

width × height2/6

W2

height × width2/6

Based on the input parameters A, I2, I3 and σy, the equivalent parameters for the plastic properties are calculated
as reported in Material data sets for beams (on page 302).
The definition of various quantities according to the embedded beam's local system of axes are visualised in
Figure 220 (on page 311). More information about the behaviour and forces in embedded beams can be found
in the Material Models Manual -Chapter 18-3D Beam.
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Figure 220: Definition of moment of inertia (I), positive bending moment (M), positive curvature (κ) and stiffness
(E) for a vertical user-defined beam type (beam profile) based on the local system of axes

Dynamic properties
For dynamic behaviour, two additional parameters can be specified as material properties:
Rayleigh α

Rayleigh damping parameter determining the influence of mass in the damping of the
system.

Rayleigh β

Rayleigh damping parameter determining the influence of the stiffness in the damping of
the system.

For more information on Rayleigh damping, see Advanced general properties (on page 195).

6.7.3 Interaction properties: bearing capacity
The interaction between the pile or rock bolt (embedded beam element) and the surrounding soil or rock (soil
volume element) is modelled by means of a special interface element. An elastoplastic model is used to describe
the behaviour of the interface. Regarding the plastic behaviour, distinction is made in the material data set
between the Skin resistance (in the unit of force per unit embedded beam length) and the Base resistance (in the
unit of force). For the skin resistance, as well as the base resistance, a failure criterion is used to distinguish
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between elastic interface behaviour and plastic interface behaviour. For elastic behaviour relatively small
displacement differences occur within the interface (i.e. between the pile/rock bolt and the average soil/rock
displacement), and for plastic behaviour permanent slip may occur.
For the interface, to remain elastic, the shear force ts at a particular point is given by:

| ts |

< T max

Eq. [65]

where Tmax is the equivalent local skin resistance at that point.
For plastic behaviour the shear force ts is given by:

| ts |

= T max

Eq. [66]

The input for the shaft resistance is defined by means of the axial skin resistance Fskin and the base resistance
Fmax. Using this approach the total pile bearing capacity, Npile, is given by:
N pile = F max + F skin

Eq. [67]

The skin resistance Fskin can be defined in three ways: Linear, Multi-linear and Layer dependent. The base
resistance Fmax can be entered directly (in the unit of force) in the embedded beam material data set window.
Note:
The base resistance is only mobilised when the pile body moves in the direction of the base (example: with a
load on top).
For rock bolts, the bearing capacity may be defined in a similar way, although rock bolts generally do not have an
end bearing (Fmax = 0):
N rock bolt = F skin

Eq. [68]

In order to ensure that a realistic bearing capacity as specified can actually be reached, a zone in the soil volume
elements surrounding the beam is identified where any kind of soil plasticity is excluded (elastic zone). The size
of this zone is determined by the embedded beam's diameter D or equivalent diameter Deq. The elastic zone
makes the embedded beam almost behave like a volume element. Installation effects are not taken into account
and the embedded beam-soil interaction is modelled at the centre rather than at the circumference.
In addition to displacement differences and shear forces in axial direction along the embedded beam element,
the beam can undergo transverse forces, t⊥ , due to lateral displacements. The lateral displacements can be
induced by a transverse force applied at the top of the pile or as a consequence of the transverse distributed load
induced by the lateral displacement field of the surrounding soil. In the first case, the overall behaviour may not
show fully realistic results. In the second case, although embedded beam elements are not meant to be used as
laterally loaded piles, they show reasonable results and the overall behaviour is quite realistic. For more
information about the modelling techniques for embedded structures, see the Appendix of the Material Models
Manual.
The transverse forces are not limited in the special interface element that connects the pile with the soil but, in
general, they are limited due to failure conditions in the surrounding soil itself outside the elastic zone.
More details about the way the shear and transverse forces are calculated on the basis of displacement
differences between the embedded beam element and the surrounding soil element are described in the
Material Models Manual.

Linear
The Linear option is the easiest way to enter the skin resistance profile. The input is defined by means of the skin
resistance at the beginning of the embedded beam, Tskin,start,max (in force per unit beam length), and the skin
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resistance at the end of the embedded beam, Tskin,end,max (in force per unit beam length). This way of defining the
skin resistance is mostly applicable to piles in a homogeneous soil layer. Using this approach the total pile
bearing capacity, Npile, is given by:
N pile = F max +

1
2

L

pile

(T skin,start ,max

+ T skin,end ,max )

Eq. [69]

where Lpile is the pile length. Tskin,start,max and Tskin,end,max are measured at the pile top and the bottom of the pile
respectively.
For rock bolts, the bearing capacity may be defined as follows:
N rock bolt =

1
2

L

(T skin,start ,max

+ T skin,end ,max )

rock bolt

Eq. [70]

where Lrock bolt is the rock bolt length. Tskin,start,max and Tskin,end,max are measured at the first point of the geometry
line and the second one respectively.

Multi-linear
The Multi-linear option can be used to take into account inhomogeneous or multiple soil layers with different
properties and, as a result, different resistances. The skin resistance, Tmax, is defined in a table at different
positions along the pile, L, where L is measured from the pile top (L=0) to the bottom of the pile (L= Lpile). Using
this approach the total pile bearing capacity, Npile, is given by:
n−1 1
2
i=1

N pile = F max + ∑

( L i+1 − L i )(T i

+ T i+1 )

Eq. [71]

where i is the row number in the table and n is the total number of rows.
For rock bolts, the bearing capacity is defined as follows:
n−1 1
2
i=1

N rock bolt = ∑

( L i+1 − L i )(T i

+ T i+1 )

Eq. [72]

where L is measured from the first point of the corresponding geometry line (L=0) to the second one (L= Lrock
bolt).

Layer dependent
The Layer dependent option can be used to relate the local skin resistance to the strength properties (cohesion c
and friction angle φ) and the interface strength reduction factor, Rinter, as defined in the material data set of the
corresponding soil or rock layers ( Interfaces tabsheet (on page 257)) in which the pile/rock bolt is located:
τi = ci + σ ′ n tan φi
ci = Rintercsoil

Eq. [73]

tan φi = Rintertan φsoil
where τi is the local shear stress resistance of the interface, φi and ci are the friction angle and the cohesion of
the interface, φsoil and csoil are the friction angle and cohesion of the correspondent soil layer, Rinter is the
strength reduction factor associated to the soil layer, σ'n = (σ'2 + σ'3 ) / 2 is the normal stress. Using this approach
the pile/rock bolt bearing capacity is based on the stress state in the soil, and thus unknown at the start of a
calculation. The special interface in the embedded beam behaves similar as an interface along a wall, except that
it is a line interface rather than a sheet.
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Note:
In case of advanced soil material models, the calculation of φi and ci is as described in Interfaces tabsheet (on
page 257). For User Defined Soil Models, φi and ci are based on direct input specified by the user.
The skin resistance, Ti, as a force per unit of depth, is defined as:
T i = 2πReq τi

Eq. [74]

where Req is the embedded beam's equivalent radius.
To avoid that the skin resistance could increase to undesired high values, an overall maximum resistance Tmax
(constant value along the pile/rock bolt in force per unit pile/rock bolt length) can be specified in the embedded
beam material data set, which acts as an overall cut-off value.
Note:
The embedded beam-soil interaction parameters in the embedded beam material data set involve only the
bearing capacity (skin resistance and base resistance). Note that the material data set does NOT include the
stiffness response of the pile in the soil (or p-y curve). The stiffness response is the result of the pile length,
equivalent radius, stiffness and bearing capacity as well as the stiffness of the soil layers in which the beam is
located.

6.8 Material data sets for anchors
In addition to material data sets for soil and interfaces, the material properties and model parameters for
anchors are also entered in separate material data sets. A material data set for anchors may contain the
properties of node-to-node anchors as well as fixed-end anchors. In both cases the anchor is just a spring
element. A data set for anchors generally represents a certain type of anchor material, and can be assigned to the
corresponding (group of) anchor elements in the geometry model.
Anchors can be prestressed in a Staged construction calculation. In such a calculation the prestress force for a
certain calculation phase can directly be given in the Object explorer. The prestress force is not considered to be
a material property and is therefore not included in an anchor data set.
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6.8.1 Material set

Figure 221: Anchor window
Several data sets may be created to distinguish between different types of anchors. Figure 221 (on page 315)
shows the Anchor window. The material data set is defined by:
Identification
Comments
Colour
Material type

A user may specify any identification title for a data set. It is advisable to use a
meaningful name since the data set will appear in the database tree view by its
identification.
A user may write down comments related to the material data set.
Colour can be used as a distinction tool in the model.
There are three available options, describing the material type of an anchor. These
options are Elastic and Elastoplastic. The availability of the parameters defined in the
Properties box depends on the selected material type.

6.8.2 Properties
The properties required for anchors can be grouped into stiffness properties and strength properties in case of
elastoplastic behaviour.
Stiffness properties

PLAXIS

315

PLAXIS 3D-Reference Manual

Material properties and material database
Material data sets for anchors
An anchor requires only one stiffness parameter:
EA

Axial stiffness, entered per anchor in the unit of force.

Strength parameters: Elastoplastic
If the material type is selected as Elastoplastic, two maximum anchor forces can be entered:
Fmax,tens

Maximum tension force

Fmax,comp

Maximum compression force

The Force-displacement diagram displaying the elastoplastic behaviour of the anchors is given in Figure 222 (on
page 316).

Figure 222: The force-displacement diagram displaying the elastoplastic behaviour of anchors
In the same way as the stiffness, the maximum anchor forces are divided by the out-of-plane spacing in order to
obtain the proper maximum force in a plane strain analysis.
Strength parameters: Elastoplastic with residual strength
The Elastoplastic with residual strength option can be used to model anchor failure or softening behaviour (e.g.
buckling of struts). When this option is selected two residual anchor forces can be specified:
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Fmax,tens

Maximum tension force

Fmax,comp

Maximum compression force

Fresidual,tens

Residual tension force

Fresidual,comp

Residual compression force
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The Force-displacement diagram displaying the elastoplastic behaviour with residual strength of the anchors is
given in Figure 222 (on page 316).

Figure 223: The force-displacement diagram displaying the elastoplastic behaviour with residual strength of the
anchor
If, during a calculation, the maximum anchor force is reached, the maximum force will immediately reduce to the
residual force. From that point on the anchor force will not exceed the residual force anymore. Even if the anchor
force would intermediately reduce to lower values, the defined residual force will be its maximum limit.
Note that if the anchor has failed (in tension, compression or both) the residual force will be valid in the
following calculation phases where the anchor is active. If the anchor is deactivated in a phase and reactivated in
the next phase, the maximum anchor force will be restored, assuming that the anchor is a completely a new one.
Note: A reduced residual strength is not recommended to be used in Safety calculations.

6.9 Assigning material data sets to geometry components
After creating material data sets, the data sets must be assigned to the corresponding geometry components
(soil layers and structures). This can be done in different ways, which are explained below. The methods
described below are primarily meant to assign properties to the initial geometry. For details on the change of
properties during calculations in the framework of staged construction (Reassigning material data sets (on page
387)).

6.9.1 Soil layers
Regarding soil data, material data sets can be assigned to individual soil layers in the boreholes. Therefore a
borehole should be double-clicked to open the corresponding Modify soil layers window. In the Modify soil
layers click the plus button next to the soil layer. The Material dataset window pops up, where the properties
of the new material can be defined.
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Materials button at the lower right hand side of the window should be clicked to open the material database. To
assign a data set to a particular soil layer, select the desired data set from the material database tree view (click
on the data set and hold the left hand mouse button down), drag it to the soil column in the borehole window
(hold the mouse button down while moving) and drop it on the desired layer (release the mouse button). The
layer should now show the corresponding material data set colour. The drag and drop procedure should be
repeated until all layers have their appropriate data set. Note that material sets cannot be dragged directly from
the global database tree view and must be copied to the project database first.
When multiple boreholes are used it should be noted that assigning a data set to a layer in one particular
borehole will also influence the other boreholes, since all layers appear in all boreholes, except for layers with a
zero thickness.

6.9.2 Structures
Regarding structures (fixed-end anchors, beams, node-to-node anchors, embedded beams, plates, geogrids and
interfaces), there are three different methods of assigning material data sets.
• The first method is based on an open Material sets window, showing the created material sets in the project
database tree view. The desired material set can be dragged (select it and keep the left mouse button down)
to the drawing area and dropped on the desired component. It can be seen from the shape of the cursor
whether or not it is valid to drop the material set.
• The second method is to select the desired structure in the drawing area or the Model explorer and select the
desired material set from the Set material of the right hand mouse button menu.
• The third method is to select the desired structure in the drawing area or model explorer and use the
Material drop-down menu in the explorer to define the material data set.
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When the geometry modelling process is complete, one can proceed with the calculations. This consists of
generation of mesh and definition of the construction stages.
Generating a proper Finite Element mesh is an important intermediate step between the definitions of the
geometry and the construction stages. In order to have a smooth and accurate calculation the finite element
mesh has to fulfill several criteria. For the numerical stability of the calculation, the mesh should have a good
quality, that is to say, the elements should be regular without being excessively long and thin. For the accuracy of
the calculation, the elements should be small enough, especially in those areas where significant changes in
stress or strain can be expected during the analysis. But that does not mean one should just generate an entire
mesh of very small elements as this will lead to a very large calculation time. Therefore proper care should be
taken to find the right balance between accuracy and calculation time while supervising on the mesh quality.
In the engineering practice, a project is divided into project phases. Similarly, a calculation process in PLAXIS 3D
is also divided into calculation phases. Examples of calculation phases are the activation of a particular loading at
a certain time, the simulation of a construction stage, the introduction of a consolidation period, the calculation
of a safety factor, etc. Each calculation phase is generally divided into a number of calculation steps. This is
necessary because the non-linear behaviour of the soil requires loadings to be applied in small proportions
(called load steps). In most cases, however, it is sufficient to specify the situation that has to be reached at the
end of a calculation phase. Robust and automatic procedures in PLAXIS 3D will take care of the sub-division into
appropriate load steps.
The construction stages can be defined in the Flow conditions and Staged construction modes. The first
calculation phase (Initial phase) is always a calculation of the initial stress field for the initial geometry
configuration by means of Gravity loading or K0 procedure. Alternatively, it may be indicated that the
calculations only involve groundwater flow. After this initial phase, subsequent calculation phases may be
defined by the user. In each phase, the type of calculation must be selected.
For deformation calculations distinction is made between Plastic, Consolidation, Fully coupled flow-deformation,
Dynamic, Dynamic with consolidation or Safety calculation. The different types of calculations are explained in
Types of analysis (on page 327).

7.1 Mesh generation - Mesh mode
When the geometry model is fully defined the geometry has to be divided into finite elements in order to
perform finite element calculations. A composition of finite elements is called a mesh. The mesh is created in the
Mesh mode.
The mesh should be sufficiently fine to obtain accurate numerical results. On the other hand, very fine meshes
should be avoided since this will lead to excessive calculation times. The PLAXIS 3D program uses fully
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automatic generation of finite element meshes. The mesh generation process takes into account the soil
stratigraphy as well as all structural objects, loads and boundary conditions.

7.1.1 Elements
The basic soil elements of the 3D finite element mesh are the 10-node tetrahedral elements (Figure 224 (on page
320)).
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Figure 224: 3D soil elements (10-node tetrahedron)
In addition to the soil elements, special types of elements are used to model structural behaviour.
• For beams, 3-node line elements are used, which are compatible with the 3-node edges of a soil element.
• For plates and geogrids, 6-node plate and geogrid elements are used to simulate the behaviour.
• For soil-structure interaction, 12-node interface elements are used to simulate the behaviour.
The element formulations are given in the Scientific Manual.
To generate the mesh, click the Generate mesh button in the side toolbar of the Mesh mode or select the
corresponding option in the Mesh menu.
The Mesh options window pops up where the general mesh properties can be defined (Figure 225 (on page
320)). The options are explained in Global settings (on page 321), Local refinement (on page 322) and
Enhanced mesh refinements (EMR) (on page 322).

Figure 225: Mesh options window
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The mesh is generated by clicking on the OK button in the Mesh options window. After the mesh was generated,
the number of generated elements is displayed in the Session tab of the Command line.
To view the generated mesh click the View mesh button in the side toolbar.
Note:
Note that if meshing failed, the Session tab of the Command line might display the cause of the meshing failure,
where in the geometry this occurs and what needs to be done to overcome this. Even when the meshing
succeeds, the session history can still show some warnings on poor geometry and how this can be improved.

7.1.2 Global settings
The mesh generator requires a global meshing parameter le, which represents the target element dimension. In
PLAXIS 3D this parameter is calculated from the outer geometry dimensions (xmin, xmax, ymin, ymax, zmin, zmax) and
the Element distribution selected in the Mesh options window. The target element dimension is calculated using
the equation below.
le = re × 0.05 ×

( xmax

− xmin )2 + ( ymax − ymin )2 + (zmax − zmin )2

where the Relative element size factor (re) is derived from the Element distribution. There are five global levels.
By default, the Element distribution is set to Medium but the user may select one of the other levels to make the
mesh globally finer or coarser.
The predefined values of the parameter re (Element distribution) are:
Element distribution

re

Very coarse

2.0

Coarse

1.5

Medium

1.0

Fine

0.7

Very fine

0.5

Note:
Note that the Relative element size (re) does not correspond in value to the parameter value which is displayed in
the command line.
The exact number of elements depends on the shape of the geometry and optional local refinement settings.
As an alternative to the Element distribution, the mesh can be defined using Expert settings.
Relative element
size
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Element dimension

The target element dimension (le) as defined above.

The user specifies either the Relative element size or the Element dimension and the other one is then generated
automatically as described above.

7.1.3 Local refinement
In areas where large stress concentrations or large deformation gradients are expected, it is desirable to have a
more accurate (finer) finite element mesh, whereas other parts of the geometry might not require a fine mesh.
Such a situation often occurs when the geometry model includes edges or corners or structural objects.
Local refinement is based on a local coarseness factor that can be specified for each geometry entity. This factor
gives an indication of the relative element size with respect to the target element size as determined by the
Element distribution parameter. By default, the Coarseness factor value is set to 1.0 for most geometry entities
whereas this value is 0.5 for structural objects and loads. A Coarseness factor value of 0.5 reduces the element
size to half the target element size. The coarseness factor can be changed by selecting the geometry entity and
clicking on the Coarseness factor in the Selection explorer. Values in the range from 0.0625 to 8.0 are acceptable.
Using a value larger than 1.0 coarsens the mesh locally.
To locally refine the mesh either click the Refine mesh button and select the geometry entity (volume,
surface, line or point) where a finer mesh is required or right-click the geometry entity and select the Finer mesh
option from the appearing menu.
To locally coarsen the mesh by a factor of √2 click the Coarsen mesh button and select the geometry entity
(volume, surface, line or point) where a coarser mesh is required or right click the geometry entity and select the
Finer mesh option from the appearing menu.
To reset the local refinement in a geometry entity right click it either in the drawing area or in Selection
explorer and select the corresponding option from the appearing menu.
Note:
• In the Mesh mode, the colours indicating the material data sets are turned off and the whole model is shown
in gray. However, refined and coarsened objects are displayed in green and yellow respectively.
• The more the object is refined, the lighter the shade of green in which it is displayed.
• The more the object is coarsened, the lighter the shade of yellow in which it is displayed.

7.1.4 Enhanced mesh refinements (EMR)
To supply a good quality mesh for every geometry which also takes into account the necessary mesh refinement
around structural elements, loads and prescribed displacements, PLAXIS 3D will apply automatic mesh
refinements. To affect the behaviour of these automatic mesh refinements, three parameters can be modified.
The Enhanced mesh refinement parameters which can be applied are (Figure 225 (on page 320)):
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Global scale factor

This parameter can be used to set the element size smaller. For example, if it is set to
0.25, this means that all EMR calculated element sizes will be 25% of what they would
normally be, i.e. instead of generating one element along a line, four elements will be
generated. This will scale to 16 times more elements in 2D and even 64 times more
elements in 3D. Note that this scaling will only be notably visible in the mesh when EMR
is determining the size. Also note that this won't be taken into account for surface
curvature on a closed surface if this value is higher than 1, e.g. for a full cylinder you
don't want to have less refinement as required here to have ~6 elements around the
shaft of the cylinder) as otherwise it is not possible to create the mesh at all.

Minimum element
size factor

This parameter sets the lower limit for any coarseness. No element size will be smaller
than the minimum element size factor multiplied by the bounding box diagonal, except
when the coarseness comes from a surface curvature on a closed surface to ensure a
mesh.

<note ishcondition="product=PLX3D" id="GUID-E7BBF8DB-AC76-446D-86CC-C7D8E9FAF061"> <p
cid="F2X7Z"> The minimum allowed element size is <em>Minimum size factor</em> (see <xref href="GUIDB4D2107B-121D-453D-87D9-9068A36B639E" cid="1oyPqN"/>) multiplied by <em>Bounding box
diagonal</em> of the geometry being meshed. </p> </note>The third parameter is the proximity factor, which
can be set only from the command line, by adding this parameter value to the arguments of the mesh command.
_mesh 0.02 256 True 1.2 0.005 2.0
In this example the last value (2.0) is the proximity factor. Please see Help > Command reference for further info
on the arguments.
The Proximity factor affects the coarseness due to the length of edges, small distances in surfaces and small
distances in volumes.
Note:
The automatic refinement considered can be turned off by unchecking the Enhanced mesh refinements option in
the Mesh options window (Figure 225 (on page 320)).

7.2 Swept meshing
It is possible for some particular geometries to generate a swept mesh. A swept mesh starts at a source surface
and sweeps along to a specified destination surface following a given trajectory (the swept direction). The option
Swept meshing in the Mesh options window can be selected for that particular purpose. Swept mesh techniques
usually result in faster mesh creation as well as it uncouples the mesh size in the source surface from the
element size along the trajectory.
When using the swept meshing technique, PLAXIS will automatically detect volumes which are swept meshable
along with their corresponding front surface and trajectory. The front surfaces of the swept meshable volumes
will first be meshed. Then their volume meshes will be created by sweeping the initially meshed surfaces, using
the coarseness of the volume to compute the number of mesh slices along the trajectory. Only once all swept
meshable volumes have been meshed, PLAXIS will start considering the non-swept meshable volumes for
meshing. Note that neighboring swept meshable volumes should have the same coarseness to ensure consistent
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number of mesh slices along the trajectories. If not this will cause some volumes not being swept meshed despite
being topologically perfectly suited for such a meshing technique.
For more information visit t Bentley Communities - Swept Meshing in PLAXIS 3D.

7.3 Defining calculation phases
Finite element calculations can be divided into several sequential calculation phases. Each calculation phase
corresponds to a particular loading or construction stage. The construction stages can be defined in the Staged
construction mode. The calculation phases are listed in the Phases explorer.

7.3.1 Phases explorer
The phases defined in a project are displayed in the Phases explorer. The Phases explorer is accessible in the
Calculation modes. However, it is not editable in the Mesh mode. The general layout is shown in Figure 226 (on
page 324).

Figure 226: Phases explorer
Note:
Note that for a new project the initial phase is automatically added. It cannot be deleted. More information on
the initial phase is given in Initial stress generation (on page 328).

Toolbar
The buttons in the toolbar enable introducing new phases, removing phases and accessing the Phases window
where the settings of phases are defined.
To introduce a new calculation phase (a child phase), select a reference phase (parent phase) in the list and
click the Add phase button. A new phase is added under the parent phase.
To insert a new calculation phase before a selected one, click the Insert phase button. The inserted phase will
be the new parent phase for the phase selected before the insertion, whereas the original parent phase will
become the parent phase of the inserted phase.
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The user has to define the new settings for the inserted phase in a similar way as defining a new phase at the end
of the phase list. The phases have the settings of the parent phase unless they are defined differently. In this case
it is required that the next phase is fully redefined, since the start conditions have changed. This may also have
consequences for the phases thereafter.
To delete a calculation phase, select it and click the Delete phase button. Before deleting a phase it should be
checked which of the subsequent phases refer to the phase to be deleted. The parent of the deleted phase will be
automatically the new parent phase. Nevertheless, it is required that the modified phases are redefined, since
the start conditions have changed.
To define the phase settings either select the phase and click the Edit phase button or double click the phase.
The Phases window pops up (Phases window (on page 326)).
The Copy button enables copying to clipboard general information about the phase.
Besides the buttons available in the Phases explorer, the right mouse button menu can be used to modify the
phases in the model (Figure 227 (on page 325)).

Figure 227: The expanded view of the right mouse menu of Phases explorer

Calculation state indication
The calculation state of a phase is indicated by the symbol at the beginning of each line in the Phases explorer.
•

The phase is to be calculated.

•

The phase is not to be calculated.

•

The phase was calculated. No error occurred during calculation.

•

The phase was calculated but an assumption is made by the program enabling the continuation of the
calculation. Information is provided in the Log info for last calculation step box in the Phases window.

•

The calculation failed. Information is provided in the Log info for last calculation step box in the Phases
window.

•

The calculation failed, but the calculation of the child phases is still possible. Information is provided in
the Log info for last calculation box in the Phases window.
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Phase identification
The ID of the phases is displayed in the Phases explorer. The ID of the phase consist of the caption and the name
(part inside the square brackets). The name of the phases is determined consecutively by the program and it can
not be modified by the user. The user may redefine the caption part of the ID of the phase in the Phases window
(General phase parameters (on page 355)).

Calculation type indication
The Calculation type, the Loading type and the Pore pressure calculation type are indicated by the corresponding
icons next to the phase ID in the Phases explorer. More information is given in Types of analysis (on page 327),
Loading type (on page 344) and Water pressure calculation (on page 348) respectively.

7.3.2 Order of calculation phases
The order of calculation phases is defined either by selecting the reference phase (parent phase) first and then
adding a phase, or selecting the reference phase in the Start from phase drop-down menu in the Phases window.
By default, the previous phase is selected as parent phase. Note that a phase that appears later in the phase list
cannot be selected.

Special cases
In some special cases, the order of calculation phases is not straightforward. Examples of such cases are:
• The Initial phase may be selected more than once as reference if different loadings or loading sequences are
to be considered separately for the same project.
• For a certain situation, a load is increased until failure to determine the safety margin. When continuing the
construction process, the next phase should start from the previous construction stage rather than from the
failure situation.
• A third example where the phase ordering is not straightforward is in calculations where safety analysis for
intermediate construction stages is considered. The calculation type in this case is Safety. In general, such a
phase results in a state of failure. When continuing the construction process, the next stage should start from
the previous phase rather than from the results of the safety analysis. Alternatively, safety analyses for the
various construction stages can be performed at the end of the calculation process. In that case, the reference
phase selected in the Start from phase drop-down menu should refer to the corresponding construction stage.

7.3.3 Phases window
Each calculation involves a number of parameters that control the calculation process. These parameters are
listed and can be edited in the Phases window (Calculation control parameters (on page 355)). The Phases
window can be opened by double clicking a phase in the Phases explorer or clicking the Edit phase button.
There are two possible views to display information in the Phases window. The view of the phases window can
be selected by clicking the icon next to the Copy button in the Phases window. The icon will change according to
the selected view.
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The information in the Phases window is displayed in three separate panels (Figure 228 (on page 327)). In
the left panel the Phases explorer is displayed giving an overview of all the phases in the model and the relation
between them. The middle panel displays information regarding the selected phase in the Model explorer. The
right panel displays log info for the last calculation of the selected phase and provides space to write comments.

Figure 228: Three panel view of the Phases window
The Spreadsheet view displays all the calculation information in a spreadsheet form (Figure 229 (on page
327)) to facilitate a comparison of parameters for different phases. Parameters can be added or removed from
the view by right-clicking on the bar with column header.

Figure 229: Spreadsheet view of the Phases window
In the Phases window, users need to select at least the Calculation type and the Loading type for each new phase.
PLAXIS 3D provides convenient default values for most calculation control parameters, but the user can change
these values. A description of the calculation types and control parameters is given in the next section.

7.4 Types of analysis
The first step in a PLAXIS 3D analysis is defining a calculation type of a phase in the Calculation type drop-down
menu in the Phases window. The options available are K0 procedure and Gravity loading for the initial phase to
generate the initial stress state of soil. The Flow only option can be used only if groundwater flow analysis will be
performed. For deformation analysis options such as Plastic, Consolidation, Safety, Dynamic, Dynamic with
consolidation and Fully coupled flow-deformation are available.
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7.4.1 Initial stress generation
Many analysis problems in geotechnical engineering require the specification of a set of initial stresses. The
initial stresses in a soil body are influenced by the weight of the material and the history of its formation. This
stress state is usually characterised by an initial vertical effective stress (σ'v,0). The initial horizontal effective
stress σ'h,0 is related to the initial vertical effective stress by the coefficient of lateral earth pressure
K 0 (σ ′ h ,0 = K 0 ⋅ σ ′ v,0 ) .
In PLAXIS 3D, initial stresses may be generated by using the K0 procedure, the Gravity loading or the Field stress
option. Note that these options are available in the Calculation type drop-down menu only for the Initial phase. It
is recommended to generate and inspect results from initial stresses first before defining and executing other
calculation phases.
Note:
The K0 procedure differs from the Gravity loading as stress field equilibrium is not checked at the end of the
initial phase. The K0 procedure is particularly suitable in cases with a horizontal surface and with all soil layers
and phreatic levels parallel to the surface. In such a case, the equilibrium is systematically satisfied (vertical
stresses = gravity weight, horizontal stresses = lateral reaction forces along the model boundaries). For all other
cases, the use of the K0 procedure may lead to out-of-balance forces.
The initial stress state may involve pre-loading or over-consolidation. In particular, advanced soil models may
take the effects of over-consolidation into account. This requires information about the over-consolidation ratio
(OCR) or the pre-overburden pressure (POP). Such information may be provided in the material data set of the
corresponding soil layer.
As part of the initial stress generation, the principal stress history parameter σ'1,max is initialised. The principal
stress history (σ'1,max, σ'2, σ'3) is used to calculate the equivalent preconsolidation pressure ppeq, which is used in
advanced soil models to initialise a cap-type yield surface.
For more information about the calculation of σ'1,max, see Initial tabsheet (on page 264).

K0 procedure
K0 procedure is a special calculation method available in PLAXIS 3D to define the initial stresses for the
model, taking into account the loading history of the soil. The parameters required in the initial stresses
development procedures are defined in the Initial tabsheet of material data sets for soil and interfaces (Initial
tabsheet (on page 264)).
Two K0 values can be specified, one for the x-direction and one for the y-direction.
K 0,x = σ ′

xx

/ σ ′ zz

K 0, y = σ ′

yy

/ σ ′ zz

Eq. [75]

In practice, the value of K0 for a normally consolidated soil is often assumed to be related to the friction angle by
Jaky's empirical expression:
K 0 = 1 − sin φ

Eq. [76]

In an over-consolidated soil, K0 would be expected to be larger than the value given by this expression.
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For the Mohr-Coulomb model, the default value K0-value is based on Jaky's formula. For the advanced models,
(Hardening Soil model, Hardening Soil model with small-strain stiffness, Soft Soil model, Soft Soil Creep model,
Modified Cam-Clay model), the default value is based on the K0nc parameter and is also influenced by the
overconsolidation ratio (OCR) or the pre-overburden pressure (POP) (see Initial tabsheet (on page 264) and the
Material Models Manual):

K 0,x = K 0, y = K 0nc OCR −

νur
1 − νur

(OCR − 1) +

K 0nc POP −

νur
POP
1 − νur

| σzz0 |

Eq. [77]

Using very low or very high K0-values in the K0 procedure may lead to stresses that violate the Mohr-Coulomb
failure condition. In this case PLAXIS 3D automatically reduces the lateral stresses such that the failure condition
is obeyed. Hence, these stress points are in a plastic state and indicated as plastic points. Although the corrected
stress state obeys the failure condition, it may result in a stress field which is not in equilibrium. It is generally
preferable to generate an initial stress field that does not contain Mohr-Coulomb plastic points.
Note:
The plot of plastic points may be viewed after the presentation of the initial effective stresses in the Output
program by selecting the Plastic points option from the Stresses menu (see Plastic points (on page 458)).
For a cohesionless material it can easily be shown that to avoid Mohr-Coulomb plasticity, the value of K0 is
bound by:
1 − sin φ
1 + sin φ

< K0 <

1 + sin φ
1 − sin φ

Eq. [78]

When the K0 procedure is adopted, PLAXIS 3D will generate vertical stresses that are in equilibrium with the
self-weight of the soil. Horizontal stresses, however, are calculated from the specified value of K0. Even if the
value of K0 is chosen such that plasticity does not occur, the K0 procedure does not ensure that the complete
stress field is in equilibrium, since it does not generate shear stresses. Full equilibrium is only obtained for a
horizontal soil surface with any soil layers parallel to this surface and a horizontal phreatic level. Therefore, the
K0 procedure is not recommended when dealing with non-horizontal surfaces, which require shear stresses to
form an equilibrium stress field. Examples of non-horizontal surfaces, and non-horizontal weight stratifications
are:

If the stress field requires only small equilibrium corrections, then these may be carried out using the K0
procedure followed by a Plastic nil-phase (Plastic nil-phase (on page 333)). If the stresses are substantially out of
equilibrium, then the K0 procedure should be abandoned in favor of the Gravity loading procedure.
At the end of the K0 procedure, the full soil weight is activated (when ΣMweight = 1.0).

Field stress
In addition to K0-procedure and Gravity loading there is another method to introduce an initial stress field in
the model, which is called Field stress. This option is available only for the Initial phase and can be selected as a
Calculation type in the phases window.

PLAXIS

329

PLAXIS 3D-Reference Manual

Meshing and calculation
Types of analysis
Field stress allows for setting up a homogeneous initial stress state in the model, taking into account a rotation of
principal stresses. This might be relevant for applications in deep soil or rock layers where the formation of
these layers in the geological history has caused a rotation of principal stresses (shearing).
In addition to the selection of Field stress as Calculation type for the initial phase, the user needs to define the
magnitude of the three principal stresses σ1, σ2, σ3, as well as the orientation of the principal stress directions
(Axis1 and Axis2), see Figure 230 (on page 330). Axis2 internally will be adjusted to create an orthogonal
reference frame: (Axis1, Axis2, Axis3). Axis3 is perpendicular to Axis1 and (adjusted) Axis2. All axes are internally
set to unit length.
Note: Compression is negative.
The principal stresses do not need to be ordered in the sense that σ1 is the major principal stress and σ3 is the
minor principal stress. Moreover, the (x,y and z) coefficients of the orientation axis do not need to form a vector
of unit length.

Figure 230: Field stress in Model explorer
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As an alternative to the global definition of the field stress in the Model conditions, the user may define local
field stress conditions in each soil polygon (cluster). To do so, in Soil mode, right click on the soil polygon. From
the context menu choose Soil_n > Create > Create field stress. Selecting this option displays ClusterFieldStress in
the selection explorer. Here the user needs to define the magnitude of the three principal stresses σ1, σ2, σ3, as
well as the orientation of the principal stress directions (Axis1 and Axis2) for the respective cluster. This option
of defining different stress states to individual clusters might be relevant for applications in rock layers with
disturbance zones where the weaker material may have a different initial stress state than the rock mass outside
the disturbance zone.
Note that, after applying the Field stress initial calculation the user will still need to apply nil-phase in order to
solve any unbalance in the model to get the correct initial stress state.
The calculation type Field stress does not consider the increase of stresses with depth due to gravity. Therefore,
the ΣMweight multiplier is always set to zero in the case that the initial stress state is generated using the Field
stress option. Still, nonzero unit weights may be defined in material data sets that are used in the soil/rock
clusters. A proper unit weight may be required in order to generate the right mass and inertia in the case of
dynamic calculations. Note that calculation phases that follow after a Field stress calculation should also have
ΣMweight = 0 in order to prevent a sudden unbalance from occurring.
Besides the input of field stresses, all model boundaries need to be fully fixed. Therefore, the user must manually
set all global model boundaries (BoundaryXMin, BoundaryXMax, BoundaryYMin, BoundaryYMax, BoundaryZMin
and BoundaryZMax) to Fully fixed in the Deformations section of the Model explorer. Note that the Field stress
option may generate shear stresses, which cannot be supported by the default boundary conditions; this is why
the model boundaries must be fixed.
The result of a field stress calculation is a stress state according to the predefined principal stresses and the
orientation of the principal stress directions according to the Axis1 and Axis2 parameters (Figure 231 (on page
331)). This stress state is not only generated in volume elements, but a corresponding stress state is also
generated in interface elements, if applicable. Note that the Field stress option does not affect structural
elements, and it will not take into account external loads and boundary conditions, just as the K0-procedure.
Hence, structural elements and external loads should be inactive in the Initial phase.

Figure 231: Initial stress generation using Field stress calculation

PLAXIS

331

PLAXIS 3D-Reference Manual

Meshing and calculation
Types of analysis

Gravity loading
Gravity loading is a type of Plastic calculation (Plastic calculation (on page 333)), in which initial stresses
are generated based on the volumetric weight of the soil. If Gravity loading is adopted, then the initial stresses
are set up by applying the soil self-weight in the first calculation phase. This is achieved by setting ΣMweight =
1.0. In this case, when using an elastic perfectly-plastic soil model such as the Mohr-Coulomb model, the ratio of
horizontal effective stress over vertical effective stress, K0, depends strongly on the assumed values of Poisson's
ratio. It is important to choose values of Poisson's ratio that give realistic values of K0. If necessary, separate
material data sets may be used with Poisson's ratio adjusted to provide the proper K0-value during gravity
loading. These sets may be changed by other material sets in subsequent calculations (Reassigning material data
sets (on page 387)). For one-dimensional compression an elastic computation will give:
K0 =

ν
1−ν

Eq. [79]

If a value of K0 of 0.5 is required, for example, then it is necessary to specify a value of Poisson's ratio of 0.333. As
Poisson's ratio must be lower than 0.5, it is not straightforward to generate K0 values larger than 1 using Gravity
loading. If K0 values larger than 1 are desired, it is necessary to simulate the loading history and use different
Poisson's ratios for loading and unloading or use the K0 procedure.
When advanced soil models are used, the resulting K0-value after gravity loading corresponds to the K0nc
parameter in the material data set.
Note:
• To make sure that Gravity loading results in initial effective stresses in situations where undrained materials
are used, the parameter Ignore undrained behaviour should be selected.
• Once the initial stresses have been set up using Gravity loading, the displacements should be reset to zero at
the start of the next calculation phase. This removes the effect of the initial stress generation procedure on
the displacements developed during subsequent calculations, whereas the stresses remain.
• The OCR and POP parameters are ignored in Gravity loading.
In some cases plastic points will be generated during the Gravity loading procedure. For cohesionless soils in
one-dimensional compression, for example, plastic Mohr-Coulomb points will be generated unless the following
inequality is satisfied:
1 − sin φ
1 + sin φ

<

ν
1−ν

<1

Eq. [80]

Results of initial stress generation
After the generation of initial stresses the plot of the initial effective stresses can be inspected (Accessing the
Output program (on page 420)). It is also useful to view the plot of plastic points.
Using K0 values that differ substantially from unity may sometimes lead to an initial stress state that violates the
Mohr-Coulomb criterion. If the plot of the plastic points shows many red plastic points (Mohr-Coulomb points),
the value of K0 should be chosen closer to 1.0.
If there are a small number of plastic points, it is advisable to perform a plastic nil-phase. When using the
Hardening Soil model and defining a normally consolidated initial stress state (OCR = 1.0 and POP = 0.0), the plot
of plastic points shows many hardening points. Users need not be concerned about these plastic points as they
just indicate a normally consolidated stress state.
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Flow only
This option allows pure groundwater flow calculations under saturated and unsaturated conditions. This option
can only be selected for the Inital phase. Note that selection of this option effects the following phases as well.
The calculation type for the following phases will be automatically set to Flow only. The Calculation type option is
grayed out indicating that no change is possible. Note that it is not possible to define Flow only phases if the
Calculation type of the initial phase is not specified as such.
When the Flow only option is selected for the initial phase only the Steady state groundwater flow option is
available for Pore pressure calculation type.

Plastic nil-phase
If the K0 procedure generates an initial stress field that is not in equilibrium or where Mohr-Coulomb plastic
points occur, then a plastic nil-phase should be adopted. A plastic nil-phase is a plastic calculation phase in which
no additional load is applied (Plastic nil-phase (on page 342)). After this phase has been completed, the stress
field will be in equilibrium and all stresses will obey the failure condition.
If the initial K0 procedure generates a stress field that is far from equilibrium, then the plastic nil-phase may fail
to converge. This happens, for example, when the K0 procedure is applied to problems with very steep slopes.
For these problems, the Gravity loading procedure should be adopted.
It is important to ensure that displacements calculated during a plastic nil-sphase (if it is applied immediately
after generating the initial stresses) do not affect later calculations. This is achieved by selecting the Reset
displacements to zero parameter in the subsequent calculation phase (Deformation control parameters (on page
357)).

7.4.2 Plastic calculation
A Plastic calculation is used to carry out an elastic-plastic deformation analysis in which it is not necessary
to take the change of pore pressure with time into account. If the Updated mesh parameter has not been selected,
the calculation is performed according to the small deformation theory. The stiffness matrix in a normal plastic
calculation is based on the original undeformed geometry. This type of calculation is appropriate in most
practical geotechnical applications.
Although a time interval can be specified, a plastic calculation does not take time effects into account, except
when the Soft Soil Creep model is used (see Material Models Manual). Considering the quick loading of saturated
clay-type soils, a Plastic calculation may be used for the limiting case of fully undrained behaviour using the
Undrained (A), Undrained (B) or Undrained (C) option in the material data sets. On the other hand, performing a
fully drained analysis can assess the settlements on the long term. This will give a reasonably accurate
prediction of the final situation, although the precise loading history is not followed and the process of
consolidation is not dealt with explicitly.
An elastic-plastic deformation analysis where undrained behaviour (Undrained (A) or Undrained (B)) is
temporarily ignored can be defined by checking the Ignore undr. behaviour (A, B) parameter. In this case the
stiffness of water is not taken into account.
Note that Ignore undrained behaviour does not affect materials of which the drainage type is set to Undrained (C).
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When changing the geometry configuration (Geometry configuration - Staged Construction mode (on page
381)) it is also possible (for each calculation phase) to redefine the water boundary conditions and recalculate
the pore pressures (Flow conditions (on page 373)). For more details on theoretical formulations of a plastic
calculation reference should be made to the Scientific Manual.
In a Plastic calculation loading can be defined in the sense of changing the load combination, stress state, weight,
strength or stiffness of elements, activated by changing the load and geometry configuration or pore pressure
distribution by means of Staged construction. In this case, the total load level that is to be reached at the end of
the calculation phase is defined by specifying a new geometry and load configuration, and/or pore pressure
distribution, in the Staged construction mode (Geometry configuration - Staged Construction mode (on page
381)).
The options for Pore pressure calculation type for a Plastic phase are:
• Phreatic
• Use pressures form previous phase
• Steady state groundwater flow
More information on Pore pressure calculation type is given in Water pressure calculation (on page 348).

7.4.3 Consolidation calculation
A Consolidation calculation is usually conducted when it is necessary to analyse the development and
dissipation of excess pore pressures in a saturated clay-type soil as a function of time. PLAXIS 3D allows for true
elastic-plastic consolidation analysis. In general, consolidation analysis without additional loading is performed
after an undrained plastic calculation. It is also possible to apply loads during a consolidation analysis. However,
take care when a failure situation is approached, since the iteration process may not converge in such a
situation.
A consolidation analysis requires additional boundary conditions on excess pore pressures (Flow conditions (on
page 373)).
Note:
• In PLAXIS 3D, pore pressures are divided into steady-state pore pressures and excess pore pressures. Steady
state pore pressures are generated according to the water conditions assigned to the soil layers for each
phase, whereas excess pore pressures are calculated as a result of undrained soil behaviour (Undrained (A)
or Undrained (B)) or consolidation. A Consolidation calculation in PLAXIS 3D only affects the excess pore
pressures.
• Rather than considering the drainage type settings Undrained (A) or Undrained (B), a Consolidation
calculation considers the corresponding permeabilities as defined in the Groundwater tab of the material
data set instead.
• A Consolidation calculation does not affect Undrained (C) materials since such materials do not allow (excess)
pore pressures to be generated.
In a Consolidation analysis, the following options are available:
Consolidation and simultaneous loading in the sense of changing the load combination, stress state, weight,
strength or stiffness of elements, activated by changing the load and geometry configuration by means of Staged
construction. It is necessary to specify a value for the Time interval parameter, which has in this case the meaning
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of the total consolidation period applied in the current calculation phase. The load is linearly increased to the
specified level within the time interval. The applied first time increment is based on the First time step parameter
in the Numerical control parameters subtree. The Staged construction option should also be selected if it is
desired to allow for a certain consolidation period without additional loading.
Consolidation without additional loading, until all excess pore pressures have decreased below a certain
minimum value, specified by the Minimum excess pore pressures parameter. By default, the Minimum excess pore
pressures is set to 1 stress unit, but this value may be changed by the user. Please note that the Minimum excess
pore pressures parameter is an absolute value, which applies to pressure as well as tensile stress. The input of a
Time interval is not applicable in this case, since it cannot be determined beforehand how much time is needed
to fulfill the minimum excess pore pressure requirement. The applied first time increment is based on the First
time step parameter in the Numerical control parameters subtree.
Consolidation without additional loading, until a desired degree of consolidation, specified by the Degree of
consolidation parameter, is reached. By default, Degree of consolidation parameter is set to 90.0 %, but this value
may be changed by the user. The input of a Time interval is not applicable in this case, since it cannot be
determined beforehand how much time is needed to fulfill the degree of consolidation requirement. The applied
first time increment is based on the First time step parameter in the Numerical control parameters subtree.
Note:
Although the degree-of-consolidation is officially defined in terms of target settlement over final settlement, in
PLAXIS 3D it is defined as the target minimum excess pore pressure over the maximum initial excess pore
pressure pmax/pmax,initial.

7.4.4 Fully coupled flow-deformation analysis
A Fully coupled flow-deformation analysis is conducted when it is necessary to analyse the simultaneous
development of deformations and pore pressures in saturated and partially saturated soils as a result of timedependent changes of the hydraulic boundary conditions. Examples where a fully coupled flow-deformation
analysis may be required include draw down of the reservoir level behind a dam, embankment dams subjected
to tidal waves and partially drained excavation and dewatering of a building site. In contrast to a consolidation
analysis, which primarily affects the excess pore pressures, a fully coupled flow-deformation analysis directly
operates on the total pore water pressures, i.e. the sum of steady-state and excess pore pressures. Still, in order
to be consistent with other calculation types, steady-state pore pressures are calculated based on the hydraulic
conditions at the end of the calculation phase, which enables the back-calculation of excess pore pressures from
the total pore water pressures.
A fully coupled flow-deformation analysis takes into account unsaturated soil behaviour and suction in the
unsaturated zone above the phreatic level. This is the most advanced and realistic type of analysis that considers
a reduced permeability and degree of saturation in unsaturated zone. For this reason, the Ignore suction option
is not available in Fully coupled flow-deformation analysis.
In principle, a fully coupled flow-deformation analysis takes into account unsaturated soil behaviour and suction
in the unsaturated zone above the phreatic level. However, positive pore stresses in the unsaturated zone may
be restricted by using the Ignore suction option.
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Note:
It is not possible to use Updated mesh in a fully coupled flow-deformation analysis.

7.4.5 Safety calculation (phi/c reduction)
The Safety calculation type is an option available in PLAXIS 3D to compute global safety factors. This option
can be selected as a separate Calculation type in the General tabsheet.
In the Safety approach the shear strength parameters tan φ and c of the soil as well as the tensile strength are
successively reduced until failure of the structure occurs. The dilatancy angle ψ is, in principle, not affected by
the phi/c reduction procedure. However, the dilatancy angle can never be larger than the friction angle. When
the friction angle φ has reduced so much that it becomes equal to the (given) dilatancy angle, any further
reduction of the friction angle will lead to the same reduction of the dilatancy angle. The strength of interfaces, if
used, is reduced in the same way. Optionally, the strength of structural objects like plates and anchors can also
be reduced in a Safety calculation (Enhanced safety analysis (on page 338)).
The total multiplier ΣMsf is used to define the value of the soil strength parameters at a given stage in the
analysis:
ΣMsf =

tan φinput
tan φreduced

=

cinput
creduced

=

su,input
su,reduced

=

Tensile strength
Tensile strength

input

reduced

Eq. [81]

where the strength parameters with the subscript 'input' refer to the properties entered in the material sets and
parameters with the subscript 'reduced' refer to the reduced values used in the analysis. Σ Msf is set to 1.0 at the
start of a calculation to set all material strengths to their input values.
A Safety calculation is performed using the Load advancement number of steps procedure (Load advancement Number of steps (on page 353)). The incremental multiplier Msf is used to specify the increment of the strength
reduction of the first calculation step. This increment is by default set to 0.1, which is generally found to be a
good starting value. The strength parameters are successively reduced automatically until all Additional steps
have been performed. By default, the number of steps is set to 100, but a larger value up to 10000 may be given
here, if necessary. It must always be checked whether the final step has resulted in a fully developed failure
mechanism. If that is the case, the factor of safety is given by:
SF =

available stregth
stregth at failure

= value of ΣMsf at failure

Eq. [82]

The principal results of a Safety calculation are the failure mechanism and the corresponding ΣMsf, which is the
safety factor. The ΣMsf-value of a particular calculation step can be found in the Calculation information
window displayed as the corresponding option is selected in the Project menu of the Output program. It is also
recommended to view the development of ΣMsf for the whole calculation using the Curves option (Curves (on
page 479)). In this way it can be checked whether a constant value is obtained while the deformation is
continuing; in other words: whether a failure mechanism has fully developed. If a failure mechanism has not
fully developed, then the calculation must be repeated with a larger number of steps.
Note:
The numerical parameters defined in the Numerical control parameters subtree are not supposed to have
significant influence on the principal results of the Safety calculation. However, in Safety calculations involving
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safety factors close to 1, other outputs (e.g. internal forces of the structures) could be sensitive to the numerical
parameters, especially to the Desired min number of iterations and the Desired max number of iterations.
To capture the failure of the structure accurately, the use of Arc-length control parameter is required. The use of
a Tolerated error of no more than 1% is also required. Both requirements are complied with when using the
default iteration parameters (Numerical control parameters (on page 361)).
Note:
• When performing Safety calculation without Arc-length control, the reduction factor ΣMsf cannot go down
and an overestimation of safety factor can occur.
• To capture the failure of the structure accurately, a sufficiently fine mesh is required.
When using Safety calculation in combination with advanced soil models, these models will actually behave as a
standard Mohr-Coulomb model, since stress-dependent stiffness behaviour and hardening effects are excluded
from the analysis. In that case, the stiffness is calculated at the beginning of the calculation phase based on the
starting stresses and kept constant until the calculation phase is complete.
Note:
• In case of the Joined Rock model the strength on all the planes will be reduced by ΣMsf.
• In the case of the NGI-ADP model and UDCAM-S model, all undrained strength parameters are reduced by
ΣMsf.
• Strength in the Modified Cam-Clay model is not reduced in Safety analysis.
• When using the Modified Cam-Clay model the strength is not reduced at all since this model does not have a
cohesion or friction angle as model parameter. In other the reduction of the parameter values need to be
explicitly defined in their code.
The strength reduction method, as adopted in a Safety calculation, gives similar safety factors as obtained from
conventional stability analysis based on the Limit Equilibrium Method (LEM) slip-circle analysis. For a more
detailed description of the strength reduction method (formerly called phi-c reduction) you are referred to
Brinkgreve & Bakker (1991) (on page 508).
Note:
A more realistic value of the safety factor will be obtained for a Fully coupled flow-deformation analysis when
suction is considered. This value is generally higher than a conventional safety factor ignoring suction.
Therefore, be careful when interpreting this value.
Note:
In general, it is not recommended to perform a Safety analysis in combination with structural elements in which
a residual strength is used. During a safety analysis in which structural elements are present in the model, there
is a redistribution of the stresses and forces, generally leading to an increase in structural forces. When the
strength of a structure is reached, and the structure has a residual strength lower than the normal strength, the
structural force will reduce to the residual strength. This may lead to an unstable situation and, as a result, an
unrealistic reduction of the factor of safety.
In a Safety calculation the following options are available:
•
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•

A Safety analysis is performed by reducing the strength parameters until a target value of the total
multiplier ΣMsf is reached. The program will first try to find a safe value (above the target value) then it will
return to the last step before passing the target and will do a last step to reach the target.

Enhanced safety analysis
For a Safety calculation, all soil clusters and interfaces are taken into account automatically. Enhanced safety
analysis makes it possible to apply strength reduction to soil clusters as well as structures. Moreover, Enhanced
safety analysis enables to exclude particular soil clusters or structures from the strength reduction procedure.
Safety calculations are controlled by the multiplier for strength reduction, ΣMsf. The purposes for the Enhanced
safety can be the following:
• Surficial soil clusters along a slope can be excluded from the strength reduction procedure to avoid
unrealistic shallow failure mechanisms.
• Along with the soil clusters, all structures can be selected for strength reduction, provided these structures
behave as elastoplastic and have a limit strength.
• Enhanced safety analysis can be performed for a deliberate manual selection of certain soil clusters or
structures for different phases.

Figure 232: Enhanced safety for soil clusters

Figure 233: Enhanced safety for structures
Note:
Regarding structures, note that strength reduction can be applied only to Elastoplastic structures. Make sure that
realistic mechanisms are not prevented in this way.
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Soil clusters that have been excluded from the strength reduction procedure are indicated in grey in the
Connectivity plot, provided that the Hide items without strength reduction in the View menu has been selected
(Connectivity plot (on page 444)). Moreover, if this option has been selected, results are not shown in these
clusters.
Note:
By performing a standard Safety calculation, unrealistic surficial mechanisms can be detected. An Enhanced
safety calculation can be performed by de-selecting the surficial clusters.

Strength factorization in the Hoek-Brown model
When using the Hoek-Brown model to describe the behaviour of a rock section, the Safety calculation procedure
is slightly modified, since the failure contour is not described by the Mohr-Coulomb criterion anymore. In order
to have an equivalent definition of a safety factor as for the Mohr-Coulomb model, the Hoek-Brown yield
function is reformulated to include the strength reduction factor ΣMsf for safety analyses:
f HB = σ ′ 1 − σ ′ 3 + f̄ red (σ ′ 3)

Eq. [83]

with
f̄ red =

f̄
η

σci
η
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a

Eq. [84]
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Eq. [85]

where
f̄ ′ =

∂ f̄
∂σ ′ 3

(
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σci

+s

)

a−1

Eq. [86]

More details and a derivation of the above equations can be found in Benz, Schwab, Vermeer & Kauther (2007)
(on page 508).
Note:
Note that the safety factor obtained for Hoek-Brown material does not correspond to the safety factor obtained
for Mohr-Coulomb material with equivalent strength properties.

Updated mesh
The geometry of the model considered in a Safety calculation depends on whether the Updated mesh option is
selected or not in the parent phase. If the mesh is updated, the resulting geometry at the end of the parent phase
will be considered in the safety calculations.
During a safety calculation the mesh is not updated at the beginning of each load step even if the Updated mesh
option is selected for the Safety phase.
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7.4.6 Dynamic calculation
The Dynamic option should be selected when it is necessary to consider stress waves and vibrations in the
soil. Dynamic loads can come in various types such as machine induced loads, impact loads, blast load, moving
vehicle load or as earthquake loads. With PLAXIS 3D it is possible to perform a dynamic analysis for these types
of loads after a series of plastic calculations. It is possible to apply dynamic loads through displacement
multipliers or load multipliers. They can be defined as harmonic or as input table. The applied dynamic load is
the product of the input value of the defined dynamic load and the corresponding dynamic load multiplier.
Besides the activation of the dynamic load or dynamic prescribed displacement, special absorbent boundary
conditions can be defined for a Dynamic calculation. For a more detailed description of the boundary conditions,
see Model conditions (on page 389). A Dynamic time interval can be defined to specify the calculation duration
and an automatic time stepping scheme (see Automatic time stepping (on page 354)) takes care of the best
combination of Max steps and Number of sub-steps, based on the estimated time steps.

Free vibration analysis
The possible vibrations of a system that occur when an existing static load is released can be analysed by
performing a free vibration analysis. A free vibration analysis can be performed in a Dynamic calculation which
can be used to determine the natural frequencies of a soil block or structure. To perform a free vibration analysis
initially a plastic analysis is conducted with prescribed loads or displacements. This is followed by a dynamic
phase in which the active static external load in the previous calculation phase is released (deactivated). Natural
frequencies can be estimated by means of a power spectral density plot generated through output.

Earthquake Analysis
This section provides an overview of the Geotechnical earthquake modelling and analysis capabilities of PLAXIS.
A variety of nonlinear native and UDSM models for earthquake analysis are offered in PLAXIS. In general, all
native models offered in PLAXIS can be used in combination with Dynamic analysis. However, the user is
expected to know the limitations of each of the models being used. Here are some models which are often used
in combination with Seismic analysis. HSsmall and its UDSM version GHS can simulate strain dependency of
stiffness and hysteretic damping. UBC3D-PLM (native) and PM4Sand (UDSM) are liquefaction models available
in PLAXIS for which the parameters can be estimated from SPT or CPT data in the absence of lab tests.
Processing and modification of input accelerograms are a key component of earthquake analysis. Options are
available in the dynamic multiplier tab ( Input accelerograms (on page 130)) to scale the signal to the required
PGA. Furthermore, the input accelerograms can be easily transformed and visualized as Fourier amplitude
spectrum, Power spectrum, PSA as well as Arias Intensity. A drift correction to correct the displacement drift
due to instrument noise or background noise can also be applied automatically during a dynamic calculation.
Special boundary conditions (Model conditions (on page 389)) are required for earthquake motion in order to
minimize wave reflection at model boundaries. The compliant base boundary condition for the bottom boundary
ensures that reflected waves from layers above are absorbed and allows direct application of an input (upward
propagating) accelerogram. Free field boundary conditions for lateral boundaries impose free-field motion at the
sides, additionally it absorbs the reflected secondary waves. Tied degrees of freedom connects the nodes on the
same elevation at left and right boundaries, which can be used to simulate one-dimensional wave propagation.
Energy dissipation due to vibrational or cyclic loading can be defined through Damping. PLAXIS offers both
hysteretic and viscous material damping, as well as numerical damping. Hysteretic damping is inherent to the
HSsmall model, whereas, Rayleigh damping is a numerical feature to simulate viscous material damping, which
can be applied in each individual material data set. Numerical damping can be imposed by changing the default
Newmark alpha and beta parameters (Dynamic control parameters (on page 372)). Dynamic calculations can be
conducted as drained, undrained or as Dynamic with consolidation. Automatic time stepping (Automatic time
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stepping (on page 354)) scheme allows for a proper selection of the time step to accurately model wave
propagation and reduce the numerical error due to integration of time history functions. The user can also
control the number of steps using the semi-automatic or Manual option for accurate modelling.
Curves in Dynamic calculations (on page 485) explains output curves generation options for dynamic analysis. It
is possible to transform the generated curves from the time domain to the frequency domain automatically using
Fast Fourier Transform (FFT). From FFT, Power Spectrum and Fourier Amplitude Spectrum(FAS) can be plotted
for each acceleration component. From output curves it is possible to produce PSA spectrum to determine the
predominant period as well as Relative displacement response spectrum, Amplification factor that displays the
magnification of the response at a point with respect to the given excitation, and Arias intensity to determine the
strength of a ground motion. Furthermore, plots can be generated for extreme accelerations, velocities and
displacements for dynamic phases.
Note:
• Note that steady-state pore pressures in a Dynamic calculation are always taken from the steady-state pore
pressures generated in the parent phase (see Calculation type (on page 348)).
• It is possible to calculate excess pore pressures in undrained soil layers in a dynamic analysis. However, the
accuracy at which pore pressures are predicted depends on the capabilities of the soil models being used.
• A standard dynamic calculation may involve the generation of excess pore pressures, but not the dissipation
of excess pore pressures. If the latter is required, a Dynamic with consolidation calculation should be
performed.

Updated mesh
During a dynamic calculation, large deformation effects and changes of the geometry can be taken into account
by selecting the Updated mesh option. See Updated mesh analysis (on page 342) for more information about
Updated mesh calculations.
In a Dynamic calculation loading can be defined in the sense of applying a predefined combination of external
loads as dynamic forces using dynamic multipliers activated in the Staged construction mode. Dynamic
calculations can also deal with moving loads.

7.4.7 Dynamic with consolidation calculation
The Dynamic with consolidation option should be selected when the dynamic generation and subsequent
dissipation of excess pore pressures in a short time domain is to be considered. This calculation type is based on
the mixed u-P formulation (where u is displacement and P is excess pore pressure and can be used when
partially drained soil conditions are present during a dynamic calculation. The applied dynamic load is the
product of the input value of the defined dynamic load and the corresponding dynamic load multiplier.
Note:
A Dynamic with consolidation calculation requires the input of soil permeabilities and appropriate flow boundary
conditions.
Besides the activation of the dynamic load or dynamic prescribed displacement, absorbent (viscous) boundary
conditions can be defined for a Dynamic with consolidation calculation. For a more detailed description of the
boundary conditions see Model conditions (on page 389).
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In a Dynamic with consolidation calculation loading can be defined in the sense of applying a predefined
combination of external loads as dynamic forces using dynamic multipliers activated in the Staged construction
mode.

7.4.8 Plastic nil-phase
A plastic calculation may also be used to carry out a so-called plastic nil-phase. A plastic nil-phase is a plastic
calculation phase in which no additional loading is applied. Each new phase introduced in the Phases explorer is
initially a plastic nil-phase, until the calculation type, geometry or load configuration is changed. It may
sometimes be required to solve large out-of-balance forces and to restore equilibrium. Such a situation can occur
after a calculation phase in which large loadings were activated (for example gravity loading) or if the K0
procedure generates an initial stress field that is not in equilibrium or where plastic points occur. After this
phase has been completed, the stress field will be in equilibrium and all stresses will obey the failure condition.
In this case no changes should be made to the geometry configuration or to the water conditions. If necessary,
such a calculation can be performed with a reduced Tolerated error to increase the accuracy of the equilibrium
stress field.
If the original K0 procedure generates a stress field that is far from equilibrium, then the plastic nil-phase may
fail to converge. This happens, for example, when the K0 procedure is applied to problems with very steep
slopes. For these problems the Gravity loading procedure should be adopted instead.
It is important to ensure that displacements calculated during a plastic nil-phase (if it is applied immediately
after generating the initial stresses) do not affect later calculations. This may be achieved by using the Reset
displacements to zero option in the subsequent calculation phase (Deformation control parameters (on page
357)).
The Staged construction loading type is used to perform a plastic nil-phase to solve existing out-of-balance
forces. No changes in the geometry, load level, load configuration and water pressure distribution should be
made.

7.4.9 Updated mesh analysis
In conventional finite element analysis, the influence of the geometry change of the mesh on the equilibrium
conditions is neglected. This is usually a good approximation when the deformations are relatively small as is the
case for most engineering structures. However, there are circumstances under which it is necessary to take this
influence into account. Typical applications where updated mesh analyses may be necessary include the analysis
of reinforced soil structures, the analysis of large offshore footing collapse problems and the study of problems
where soils are soft and large deformations occur.
Note:
By default the Updated mesh option in Phases window is unchecked.
When large deformation theory is included in a finite element program some special features need to be
considered. Firstly it is necessary to include additional terms in the structure stiffness matrix to model the
effects of large structural distortions on the finite element equations.
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Secondly, it is necessary to include a procedure to model correctly the stress changes that occur when finite
material rotations occur. This particular feature of large displacement theory is usually dealt with by adopting a
definition of stress rate that includes rotation rate terms. Several stress rate definitions have been proposed by
researchers working in this field although none of these are wholly satisfactory. In PLAXIS 3D the co-rotational
rate of Kirchhoff stress (otherwise known as the Hill stress rate) is adopted. This stress rate would be expected
to give accurate results provided that the shear strains do not become excessive.
Thirdly, it is necessary to update the finite element mesh as the calculation proceeds. This is done automatically
within PLAXIS 3D when the Updated mesh option is selected.
It should be clear from the descriptions given above that the updated mesh procedures used in PLAXIS 3D
involve considerably more than simply updating nodal coordinates as the calculation proceeds. These
calculation procedures are in fact based on an approach known as an Updated Lagrangian formulation (Bathe,
1982 (on page 508)). Implementation of this formulation within PLAXIS 3D is based on the use of various
advanced techniques that are beyond the scope of this manual. More details can be found in (van Langen, 1991
(on page 510)).
The three basic types of calculations (Plastic, Consolidation and Safety) can optionally be performed as an
Updated mesh analysis, taking into account the effects of large deformations. Therefore, the Updated mesh
parameter should be selected. The Updated mesh option cannot be used in a fully coupled flow-deformation
analysis.
Please note that an updated mesh calculation cannot be followed by a 'normal' calculation. Reversely, a normal
calculation can be followed by an updated mesh calculation, provided that the option Reset displacements to zero
is used (Deformation control parameters (on page 357)).
It should be noted that an updated mesh analysis takes more time and is less robust than a normal calculation.
Hence, this option should only when really necessary.
Note:
Note that water conditions at the mesh boundary and pore pressures in stress points are not updated as the
mesh is updated.

Distributed loads
Distributed loads on deformed boundaries are taken into account as if those boundaries were not deformed.
This is to ensure that the total force involved does not change when the boundary stretches or shrinks. This also
applies to axisymmetric applications where the radius changes as a result of deformation.

Calculation procedures
In order to carry out an updated mesh analysis the Updated mesh checkbox in the Deformation control
parameters subtree in the Phases window should be selected (Deformation control parameters (on page 357)).
Updated mesh calculations are carried out using iteration procedures similar to the conventional calculation
options as described in preceding sections. Therefore an updated mesh analysis uses the same parameters.
However, because of the large deformation effect, the stiffness matrix is always updated at the beginning of a
load step. Due to this procedure and to the additional terms and more complex formulations, the iterative
procedure in an updated mesh analysis is considerably slower than that for conventional calculations.
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Safety calculations
The geometry of the model considered in a Safety calculation depends on whether the Updated mesh option is
selected or not in the parent phase. If the mesh is updated, the resulting geometry at the end of the parent phase
will be considered in the safety calculations.
During a safety calculation the mesh is not further updated at the beginning of each load step even if the Updated
mesh option is selected for the Safety phase.

Practical considerations
Updated mesh analysis tends to require more computer time than an equivalent, conventional calculation. It is
recommended, therefore, that when a new project is under study a conventional calculation is carried out before
an updated mesh analysis is attempted.
It is not possible to give simple guidelines that may be used to indicate when an updated mesh analysis is
necessary and where a conventional analysis is sufficient. One simple approach would be to inspect the
deformed mesh at the end of a conventional calculation using the Deformed mesh option in the Output program.
If the geometry changes are large (on a real scale) then significant importance of geometric effects might be
suspected. In this case the calculation should be repeated using the updated mesh option. It cannot definitely be
decided from the general magnitudes of the deformations obtained from a conventional plasticity calculation
whether geometric effects are important or not. If the user is in any doubt about whether updated mesh analysis
is necessary then the issue can only be resolved by carrying out the updated mesh analysis and comparing the
results with the equivalent conventional analysis.
In general, it is not appropriate to use an updated mesh calculation for gravity loading to set up the initial stress
field. Displacements resulting from gravity loading are physically meaningless and should therefore be reset to
zero. Resetting displacements to zero is not possible after an updated mesh analysis. Hence, gravity loading
should be applied in a normal plastic calculation.
Changing from a 'normal' plastic calculation or consolidation analysis to an updated mesh analysis is only valid
when displacements are reset to zero, because a series of updated mesh analyses must start from an
undeformed geometry. Changing from an updated mesh calculation to a 'normal' plastic calculation or
consolidation analysis is not valid, because then all large deformation effects will be disregarded, resulting in a
large force unbalance.

7.5 Loading type
The loading type is specified in the Loading input drop-down menu in the Phases window. Only one of the
described loading types can be activated in any single calculation phase. The available loading types depend on
the selected type of calculation.
Note:
Note that the Loading type drop-down menu is NOT available for Flow only calculation type.
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7.5.1 Staged construction
The Staged construction loading type enables the user to specify a new state that is to be reached at the end
of the calculation phase. The water pressure distribution, the geometry, the input values of loads and the load
configuration in the Flow conditions and Staged construction mode can be modified. The Staged construction
option may also be used to perform plastic nil-phases to solve existing out-of-balance forces. In this case, no
changes in the geometry, load level, load configuration and water pressure distribution should be made.
Before specifying the construction stage, the Time interval of the calculation phase should be considered. The
Time interval is expressed in the unit of time. A non-zero value is only relevant in the case of a Consolidation
analysis, a Fully coupled flow-deformation analysis or if a time-dependent soil model (such as Soft Soil Creep
model) is used.
Since staged construction is performed using the Load advancement ultimate level procedure (Load
advancement - Ultimate level (on page 352)), it is controlled by a total multiplier (ΣMstage).This multiplier
starts at zero and is expected to reach the ultimate level of 1.0 at the end of the calculation phase. Note that the
maximum number of additional steps as defined by the Max steps parameter will not be reached if ΣMstage
criterion is met before.
In some special situations, however, it might be necessary to split the staged construction process into more
than one calculation phase and to specify an intermediate value of ΣMstage. This can be done by assigning a
value lower than 1.0 to the ΣMstage parameter in the General subtree in the Phases window which is only
available for a Plastic calculation. However, care must be taken with an ultimate level smaller than 1.0, since this
is associated with a resulting out-of-balance force. Such calculations must always be followed by another staged
construction calculation.
Without specifying a value for ΣMstage, the program always assumes an ultimate level of ΣMstage = 1.0. Before
starting any other type of calculation the ΣMstage parameter must first have reached the value 1.0. This can be
verified in the Reached values subtree in the Phases window (Reached values (on page 372)).

Staged construction with ΣMstage < 1
In general, the total multiplier associated with the staged construction process, ΣMstage, goes from zero to unity
in each calculation phase where staged construction has been selected as the loading input. In some very special
situations it may be useful to perform only a part of a construction stage. This can be done by specifying a value
lower than 1.0 tothe ΣMstage.

Unfinished staged construction calculation
At the start of a staged construction calculation, the multiplier that controls the staged construction process, that
is to say ΣMstage, is zero and this multiplier is stepwise increased to the ultimate level (generally 1.0). When
ΣMstage has reached the ultimate level, the current phase is finished. However, if a staged construction
calculation has not properly finished, i.e. the multiplier ΣMstage is less than the desired ultimate level at the end
of a staged construction analysis, then a warning appears in the Log info box. The reached value of the ΣMstage
multiplier may be viewed in the Reached values subtree in the Phases window.
There are three possible reasons for an unfinished construction stage:
• An ultimate value of ΣMstage less than 1.0 is specified by the user. Note that the out-of-balance force is still
partly unresolved. The remain out-of-balance forces must be solved in the next calculation phase.
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• Failure of the soil body has occurred during the calculation. This means that it is not possible to finish the
construction stage. Note that the out-of-balance force is still partly unsolved so that further calculations
starting from the last calculation phase are meaningless.
• The maximum number of loading steps was insufficient. In this case the construction stage should be
continued by performing another staged construction calculation that is directly started without changing
the geometry configuration or water pressures. Alternatively, the phase may be recalculated using a larger
number of Max steps. Note that it is advised against applying any other type of loading as long as the ΣMstage
has not reached the value 1.0.
In the case of an unfinished staged construction calculation, the load that has actually been applied differs from
the defined load configuration. The reached value of the ΣMstage multiplier may be used in the following way to
estimate the load that has actually been applied:
f applied = f 0 + ΣMstage ( f defined − f 0)

Eq. [87]

where fapplied is the load that has actually been applied, f0 is the load at the beginning of the calculation phase (i.e.
the load that has been reached at the end of the previous calculation phase) and fdefined is the defined load
configuration.
A reduced ultimate level of ΣMstage may be reduced repetitively. In the case of multiple subsequent phases with
ΣMstage < 1, it should be realised that ΣMstage starts at 0 in every phase. For example, if three phases are
defined, where in phase 1 ΣMstage = 0.5; in phase 2 ΣMstage = 0.5 and phase 3 ΣMstage = 1.0 (without additional
changes), it means that:
• At the end of phase 1: 50% of the unbalance is solved.
• At the end of phase 2: 50% of the remaining unbalance (= 75% of the initial unbalance) is solved.
• At the end of phase 3: 100% of the remaining unbalance (= 100%of the initial unbalance) is solved.

7.5.2 Minimum excess pore pressure
The Minimum excess pore pressure option in the Loading input drop-down menu is a criterion for
terminating a consolidation analysis. The calculation stops when the maximum absolute excess pore pressure is
below the prescribed value of |P-stop|. Note that the maximum number of steps as defined by the Max steps
parameter will not be reached if the |P-stop| criterion is met before. For example, when the maximum excess
pore pressure has reached a certain value during the application of load, the user can make sure that the
consolidation process is continued until all nodal values of excess pore pressure are less than |P-stop|, provided
the value of Max steps is sufficient.
Note:
The Minimum excess pore pressure loading type is available only for Consolidation calculations.

7.5.3 Degree of consolidation
The option Degree of consolidation is an alternative criterion for terminating a consolidation analysis. The
calculation stops when the degree of consolidation, as defines herein, is below the value of Degree of
consolidation. The degree of consolidation is an important indication of the consolidation state. Strictly, the
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degree of consolidation, U, is defined in terms of the proportion of the final settlement although the term is often
used to describe the proportion of pore pressures that have dissipated to at least (100-U)% of their values
immediately after loading. The Degree of consolidation option may be used to specify the final degree of
consolidation in any analysis.
In this case the Minimum excess pore pressure parameter (see above) is set to a value as defined by the maximum
excess pore pressure in the previous phase and the defined Degree of consolidation (U):
Minimim pore pressure = (100 − U )Pmax

Eq. [88]

where Pmax is the maximum excess pore pressure reached in the previous phase which can be found in the
Reached values subtree in the Phases window (Reached values (on page 372)). The calculation stops when the
maximum absolute excess pore pressure is below this calculated value of Minimum excess pore pressure. Note
that the maximum number of steps as defined by the parameter Max steps will not be reached if the Minimum
excess pore pressure criterion is met before.
Note:
The Degree of consolidation loading type is available only for Consolidation calculations.

7.5.4 Target ΣMsf
Reduction of the soil and interface strength towards a target value of the total multiplier ΣMsf. The program
first performs a full safety analysis until failure (Incremental multipliers (on page 347)) and then it recalculates
the last step before the target value of ΣMsf in order to reach the target exactly.
Note:
The Target ΣMsf loading type is available only for Safety calculations.

7.5.5 Incremental multipliers
The Incremental multipliers loading type enables the user to perform a Safety analysis using the Load
advancement number of steps procedure (Incremental multipliers (on page 347)). The incremental multiplier Msf
is used to specify the increment of the strength reduction of the first calculation step. This increment is by
default set to 0.1, which is generally found to be a good starting value. The strength parameters are successively
reduced automatically until the value assigned to the Max steps parameter has been reached. By default, the
maximum number of steps is set to 100, but a larger value up to 1000 may be given here, if necessary. It must
always be checked whether the final step has resulted in a fully developed failure mechanism. If that is the case,
the factor of safety is given by:
SF =

available strength
strength at failure

= value of ΣMsf at failure

Eq. [89]

The ΣMsf-value of a particular calculation step can be found in the Calculation Information window of the
Output program. It is also recommended to view the development of ΣMsf for the whole calculation using the
Curves option (Curves (on page 479)). In this way it can be checked whether a constant value is obtained while
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the deformation is continuing; in other words: whether a failure mechanism has fully developed. If a failure
mechanism has not fully developed, then the calculation must be repeated with a larger number of steps.
Note:
The Incremental multipliers loading type is only available for Safety calculations.

7.6 Water pressure calculation
Water pressure can be 'external' water pressure (i.e. 'water load' on model boundaries) or 'internal' water
pressure, which is known as pore water pressure. Pore water pressure is included in what is denoted in PLAXIS
3D as active pore pressure. Active pore pressure is composed of steady-state pore pressure and excess pore
pressure, and may also include suction (positive pore water stress). In general, the steady-state component of
water pressure (both the 'external' and 'internal' part) is considered to be input data and supposed to be known
at the beginning of a deformation analysis, whereas excess pore pressure is the result of undrained loading or
consolidation. This section deals with the calculation of steady-state water pressure as input for a deformation
analysis, which can be generated according to the options available in the Phases window.

7.6.1 Calculation type
Phreatic
The steady-state water pressure calculation by Phreatic is based on the input of a Global water level (Global
water level (on page 350)) and the water conditions of the clusters ( Defining water conditions (on page 75)).
This generation is quick and straightforward. The following quantities are calculated as input for a deformation
analysis:
• 'External' water pressures (i.e. 'water loads') on external model boundaries are calculated on the basis of the
Global water level.
• Steady-state pore pressures in active clusters are calculated on the basis of the water conditions as defined
for the corresponding clusters. If it is desired to exclude pore pressures from certain clusters, the Dry option
should be used (Assigning water conditions to soil volumes (on page 377)) or the cluster should be Nonporous (General tabsheet (on page 192)).
• Steady-state pore pressures in inactive clusters are calculated on the basis of the water conditions as defined
for the corresponding clusters, which forms the basis for the calculation of 'external' water pressures on
boundaries between active and inactive clusters.
Steady-state pore pressure may include suction in the unsaturated zone above the phreatic surface. If it is
desired to exclude suction from the steady-state pore pressure as input for a deformations analysis, the option
Ignore suction may be used.

Groundwater flow (steady-state)
The steady-state water pressure calculation by Steady state groundwater flow is based on the input of hydraulic
boundary conditions (Hydraulic conditions (on page 175) and Water pressure generation and previewing (on
page 379)). It also requires the input of a non-zero permeability, in the material datasets for soil and interfaces.
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This generation is more time-consuming and the result is not always straightforward. The following quantities
are calculated and are considered as input for a deformation analysis:
• The global water level. The 'internal' part of the global water level, is calculated as the level where the steadystate pore pressure is zero, whereas the 'external' part (if applicable) is calculated from the groundwater
heads that are higher than the external model boundaries.
• 'External' water pressure (i.e. 'water load') on external model boundaries is calculated on the basis of the
Global water level.
• Steady-state pore pressures in active clusters are calculated on the basis of the groundwater flow calculation.
If it is desired to exclude pore pressures from certain clusters, the Dry option should be used (Assigning
water conditions to soil volumes (on page 377)) or the cluster should be Non-porous (General tabsheet (on
page 192)).
• Steady-state pore pressures in inactive clusters are interpolated (or extrapolated) on the basis of the water
pressures at the boundaries between active and inactive clusters, as obtained from the groundwater flow
calculation. These pressures also form the basis for the calculation of the 'external' water pressure on such
boundaries.
• If the Global water level is used to define the hydraulic boundary conditions (groundwater head), the global
water level will be replaced by the results of the groundwater flow calculation. In general, this will result in
the same 'external' part of the global water level, but the 'internal (phreatic)' part will most likely change.
Note:
• If no groundwater flow boundary conditions are defined, the hydraulic boundary conditions for a steadystate groundwater flow calculation are taken from the Global water level, which means a prescribed hydraulic
head below the water level and seepage above.
• The Steady state groundwater flow option is available for K0 procedure, Gravity loading, Flow only, Plastic and
Consolidation calculation types.
Steady-state pore pressure may include suction in the unsaturated zone above the phreatic surface. If it is
desired to exclude suction from the steady-state pore pressure, as input for a deformation analysis, the option
Ignore suction may be used.

Groundwater flow (transient)
This option is available if it is intended to perform ONLY groundwater flow calculations, to be indicated by
selecting Flow only for the Calculation type. A transient groundwater flow calculation is based on the input of
(time-dependent) hydraulic boundary conditions (Surface flow boundary conditions (on page 179)) and water
levels (Water levels (on page 374)) A transient groundwater flow calculation requires a non-zero time interval.
Moreover, it requires the input of a non-zero permeability in the material datasets for soils and interfaces and
the selection of an appropriate flow model to describe the behaviour in the unsaturated zone (Groundwater
tabsheet (on page 248)).
Note:
Note that the Flow only option is available only for the initial phase. When this option is selected for the initial
phase, it will be automatically assigned for the following (child) phases as well and it will be grayed out,
indicating that no change is possible.
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Use pressures from previous phase
If the steady-state water pressure does not change compared to its parent phase, the option Use pressures from
previous phase can be used to indicate that the calculation kernel should use the water pressures of the previous
step (phase) as input for the current deformation analysis. This option should NOT be used if clusters change
from active to inactive or vice versa. In that case the water pressures need to be generated using one of the other
options.

7.6.2 Global water level
The Global water level can be used to generate a simple hydrostatic pore pressure distribution (Phreatic
calculation type) for the full geometry. The global water level is by default assigned to all clusters in the
geometry.
The Global water level can also be used to create boundary conditions for the groundwater head in the case that
pore pressures are calculated on the basis of a Groundwater flow calculation or Fully coupled flow-deformation
analysis.
The Global water level for a selected phase can be specified in the Water subtree under the Model conditions in
the Model explorer. The drop-down menu displays the available water levels in the model (Borehole water levels
or User water levels). More information on water levels is given in Water levels (on page 374).

7.7 Load stepping procedures
When soil plasticity is involved in a finite element calculation the equations become non-linear, which means
that the problem needs to be solved in a series of calculation steps. An important part of the non-linear solution
procedure is the choice of step size and the solution algorithm to be used.
During each calculation step, the equilibrium errors in the solution are successively reduced using a series of
iterations. The iteration procedure is based on an accelerated initial stress method. If the calculation step is of a
suitable size then the number of iterations required for equilibrium will be relatively small, usually around ten.
If the step size is too small, then many steps are required to reach the desired load level and computing time will
be excessive. On the other hand, if the step size is too large then the number of iterations required for
equilibrium may become excessive or the solution procedure may even diverge.
PLAXIS 3D has an automatic load stepping procedure for the solution of non-linear plasticity problems. The
following procedures are available: Load advancement ultimate level, Load advancement number of steps and
Automatic time stepping. Users do not need to worry about the proper selection of these procedures, since
PLAXIS 3D will automatically use the most appropriate procedure by itself to guarantee optimum performance.
The parameters for the load stepping procedures are available in the Numerical control parameters subtree in
the Phases window (Figure 234 (on page 351)).
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Figure 234: Numerical control parameters subtree in the Phases window
The automatic load stepping procedure is controlled by a number of calculation control parameters (Numerical
control parameters (on page 361)). There is a convenient default setting for most control parameters, which
strikes a balance between robustness, accuracy and efficiency. For each calculation phase, the user can influence
the automatic solution procedures by manually adjusting the control parameters in the Numerical control
parameters subtree in the Phases window.
In this way it is possible to have a stricter control over step sizes and accuracy. Before proceeding to the
description of the calculation control parameters, a detailed description is given of the solution procedures
themselves.

7.7.1 Automatic step size procedure
For each calculation phase the user specifies the new state or the total load that is to be applied at the end of this
phase. The calculation program will compare the new situation (at the end of this phase) with the previous
situation (at the end of the phase where it starts from) and will solve the difference during the current
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calculation phase by applying multiple load steps. In fact, the program will try to reach equilibrium for the new
situation in the final load step of the current phase.
The size of the first load step in a calculation phase is automatically determined by performing trial calculations,
taking into account the Tolerated error (Numerical control parameters (on page 361)). When a new load step is
applied (first step or later steps), a series of iterations is carried out to reach equilibrium. There are three
possible outcomes of this particular process. These outcomes are:
Case 1: The solution reaches equilibrium within a number of iterations that is less than the Desired minimum
control parameter. By default, the Desired minimum number of iterations is 6, but this value may be changed in
the Numerical control parameters subtree in the Phases window (Numerical control parameters (on page 361)).
If fewer iterations than the desired minimum are required to reach the equilibrium state then the calculation
step is assumed to be too small. In this case, the size of the load increment is multiplied by two and further
iterations are applied to reach equilibrium.
Case 2: The solution fails to converge within a Desired maximum number of iterations. By default, the Desired
maximum number of iterations is 15, but this value may be changed in the Numerical control parameters subtree
in the Phases window (Numerical control parameters (on page 361)). If the solution fails to converge within the
desired maximum number of iterations then the calculation step is assumed to be too large. In this case, the size
of the load increment is reduced by a factor of two and the iteration procedure is continued.
Case 3: The number of required iterations lies between the Desired minimum number of iterations and the
Desired maximum number of iterations in which case the size of the load increment is assumed to be satisfactory.
After the iterations are complete, the next calculation step begins. The initial size of this calculation step is made
equal to the size of the previous successful step.
If the outcome corresponds to either case 1 or case 2 then the process of increasing or reducing the step size
continues until case 3 is achieved.

7.7.2 Load advancement - Ultimate level
This automatic step size procedure is used for calculation phases where a certain 'state' or load level (the
'ultimate state' or 'ultimate level') has to be reached, as in the case for a Plastic calculation where a construction
stage is defined. The procedure terminates the calculation when the specified state or load level is reached or
when soil failure is detected. By default, the Max steps parameter is set to 1000, but this parameter does not play
an important role, since in most cases the calculation stops before the maximum number of steps is reached.
An important property of this calculation procedure is that the user specifies the state or the values of the total
load that is to be applied. The size of the first load step is obtained automatically using one of the two following
methods:
• PLAXIS 3D performs a trial calculation step and determines a suitable step size on the basis of this trial.
• PLAXIS 3D sets the initial load step size to be equal to the final load step size of any previous calculation.
The first method is generally adopted. The second method would only be used if the loading applied during the
current load step is similar to that applied during the previous load step, for example if the number of load steps
applied in the previous calculation proved to be insufficient.
In subsequent steps, the automatic load stepping procedures are adopted (Automatic step size procedure (on
page 351)). If at the end of the calculation, the defined state or load level has been reached, the calculation is
considered to be successful. A successful calculation is indicated by a check mark in a green circle in the Phases
explorer and the Phases window.
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If the defined state or load level has NOT been reached, the calculation is considered to have failed. A failed
calculation is indicated by a cross mark in a red circle in the Phases explorer or the Phases window. A message
describing the error is given in the Log info for the last calculation box in the Phases window:
Prescribed ultimate state not reached; Soil body collapses: A collapse load has been reached. In this case, the
total specified load has not been applied. Collapse is assumed when the applied load reduces in magnitude in X
successive calculation steps (where X is the maximum number of unloading steps; see Numerical control
parameters (on page 361)) and the current stiffness parameter CSP is less than 0.015 (see Automatic error
checks (on page 406) for the definition of CSP). It is also possible that the problem is failing but due to switchedoff arc-length control, the program is not allowed to take negative step sizes. The user should check the output of
the last step and judge whether the project is failing or not. In case of failure, recalculating the project with a
higher Max steps parameter is useless.
Prescribed ultimate state not reached; load advancement procedure fails. Try manual control: The load
advancement procedure is unable to further increase the applied load, but the current stiffness parameter CSP is
larger than 0.015. In this case the total load specified has not been applied. The user can now attempt to rerun
the calculation with slight changes to the iterative parameters in Numerical control parameters subtree in the
Phases window, in particular turning off the Arc-length control type parameter.
Prescribed ultimate state not reached; Not enough load steps: The maximum specified number of load steps
have been applied. In this case, it is likely that the calculation stops before the total specified load has been
applied. It is advised to recalculate the phase with an increased value of Max steps or to add a similar subsequent
calculation phase in which no changes in geometry configuration or water pressures are defined.
Cancelled by user: This occurs when the calculation process is terminated by clicking Stop in the Active tasks
window.
Prescribed ultimate state not reached; Numerical error: A numerical error has occurred. In this case, the
total specified load has not been applied. There may be different causes for a numerical error. Most likely, it is
related to an input error. Careful inspection of the input data, the finite element mesh and the defined calculation
phase is suggested.
Severe divergence: This is detected when the global error is increasing and has reached huge values. This error,
for example, can be caused by very small time steps in a consolidation phase. The program scales down the step
size when the tolerated error cannot be reached, resulting in small time steps. One of the reasons can be that a
failure situation is reached. As for consolidation the arc-length procedure is not used, the program cannot really
detect failure.
File xxxx not found: Such a message appears when a file that ought to exist does not exist.
Messages may indicate errors related to the iterative solution algorithm or the matrix condition. In the case of
'floating' elements (insufficient boundary conditions), one could get a message indicating that the matrix is
nearly singular. Checking and improving the defined calculation phase usually solves the problem.
Another problem related to the solution process can occur due to insufficient direct computer memory (RAM). In
such cases, the iterative solver cannot store the minimum amount of data necessary to have sufficient accuracy.
As a result, the iteration process converges very slowly, or does not reach the accuracy condition. To solve this
problem, either the problem size should be reduced, or internal memory capacity should be increased.
Note:
A list of warning and error messages appearing in PLAXIS 3D is available in Appendix H.
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7.7.3 Load advancement - Number of steps
This automatic step size procedure always performs the number of steps specified in Max steps and is, in general,
used for calculation phases where a complete failure mechanism should be developed during the analysis. This
algorithm is therefore used in Safety analysis.
The size of the first step is determined by the incremental multiplier as defined for the particular calculation
phase. For Safety calculations the Loading type parameter is Incremental multipliers and the default increment is
Msf = 0.1. This value may be changed in the General subtree of the Phases window. In subsequent steps, the
automatic load stepping procedures are adopted (Automatic step size procedure (on page 351)).
If at the end of the calculation the value assigned to the Max steps parameter has been reached, the calculation is
considered to be successful. A successful calculation is indicated by a tick mark in a green circle in the Phases
explorer or the Phases window.
If the value assigned to the Max steps parameter has NOT been reached, the calculation is considered to have
failed. A failed calculation is indicated by a cross mark in a red circle in the Phases explorer or the Phases
window. A message describing the error is given in the Log info for last calculation box in the Phases window.
Cancelled by user: This occurs when the calculation process is terminated by clicking Stop in the Active tasks
window.
Apart from cancellation by the user, a load advancement calculation will proceed until the number of steps
defined in the Max steps parameter have been applied. In contrast to the Ultimate level procedure the calculation
will not stop when failure is reached.
Note:
A list of warning and error messages appearing in PLAXIS 3D is available in Appendix H.

7.7.4 Automatic time stepping (consolidation or fully coupled analysis)
When the Calculation type is set to Consolidation, the Automatic time stepping procedure is used. This procedure
will automatically choose appropriate time steps for a consolidation analysis. When the calculation runs
smoothly, resulting in very few iterations per step, then the program will choose a larger time step. When the
calculation uses many iterations due to an increasing amount of plasticity, then the program will take smaller
time steps.
The first time step in a consolidation analysis or a fully coupled analysis is generally based on the First time step
parameter. This parameter is, by default, based on the advised minimum time step (overall critical time step) as
described in Numerical control parameters (on page 361). The First time step parameter can be changed in the
Numerical control parameters subtree in the Phases window when the Use default iter parameters checkbox is
not selected. However, be careful with time steps that are smaller than the advised minimum time step.
During a Consolidation calculation or a Fully coupled analysis, arc-length control is always inactive.
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7.7.5 Automatic time stepping
When the Calculation type is set to Dynamic or Dynamic with consolidation, the Newmark time integration
scheme is used in which the time step is constant and equal to the critical time step during the whole analysis
(Scientific Manual- Chapter 7 - Bounds on the system response). The proper critical time step for dynamic
analyses is estimated in order to accurately model wave propagation and reduce error due to integration of time
history functions. First, the material properties and the element size are taken into account to estimate the time
step and then the time step is adjusted based on the time history functions used in the calculation. If the Use
default iteration parameters is selected, the best combination of Max steps and Number of sub-steps, based on the
estimated time step, will be calculated in the kernel. The user can always get and change these values by
pressing the Retrieve button in the Phases window.
During a dynamic calculation, arc-length control is always inactive.

7.8 Calculation control parameters
The control parameters of a particular calculation phase and the corresponding solution procedure can be
defined in the Phases window.

7.8.1 General phase parameters
The general properties of a phase can be defined in the General subtree in the Phases window (Figure 235 (on
page 355)).

Figure 235: General subtree in the Phases window
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Phase identification
The ID of the phase consists of the caption and the name (in square brackets). The name of the phases is
determined consecutively by the program and it can not be modified by the user. The user may redefine the
caption of the phase in the Phases window.

Calculation type
The calculation type of the selected phase can be defined in the corresponding drop-down menu in the Phases
window. The options available are:
•
•

K0 procedure
Field stress

•

Gravity loading
• Flow only
•
Plastic
•
Consolidation
•
Safety
•
Dynamic
•
Fully coupled flow-deformation
•
Dynamic with consolidation
A description of the different analysis types available in PLAXIS 3D is given in Types of analysis (on page 327).

Loading type
The options available for the Loading type parameter are:
•
•
•
•
•

Staged construction
Incremental multipliers
Target SumMsf
Minimum excess pore pressure
Degree of consolidation

A description of the different loading types available in PLAXIS 3D is given in Loading type (on page 344).

ΣMstage
ΣMstage is the total multiplier that controls the staged construction process. It is associated with the reduction
of the out-of-balance forces that are to be solved in a staged construction calculation. By default, its target value
is 1.0. The lowest allowed input value is 0.001. If ΣMstage is lower than this value, the load is considered to be
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negligible and no calculations take place. A value larger than 1.0 is not possible. By entering the default value of
1.0, the staged construction procedure is performed in the normal way.
In general, care must be taken with an ultimate level of ΣMstage smaller than 1.0, since this leads to a resulting
out-of-balance force at the end of the calculation phase. Such a calculation phase must always be followed by
another staged construction calculation. If Σ Mstage is not specified by the user, the default value of 1.0 is always
adopted, even if a smaller value was entered in the previous calculation phase.

ΣMweight
ΣMweight is the total multiplier for the material weight. For ΣMweight = 1, the material weight as specified by the
unit weights in the material data sets is applied. In general, ΣMweight remains at its default value of 1, but there
are situations in which ΣMweight may be changed:
• In the case of modelling simplified soil tests by means of finite element models, self weight of the material
may be disregarded since the stresses are dominated by external loads rather than material weight. This can
either be achieved by using zero unit weights in the material data set or by using ΣMweight = 0 during the
calculations. Note that in the former case (γ = 0) the material has no mass, which has consequences for a
dynamic calculation.
• In the case of over-consolidated material in situations where the K0 procedure cannot be used (for example
slopes), gravity loading can be used in the initial phase with an increased value of ΣMweight equal to the
overconsolidation ratio. In this way, the preconsolidation stress is properly initialised, at least when using
advanced soil models. In the subsequent phase, Σ Mweight should be set back to 1.0 in order to have realistic
initial soil stresses whilst the preconsolidation stress (in advanced models) will memorize the
overconsolidated stress level.
• In the case of modelling a centrifuge test, ΣMweight may be used to simulate the increased amount of gravity.
Hence, in order to simulate a centrifuge test at 100 g, ΣMweight should be set to 100.

Time interval
A non-zero value for the time-related parameters is only relevant when a transient groundwater flow
calculation, a consolidation analysis, a fully coupled flow-deformation analysis or a dynamic analysis is
performed or when using time-dependent material models (such as the Soft Soil Creep model).
Time interval

To define the total time period considered in the current calculation phase, expressed in
the unit of time as defined in the Project properties window.

Dynamic time
interval

To define the total time period considered in the current dynamic calculation phase,
expressed in seconds [s].

A dynamic analysis uses a different time parameter than other types of calculations. The time parameter in a
dynamic analysis is the Dynamic time, which is always expressed in seconds [s], regardless of the unit of time as
specified in the Project properties window. In a series of calculation phases in which some of them are
dynamic, the Dynamic time is only increased in the dynamic phases (even non-successive), while the Dynamic
time is kept constant in other types of calculations (whether before, in-between or after the dynamic phases).
The Dynamic time is not affected by the regular time parameter. Reversely, the regular time parameter includes
the Dynamic time.
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7.8.2 Deformation control parameters
Ignore undrained behaviour
Ignore undrained behaviour excludes temporarily the effects of undrained behaviour in situations where
undrained material data sets (Undrained (A) or Undrained (B)) are used. The selection of this option is associated
with the selection of the Plastic calculation type. When the option is selected, the stiffness of water is not taken
into account. As a result, all undrained material clusters (except for Undrained (C) materials) become
temporarily drained. Existing excess pore pressures that were previously generated will remain, but no new
excess pore pressures will be generated in that particular calculation phase.

Figure 236: Deformation control parameters subtree in the Phases window
Gravity loading of undrained materials will result in unrealistic excess pore pressures. Stresses due to the selfweight of the soil, for example, are based on a long-term process in which the development of excess pore
pressures is irrelevant. The Ignore undrained behaviour option enables the user to specify the material type from
the beginning as undrained for the main loading stages and to ignore the undrained behaviour during the Gravity
loading stage, at least for data sets defined as Undrained A or Undrained B.
Note:
The Ignore undrained behaviour option is not available for a Consolidation analysis, Fully coupled flowdeformation analysis or a Dynamic with consolidation analysis, since these calculation types do not consider the
Drainage type as specified in the material data sets, but use the material permeability instead.

Force fully drained behaviour of newly activated clusters
In order to use PLAXIS 3D properly for the application of consolidation of tailings and slurries in reservoirs, the
user needs to be able to change the undrained/drained state of newly activated clusters (for fully coupled flow
deformation or consolidation analysis).
By allowing clusters to act as undrained upon activation the user can model the gradual settlement of the tailing
body correctly.
For the Consolidation and Fully Coupled calculation type, the parameter Force fully drained behaviour newly
activated clusters is available to exclude temporarily the effects of undrained behaviour in situations where
undrained material data sets (Undrained (A) or Undrained (B)) are used.
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Figure 237: Deformation Control Parameters: Force Fully Drained Behaviour
By default, this parameter is switched on, which means that newly activated clusters will essentially behave as
drained materials, irrespective of their drainage type setting.
This option does not affect already active clusters.

Reset displacements to zero
This option should be selected when irrelevant displacements of previous calculation steps are to be
disregarded at the beginning of the current calculation phase, so that the new calculation starts from a zero
displacement field. For example, deformations due to gravity loading are physically meaningless. Hence, this
option may be chosen after Gravity loading to remove these displacements. If the option is not selected, the
incremental displacements occurring in the current calculation phase will be added to those of the previous
phase. The selection of the Reset displacements to zero option does not influence the stress field.
The use of the Reset displacements to zero option may not be used in a sequence of calculations where the
Updated mesh option is used. However, if an Updated mesh analysis starts from a calculation where the Updated
mesh option is not used, then the Reset displacements to zero option MUST be used in this Updated mesh analysis.
Note:
When the parameter Reset displacements to zero is selected, then automatically the check box for Reset small
strain is selected. Hence if only the displacements is to be disregarded, then the box for Reset small strain should
be unchecked.

Reset small strain
This option should be selected when an existing state of the small-strain tensor in the Hardening Soil model with
small-strain stiffness, as reached at the end of the previous phase, is to be disregarded. As a result, the soil will
behave as a 'virgin soil' without strain history. Other state parameters are not affected by this option. If it is the
user's intention to reset all state parameters, then the option Reset State Variables should be used.

PLAXIS

359

PLAXIS 3D-Reference Manual

Meshing and calculation
Calculation control parameters

Reset time
The Reset Time option can be used in calculation phases to reset the Time parameter to zero. This applies to the
regular Time as well as to Dynamic Time. As a result, the new phase will start from t = 0 [days]. Resetting the
time does not have consequences for existing stresses, deformations or dynamic motions, and it does not
influence time-dependent processes like consolidation or creep. Resetting time mainly affects history curves
where Time or Dynamic Time is used on one of the axes.
As an example of where this option might be used is if the Soft Soil Creep model is used to set up the initial stress
state using Gravity Loading (with a non-zero time interval). Similar as for the option Reset displacements to zero,
it might be desired to reset time to zero and to start the new project at t = 0 [days]. This will give a clear history
curve that starts from zero.

Reset state variables
This option should be selected when the values of the state parameters in advanced soil models, as reached at
the end of the previous phase, are to be disregarded. As a result, the soil will behave as 'virgin' soil. The reset
parameters are given in Table 17 (on page 360).
Table 17: The material models and the corresponding reset parameters
Material model

Parameter

Soft Soil model, Soft Soil Creep model, Modified CamClay model, Hardening Soil model, Hardening Soil
model with small-strain stiffness

pp reset to the OCR value from the Initial tab of the
material set

Hardening Soil model with small-strain stiffness

Strain history tensor reset to zero

Hardening Soil model, Hardening Soil model with
small-strain stiffness

Mobilised shear reset to current effective stress state

Note:
Note that resetting the OCR only adjust the preconsolidation pressure and not the current stresses. Therefore
the user should be aware that, after resetting the OCR, the current stress state (particularly the ratio between
horizontal and vertical stresses) may not be representative for the new OCR.

Updated mesh
This option must be selected when the calculation should be performed as a large deformation analysis
according the Updated Lagrange formulation. For a more detailed information see Updated mesh analysis (on
page 342).

Ignore suction
When steady-state pore pressures are generated by the phreatic level option or by a groundwater flow
calculation, tensile pore water stresses (suction) will be generated above the phreatic level. Although suction is a
realistic phenomenon, the use of suction in a deformation analysis may lead to an increased shear strength when
effective strength parameters are used for the soil. In order to avoid this, suction can be cut off by selecting the
Ignore suction option. Note that the Ignore suction option does not affect the excess pore pressures generated in
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undrained soil layers, except in the case of a fully coupled flow-deformation analysis. The default setting is such
that Ignore suction is selected.
When Ignore suction is selected, soil below the phreatic level is considered to behave fully saturated, whereas
soil above the phreatic level is considered to behave as dry soil, although excess pore pressures may still occur
here. Positive values of steady-state pore stresses will be set to zero. However, any excess pore pressure above
the phreatic level, both positive and negative, will be taken into account. This requires the effective degree of
saturation, Seff, to be set to 1. Hence, positive excess pore stresses will always be taken into account to their full
extent until the cavitation cut-off is reached, except in the case of a consolidation analysis.
When Ignore suction is NOT selected, suction is allowed and included in the pore water stresses (both steady
state and excess pore stresses). In this case the effective degree of saturation, Seff, determines the proportion of
the suction that is included in the active pore stresses. This depends on the soil-water retention curve as defined
in the material data set of the soil layer.

Cavitation cut-off
In case of unloading of undrained materials (undrained A or B) tensile excess pore stresses may be generated.
These excess pore stresses might give rise to tensile pore water stresses. In case the cavitation cut-off option is
activated, excess pore pressures are limited so that the tensile pore water stress is never larger than the
cavitation stress. By default, the cavitation cut-off option is not activated. If it is activated, the default cavitation
stress is 100 kN/m2. The Cavitation cut-off option is not available for a consolidation analysis or a fully coupled
flow-deformation analysis.
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7.8.3 Numerical control parameters

Figure 238: Numerical control parameters subtree in the Phases window

Solver type
In PLAXIS 3D the assembly and solution of sparse linear equation systems is carried out by solvers. The available
solvers are:
Picos (multicore
iterative)

It stands for Plaxis Iterative Concurrent Solver. Picos is an efficient iterative solver that
solves the system of equations in parallel on multi-core processors. It is generally the
fastest way to perform calculations.

Pardiso (multicore
direct)

It stands for Parallel Sparse Direct Solver. Pardiso is a direct solver that solves the system
of equations in parallel on multi-core processors. It is generally the most robust way to
solve equations, but it has also the highest memory consumption (Schank & Gärtner
(2006) (on page 510) and Schank, Wächter & Hagermann (2007) (on page 510)).

Classic (single core
iterative)

This is the iterative solver that has been used in previous PLAXIS 3D versions. It solves
the system of equations using only a single core on the processor.

Max cores to use
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The number of cores to be used by the solvers in the calculation process can be defined in the Numerical control
parameters subtree of the Phases window. Note that the option of using more than two cores is a PLAXIS GSE
feature.The Max cores to use parameter has no effect when the Classic solver is used.

Max number of steps stored
The Max number of steps stored parameter defines the number of steps of a calculation phase to be stored. In
general, the final output step contains the most relevant result of the calculation phase, whereas intermediate
steps are less important.
The final step of a calculation phase is always stored.
In case the Max number of steps stored is larger than 1, intermediate steps are stored when the corresponding
calculation control parameter has passed another 'Interval' of the calculation phase. The 'Interval' is defined by
the difference between the start value and the target value of the control parameter, divided by the number of
steps stored.

Figure 239: Max number of steps stored
The calculation control parameter and the 'Interval' depend on the type of calculation which is described in table
below (Figure 239 (on page 363)).
Table 18: Calculation control parameters
Calculation type

Control parameter

Gravity loading

Σ Mweight

target ΣMweight / Max number of
steps stored

Plastic calculation

Σ Mstage

target ΣMstage (usually 1) / Max
number of steps stored

Consolidation (staged construction)
and Fully coupled analysis

Time

Consolidation (min. pore pressure,
degree of consolidation) and Safety
analysis

Step number

Safety analysis (target Σ Msf)

Σ Msf
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Time interval / Max number of steps
stored
Applied number of steps / Max
number of steps stored
(Σ Msf - 1) / Max number of steps
stored (in this case the last step - 1
is also stored)
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Calculation type

Control parameter

Dynamic analysis

Dynamic time

'Interval'
Dynamic time interval / Max
number of steps stored

If a calculation phase does not finish successfully, as indicated by a red cross in front of the phase, then up to 50
steps of that phase will be stored. This enables a stepwise evaluation of the cause of the problem.
Note:
When it is intended to create animations of the results (e.g. in the case of transient calculations), the Max number
of steps stored parameter should be set to a higher value.

Use compression for result files
Enabling the Use compression for result files option . Compression reduces file size, but causes a small
performance overhead when opening the project in Output.

Iterative procedure control parameters
The iterative procedures, in particular the load advancement procedures, are influenced by some control
parameters. These parameters can be set in the Numerical control parameters subtree in the Phases window.
PLAXIS 3D has an option to adopt a default iterative procedure, which in most cases leads to a good
performance. Users who are not familiar with the influence of the control parameters on the iterative
procedures are advised to select the Use default iter parameters.
In some situations, however, it might be desired or even necessary to change the standard setting. In this case
the user should deselect the Use default iter parameters and change the desired parameters. A description of the
parameters is given below.

Max steps
This parameter specifies the maximum number of calculation steps (load steps) that are performed in a
particular calculation phase.
If Plastic, Consolidation or Fully coupled flow-deformation is selected as the calculation type, then the Max steps
parameter should be set to an integer number representing the upper bound of the required number of steps for
this calculation phase. In this case the defined value is an upper bound to the actual number of steps that will be
executed. In general, it is desired that such a calculation is completed within the defined number of steps and
stops when either the prescribed ultimate state is reached or the soil body collapses. If such a calculation
reaches the maximum number of steps, it usually means that the ultimate level has not been reached. By default,
the Max steps parameter is set to 250, but this number can be changed within the range 1 to 10000.
If Safety or Dynamic is selected as the calculation type, then the number of steps is always exactly executed. In
general, it is desired that such a calculation is completed within the defined number of steps and stops when
either the prescribed ultimate state is reached or the soil body collapses. If such a calculation reaches the
maximum number of steps, it usually means that the ultimate level has not been reached. By default, the Max
steps parameter is set to 100 for both Safety and Dynamic calculations which is generally sufficient to complete
the calculation phase. However, this number may be changed within the range 1 to 10000.
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Time step determination
This parameter determines how the time step parameter is calculated in a Consolidation, a Fully coupled flowdeformation or a Dynamic analysis. The user can select either the automatic procedure or specify the parameters
manually.

First time step
The First time step is the increment of time used in the first step of a consolidation analysis (Automatic time
stepping (consolidation or fully coupled analysis) (on page 354) ). By default, the first time step is equal to the
overall critical time step. The overall critical time step is calculated based on the material properties and the
geometry of the model. For a more detailed description see the Scientific Manual - Chapter 4 - Critical Time Step.
The Min time step and Max time step parameters are the minimum and maximum time step values.

Figure 240: Dialog box displaying the retrieved value for the First time step parameter
To retrieve the value suggested by the program click the cell next to the First time step parameter. The value is
displayed when the Retrieve button is clicked. The value is used when the Apply button is clicked and the Time
step determination.

Sub steps in Dynamic calculation
The time step used in a Dynamic calculation is constant and equal to δt = Δ t /(m·n), where Δ t is the duration of
the dynamic loading (Dynamic time interval), m is the value of Max steps and n is the value of the Number of sub
steps parameter. The result of the multiplication of the Max steps number (m) and the Number of sub steps
number (n) gives the total number of steps to be used in the time discretisation. It is important to define a
proper number of steps such that the dynamic signal used in dynamic loading is properly covered.
The Max steps parameter specifies the number of the steps that are stored which can be used in plots in the
Output program. A higher value of the Max steps parameter provides more detailed plots and animations,
however the processing time required by the Output program is increased as well.
In general, the total number of steps, which is the product of the values defined for the Max steps and Number of
sub steps parameters, should be the same as the total number of data points used in the dynamic calculation. If
the Time step determination is set to default option Automatic, PLAXIS 3D automatically calculates the proper
number of steps and sub steps based on the material, mesh and number of data points in all active time history
function (dynamic multipliers). In this case, the Number of sub steps parameter is automatically calculated in the
kernel. When the option Semi-automatic is selected, the Number of sub steps will be automatically calculated
inside the kernel, based on the Max steps as given by the user. When the Manual option is selected, both Max
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steps and Number of sub steps will not be automatically calculated inside the kernel but must be provided by the
user.
To be able to see and change these two parameters, the user has the possibility to retrieve them by pressing the
Retrieve button. By pressing the Apply button, these values will be applied and will be used by kernel without
any change. It should be noted that PLAXIS 3D always tries to find the closest number of steps to the Max steps
that the user specifies (in case of using the default option, the number of steps will be the closest number to 250
as shown below).

Figure 241: Dialog box displaying the retrieved value for the Number of sub steps parameter

Tolerated error
In any non-linear analysis where a finite number of calculation steps are used there will be some drift from the
exact solution, as shown in Figure 242 (on page 367). The purpose of a solution algorithm is to ensure that the
equilibrium errors, both locally and globally, remain within acceptable bounds (Automatic error checks (on page
406)). The error limits adopted in PLAXIS 3D are linked closely to the specified value of the Tolerated error.
Within each step, the calculation program continues to carry out iterations until the calculated errors are smaller
than the specified value. If the tolerated error is set to a high value then the calculation will be relatively quick
but may be inaccurate. If a low tolerated error is adopted then computer time may become excessive. In general,
the standard setting of 0.01 is suitable for most calculations.

PLAXIS

366

PLAXIS 3D-Reference Manual

Meshing and calculation
Calculation control parameters

load

numerical solution

exact solution

displacement
Figure 242: Computed solution versus exact solution
Note:
Be careful when using a tolerated error larger than the default value of 0.01, as this may give inaccurate results
which are not in equilibrium.
If a calculation gives failure loads that tend to reduce unexpectedly with increasing displacement, then this is a
possible indication of excessive drift of the finite element results from the exact solution. In these cases, the
calculation should be repeated using a lower value of the tolerated error. For further details of the error
checking procedures used in PLAXIS 3D see Automatic error checks (on page 406).
Most Validation examples have been performed with a tolerated error lower than the default settings.

Maximum unloading steps
This value gives the number of steps that PLAXIS 3D allows before declaring that the soil body has collapsed. The
default value is 5. However, sometimes, in the case of a changing mechanism the load level may temporarily
decrease in order to pick up another mechanism after which the load can still increase. For example in uplift
problems there is a calculation stage when the top soil structure exhibits buckling behaviour (that lasts longer
than 5 steps), which results in a small unloading. This small unloading is not a collapse of the whole model, as
the final loading finally grows above the previous levels. Hence, the user might decide to set this value to a
higher number and later judge on the presence of collapse based on the loading curve.

Max load fraction per step
This value controls the size of the load step in staged construction. Since this is a fraction, it determines what
maximum part of the stage can be solved in one step. For instance, a value of 0.5 (default) means that the applied
load or unbalance will be solved at least in 1/0.5 = 2 steps. More steps are possible if convergence is slow, but
not less. The user might want to use small values (like 0.02 to force at least 50 steps) in order to observe the
kinetics of the deformation process, prevent divergence in case of high nonlinearity or in combination with
Gradual Error reduction.
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Over-relaxation factor

load

load

To reduce the number of iterations needed for convergence, PLAXIS 3D makes use of an over-relaxation
procedure as indicated in Figure 245 (on page 370). Over-relaxation is a deliberate over-estimation of the
equilibrium error under the assumption that by just solving the exact unbalance, the next iteration is still far
from equilibrium. The purpose of this is to reduce the number of the iterations in order to speed up the
calculation. The parameter that controls the degree of over-relaxation is the over-relaxation factor. The
theoretical upper bound value is 2.0, but this value should never be used. For low soil friction angles, for
example φ < 20°, an over-relaxation factor of about 1.5 tends to optimise the iterative procedure. If the problem
contains soil with higher friction angles, however, then a lower value may be required. The standard setting of
1.2 is acceptable in most calculations.

over relaxation = 1

over relaxation > 1

displacement

displacement

Figure 243: Influence of over-relaxation

Maximum number of iterations
This value represents the maximum allowable number of iterations within any individual calculation step. In
general, the solution procedure will restrict the number of iterations that take place. This parameter is required
only to ensure that computer time does not become excessive due to errors in the specification of the
calculation. The standard value of Maximum number of iterations is 60, but this number may be changed within
the range 1 to 100.
If the maximum allowable number of iterations is reached in the final step of a calculation phase, then the final
result may be inaccurate. If this is the case then the message 'Maximum iterations reached in final step' is
displayed in the Log info for last calculation box of the Phases window. Such a situation occasionally occurs
when the solution process does not converge. This may have various causes, but it mostly indicates an input
error.

Desired min and desired max number of iterations
PLAXIS 3D makes use of an automatic step size algorithm (Automatic error checks (on page 406)). This
procedure is controlled by the two parameters Desired min number of iterations and Desired max number of
iterations, specifying the desired minimum and maximum number of iterations per step respectively. The default
values of these parameters are 6 and 15 respectively, but these numbers may be changed within the range 1 to
100. For details on the automatic step size procedures see Automatic step size procedure (on page 351).
It is occasionally necessary for the user to adjust the values of the desired minimum and maximum from their
standard values. It is sometimes the case, for example, that the automatic step size procedure generates steps
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that are too large to give a smooth load-displacement curve. This is often the case where soils with very low
friction angles are modelled. To generate a smoother load-displacement response in these cases, the calculations
should be repeated with smaller values for these parameters, for example:
Desired minimum = 3 Desired maximum = 7
If the soil friction angles are relatively high, or if high-order soil models are used, then it may be appropriate to
increase the desired minimum and maximum from their standard values to obtain a solution without the use of
excessive computer time. In these cases the following values are suggested:
Desired minimum = 8 Desired maximum = 20
In this case it is recommended to increase the Maximum iterations to 80.

Arc-length control
The Arc-length control procedure is a method that is by default selected in PLAXIS 3D to obtain reliable collapse
loads for load-controlled calculations. The iterative procedure adopted when arc-length control is not used is
shown in Figure 244 (on page 369) for the case where a collapse load is being approached. In the case shown,
the algorithm will not converge. If arc-length control is adopted, however, the program will automatically
evaluate the portion of the external load that must be applied for collapse as shown below.
load

load

step 3

step 3

step 2

step 2

step 1

step 1

arc

displacement

displacement

load control

arc-length control

Figure 244: Influence of Arc-length control
Arc-length control is activated by selecting the corresponding check box in the Numerical control parameters
subtree. The arc-length control procedure should be used for load-controlled calculations, but it may be
deactivated, if desired, for displacement-controlled calculations.
Setting the Arc-length control type parameter to Auto enables the procedure only when the CSP (current stiffness
parameter) is less than 0.5. In this way arc-length is only used when the material exhibits significant plastic
behaviour.

Use line search
This method aims to improve the convergence of non-linear problems in a relatively inexpensive way. It can also
be seen as an improvement on the over-relaxation method that exists in PLAXIS 3D. In its essence line search
tries to scale the correction of the solution increment that is calculated every iteration but the scaling parameter
is not fixed as in the over-relaxation method but calculated in a special way to bring the whole system closer to
equilibrium. In general, the usage of line search is advised for problems without severe non-linearity, like
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serviceability calculations. On the other hand, critical state calculations, like footing failure or embankment
failure generally do not benefit from line search with respect to calculation time.

Use gradual error reduction
Gradual error reduction is a simple numerical trick that aims to speed up the calculation in case of very slow
convergence, as it happens sometimes for non-associated plastic flow. It works as follows: initially the tolerated
error (the one that controls the convergence of the nonlinear calculations) is increased 10-fold and then, by the
end of the phase, it linearly reduces to the error as defined by the Tolerated error parameters. Hence, when using
the default error of 0.01, the calculation will start with 0.1 and end with 0.01. The rationale behind is that in case
of non-associative plastic flow one can obtain an infinite number of alternative (but still correct) solutions with
the same tight tolerance, but with, for instance, different step size. Hence, is it not really necessary to enforce a
tight tolerance during the whole calculation, as a feasible solution is located in a certain band, defined by all
alternative paths. When the gradual error reduction procedure is enabled, the solution does not follow one of the
paths, but, possibly, jumps from one to another. However, in the end of the calculation the error is forced to
reduce to the levels, as defined for the calculation phase.
Nonetheless, application of this procedure should be done with caution. If the initial tolerated error is too high,
hypothetically, the solution can switch to a path that is not even connected to the current initial conditions
(hence infeasible). One way to prevent this is to use much smaller allowable Max load fraction per step than the
default value used in PLAXIS 3D. The default maximum step size is 50% of the whole stage load. The user might
consider reducing the step size to something like 2% or less, hence requiring at least 50 steps (100% / 2%) to
obtain the solution of the calculation phase.

Extrapolation
It is a numerical procedure, which is automatically used in PLAXIS 3D if applicable, when a certain loading that
was applied in the previous calculation step is continued in the next step. In this case, the displacement solution
to the previous load increment can be used as a first estimate of the solution to the new load increment.
Although this first estimate is generally not exact (because of the non-linear soil behaviour), the solution is
usually better than the solution according to the initial stress method (based on the use of the elastic stiffness
matrix) (See Figure below).

load

load

displacement

displacement

without extrapolation

with extrapolation

Figure 245: Difference between elastic prediction (a) and extrapolation from previous step (b)
After the first iteration, subsequent iterations are based on the elastic stiffness matrix, as in the initial stress
method (Zienkiewicz, 1977 (on page 510)). Nevertheless, using Extrapolation the total number of iterations
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needed to reach equilibrium is less than without extrapolation. The extrapolation procedure is particularly
useful when the soil is highly plastic.

7.8.4 Flow control parameters

Figure 246: Flow control parameters subtree in the Phases window

Iterative procedure
Groundwater flow, optionally coupled with thermal flow, involves extra parameters to control the iterative
procedure to solve the corresponding system of equations. For Steady state flow calculations two extra
parameters are available, namely Tolerated error and Over-relaxation factor. For Transient flow a higher number
of parameters are required to define the iterative procedure.

Max steps
This parameter specifies the maximum number of calculation steps that are performed in a phase in which the
Pore pressure calculation type is set to Steady state groundwater flow or Transient groundwater flow or the
Thermal calculation type is set to Steady state thermal flow or Transient thermal flow. By default, the Max steps
parameter is set to 1000.

Tolerated error
Similar to the Tolerated error option in deformation analyses (Numerical control parameters (on page 361)), the
Tolerated error option in flow calculations is used to check if the result is accurate enough. In the case of
unsaturated groundwater flow, checking the local error (error which occurs in a few elements) is also needed. In
this case, due to the fact that the permeability can change significantly, it is possible to have isolated water in
some elements in unsaturated zones. The specified Tolerated error is used for checking both the global flow
error and local errors. PLAXIS 3D used higher Tolerated error to check the local flow errors (usually 10 times
larger). If both global and local errors are less than the Tolerated error, the groundwater flow calculation is
terminated.

Over-relaxation factor
Since the unsaturated flow analyses may be highly non-linear, PLAXIS 3D uses an over-relaxation factor to speed
up the steady state calculations and to decrease the number of steps needed. This factor is by default 1.5. For
confined flow analyses which are linear a factor of 1 is enough. In case of highly non-linear analyses for which
PLAXIS 3D needs more steps, higher values than 1.5 might result in faster convergence. The maximum possible
value is 2.0.
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7.8.5 Dynamic control parameters
The parameters controlling a Dynamic and Dynamic with consolidation analysis can be defined in the Dynamic
control parameters subtree in the Phases window.

Newmark alpha and beta
The Newmark alpha and beta parameters determine the numerical time-integration according to the implicit
Newmark scheme. In order to obtain an unconditionally stable solution, these parameters must satisfy the
following conditions:
Newmark β ≥ 0.5 and Newmark α ≥ 0.25 (0.5 + β)2

Figure 247: Dynamic control parameters subtree in the Phases window
For an average acceleration scheme you can use the standard settings (α = 0.25 and β = 0.5). Using a higher βvalue and corresponding α-value results in a damped Newmark scheme (e.g. α = 0.3025 and β = 0.6).

Mass matrix
In dynamic calculations, PLAXIS 3D uses, by default, a lumped mass matrix, i.e. a mass matrix that contains only
diagonal terms in which the contributions of the off-diagonal terms are incorporated. This provides an efficient
dynamic calculation process, but it may lead to slightly inaccurate results. For example, results of block waves in
soil columns may show small oscillations as well as some dispersion. This can be improved by using a consistent
mass matrix instead of a lumped mass matrix.
The Mass matrix parameter can be used to distinguish between a lumped mass matrix (Mass matrix parameter =
0) and a consistent mass matrix (Mass matrix parameter = 1). In fact, any intermediate value between a lumped
mass matrix and a fully consistent mass matrix can be entered for dynamic calculations (0≤ Mass matrix ≤ 1),
allowing for a mixed matrix to be used.
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7.8.6 Reached values

Figure 248: Reached values subtree in the Phases window
Reached total time

It is the actual accumulated time at the end of a finished calculation phase.

CSP - Relative
stiffness

It is the relative stiffness parameter calculated at the end of the phase, which is a
measure for the amount of plasticity that occurs during the calculation (Automatic error
checks (on page 406)). A value of 1.0 means that the full model is elastic; a value close to
zero indicates that failure is approached.

Reached total force

They are the component of the resulting reactions on the nodes where non-zero
prescribed displacement is applied.

It is the value of the maximum pore pressure that has been actually reached at the end of
Pmax - Reached max a calculation phase. This value corresponds to the maximum excess pore pressure for a
pp
Consolidation analysis, the steady state pore pressure for a groundwater flow analysis
and the maximum active pore pressure for a Fully coupled flow-deformation analysis.
Σ Mstage - Reached
phase proportion

It is an indication of the proportion of the unbalance solved in a phase where the Staged
construction loading type is applied (Staged construction (on page 344)).

Σ Mweight - Reached
material weight
proportion

It is an indication of the total proportion of the material weight applied in a calculation
(General phase parameters (on page 355)). A reached value of 1.00 means that the
specified weight of soil and structural materials is fully applied.

Σ Msf - Reached
safety factor

It is the resulting value of the Σ Msf parameter in a Safety phase (Safety calculation (phi/c
reduction) (on page 336)).
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7.9 Flow conditions
PLAXIS 3D is generally used for effective stress analysis in which total stresses are divided into effective
stresses, σ', and active pore pressures, pactive.
σ = σ ′ + pactive

Eq. [90]

Active pore pressure (pactive) is defined as the effective saturation, Seff, times the pore water pressure, pwater.
pactive = Seff ⋅ pwater

Eq. [91]

Pore water pressure differs from active pore pressure when the degree of saturation is less than unity. PLAXIS
3D can deal with saturated soil below the phreatic level, as well as with partially saturated soil above the
phreatic level. More details about partially saturated soil behaviour are provided in Groundwater tabsheet (on
page 248).
In the pore water pressure a further division is made between steady state pore pressure, psteady, and excess
pore pressure, pexcess.
pwater = psteady + pexcess

Eq. [92]

Excess pore pressures are pore pressures that occur as a result of stress changes in undrained materials. In this
respect, changes in stress may be a result of loading, unloading, a change in hydraulic conditions or
consolidation. Hence, excess pore pressures are a result of a deformation analysis. In a Plastic calculation, a
Safety analysis or a Dynamic analysis, excess pore pressures can occur in clusters for which the Drainage type is
set to Undrained A or Undrained B. In Consolidation analysis, Dynamic with consolidation analysis and Fully
coupled flow-deformation analysis, excess pore pressures can occur in any material (except Non-porous
materials), depending on the permeability as defined in the corresponding material data set. In the case of a Fully
coupled flow-deformation analysis, excess pore pressure is calculated by subtracting the steady-state pore
pressure, psteady, from the pore water pressure, pwater.
Steady-state pore pressures are pore pressures that represent a stable state. Since steady-state pore pressures
are not supposed to change during a deformation analysis, they are considered input data. There are various
ways to define and generate steady-state pore pressures. The way to indicate how pore pressures are generated
for a particular calculation phase is indicated by means of the Pore pressure calculation type parameter in the
Phases window. In contrast to other deformation calculation types, a Fully coupled flow-deformation analysis
does not allow for the selection of the Pore pressure calculation type, because in this case total pore water
pressures, pwater, are calculated together with displacements. To enable a division in steady-state pore pressures
and excess pore pressures, the steady-state pore pressures, psteady, are automatically calculated on the basis of a
preliminary steady-state groundwater flow calculation using the hydraulic boundary conditions at the end of the
calculation phase. This enables the calculation and output of excess pore pressures, pexcess, in all steps:
pexcess = pwater − psteady

Eq. [93]

The definition of water conditions is needed to generate pore pressures in the soil and to generate external
water pressures, if applicable. The definition of water conditions can be divided into the creation of water levels
and assigning water conditions to volume clusters. These features will be described in more detail below.

7.9.1 Water levels
Water levels can either be generated according to the information specified in boreholes ( Defining water
conditions (on page 75)) or can be defined in the Flow conditions mode. A water level can be used to generate
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external water pressures (for water levels outside the model) and to generate pore pressures in soil layers. In
the latter case the water level can act as a phreatic level in partially saturated soil layers as well as a pressure
head level in aquifer layers. Water levels created in the model are grouped under the Water levels subtree in the
Attributes library in the Model explorer. Due to the global nature of the water levels, any change to an existing
water level in the model will affect it in all the phases. If a water level in a time-dependent phase has the same
geometry as previously defined but it varies with time, a flow function needs to be assigned to it. Moreover, it is
required to create a copy of a water level with the same geometry. To create a copy of the water level, right-click
the existing water level in the Model explorer and select the Duplicate option in the appearing menu (Figure 249
(on page 375)). A copy of the water level is created. Now a flow function can be created and assigned to this new
water level. Note that copies of Borehole water levels are listed as User water levels rather than Generated water
levels. No modifications, such as Time dependency are possible for Borehole water levels and non-horizontal
water levels.

Figure 249: Copying water levels in Model explorer
The continuity of the flow functions assigned to water levels in consecutive phases can be maintained by using
the options available in the pop up menu displayed when the water level is right-clicked. These options are:
Create the reached
water level

When this option is selected a new water level is created at the position reached at the
end of the previous phase. The location of the water level will be constant in the current
phase.

Create the reached
water level and
continue

When this option is selected a new water level is created at the position reached at the
end of the previous phase. The location of the water level in the current phase will
change from that point on according to the flow function assigned to the original water
level in the previous phase. PLAXIS 3D ensures the continuity of the flow function,
whereby the accumulated time from previous phases is used as an offset to enter the
flow function for the current phase.
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Borehole water levels
The easiest way to define a water level is in the Soil mode by specifying a Head in the boreholes ( Defining water
conditions (on page 75)). A single borehole can be used to create a horizontal water surface that extends to the
model boundaries. When multiple boreholes are used, a non-horizontal water surface can be created by
combining the heads in the various boreholes. The water level defined in this way is termed a 'Borehole water
level'. This water level is, by default, used as the Global water level (see further). In principle, a pore pressure
distribution underneath this generated water level is hydrostatic. However, a non-hydrostatic distribution in the
soil may be specified in the Water tabsheet of the Modify soil layers window, which may lead to additional
generated water levels representing the (virtual) level where the extrapolated pore pressure in a particular soil
layer is zero. For more details about this feature, see Defining water conditions (on page 75).

User water levels - Water levels mode
As an alternative to the Generated water levels, the user may define 'User water levels' using the Create water
level option, which is available in the Flow conditions mode.
After selecting this option, a first water level point can be created by clicking in the model at a position where
the water pressure is supposed to be zero. As a result,a horizontal water level is created through this point,
extending to the model boundaries. At the same time, the Waterlevel points window appears with a table of the
point coordinates and a pressure increment with depth.

Figure 250: Waterlevel points window
A non-horizontal water level can be created by defining more points in the geometry, while the Create water
level option is still active. The creation of water levels is basically the same as the creation of surfaces (Create
surface (on page 105)). If necessary, the point coordinates or the pressure increment with depth (Pinc) may be
changed in the table. Unlike surfaces, user water levels can only be moved in vertical direction by dragging them
with the mouse. A new user water level may also be created by duplicating an existing water level and modifying
it afterwards. To duplicate an existing water level, right-click it and select Duplicate from the appearing menu.
User water levels can be deleted by right-clicking them and selecting the Delete option from the appearing menu.
Time dependency can be specified for horizontal User water levels. The time dependent behaviour can be
specified by selecting the corresponding flow function.
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Note:
• The Borehole water levels cannot be deleted.
• A time-dependent flow function cannot be assigned to water levels that are non-horizontal.

7.9.2 Assigning water conditions to soil volumes
Pore pressures in soil volumes are generated on the basis of the water conditions assigned to these volumes. By
default, the water conditions as defined in the Modify soil layers window are assigned to all soil volumes
clusters. This could be the Global water level, but (in case of non-hydrostatic pressures defined in the boreholes)
it could also be a different generated water level or one of the other water conditions as defined for soil layers in
Soil mode.
To change the water conditions in the calculation phase considered, volumes objects have to be selected and the
desired option should be selected from the Water conditions feature in the Selection explorer. Similar options can
be selected in the Model explorer or from the right-hand mouse menu. A summary of all available options is given
below:
Global level

Water conditions defined by the Global water level (default).The Global water level is
defined in the General group in the Phases window.

Custom level

Another predefined water level is selected to set the water conditions.

Head

A new Head level is defined to set the water conditions.

User-defined

A reference level, reference pressure and pressure increment with depth are defined to
set the water conditions.

Interpolate

Water pressures are linearly interpolated (in vertical direction) between the volumes
cluster above and the volumes cluster below.

Dry

Set water pressures to zero.

Unsaturated

A saturation level is defined to set the water conditions to partially saturated. The
resulting pore stress (suction) will be calculated according to the hydraulic model as
defined in the material data set.

Global level
When the Global level option is selected, the pore pressure distribution in the soil layer is generated according to
the global water level of the phase considered. The resulting pore pressure distribution in the soil layer is then
hydrostatic. This does not mean that the pore pressure distribution in the soil as a whole is hydrostatic, since
other soil layers may have other hydraulic conditions.

Custom level
When the Custom level option is selected in the Water conditions drop-down menu, a further selection should be
made from the list of available water levels (Borehole water levels and User water levels). The resulting pore
pressure distribution in the soil layer is then hydrostatic.
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Head
The Head option is a quick alternative for the generation of hydrostatic pore pressures based on a horizontal
water level. After selecting the Head option in the Water conditions drop-down menu, a reference level (zref)
should be defined, indicating the level where the pore pressure will be zero.
Note:
• The multi-select option may be used to efficiently set water conditions for multiple soil layers at once.
• When a non-horizontal water level is used to generate a hydrostatic pore pressure distribution, this
distribution may not be fully realistic, since in reality a non-horizontal water level would be the result of a
groundwater flow process in which case the pore pressure distribution may be non-hydrostatic.

User-defined
If the pore pressure distribution is linear but not hydrostatic, the User-defined option should be selected in the
Water conditions drop-down menu. Subsequently, values for the reference level (zref), the reference pressure
(pref) and the pressure increment (pinc) should be entered. Note that pressure is entered as a negative value.

Interpolate
It is possible to generate pore pressures in a soil volumes based on the pore pressures of the adjacent soil
volumes (above and below) by selecting the Interpolate option in the Water conditions drop-down menu. This
option is, for example, used if a relatively impermeable layer is located between two permeable layers with a
different groundwater head. The pore pressure distribution in the relatively impermeable layer will not be
hydrostatic, so it cannot be defined by means of a phreatic level.
On selecting the option Interpolate the pore pressure in that soil volumes is interpolated linearly in vertical
direction, starting from the value at the bottom of the soil volumes above and ending at the value at the top of
the soil volume below. The Interpolate option can be used repetitively in two or more successive soil volumes
(on top of each other). In the case that a starting value for the vertical interpolation of the pore pressure cannot
be found, then the starting point will be based on the Global water level.

Dry
In addition to the global water pressure distribution it is possible to remove water pressures from individual
groups of volumes in order to make them 'dry'. Deactivation of water can be done independent from the soil
itself. Hence, if the soil is deactivated and the water level is above the excavation level, then there is still water in
the excavated area. If it is the user's intention to simulate a dry excavation, then the water must be explicitly
deactivated. Please note that the water pressure in adjacent soil volumes is not affected and may need to be
changed manually.
Note:
The Dry clusters behave as non-porous materials. As a result, neither initial nor excess pore pressure is taken
into account and flow is not possible through the cluster.

Unsaturated
It is possible to generate pore stresses (suction) based on an explicit value of initial saturation in a soil volumes,
by selecting the Unsaturated option from the Water conditions drop-down menu. The Saturation value has to be
in the range 0.1 and 0.99. The saturation is uniform throughout the soil cluster. The resulting pore stess
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(suction), will be calculated according to the hydraulic model and parameters as defined in the material dats set.
In order to be able to use this suction during calculations, the option 'ignore suction' must be de-selected.

7.9.3 Water pressure generation and previewing
Water pressures (i.e. pore pressures in finite element stress points and external water loads) are calculated on
the basis of the water conditions as defined for a calculation phase as soon as the phase is previewed or when
the calculation process is started.
It is recommended to preview the water pressures in order to check that the generated pressures are
satisfactory. This can be done by clicking the Preview phase button in the side tool bar. After the water pressures
have been generated and written to data files, the Output program is started, showing the active mesh for the
phase considered. The various types of pore pressures can be previewed by selecting the desired option from
the Stress menu. The phreatic level or external water level can be seen when the Phreatic level option is active in
the Geometry menu. If the Loads option is also active and the water level is outside the active mesh, external
water pressures can be seen.
Water pressures for phases that are selected for calculation are also generated at the start of the calculation
process, just before the execution the finite element calculation itself. The results of the water pressure
generation are also included in the output steps with computational results, and can be viewed after the
calculation has finished.

7.9.4 Flow boundary conditions
The flow boundary conditions of a phase (at least which boundaries are 'open' and which are 'closed') can be
specified in the GroundwaterFlow subtree under Model conditions in the Model explorer. Such boundary
conditions are required for a groundwater flow calculation, a consolidation analysis or a fully coupled flowdeformation analysis. By default the bottom boundary of the model is closed. The prescribed groundwater head
on external geometry boundaries is, by default, derived from the position of the general phreatic level, at least
when the general phreatic level is outside the active geometry. Also internal geometry lines that have become
external boundaries due to a de-activation of soil clusters are considered to be external geometry boundaries
and are therefore treated similarly.
In a consolidation analysis the flow boundary conditions define where excess pore pressures may dissipate
through the model boundary, and hence, it affects the excess pore pressures only. In a groundwater flow or fully
coupled analysis the flow boundary conditions define where pore water may flow into or out of the soil, and
hence, it affects the total pore pressures in these cases. In the latter case, additional conditions may be required
to define the hydraulic head at 'open' boundaries. By default, the hydraulic head is implicitly defined by the
Global water level, but this can be overwritten by using the Create groundwater flow boundary conditions feature
in the Structures mode (Surface flow boundary conditions (on page 179)). The parts of an 'open' boundary
above the level defined by the hydraulic head are considered to be 'seepage' boundaries whereas the parts
below are assigned the given hydraulic head as a boundary condition.

Boundary conditions - Phases
Besides the options described in Surface flow boundary conditions (on page 179) for groundwater flow
boundary conditions, two other options are available in Calculation modes. These options are:
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Constant value from The water level reached at the end of the previous phase will be kept constant during
previous phase
the current phase.
The water level in the current phase will continue to vary according to the flow function
Maintain function
assigned to the boundary in the previous phase. The accumulated time from previous
from previous phase
phases is used as an offset to enter the flow function for the current phase.

7.9.5 Precipitation
The Precipitation option can be used to specify a general vertical recharge or infiltration (q) due to weather
conditions. This condition is applied at all boundaries that represent the ground surface. This option can be
selected in the Model conditions subtree in the Model explorer (Figure 251 (on page 380)).

Figure 251: The expanded Precipitation subtree in the Model explorer
Note:
Note that when both Precipitation and a groundwater flow boundary conditions is created at the top boundary of
the model, the condition specified for the boundary condition is taken into account ignoring Precipitation.
The parameters used to define precipitation are:
q

Recharge (infiltration), specified in the unit of length per unit of time. Negative values
can be used to model evaporation.

ψmax

Maximum pore pressure head, relative to the elevation of the boundary, specified in the
unit of length (default 0.1 length units). When the groundwater head increases above
this level, the infiltration discharge changes into the corresponding head to simulate run
off.
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ψmin

Minimum pore pressure head, relative to the elevation of the boundary, specified in the
unit of length (default -1.0 length units). When the groundwater head decreases below
this level, the evaporation discharge changes into the corresponding head.

At horizontal ground surface boundaries, the full precipitation as specified by the value of q is applied as a
recharge. At inclined ground surface boundaries (slopes) under an angle α with respect to the horizon, a
recharge is applied perpendicular to the inclined boundary with a magnitude q cos(α).
If the resulting pore pressure head at a certain point of a boundary where a positive precipitation has been
prescribed is increased such that it reaches the value y + ψmax (i.e. the water level comes above the ground
surface at a depth of ψmax) then the water is supposed to run-off. As a result, a constant head boundary condition
equal to y + ψmax is applied instead.
If the resulting pore pressure head at a certain point of a boundary where a negative precipitation
(evapotranspiration) has been prescribed is below a value y + ψmin (i.e. the upper part of the ground has become
unsaturated), then the evapotranspiration is supposed to stop. As a result, a constant head boundary condition
equal to y + ψmin is applied instead.
For transient groundwater flow calculations and fully coupled flow-deformation analysis, a variation of the
precipitation in time can be specified resulting in time-dependent boundary conditions. This can be done by
selecting the Time dependent option in the Precipitation subtree. The corresponding flow function describing the
variation of the discharge with time can be selected from the drop-down menu. More information on Flow
functions is available in Flow functions (on page 184).

7.10 Geometry configuration - Staged Construction mode
In PLAXIS 3D, it is possible to change the geometry and load configuration by activating or deactivating loads,
soil volume clusters or structural objects created in the geometry input for each calculation phase. The material
data sets can be reassigned and the water pressure distribution in the geometry can be changed as well.
Changes to the geometry configuration generally cause substantial out-of-balance forces. These out-of-balance
forces are stepwise applied to the finite element mesh using the automatic load stepping procedures (Automatic
step size procedure (on page 351)).

7.10.1 Changing geometry configuration
Loads, soil volume clusters or structural objects may be activated or deactivated to simulate a process of
construction or excavation in the Staged construction mode. Hence, it is possible, for example, to first make an
excavation with soil retaining walls, then install a basement floor and subsequently constructing the building
above. In this way, the effects around the excavation can be analysed realistically.
To activate elements in a selected mode in Phases explorer, click the Activate button and click the objects to
be activated in the drawing area. All the elements assigned to the geometry selected after clicking Activate will
be activated.
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To deactivate elements in a selected mode in Phases explorer, click the Deactivate button and click the
objects to be deactivated in the drawing area. All the elements assigned to the geometry selected after clicking
Deactivate will be deactivated.
The right mouse button menu or the Object explorers can be used in cases where not all features should be
deactivated. Note that in the right mouse button menu, besides the geometry entity, the features assigned to it
are listed as well. To deactivate a feature, point that in the right mouse button menu and select the Deactivate
option.
Entities and the features assigned to them can be activated or deactivated in Object explorers by clicking on the
square in front of them (See Figure 252 (on page 382)).
•

Not active object or group of objects.

•

Active object or group of objects.

•

Partly active group of objects.

Figure 252: Selection explorers in Staged construction mode
The activation or deactivation of soil volume clusters or structural objects or change of properties can introduce
substantial out-of-balance forces. These out-of-balance forces are solved stepwise during the staged
construction calculation process.
Note:
• The option to activate or deactivate objects should not be confused with the option to show or hide objects. A
hidden object (invisible) may still be active.
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• The visibility of deactivated objects is defined in the Visibility tabsheet of the Visualisation settings
window

7.10.2 Staged construction procedure in calculations
At the start of a calculation phase the information about active and inactive objects in the geometry model is
transformed into information on an element level. Hence, deactivating a soil cluster results in 'switching off' the
corresponding soil elements during calculation. The following rules apply to elements that have been switched
off:
•
•
•
•
•

Properties, such as weight, stiffness and strength, are not taken into account.
All stresses are set to zero.
All inactive nodes will have zero displacements.
Boundaries that arise from the removal of elements are automatically taken to be free and permeable.
As a soil cluster is deactivated, the Water conditions are maintained. The water conditions of the deactivated
soil cluster can be changed to model a dry excavation.
• External loads that act on a part of the geometry that is inactive will not be taken into account.
For elements that have been inactive and that are (re)activated in a particular calculation, the following rules
apply:
• Stiffness and strength will be fully taken into account from the beginning (i.e. the first step) of the calculation
phase.
• Weight will, in principle, be fully taken into account from the beginning of the calculation phase. However, in
general, a large out-of-balance force will occur at the beginning of a staged construction calculation since the
initial stresses (if any) are not in equilibrium with the weight of the newly activated elements or loads. This
out-of-balance force is stepwise solved in subsequent calculation steps.
• The stresses will develop from zero.
• When a node becomes active, an initial displacement is estimated by stressless pre-deforming the newly
activated elements such that they fit within the deformed mesh as obtained from the previous step. Further
increments of displacements are added to this initial value. As an example, one may consider the construction
of a block in several layers, allowing only for vertical displacements (one-dimensional compression). Starting
with a single layer and adding one layer on top of the first will give settlements of the top surface. If a third
layer is subsequently added to the second layer, it will be given an initial deformation corresponding to the
settlements of the surface.
The following rules apply for interfaces:
Deactivated
interfaces

The interfaces can be deactivated when modelling soil-structure interaction is not
desired. Nodes generated for interfaces in mesh generation process are still there. They
have stiff elastic behaviour; fully permeable (Consolidation analysis).

Activated interfaces

Elasto-plastic behaviour; fully impermeable (Consolidation analysis).
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7.10.3 Changing loads
During creation in the Geometry modes, a default value is given to a load which represents a unit load. These load
values may be changed in each calculation phase to simulate changing loads in the various stages of
construction. The change of loads can introduce substantial out-of-balance forces. These out-of-balance forces
are solved during the staged construction calculation process.

7.10.4 Definition of connections
When structural elements are connected, by default they share all degrees of freedom (rotations and translation
degrees of freedom) in the connected node, which implies that the connection is rigid.
In the Calculation modes it is possible to customize the connection between two plates or between a plate and a
beam by explicitly defining a Connection object. In this way it is possible to define line hinges (between two
plates) and point hinges (between a plate and a beam), as well as dilation joints (displacement discontinuities)
between two plates and between a plate and a beam.
A connection consists of:
The Reference part (or the 'parent object')

This is the object to which another object (a 'child
object') is connected.

The Custom part (or the 'child object')

This is the object that is connected to the 'parent
object'.

A connection requires the presence of interface elements (Interfaces (on page 146)). Interfaces are features that
can only be assigned to surfaces. Interface elements are composed of pairs of nodes in which the nodes in a pair
have the same coordinates (Scientific Manual - Chapter 5). This ensures that extra nodes are available for the
extra degrees of freedom that are associated with the creation of a hinge or dilation joint.
When an invalid connection is defined a warning message appears before calculating the project (Figure 253 (on
page 384)). If a connection is defined on a node where no interface is applied, the problem can be overcome by
defining interfaces larger than the reference plate, defining interfaces on both sides of the reference plate or by
assigning interfaces to both of the connected plates. Note that a Beam cannot be the Reference part of the
connection as interface elements cannot be assigned to beams.

Figure 253: Warning regarding invalid connections

PLAXIS

384

PLAXIS 3D-Reference Manual

Meshing and calculation
Geometry configuration - Staged Construction mode
A connection is active when both parts are active in a calculation phase. Modifications done in connections are
valid for all the phases where the connection is active. It is not possible to assign different properties to a
connection in different phases.
If a connection has been defined, by default, the rotation degree of freedom of the 'child's' node(s) involved in
the connection is disconnected (free) from the corresponding degree of freedom in the 'Parent's' node(s),
whereas the translational degrees of freedom are tied (fixed). This means that the default connection is a hinge.
The user can modify a connection by defining for each 'child' degree of freedom whether it is free or fixed.
Distinction is made between rotation around the first local axis and translation in the three individual local
directions. In order to define a dilation joint, at least one translational degree of freedom should be set free.

Connection between two plates
To create a connection between two plates:
• Make sure that an interface as well as a plate is assigned to the surface representing the Reference part in the
connection.
• In the Staged construction mode select all plates involved in the connection.
• Right click the model and select the Create custom connection option from the appearing menu. The newly
created connection is indicated by a yellow line in the model. The local axes of the connections are displayed
if the Show local axes option is selected in the Options menu. A new connection is listed in the Connections
subtree of the Model explorer (Figure 254 (on page 386)).
• Right-click on the model and select the Create custom connection option from the appearing menu.
To create a line hinge between two plates:
• Set the required option for rotation to Free.
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Figure 254: Connections subtree displaying a plate-plate connection
Note:
• The order of selection effects the part of the connection assigned to each plate. The first selected plate will be
assigned as the Custom part of the connection whereas the second selected part will be assigned as the
Reference part of the connection.
• The role of the parts of the connection can be interchanged by right clicking the connection in the Object
explorer and selecting the Invert connected part option from the appearing menu.
• The order of selection is not important in a plate-beam connection. In that case the plate will always be the
reference part of the connection.
To create a dilation joint between two plates:
• Set the required option for translation to Free.

Connection between a plate and a beam
To create a connection between a plate and a beam:
• Make sure that an interface as well as a plate is assigned to the surface representing the Reference part in the
connection.
• In the Staged construction mode multi select the plate and the beam, the connection between which is to be
customised.
• Right click the model and select the Create custom connection option from the appearing menu. The newly
created connection is indicated by a yellow point in the model. The local axes of the connections are
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displayed if the Show local axes option is selected in the Options menu. A new connection is listed in the
Connections subtree of the Model explorer (Figure 255 (on page 387)).
To create a point hinge between a plate and a beam:
• Set the required option for rotation to Free.

Figure 255: Connections subtree displaying a plate-beam connection
To create a dilation joint between a plate and a beam:
• Set the required option for translation to Free.

7.10.5 Reassigning material data sets
It is possible in a calculation phase to assign new material data sets to soil volume or structural objects. This
option may be used to simulate the change of material properties with time during the various stages of
construction. The option may also be used to simulate soil improvement processes, e.g. removing poor quality
soil and replacing it with soil of a better quality.
The change of certain properties, for example when replacing peat by dense sand, can introduce substantial outof-balance forces due to a difference in unit weight. These out-of-balance forces are solved during the staged
construction calculation process.
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7.10.6 Applying volumetric strains in clusters
In addition to changing material properties for clusters, in PLAXIS 3D it is also possible to apply a Volumetric
strain in individual soil clusters. This can be done in the Selection explorer by selecting the corresponding soil
volume and clicking the checkboxes corresponding to VolumetricStrain and to Apply (Figure 256 (on page 388)).

Figure 256: Volumetric strain in the Selection explorer
Values can be defined for the three strain components in x-, y- and z-direction and for volumetric strain. A
positive value of the strain component represents an expansion, whereas a negative value represents a
shrinkage in that direction.
In contrast to other types of loading, volumetric strains are not activated with a separate multiplier. Note that
the imposed volumetric strain is not always fully applied, depending on the stiffness of the surrounding clusters
and objects.

7.10.7 Prestressing of anchors
Prestressing of anchors can be activated in the Object explorer for a selected phase. By default the Adjust
prestress option is not selected. On selecting the Adjust prestress force check box it is possible to enter a value for
the prestress force (Fprestress) in the corresponding edit box. A prestress force should be given in the unit of force.
Note that tension is considered to be positive and compression is considered negative.
By default, in a calculation phase following a phase in which an anchor has been prestressed the prestress
setting is NOT continued but the anchor force is maintained. In this way the existing anchor force is used as a
start condition and will develop 'naturally' based on changes of stresses and forces in the model. If you intend to
again apply a prestress force, this has to be done explicitly following the same procedure as described above.
If a previously entered prestress force needs to be 'reset' to retain a standard active anchor without prestressing
but with existing anchor force, this should be done by de-selecting the Adjust prestress parameter in the Object
explorer. It is generally NOT correct to set a prestress force to zero, since this will result in a zero anchor force.
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7.10.8 Advancing a tunnel
The construction of a tunnel can be regarded as a 'train' of construction steps ('tunnel train') that is advancing as
a continuous process or in sections of a certain length. In the numerical modelling of tunnel construction, the
advancement of the construction process always has to be discretised in sections. Therefore, the Tunnel Designer
allows for a division of the full tunnel path (Trajectory) into sections, which are called 'slices'.
In order to simplify the definition of calculation phases in Staged Construction to account for the advancement of
the 'tunnel train', the Tunnel Designer includes facilities to define the necessary steps (see Sequencing (on page
171)).

Advance to next tunnel step
In the Model explorer expand Tunnels and right-click on the corresponding Tunnel. The Advance to next tunnel
step option can now be selected. The 'tunnel train' advances one step without regenerating the whole tunnel,
maintaining the changes performed to the part of the model that is not affected by the advancement in the
current phase.
In the case the construction and advancement of a tunnel consists of multiple phases, it might be useful to run
the following commands in the commands runner (Click on the Expert menu and then Run commands, or Ctrl
+F9):
phase Phases[-1]
setcurrentphase Phases[-1]
phase Phases[-1]advance Tunnel_1 Phases[-1]
These commands can be copied for the required number of phases. Alternatively, these commands can be copied
to the clipboard. Commands on the clipboard can be executed directly by pressing Ctrl+Shft+F9 without the need
to have the Run Commands window open. As long as these commands are on the clipboard, pressing Ctrl+Shft+F9
will automatically introduce another phase in which the tunnel is advanced over one slice.

Advancement step
In the Model explorer expand Tunnels and then expand the corresponding Tunnel. Scroll down the Model explorer
until the option Advancement step is displayed. The number of advanced steps can be manually set. The 'tunnel
train' advances to the chosen step regenerating the whole tunnel accordingly to the defined sequencing. All the
changes previously performed to the part of the model that is not affected by the advancement are overwritten
accordingly to the defined sequencing. The regeneration of the advancement regards only the current phase.

7.10.9 Model conditions
The global boundary conditions for a selected phase can be defined in the Model conditions subtree in the Model
explorer. Note that user-defined conditions always prevail over the ones defined in the Model conditions subtree.

Deformation
PLAXIS 3D automatically imposes a set of standard fixities to the boundaries of the geometry model. These
conditions are generated according to the following rules.
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Soil volume:
• Vertical model boundaries with their normal in x-direction (i.e. parallel to the yz-plane), are fixed in xdirection (ux=0) and free in y- and z-direction.
• Vertical model boundaries with their normal in y-direction (i.e. parallel to the xz-plane), are fixed in ydirection (uy = 0) and free in x- and z-direction.
• Vertical model boundaries with their normal neither in x- nor in y-direction, are fixed in x- and y-direction (ux
= uy = 0) and free in z-direction.
• The model bottom boundary is fixed in all directions (ux = uy= uz = 0).
• The 'ground surface' is free in all directions.
The options available for the model boundaries are (defaults in square brackets):
BoundaryXMin

Free, [Normally fixed], Horizontally fixed, Vertically fixed, Fully fixed

BoundaryXMax

Free, [Normally fixed], Horizontally fixed, Vertically fixed, Fully fixed

BoundaryYMin

Free, [Normally fixed], Horizontally fixed, Vertically fixed, Fully fixed

BoundaryYMax

Free, [Normally fixed], Horizontally fixed, Vertically fixed, Fully fixed

BoundaryZMax

Free, Normally fixed, Horizontally fixed, Vertically fixed, [Fully fixed]

BoundaryZMin

[Free], Normally fixed, Horizontally fixed, Vertically fixed, Fully fixed

In the case that the model has no vertical model boundaries and/or no horizontal bottom boundary, prescribed
displacements need to be defined in order to set the displacement boundary conditions.
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Figure 257: Boundary conditions
Structures: Structures that extend to the model boundary (XMin, XMax, YMin, YMax, ZMin, ZMax), where at least
one displacement direction is fixed, obtain at least two fixed rotations in the points at the boundary.
•
•
•
•

At vertical model boundaries with a normal in x-direction: φy=φz=0 (φx=free).
At vertical model boundaries with a normal in y-direction: φx=φz=0 (φy= free).
At vertical model edges and at the bottom boundary: φx=φy=φz=0.
At the 'ground surface': φx=φy=φz= free.

Note:
• Note that the standard displacement fixities (Model conditions (on page 389)) apply to soil volumes and
structures.
• User-defined prescribed displacements always prevail over the automatically defined fixities.

Dynamics - Dynamic boundary conditions
For dynamic calculations, different boundary conditions than the standard fixities are required in order to
represent the far-field behaviour of the medium. The reality is characterised by an infinite domain which has to
be reduced to a finite domain when creating a geometry model. Appropriate boundary conditions can simulate
the far-field behaviour by absorbing the increment of stresses caused by dynamic loading and avoiding spurious
wave reflections inside the soil body. By default, PLAXIS 3D provides the option to use Viscous boundaries but
other options are available as well.
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When a Dynamic calculation is defined, the boundary conditions can be defined for the phase by selecting the
proper options displayed when the Dynamics subtree is expanded under Model conditions in the Model explorer
(Figure 258 (on page 392)).

Figure 258: Boundary conditions for Dynamic calculations
The options available for the model boundaries are (defaults in square brackets):
BoundaryXMin

None, [Viscous], Free-field

BoundaryXMax

None, [Viscous], Free-field

BoundaryYMin

None, [Viscous], Free-field

BoundaryYMax

None, [Viscous], Free-field

BoundaryZMin

[None], Viscous, Compliant base

BoundaryZMax

[None], Viscous

All nodes fixities

[None], Fixed in x-direction, Fixed in y-direction , Fixed in z-direction

The meaning of these conditions is as follows:

None

PLAXIS

Only the standard fixities are applied to this boundary. In earthquake analysis, this
option can be used at the base of the geometry model in combination with a line
prescribed displacement to simulate the boundary of two layers with a very high
impedance contrast, for instance a soft soil layer over a rigid bedrock. This results in a
full reflection of downward propagating waves.
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Viscous

Viscous boundaries absorb the outgoing wave energy. This boundary condition
corresponds to a situation in which viscous dampers are applied in the x and y direction
along the boundary providing a resistant force in the normal and tangential direction at
the boundary that is proportional to the velocity in the near-boundary material. The
Viscous boundary condition has been introduced by Lysmer & Kuhlmeyer (1969) (on
page 509). This option is suitable for problems where the dynamic source is inside the
mesh. If a Viscous boundary is selected at the base of the model for a seismic analysis, the
required input has to be a load history. The Relaxation coefficients C1 and C2 need to be
considered (see Scientific Manual - Chapter 5 - Model Boundaries).
The Free-field boundary condition is only available for the lateral boundaries (i.e. xmin
and xmax) and simulates the propagation of waves into the far field with minimum
reflection at the boundary. Free field elements can be modelled at both sides of the main
domain and are characterised by the same properties as the soil layers inside the mesh.
The free field motion is transferred from the free field elements to the main domain by
applying equivalent normal and shear forces. Two dashpots are added, in the normal
and shear direction, at each node of the lateral boundary, to adsorb the waves reflected
from the internal structures (Figure 259 (on page 393)). This option requires the
creation of interface elements along the vertical model boundaries in the Structures
mode. The interface elements must be added inside the model, else the Free-field
boundary condition will be ignored. If this option is selected for one of the vertical
model boundaries, it must also be selected for the opposite vertical model boundary.
This option is preferred for earthquake analysis, where the dynamic input is applied
along the model bottom boundary. The input motion is then also applied at the base of
the free-field elements.

Free-field

Figure 259: Free field boundary condition
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Compliant base

The Compliant base boundary condition is only available for the base (ymin) of the model
and simulates the continuation of waves into the deep soil with minimum reflection at
the bottom boundary. The compliant base (Joyner & Chen (1975) (on page 509)) is
made up of a combination of a line prescribed displacement and a viscous boundary. The
input signal (i.e. a displacement, velocity or acceleration time history) is transferred to
the main domain by applying equivalent normal and shear forces. The viscous boundary
consists of a series of dashpots, in the normal and shear direction, at each node of the
base, to adsorb downward propagating compressive and shear waves. Note that only
upward propagating waves should be considered in the signal applied at a compliant
base boundary. In the case of a bedrock layer, this can be defined by taking only half of
the input value of the corresponding prescribed displacement (e.g. 0.5 m instead of 1.0
m), together with the bedrock outcropping motion as dynamic multiplier. The
combination of a load history and a viscous boundary allows for input of an earthquake
motion while still absorbing outgoing waves. In earthquake analysis, this option can be
used for site response analysis as well as for dynamic soil-structure interaction analysis
where the model bottom boundary is within a homogeneous layer of soil or bedrock
with a high shear wave velocity. In the case of a bedrock layer, it is recommended to
include 1 m (3 ft) of bedrock at the base of the model below which the compliant based
boundary is applied. Downward propagating waves from the main domain are free to
propagate to the underlying layer which is not included in the finite element mesh. The
equivalent forces are calculated taking into account the soil layer at the base. This option
requires the presence of interface elements along the bottom boundary in the Structures
mode. The interface elements must be added inside the model, else the Compliant base
boundary condition will be ignored.

Fixed in x-direction All nodes at the boundary are fixed in x direction.
Fixed in y-direction All nodes at the boundary are fixed in y direction.
Fixed in z-direction All nodes at the boundary are fixed in z direction.
Note:
• Viscous boundaries do not consider additional forces from structural elements. Hence when using viscous
boundaries, do not use structural elements at these boundaries.
• In case the soil in the main domain is characterised by undrained behaviour (Undrained A or Undrained B),
Free-field and Compliant base require a small layer or column of soil with drained soil behaviour near the
model boundaries. The reason is that Free-field and Compliant base boundary conditions are only defined for
drained soil behaviour.
• By default, Free-field or Compliant base elements are not displayed in the Output program. In order to be able
to visualise the movement in the Free-field or Compliant base, a (inactive) geogrid or plate element can be
added at these boundaries. Note that during calculations such a plate or geogrid must remain inactive.
The Relaxation coefficients C1 and C2 are used to improve the wave absorption on the viscous boundaries. C1
corrects the dissipation in the direction normal to the boundary and C2 does this in the tangential direction. If
the boundaries are subjected only to waves that come in perpendicular to the boundary, relaxation is not
necessary (C1 = C2=1). When there are waves in arbitrary direction (which is normally the case), C2 has to be
adjusted to improve the absorption. The standard values are C1=1 and C2=1.
Note that the Compliant base condition requires the manual creation of interface elements along the full model
boundary, which enable the creation of a so called node pair. Between the two nodes of a node pair a viscous
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damper is created which allows to transfer the input motion and absorb the incoming waves. In the Output
program only the parameters related to one side of the node pair can be visualised, i.e. the motion in these nodes
is not equal to the input motion. To be able to see and to explicitly check the input motion, it is possible to create
a so called 'dummy plate', i.e. a plate at the bottom line of the model, characterised by very low stiffness
parameters so that it does not influence the results. A node has to be selected on the plate to be able to compare
the motion in this node with the input signal. There is no specific need to activate the dummy plate during the
calculation.

Field stress
The Field stress conditions option can be used when using the calculation type Field stress for initial phase
calculation. This is used to specify rotated principal stresses as the initial stress conditions. This option can be
selected in the Model conditions subtree in the Model explorer (See Figure 260 (on page 395)).

Figure 260: Boundary conditions for groundwater flow
The parameters used to define field stress are:

PLAXIS

σ1

The principal stress in first direction

σ2

The principal stress in second direction

σ3

The principal stress in third direction

Axis 1

Direction of the first principal stress

Axis 2

Direction of the second principal stress
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Note:
• Note that the calculation is considered with Σ Mweight as zero
• Water weight is not considered when performing this type of calculation, but external loads may be applied if
necessary.
• All model boundaries must be set to Fully fixed to ensure shear stress condition is simulated.
Refer to Initial stress generation (on page 328) for a more elaborate description of the Field stress option.

Groundwater flow boundary conditions
The flow boundary conditions of a phase (at least which boundaries are 'open' and which are 'closed') can be
specified in the GroundwaterFlow subtree under Model conditions in the Model explorer (See Figure 261 (on page
396)).

Figure 261: Boundary conditions for groundwater flow
Such boundary conditions are required for a groundwater flow calculation, a consolidation analysis or a fully
coupled flow-deformation analysis. More information regarding the flow boundary conditions is available in
Flow boundary conditions (on page 379).

Precipitation
The Precipitation subtree in the Model explorer (Figure 262 (on page 397)) can be used to specify a general
vertical recharge or infiltration (q) due to weather conditions. This condition is applied at all boundaries that
represent the ground surface. More information on Precipitation is available in Precipitation (on page 380).
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Figure 262: The Precipitation subtree in the Model explorer

Pseudo-Static
Dynamic forces can be considered in a pseudo-static way by specifying a global acceleration (Figure 263 (on
page 397)). A specified global acceleration is taken into consideration in Gravity loading, Plastic, Consolidation
and Safety calculation type. Note that in aSafety analysis the settings of the parent phase are considered. It is
possible to perform a safety analysis of a pseudo-static parent phase, however a change of global accelerations
cannot be specified for the Safety phase itself.
When performing a groundwater flow calculation, the specified global accelerations are composed with the
gravity affecting the unit weight of water used in the calculation of the pore water pressures.

Figure 263: The PseudoStatic subtree in the Model explorer
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Water
The global water level in a calculation phase can be defined in the Water subtree (Figure 264 (on page 398)).
More information on Global water level is available in Assigning water conditions to soil volumes (on page 377).

Figure 264: The Water subtree in the Model explorer

7.11 Special option
The General section of the calculation parameters allows setting a Special option parameter. This parameter may
be used in user-defined soil models to trigger a particular event or action at the beginning of the calculation
phase based on the value of this parameter. The Special option parameter does not affect standard PLAXIS
functionality.

7.12 Starting a calculation
When a calculation phase has been defined, its calculation can be started.

7.12.1 Previewing a construction stage
When a construction stage is fully defined, a view of the situation can be presented by pressing the Preview
phase button in the side toolbar. This enables a direct visual check before the calculation is started. The active
part of the model is presented in the Output program.
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See Output program - General overview (on page 409) for more details on the inspection of models in the
Output program. After the preview, press the Close button to return to the Calculation mode.

7.12.2 Selecting points for curves
After the project geometry is defined and the mesh is generated, some points may be selected by the user for
the generation of load-displacement curves or stress paths by clicking the Select points for curves button .
Nodes should be selected to plot displacements, whereas stress points should be selected to plot stresses and
strains. Selection of points is described in detail in Selecting points for curves (on page 479).

7.12.3 Execution of the calculation process
When calculation phases have been defined and points for curves have been selected, then the calculation
process can be executed. Before starting the process, however, it is useful to check the list of calculation phases.
In principle, all calculation phases indicated with a blue arrow (→) will be executed in the calculation process. By
default, when defining a calculation phase, it is automatically selected for execution. A previously executed
calculation phase is indicated by a green tick mark (✓) if the calculation was successful, otherwise it is indicated
by a red cross (×). To select or deselect a calculation phase for execution, the button in front of the phase should
be clicked in the Phases window.
Alternatively, right click the corresponding line and select Mark for calculation or Unmark for calculation in the
appearing menu.

∙ Starting the calculation process
The calculation process can be started by clicking the Calculate button in the tool bar. As a result, the
program first performs a check on the ordering and consistency of the calculation phases. In addition, the first
calculation phase to be executed is determined and all selected calculation phases in the list are subsequently
executed, provided that failure does not occur.

7.12.4 Aborting a calculation
If, for some reason, the user decides to abort a calculation, this can be done by pressing the Stop button in the
separate window that displays information about the iteration process of the current calculation phase.
If the Stop button is pressed, the total specified load will not be applied. In the Phases explorer the phase is
preceded by a red cross and in the General subtree in the Phases window the following message is displayed in
the Log info box: Cancelled.
In addition to aborting a calculation permanently, it is also possible to abort the calculation temporarily by
clicking the Pause button. The calculation will be resumed after clicking the Resume button.
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7.12.5 Output during calculations
During a 3D finite element deformation analysis, information about the calculation process is presented in a
separate window (Figure 265 (on page 400)). The phase being calculated is indicated in the Phase tabs.

Figure 265: The Active tasks window
Note:
Parallel calculation is possible on multi-core computers when phases have the same parent phase.
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Kernel information
Start time

The time indicating the start of the calculation is displayed.

Memory used

The memory occupied by the calculation process is displayed.

Total multipliers at the end of the previous loading step
ΣMdispX, ΣMdispY

Indicates the portion of the defined prescribed displacement applied in the current
phase.

ΣMloadA

Indicates the portion of the defined load applied in the current phase. In PLAXIS 3D this
value is always 1 since load is applied as a staged construction process changing the
input value of the load rather than the multiplier.

ΣMweight

Indicates the total proportion of the material weights applied in a calculation. Its value is
0 at the beginning of the calculation and changes to 1.000, indicating that all the
materials weight is applied.

ΣMaccel

The value of this parameter is always 0.

ΣMsf

This parameter is related to the Safety analysis. It is defined as the ratio of the original
strength parameters and the reduced strength parameters at a given stage of analysis.
Its value is 1.000 at the beginning of an analysis. The increment of the strength reduction
of the first calculation step is described in Safety calculation (phi/c reduction) (on page
336).

ΣMstage

It gives the completed proportion of a plastic calculation. Its value is always 0 at the start
of the calculation and it will be 1.000 at the end of a successful calculation. For other
analysis types (Consolidation and Safety) it is always 0.

Pexcess,max

It represents the maximum excess pore pressure in the mesh, expressed in the units of
stress. Pexcess,max is available in the deformation calculation tabsheet of the Active task
window for the Plastic, Consolidation, Safety and Dynamic calculation types.

Pactive,max

It represents the maximum active pore pressure in the mesh in Fully coupled flowdeformation analysis, expressed in the units of stress.

Psteady,max

It represents the maximum steady state pore pressure in the mesh, expressed in the
units of stress. Psteady is only available for Flow only calculation types.

ΣMarea

It indicates the proportion of the total area of soil clusters in the geometry model that is
currently active.

ΣMvolume

It indicates the proportion of the total volume of soil clusters in the geometry model that
is currently active. If all soil clusters are active, then the value is 1.000.

ΣFx, ΣFy , Σ Fz

These parameters indicate the reaction forces corresponding to the non-zero prescribed
displacements.
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The Stiffness parameter gives an indication of the amount of plasticity that occurs in the
calculation. The Stiffness is defined as:
Stiffness = ∫

Stiffness

Δε ⋅ Δσ

ΔεD e Δε

When the solution is fully elastic, the Stiffness is equal to unity, whereas at failure the
stiffness approaches zero. The Stiffness is used in determining the Global error. See
Automatic error checks (on page 406) for more details.
Time

The current time within the specified time interval of the loading input for the calculated
phase, defined in the General subtree in the Phases window.

Dyn. time

The current dynamic time within the specified time interval of the loading input for the
calculated phase, defined in the General subtree of the Phases window.

Calculation progress
A small load-displacement curve for one of the pre-selected nodes for curves is shown in the Calculation progress
group box. By default, the curve is shown for the first selected node. Curve for other pre-selected nodes is shown
when the node is selected in the drop-down menu. The presented graph may be used to roughly evaluate the
progress of the calculation.
Plastic analysis

For a plastic analysis the development of the ΣMstage parameter is plotted against the
displacement.

Consolidation
analysis

In case of a Consolidation analysis, the maximum excess pore pressure, Pexcess,max is
plotted against the logarithm of time.

Fully coupled flowIn case of a Fully coupled flow-deformation analysis, the maximum active pore pressure,
deformation analysis Pactive,max, is plotted against the logarithm of time.
Safety analysis

In case of Safety analysis, the development of Σ Msf is plotted against the displacement.

Dynamic analysis

In case of Dynamic analysis, the displacement is plotted against the dynamic time.

Dynamic with
consolidation
analysis

In case of Dynamic with consolidation analysis, the displacement is plotted against the
dynamic time.

Steady state
groundwater flow

In case of Steady state groundwater flow, the maximum steady pore pressure, Psteady,max,
at steady state is plotted.

Transient
groundwater flow

In case of Transient groundwater flow, the maximum steady pore pressure, Psteady,max, is
plotted against the logarithm of time.

Iteration process of current step
Current step

Indicates the number of the current calculation step.

Iteration

Indicates the number of the iterations in the current calculation step.
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Global error

The value of this error is an indication of the global equilibrium error within the
calculation step. As the number of iterations increases, its value tend to decrease. For
further details on this parameter see Automatic error checks (on page 406).

Max. local error in
flow

The value of this error is an indication of possible entrapment of water in saturated
regions in the current calculation step. The tolerated value is 0.05.

Relative change in
saturation

The value is an indication of variation of saturation degree in consecutive calculation
steps. The tolerated value is 0.1. When the relative change in saturation is higher than
the tolerated value, the time step is automatically decreased. When the relative change
in saturation is lower than the tolerated value, the time step is automatically increased.
Note that the values of the time step are always in the range defined by Desired minimum
and Desired maximum parameters.

Relative change in
relative
permeability

The value is an indication of variation of relative permeability in consecutive calculation
steps. The tolerated value is 0.1. When the relative change in relative permeability is
higher than the tolerate value, the time step is automatically decreased. When the
relative change in relative permeability is lower than the tolerated value, the time step is
automatically increased. Note that the values of the time step are always in the range
defined by Desired minimum and Desired maximum parameters.

Max. step

Indicates the last step number of the current calculation phase according to the Max
steps parameter defined in the Numerical control parameters subtree in the Phases
window.

Max. iterations

The value of Maximum iteration steps for the calculated phase, defined for the Iterative
procedure in the Numerical control parameters subtree in the Phases window.

Tolerance

This value indicates the maximum global equilibrium error that is allowed. The value of
the tolerance corresponds to the value of the Tolerated error in the settings for the
iterative procedure. The iteration process will at least continue as long as the Global
error is larger than the Tolerance. For details see Automatic error checks (on page 406).

Element

The number of soil elements in the calculated phase.

Decomposition

Progress of the decomposition of the phase being calculated.

Calc. time

Indicates the calculation time of the current calculation step.

Plastic points in current step
Plastic stress points

The total number of stress points in soil elements that are in plastic state.

Plastic interface
point

The total number of stress points in interface elements that are in plastic state.

Inaccurate

This value indicates the number of plastic stress points in soil elements and interface
elements respectively, for which the local error exceeds the tolerated error.
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Tolerated

This value indicates the maximum number of inaccurate stress points in soil elements
and interface elements respectively that are allowed. The iteration process will at least
continue as long as the number of inaccurate points is larger than the tolerated number.

Tension points

A Tension point is a point that fails in tension. These points will develop when the
Tension cut-off is used in any of the material sets in the model. This parameter indicates
the total number of points that fail in tension.

Cap/Hardening
points

A Cap point occurs if the Hardening Soil model, Hardening Soil model with small-strain
stiffness, Soft Soil model or Soft Soil Creep model are used and the stress state in a point
is equivalent to the preconsolidation stress, i.e. the maximum stress level that has
previously been reached (OCR≤1.0). A Hardening point occurs if the Hardening Soil
model or Hardening Soil model with small-strain stiffnessmall is used and the stress
state in a point corresponds to the maximum mobilised friction angle that has previously
been reached.

Apex points

These are special plastic points where the allowable shear stress is zero. The iterative
procedure tends to become slow when the number of plastic apex points is large. Apex
points can be avoided by selecting the Tension cut-off option in the material datasets for
soil and interfaces.

Calculation status
The calculation status indicates what part of the calculation process is currently being executed. The following
processes are indicated:
Reading data...

Reading input data from the disk.

Renumbering...

Optimising the node numbering and determining matrix properties.

Profile...

Determining the profile of the global stiffness matrix or pre-conditioner.

Forming matrix...

Forming the global stiffness matrix.

Forming preconditioner...

Forming the pre-conditioner for the iterative solution procedure.

Solving equations...

Solving the global system of equations to obtain the displacement increments.

Calculating
stresses...

Calculating the strain increments and constitutive stresses.

Reaction forces...

Calculating the reaction forces and the out-of-balance force.

Writing data...

Writing output data to disk.

Previewing intermediate results during calculation
The Preview button in the Active tasks window enables previewing the results of the intermediate calculation
steps of the phase being calculated. The intermediate steps are listed in the drop-down menu (Selection of
results (on page 426)) and the list is updated when the calculation of new intermediate steps is complete.
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The results of the intermediate calculation steps can be used in curves as well. When a curve is created, the
newly calculated steps can be included in the plot by using the Regenerate button available in the Settings
window (Regeneration of curves (on page 501)).
Note that when the calculation of the phase is completed, a warning will appear indicating that the intermediate
results are no longer available. A more detailed description on how to display the results of a calculated phase is
given in Selecting calculation phases for output (on page 405).

7.12.6 Selecting calculation phases for output
After the calculation process has finished, the Phases explorer and Phases window are updated. Calculation
phases that have been successfully finished are indicated by a green tick mark (✓), whereas phases that did not
finish successfully are indicated by a red cross (×). In addition, messages from the calculations are displayed in
the Log info box of the General tabsheet.
In the Phases explorer individual phases can be selected. When a calculation phase is selected, the View results
button can be clicked after which the results are presented in the Output program.

7.12.7 Adjustment to input data in between calculations
Be careful when changing the input data (in the Input program) in between calculation phases. In general, this
should not be done since it causes the input to cease to be consistent with the calculation data. In most cases
there are other ways to change data in between calculation phases instead of changing the input data itself.

Modification of geometry
When the geometry is slightly modified (small relocation of objects, slight modification of their geometry or
deleting objects) in the Geometry modes, the model is automatically regenerated in the Calculation modes. The
projects should be re-meshed. Note that the phases in the Phases explorer are marked for calculation
automatically. The deleted geometry entities will not be any more available in the calculation phases. However,
the program preserves the definition of the phases. If significant changes in the geometry are made then all
settings need to be redefined, since PLAXIS 3D is not able to properly regenerate the settings automatically.

Modification of feature properties
The properties assigned to soil layers or features in the Geometry modes are the default properties for these in
the calculation phases. When a property is changed (or modified) in the Geometry modes, the program will
automatically change this property in the defined phases. However, if the property is already redefined in a
phase (it is not the default any more), it will not be changed. The property as defined in the calculation phase will
remain valid.
When a property is modified in a reference phase in the Phase definition modes, it will not be automatically
modified in the following phases. The properties defined in the reference phase can be copied by using the
Regenerate option in the right mouse button menu appearing when the feature is right clicked in the Object
explorer. Regeneration consists of two steps:
• Determining which properties in which phases should be reset
• Finding out what the new values should be and applying those values
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In the determination step by definition the properties of the target feature in the target phase are included. The
properties of the target feature are examined in all child phases of the target. If the properties of target feature in
a given child phase are identical to those in target phase, those properties will be included in the regeneration,
and the process will repeat for all child phases of the child phase. Otherwise, the properties of target feature in
the child phase will not be included in the regeneration process.
When establishing the new values, the properties of target feature in the parent phase of the target phase are
examined. If the parent phase is the initial phase (which has no previous phase), the properties as defined in the
geometry will be taken as source. These properties are then applied to everything that was selected in the
determination process.
Note that the regeneration process is implicitly applied when switching from the Geometry modes to the
Calculation modes, in order to maintain staged model integrity even if the geometry was modified. This
procedure is mainly useful for quick propagation of staged construction changes to child phases.

7.12.8 Automatic error checks
During each calculation step, the PLAXIS 3D calculation kernel performs a series of iterations to reduce the outof-balance errors in the solution. To terminate this iterative procedure when the errors are acceptable, it is
necessary to establish the out-of-equilibrium errors at any stage during the iterative process automatically.
Two separate error indicators are used for this purpose, based on the measure of either the global equilibrium
error or the local error. The values of both of these indicators must be below predetermined limits for the
iterative procedure to terminate. These two error indicators and the associated error checking procedures are
described below.

Global error check
The global error checking parameter used in the PLAXIS 3D calculation kernel is related to the sum of the
magnitudes of the out-of-balance nodal forces. To obtain this parameter, the out-of-balance loads are nondimensionalised as shown below:
Global error =

Σ

Σ Out of balance nodal forces
Active loads
+ CSP ⋅
Inactive loads

Eq. [94]

where the Out-of-balance nodal forces are the difference between the external loads and the forces that are in
equilibrium with the current stresses, the Active loads are the load difference between the actual calculation and
the previous calculation phase (when Σ Mstage = 0 the Active loads are equal to the Out-of-balance nodal forces)
and the Inactive loads are the active loads from the previous calculation phases.
CSP is the current value of the Stiffness parameter, defined as:
Stiffness = ∫

Δε ⋅ Δσ

ΔεD e Δε

Eq. [95]

which is a measure for the amount of plasticity that occurs during the calculation. See the Material Models
Manual - Chapter 2 - Elastic strains for more information on the stiffness parameters. When the solution is fully
elastic, the Stiffness is equal to unity, whereas at failure the Stiffness approaches zero. In the latter case the global
error will be larger for the same out of balance force. Hence, it will take more iterations to fulfill the tolerance.
This means that the solution becomes more accurate when more plasticity occurs.
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Additional error check for structures
In case structures with rotational degree of freedom are included in the model, further checks are performed to
ensure the robustness of the solution. The additional error check (AEC) for structures is defined as:
AEC for structures =

max

Out of balance structure nodal moments
max
Structures nodal moments

Eq. [96]

where max ||Out of balance structure nodal moments|| is the maximum out-of-balance moment of the structure
nodes and max ||Structure nodal moments|| is the maximum bending moment from the stress integration of all
structures. In case of elastic structures, the max ||Out of balance structure nodal moments|| is equal to 0.
For embedded beams, an additional error check (AEC) is defined for the skin friction:
AEC for skin friction =

Σ

Out of balance nodal forces
Σ Nodal forces

Eq. [97]

Local error check
Local errors refer to the errors at each individual stress point. To understand the local error checking procedure
used in PLAXIS 3D it is necessary to consider the stress changes that occur at a typical stress point during the
iterative process. The variation of one of the stress components during the iteration procedure is shown in the
figure below

equilibrium stress

constitutive stress
stress

strain
Figure 266: Equilibrium and constitutive stresses
At the end of each iteration, two important values of stress are calculated by PLAXIS 3D. The first of these, the
'equilibrium stress', is the stress calculated directly from the stiffness matrix (e.g. point A in Figure 266 (on page
407)). The second important stress, the 'constitutive stress', is the value of stress on the material stress-strain
curve at the same strain as the equilibrium stress, i.e. point B in Figure 266 (on page 407).
The dashed line in Figure 266 (on page 407) indicates the path of the equilibrium stress. In general, this
equilibrium stress path depends on the nature of the stress field and the applied loading. For the case of a soil
element obeying the Mohr-Coulomb criterion, the local error for the particular stress point at the end of the
iteration is defined:
Local error =
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In this equation the numerator is a norm of the difference between the equilibrium stress tensor, σe, and the
constitutive stress tensor, σc. This norm is defined by:
σe − σc

=

(σxxe − σxxc )2 + (σ yye − σ yyc )2 + (σzze − σzzc )2 +
e
c 2
σxy
− σxy
(¯
) + (σ yze − σ yzc )2 + (σzxe − σzxc )2

Eq. [99]

The denominator of the equation for the local error is the maximum value of the shear stress as defined by the
Coulomb failure criterion. In case of the Mohr-Coulomb model, Tmax is defined as:
T max = max

( 12 (σ3′ − σ1′), c ⋅ cos φ)

Eq. [100]

When the stress point is located in an interface element the following expression is used:
Local error =

(σne − σnc)2 + (τ e − τ c)2

Eq. [101]

ci − σnc tan φi

where σn and τ represent the normal and shear stresses respectively in the interface. To quantify the local
accuracy, the concept of inaccurate plastic points is used. A plastic point is defined to be inaccurate if the local
error exceeds the value of the user specified tolerated error (Numerical control parameters (on page 361)).

Termination of iterations
For PLAXIS 3D to terminate the iterations in the current load step, all of the following four error checks must be
satisfied. For further details of these error-checking procedures, see Vermeer & van Langen (1989) (on page
510).
Maximum global error ≤ Tolerated error
No. of inaccurate soil points ≤ 3 +

No. of plastic soil points
10

No. of inaccurate interface points ≤ 3 +

No. of plastic interface points
10

No. of inaccurate structure points ≤ 3 +

No. of plastic structure points
10

Eq. [102]

where Maximum global error is the maximum between the Global error, the Additional error check for skin
resistance and the Additional error check for structures. The Maximum global error is the only one displayed
during calculations.
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Output program - General overview
This icon represents the Output program.
The main output quantities of a finite element calculation are the displacements and the stresses. In addition,
when a finite element model involves structural elements, the structural forces in these elements are calculated.
An extensive range of facilities exists within the PLAXIS 3D Output program to display the results of a finite
element analysis. This chapter gives a description of the features available in the program.
If the Output program is activated by running its executable file or by clicking the Output program button in the
Input program, the user has to select the model and the appropriate calculation phase or step number for which
the results are to be viewed. More options on how to activate the Output are given in Accessing the Output
program (on page 420). In addition to the 3D view, it is possible to view output in individual work planes by
selecting corresponding tabsheets in the Output window.

Figure 267: File requester of Output program
When a particular project is selected, the file requester displays the corresponding list of calculation phases from
which a further selection should be made. If it is desired to select an intermediate calculation step, then a single
mouse click should be given on the plus icon (+) at the left of the desired phase. As a result, the calculation list
expands a list with all available step numbers for this phase, from which the desired step number can be
selected.
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Layout of the Output program
Note:
Please note that the number of the individual steps available depends on the value assigned to Max steps saved in
the Parameters tabsheet of the Phases window.
Once an output step of a particular project has been opened, the combo box in the toolbar will contain a list of
available output steps, indicated by the step number and corresponding phase number.

8.1 Layout of the Output program
The layout of the Output program is shown below:
1.

Title bar

4.

Model explorer

2.

5.

Side toolbar

6.

Command line

7.

Menu bar

Plot area

3.

8.

General toolbar

Status bar

Figure 268: Main window of the Output program

8.1.1 Title bar
The title bar gives information about the project name, the step number and the type of information/results
displayed.
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8.1.2 Menu bar
The menu bar contains all output items and operations facilities of the Output program ( Menus in the Menu bar
(on page 411)).

8.1.3 Toolbars
Buttons for different features in the Output program are located above and at the left side of the plot area. A hint
about the function of each tool is given as the cursor is located on it.

8.1.4 Plot area
The calculation results are displayed in the Plot area. The results can be displayed in graphical or tabular form.
More information on how to handle the plot is given in Display area (on page 433).

8.1.5 Status bar
The status bar displays the locations of the cursor and the viewpoint and a hint about the object in the model
and their element numbers.

8.1.6 Command line
PLAXIS 3D Output program enables to carry out certain actions using keyboard input by typing the
corresponding commands in the command line.
More information about the available commands is provided when the Command reference option of the Help
menu is selected.

8.1.7 Explorers
Information about the model and the project is given in the explorer.
Model explorer

It displays the properties of all the geometry objects and the features assigned to them
in the model and gives the possibility to hide/show, activate/deactivate these objects,
see the Model explorer (on page 62).

8.2 Menus in the Menu bar
The menu bar contains drop-down menus covering the options available in the Output program. The main
results from a finite element calculation are deformations and stresses. Hence, these two aspects form the major
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part of the Output menu. When displaying a basic 3D geometry model, the menu consists of the File, View,
Project, Geometry, Mesh, Deformations, Stresses, Tools, Window and Help menus. Note that the availability of the
menus in the bar depends on the type of data that is presented on the output form.

8.2.1 File menu
Open project

To open the output of an existing project.

Close active project

To close all forms of the active project.

Close all projects

To close all forms of all opened projects.

Work directory

Set the default directory where PLAXIS 3D project files are stored.

Export to file

To export the information displayed, depending on the information type, to a text file
(for results in tables) or image file (for plot).

Export to Paraview

To export PLAXIS results to the visualization tool Paraview

Report generator

To generate a report of the project.

Create animation

Create an animation from selected output steps. The Create animation window is
presented.

Print...

To print the active output on a selected printer.

(List of recent
projects)

A list of the five most recent projects.

Exit

To leave the output program.

8.2.2 View menu
Zoom out

To restore to view before the most recent zoom action.

Reset view

To restore the original plot.

Viewpoint...

To change the viewpoint of the 3D projection of the model. This allows the input of a
particular viewpoint or a selection from several predefined viewpoints.

Save view

To save the current view (image or table). The saved views can be included in a report of
the project.

Show saved views

To open or delete saved views.
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Scale

To modify the scale factor of the presented quantity.

Legend settings...

To modify the range of values of the presented quantity in contour line plots and plots
with shadings.

Scan line

To change the scan line for displaying contour line labels. After selection, the scan line
must be drawn using the mouse. Press the left mouse button at one end of the line; hold
the mouse button down and move the mouse to the other end. A contour line label will
appear at every intersection of the scan line with a contour line.

Use result
smoothing

To reduce the numerical noise resulting from the extrapolation of the results obtained in
stress points (e.g. stress, force) to nodes. This option is available for plots and tables.
Note that the option is by default selected in plot presentation of the results.

Title

To toggle the display of the title of the active plot in the caption.

Model explorer

To toggle the model explorer panel.

Legend

To toggle the display of the legend of contours or shadings.

Axes

To toggle the display of the global x- and y-axes in the active plot (displayed in the lower
right corner).

Command line

To toggle the command line situated the bottom of the window.

Hide panels

To hide all the panels in the Output program.

Shrink

To shrink the soil volumes in the model. This option is available in the Model view.

Expand

To expand the structures in the model. This option is available in the Model view.

Explode

To disassemble the components of the project geometry. This option is available in the
Model view.

Implode

To assemble the components of the project geometry. This option is available in the
Model view.

Settings

To set various graphical attributes, such as object and background colours, symbol size,
font size and diffuse shading.

Note:
Distribution envelope and Wireframe distribution envelope show the whole history of the selected structures but
the results (e.g. maximum and minimum value) correspond to the currently phase and active part of the
structure.
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8.2.3 Project menu
Node fixities

View the table of the node fixities.

Load information

View the table of the active loads and bending moments in the current step.

Water load
information

View the table of the external water loads on the geometry boundaries in the current
step.

Virtual interface
thickness

View the table of the virtual interface thickness.

Volume information

View the boundaries of the soil polygon, the total area of soil and the area of each cluster
in the project.

Material information
View the material data of all load cases.
(all load cases)
Material information
View the material data of the current load case.
(current load case)
General information View the general project information.
Calculation
information

View the calculation information of the presented step.

Calculation info per
phase

View the calculation information for each calculation phase.

Calculation info per
step

View the calculation information for each calculation step.

Step info

View the step information of the presented step.

Structures per phase View the active structures per calculation phase.
Rigid body
configurations

View the rigid body configurations.

Rigid body results

View the rigid body results.

8.2.4 Geometry menu
Phreatic level

Toggle the display of the phreatic level in the model.

Fixities

Toggle the display of the fixities in the model.
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Connection axes

Toggle the display of the connection axes in the model.

Filter

Filter the nodes displayed in the model according to a defined criteria.

8.2.5 Mesh menu

Quality spheres

The quality of the elements in the mesh is defined as inner circle divided by the outer
spheres of the soil or plate element where an equal sided tetrahedralis normalised at
1.0. The quality of a plate element in the mesh is defined as the inner circle divided by
the outer circle of the plate element where an equilateral triangle is normalised at 1.0.
For soil elements the displayed mesh elements in the model vary according to the
quality value selected as the yellow bar is dragged through the legend.

Quality SICN

A signed inverse condition number to check the quality of the elements. This parameter
takes into account the intermediate nodes for quality measurement hence it gives a
better understanding of the quality for higher order elements. For soil elements the
displayed mesh elements in the model vary according to the quality value selected as the
yellow bar is dragged through the legend.

Table of quality

View the table of the quality of the soil or plate elements according to different criteria.

Volume

View the distribution of the volume of the soil elements.

Table of element
volumes

View the table of the distribution of the volumes of the soil elements.

Connectivity plot

View the connectivity plot (Connectivity plot (on page 444)).

Cluster borders

Toggle the display of the cluster borders in the model.

Element contours

Toggle the display of the element contours in the model.

Element
deformation
contours

Toggle the display of the deformed element contours in the model.

Materials

Toggle the display of the materials in the model.

Element numbers

Toggle the display of the soil element numbers.

Material set
numbers

Toggle the display of the material set numbers in the soil elements.

Structure material
set numbers

Toggle the display of the material set numbers of the structural elements.

Group numbering

Toggle the display of the group numbers. Groups are created according to the material
setsand the assigned design approaches.
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Cluster numbers

Toggle the display of the cluster numbers in the soil elements.

Node numbers

Toggle the display of the node numbers. Only possible when nodes are displayed.

Stress point
numbers

Toggle the display of the stress point numbers. Only possible when stress points are
displayed.

Selection labels

Toggle the display of the labels of the selected nodes or stress points.

8.2.6 Deformations menu
The Deformations menu contains various options to visualise the deformations (displacements, strains), the
velocities and the accelerations (in the case of a dynamic analysis) in the finite element model (Deformations (on
page 445)). These quantities can be viewed for the whole analysis (total values), for the last phase (phase
values) or for the last calculation step (incremental values). In principle, displacements are contained in the
nodes of the finite element mesh, so displacement related output is presented on the basis of the nodes, whereas
strains are usually presented in integration points (stress points).

8.2.7 Stresses menu
The Stresses menu contains various options to visualise the stress state and other state parameters in the finite
element model (Stresses (on page 450)). Stresses are contained in the integration points of the finite elements
mesh, so stress related output is presented on the basis of the integration points (stress points).

8.2.8 Forces menu
The Forces menu contains various options to visualise the resulting forces in structural elements (Structures and
interfaces (on page 461)).

8.2.9 Options
Autocomplete

To select the Significant digits for the project.

Licencing
information

To switch on or off showing the licence information at startup.
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8.2.10 Tools menu
Copy

To copy the active output to the Windows clipboard.

Select points for
curves

To enable selection of nodes and stress points to be considered in curves. All the nodes
and stress points in the project are displayed enabling selection by clicking on them. The
Select points window is activated, where the location of interest can be defined and the
appropriate nodes or stress points can be selected form the list.

Mesh point selection

To activate the Mesh selection window. This option is active when the Select points for
curves has been previously selected and the Select points window is closed.

Curves manager

To activate the Curves manager (Curves (on page 479)).

Table

To open a new form with a table of numerical values of the presented quantity.

Vertical cross
section

To select a user-defined vertical cross section with a distribution of the presented
quantity. The cross section is defined by specifying two points in the corresponding
window. To define the cut line in the plot, press the left mouse button at one end of the
cross section; hold the mouse button down while moving the mouse to the other end of
the line; release the mouse button. The cross section is presented on a new form.

Horizontal cross
section

To select a user-defined horizontal cross section with a distribution of the presented
quantity. The cross section must be selected by defining the z-coordinate. The cross
section is presented on a new form.

Free cross section

To select a user-defined cross section with a distribution of the presented quantity. The
cross section is defined by specifying three points in the corresponding window. The
cross section is presented on a new form.

Line cross section

To define a line on which the distribution of the presented quantity is displayed. The line
is defined by specifying two points in the corresponding window. The results on the
defined line are presented on a new form.

Structural forces in
volumes

To compute the forces in a structure which is modeled using soil with the material
properties of the structure (e.g. concrete), after the calculation has already been
finished. More information on the usage of this option is given in Structural forces in
volume piles (on page 468).

Cross section curves

To display a plot of the results along the cross sections. The values in the x-axis in the
plot are the distances of the points from the first point in the cross section.

Hint box

To display a hint box with information in individual nodes or stress points (if nodes or
stress points are displayed).

Cross section points

To display the points defining the cross section. These points are displayed as greyed out
in the Cross section points window. Their location can not be modified. This option is
valid only when the Cross section view is active.
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Distance
measurement

To measure the distance between two nodes in the model both for the original mesh as
well as the deformed mesh. This option is valid in the Model view only when nodes
and/or stress points are displayed in the plot (Miscellaneous tools (on page 430)).

Remove annotations

To remove the annotations either partially (current view) or completely from the plots
displayed in the output.

8.2.11 Expert menu
Run commands

To open the Commands runner window.

Macro library

To modify and run macros. Macros can be defined and indexed in the Macro library
window, displayed as the corresponding option is selected in the sub-menu. To run a
macro click the corresponding option in the sub-menu.

Python

To open and use Interpreter, Editor, Command prompt and to run python scripts
(Appendices Python HTTP REST API wrapper (on page 534) and HTTP REST API (on
page 560)).

Run Python script

To configure remote scripting server and open python script to run them (Appendices
Python HTTP REST API wrapper (on page 534) and HTTP REST API (on page 560)).

Run Python tool

To configure remote scripting server and run python scripts (Appendices Python HTTP
REST API wrapper (on page 534) and HTTP REST API (on page 560)).

Configure remote
scripting server

To specify an available port and open it for connections by local or remote clients
(Appendices Python HTTP REST API wrapper (on page 534) and HTTP REST API (on
page 560)).

8.2.12 Window menu
Project manager

To view the projects and forms currently displayed in Output.

Duplicate model
view

To duplicate the active view.

Close window

To close the active output form.

Cascade

To cascade the displayed output forms.

Tile horizontally

To tile horizontally the displayed output forms.

Tile vertically

To tile vertically the displayed output forms.
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(List of recent
views)

A list of the output forms.

8.2.13 Help menu
Manuals

To display the manuals.

Command reference To display information about commands in the program.
Instruction movies

To reach the Bentley Geotechnical Engineering website where instruction movies are
displayed.

Request support

To send a request for support.

Licence
configuration

To view and configure licences.

Visit website

To reach the PLAXIS 3D website.

News feed

Latest news and events of PLAXIS products.

Disclaimer

The complete disclaimer text is displayed.

About

Information about the program version and licence are displayed.

8.3 General information on command line
At the bottom of the Output application, a command line panel is available. The command line provides an
alternative way of executing certain operations, by entering commands as text.
A feedback panel is situated above the command line panel. Here, the executed commands are shown, together
with the feedback of the command. Successful commands return green coloured feedback, consisting of details
on newly generated geometry or elements. Erroneous commands return red coloured feedback, containing an
error report.
In the PLAXIS 3D Output program, a global command is included that shows information on the commands that
can be executed: cms. This command lists the signatures of all commands available in the PLAXIS 3D Output
program. An extended overview and description of all available commands is accessible via the Help menu in the
user interface of the PLAXIS 3D Output program.
More information is available in General information on command line (on page 56).
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8.3.1 Indexing in commands
Array indexing syntax can be used in the command line. This consists of square brackets behind an object name,
followed by an integer and a matching closing bracket. Integer indexing is zero-based and works on any listable
object, i.e. any object on which you can fire a filter or tabulate command. Both positive and negative numbering
is used in indexing. The positive numbering begins at the start of the list, in which 0 is the first item from the
table, while negative numbering starts from the end and goes backward through the list (refer Indexing in
commands (on page 58)).

8.4 Tools in the Output program
Besides displaying the calculation results, the Output program provides tools to handle the view and enable a
better examination of the results. The buttons are grouped in the toolbar below the menu bar and in the side tool
bar. The tools and their functionality is described in the following sections.

8.4.1 Accessing the Output program
All the results are displayed in the Output program. There are different ways to access the Output program.
Besides the option of activating the program as described at the beginning of this chapter, the results can be
displayed before or after the calculation of the phases is completed.
The results that can be displayed before calculating the phases are:
The generated mesh

The generated mesh can be displayed by clicking the View mesh button in the Mesh
mode in the Input program.

Pore pressures

The element configuration and pore pressure distribution in the in the Phases explorer
can be displayed by clicking the Preview phase button in the Flow conditions and
Staged construction modes in the Input program.

Connectivity plot

The Connectivity plot displays the distribution of the finite elements in the mesh and the
nodes and stress points available. The Connectivity plot is displayed when the Select
point for curves button is selected in the Calculations program. A more detailed
description is given in Connectivity plot (on page 444).

The calculation results of a project are displayed in the Output program by selecting a calculated phase in the
Phases explorer and clicking the View calculation results button in the
While the Output program is already active, the results of other projects can be accessed either by clicking
the Open project button or by selecting the corresponding option in the File menu (File menu (on page 412)).
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8.4.2 Exporting output data
The PLAXIS 3D Output program enables exporting the displayed results such as plots or values. This is possible
by clicking the corresponding button in the toolbar.

Copy to clipboard
Data as displayed in output forms may be exported to other programs using the Windows clipboard
function. When clicking on the Copy to clipboard button, the Copy window appears in which selections can be
made of the various plot components that are to be included in the copy (Figure 269 (on page 421)).

Figure 269: Copy window

Print
Hardcopies of graphs and tables can be produced by sending the output to an external printer. When the
Print button is clicked or the corresponding option is selected in the File menu, the Print window appears, in
which various plot components that are to be included in the hardcopy can be selected (Figure 270 (on page
422)).
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Figure 270: Print window
When pressing the Setup button, the standard printer setup window is presented in which specific printer
settings can be changed. When the Print button is clicked, the plot is send to the printer. This process is fully
carried out by the Windows® operating system.
Note:
When the Copy to clipboard option or the Print option is used on a plot that shows a zoomed part of the model,
only the part that is currently visible will be exported to the clipboard or the printer.

Export
Data in output forms may be exported to files. When the Export to file button is clicked, the Export window
appears. Note that a text scaling factor can be defined.

Figure 271: Export window
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Instead of the PLAXIS 3D logo in the frame, it is also possible to insert a company logo. This logo has to be
provided as a bitmap and can be selected in the Print window after clicking on the logo.

8.4.3 Curves manager
Clicking the Curves manager button activates the Curves manager window where curves can be generated
to evaluate the results at specified locations in the model. Selection of points of interest and the generation of
curves is described in detail in Curves (on page 479).

8.4.4 Store the view for reports
The views in the Output program can be saved to be used when reports are generated by clicking on the
Store the view for reports button. The Save view window pops up as the button is clicked. Description can be
given to the view in the Figure 272 (on page 423) window which can be beneficial when the report is generated.
Report generation is described in detail in Report generation (on page 437).

Figure 272: Save view window

8.4.5 Zooming the plot
It is possible to zoom in and out in the view of the plots by scrolling the mouse wheel. Other options for zooming
are available by clicking the corresponding buttons in the toolbar.
•
•
•

PLAXIS

As this feature is selected, the mouse can be dragged on the model to define a local zooming rectangle. In
the window, only the results in the defined rectangle will be displayed.
Clicking the Zoom out button or selecting the corresponding option in the View menu (on page 412)
restores the view of before the most recent zoom action.
Clicking the Reset view or selecting the corresponding option in the View menu (on page 412) enables
restoring the original plot.
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8.4.6
The plot can be moved using the mouse.
When this button is clicked, the plot will be relocated (moved) by clicking on the plot area and dragging it
while keeping the left mouse button pressed.
When this button is clicked, the model will be rotated by clicking on the plot area and dragging it while
keeping the left mouse button pressed.
The viewpoint changes as the model is moved or rotated. The location of the viewpoint can be defined by
selecting the Viewpoint option in the View menu (View menu (on page 412)). When the option is selected, the
Viewpoint window pops up. A viewpoint can be set by either defining it in the Viewpoint window, or by
selecting one of the default viewpoint options.

Figure 273: Viewpoint window

8.4.7 Scaling the displayed results
Whenever the results are indicated by length entities such as Arrows, Distribution, Axis, etc. (Display type of
results (on page 426)), the Scale factor button can be used to receive a better overview. When the button is
clicked or the corresponding option in the View menu is selected, a window pops up where the factor can be
defined. Note that this option is also available in the right mouse click pop-up menu.
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Figure 274: Scale factor window
Note:
• The default value of the Scale factor depends on the size of the model.
• The Scale factor may be used to increase or reduce the displayed (virtual) thickness of interfaces in the
Connectivity plot.

8.4.8 Tables
The tabular form of the results given in the plot can be obtained by clicking on the Table button or by
selecting the corresponding option in the menu. Note that this option is also available in the right mouse click
pop-up menu.
Note:
The table of displacements may be used to view the global node numbers and corresponding coordinates of
individual elements.

Displaying of tables
By default, a table is presented in ascending order according to the global element number and local node or
stress point. However, a different ordering may be obtained by clicking on the small triangle in the column
header of the desired quantity on which the ordering should be based. Another click on the same column header
changes the ordering from ascending to descending.
The options available in the right click pop-up menu are:
Select for curves

To select the right clicked point in the table to be considered in curves.

Create chart

To create a chart from the values presented in the table.
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Align

To align the text in the selected part of the table.

Decimal

To display data in decimal representation.

Scientific

To display data in scientific representation.

Decimal digits

To define the number of decimal digits displayed.

View factor

To define a factor to the values in the table.

Copy

To copy the selected values in the table.

Find value

To find a value in the table.

Find soil element

To find a soil element with a specified ID in the table when the results are displayed for
soil elements.

Find structural
element

To find a structural element with a specified ID in the table when the results are
displayed for structures.

Filter

To filter the results in the table.

Note:
The values in the tables contain the most accurate information, whereas information in plots can be influenced
or be less accurate due to smoothing or extrapolation of information from stress points to nodes.

8.4.9 Selection of results
As the type of result is selected from the Deformations, Stresses or Structures menu, the results are displayed
either in plots or tables according to the selection made.
While the Output program is running, other steps of the project can be selected from the drop-down menu in the
toolbar. The button in front of the drop-down menu can be used to toggle between the end results of phases, or
individual output steps:
•
•

A list of the calculation phases and their final calculation steps is given. The results at the end of the final
calculation steps can be shown for each phase.
A list the saved calculation steps and the calculation phase they belong to is given. The results of each
calculation step can be shown.

In addition to the drop-down menu, the spinner at the right of the drop-down menu or using the Ctrl-Up and
Ctrl-Down keys will select the end results of the previous or next calculation step or calculation phase.
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8.4.10 Display type of results
The plot type options are located at the right of the drop-down menu:
•
•

The results are displayed as contours.
The results are displayed as shadings.

•

The results are displayed as iso-areas.

•
•

•

•

•

The results for Displacements can be displayed as arrows. Scaling of the results is possible.
The results are displayed at each stress point of the soil elements. The length of each line represents the
magnitude of the principal quantity (stress or strain) and the direction indicates the principal direction.
Positive direction is indicated by arrows. Scaling of the results is possible.
The average results are displayed at the center of each soil element. The length of each line represents
the magnitude of the principal quantity (stress or strain) and the direction indicates the principal direction.
Positive direction is indicated by arrows. Scaling of the results is possible.
The results are displayed in different colours at each stress point of the soil elements. The length of each
line represents the magnitude of the principal quantity (stress or strain) and the direction indicates the
principal direction. Positive direction is indicated by arrows. Scaling of the results is possible.
The average results are displayed in different colours at the center of each soil element. The length of
each line represents the magnitude of the principal quantity (stress or strain) and the direction indicates the
principal direction. Positive direction is indicated by arrows. Scaling of the results is possible.

•
•
•

The deformed shape of cross sections, geogrids or plates is displayed. Scaling of the results is possible.
The distribution of the results in cross sections, plates, geogrids or interfaces is displayed. Scaling of the
results is possible.
The deformed shape of is displayed. The relative deformation is indicated by arrows. Scaling of the
results is possible.

•

The distribution of the results in is displayed. Scaling of the results is possible.

•
The wireframe distribution of the results in is displayed. Scaling of the results is possible.
•

The Plastic points option shows the stress points that are in a plastic state, displayed in a plot of the
undeformed geometry (Plastic points (on page 458)). Scaling of the results is possible. When scaling is used,
it is possible to pull the interfaces out of the plates, however the stress points will remain at their physical
locations.

Note:
For (enhanced) safety calculations, results are NOT shown in soil clusters that are excluded from the strength
reduction procedure as long as the Hide items without strength reduction option in the View menu has been
selected.
The availability of the display type buttons in the toolbar can be toggled on/off by selecting the corresponding
options in the View menu.
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8.4.11 Select structures
By default, all the active structures and interfaces in the selected phase are displayed in the plot. The disabled
structures can be displayed by selecting the corresponding option in the Geometry menu.
Note:
To quickly view structures inside the 3D model, the Materials option may be deselected from the Geometry.
Output for structures and interfaces can be obtained by clicking the Select structures button and then double
clicking the desired object in the 3D model. As a result, a new form is opened on which the selected object
appears. At the same time the menu changes to provide the particular type of output for the selected object.
Another option of selecting structural elements in the output is by clicking on the Select structures in a
rectangle and drawing a rectangle in the model. As a result, the structures in the rectangle will be selected.
To clear the selection, press Esc. Only structural elements of the same type can be selected at the same time. For
example, if a beams is selected, only other beams can be added to the selection and no .

8.4.12 Partial geometry
To enable the inspection of certain internal parts of the geometry (for example individual layers or volume
clusters) it is possible to make other parts of the geometry invisible in the Model explorer by clicking the button
in front of them as shown in Figure 275 (on page 428).

Figure 275: Model explorer in Output
Visible model components are indicated by an open eye, whereas invisible ones are indicated by a closed eye. By
clicking on the button, the view of the components (individual and/or groups) can be toggled from being visible
to being invisible and vice versa. A group is expanded by clicking on the + sign in front of the group. Clusters that
have been set inactive in the framework of staged construction are always invisible and cannot be made visible.
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The user will be able to show/hide clusters in the Model explorer under the option of Soils based on the materials
assigned to them.
Note:
The cluster numbers are activated by selecting the Cluster numbers option in the Mesh menu.
The information in the Model explorer can be narrowed according to the filtering criteria specified at the
corresponding cell.
The Show all option will make all the object active in the selected phase visible. The Hide all will revert the
action. The Invert selection option will toggle all visible elements invisible and all invisible elements visible. The
Deselect all button will set all elements to invisible. On pressing the Close button the Partial geometry window
is closed without further changes.
Apart from the Model explorer, individual volume elements or entire clusters of volume elements can be made
invisible by holding down the Ctrl key, the Shift key or both keys at the same time, respectively, while clicking on
an element in the 3D model. These elements can be visible again by clicking the corresponding check boxes in
the Model explorer.
Clicking the Hide soil button in the side bar menu enables hiding parts of the soil. To hide soil elements, click
the Hide soil button first and hold the Ctrl key pressed while clicking on the soil elements. To hide soil clusters,
click the Hide soil button first and hold the Shift key pressed while clicking on the soil clusters.
Clicking on the Hide soil in the rectangle button enables hiding the soil in the rectangle drawn in the model.
The drawing order of the rectangle effects the resulting hidden soil elements.
To hide only the soil elements that fall completely in the defined rectangle, first click the Hide soil in the rectangle
button. In the model, click at the point defining the upper left corner of the rectangle, drag the mouse to the point
defining the lower right corner of the rectangle and click again.
To hide all the soil elements that are intersected by the defined rectangle, first click the Hide soil in the rectangle
button. In the model, click at the point defining the lower right corner of the rectangle, drag the mouse to the
point defining the upper left corner of the rectangle and click again.

8.4.13 Viewing results in cross sections
To gain insight in the distribution of a certain quantity in the soil it is often useful to view the distribution of that
quantity in a particular cross section of the model. This option is available in PLAXIS 3D for all types of stresses
and displacements in soil elements as well as structural elements and interfaces.
The user may define vertical cross sections by clicking on the Vertical cross section button in the toolbar or
by selecting the corresponding option from the View menu. Note that this option is also available in the right
mouse click pop-up menu. Upon selection of this option, the 3D model is presented in top view with the x-axis
pointing to the right and the y-axis pointing upwards. The cross section can be specified precisely by clicking on
one end of the cross section line in the plot and moving the cursor to the other end while holding down the
mouse button. Cross sections exactly in x- or y-direction may be drawn by holding down the Shift key on the
keyboard while drawing the cross section. Alternatively, both cross section coordinates can be entered precisely
in the Cross section points window that appears at the upper left hand corner.
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In addition to the vertical cross section, the user may define horizontal cross sections by clicking on the
Horizontal cross section button in the toolbar or by selecting the corresponding option from the View menu.
Upon selection of this option, the Cross section height window pops up in which the z-coordinate can be
defined.
Free cross sections can be defined by clicking on the Free cross section button in the toolbar or by selecting
the corresponding option from the View menu. Upon selection of this option, the Cross section points window
pops up in which the three cross section coordinates can be defined.
A line cross section can be defined by clicking the Line cross section button in the side button bar or by
selecting the Line cross section option in the View menu. Upon selection of this option, the Cross section points
window pops up in which the two cross section coordinates can be defined.}
After the cross section has been selected, a new form is opened in which the distribution of a quantity is
presented on the indicated cross section. At the same time, the menu changes to allow for the selection of all
other quantities that may be viewed on the indicated cross section.
Note:
The distribution of quantities in cross sections is obtained from interpolation of nodal data and may be less
accurate than data presented in the 3D model.
Multiple cross sections may be drawn in the same geometry. Each cross section will appear in a different output
form. To identify different cross sections, the end points of a cross section are indicated with characters in
alphabetical order. The points defining the cross section can be viewed by selecting the Cross section points
option in the Tools menu.
In addition to the output quantities that are available for the 3D model, a cross section allows for the display of
cross section stresses, i.e. effective normal stresses σ'N, total normal stresses σN, vertical shear stresses τs and
horizontal shear stresses τt.
Note:
It is possible to move a cross section in the direction of its normal while the presentation of results is updated
for the new location of the cross section.
• Using the Ctrl+- and Ctrl++ keys will move the cross section 1/100 times the diagonal of the geometry model.
• Using the Ctrl+Shift+- and Ctrl+Shift++ will move the cross section 1/1000 times the diagonal of the geometry
model.

8.4.14 Miscellaneous tools
Distance measurement
The distance between two nodes in the model can be measured by either clicking on the Distance
measurement button or by selecting the Distance measurement option in the Tools menu and by subsequently
selecting the nodes in the model. The Distance information window pops up displaying the information about
the distance (Figure 276 (on page 431)).
The distance can be given according to the original node position or in deformed shape (i.e. using shifted node
positions according to their displacements).
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Figure 276: Distance information
A description of the information available in the table is given as follows:
Coordinates

The Original and Deformed coordinates for the first node/stress point and the second
node/stress point.

Δx

The Original and Deformed x-component of the distance between the nodes.

Δy

The Original and Deformed y-component of the distance between the nodes.

Δz

The Original and Deformed z-component of the distance between the nodes.

Elongation

The difference between the original vector and the projection of the deformed vector
onto the original vector (Figure 277 (on page 432)). Hence, Elongation does not
consider the rotation of the line between the two points. If the Updated mesh analysis is
performed, Elongation is the difference in distance between the original and deformed
vectors.

Distance

The Original (v) and Deformed (v') distance between the points.

Orientation

The angle between the measurement line and the horizontal (XY) plane.. Orientation is
positive if the vector describing the line points upwards (Z>0) and negative if it points
downwards (Z<0). The Orientation is calculated for the undeformed and deformed
measurement line.

|Δ u|

The change in the distance between the selected points before and after deformation.
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Δ uperpendicular

The deformation in the direction perpendicular to the original line between the selected
points.

Rotation

The difference between the deformed orientation and the original orientation (Figure
277 (on page 432)). This angle is always between 0 ° and 180 °.

Tilt

The ratio of the deformation in the direction perpendicular to the line between the
selected points, Δ uperpendicular, to the original distance between the selected points, v, ()
given both as ratio and percentage:
Tilt = tan (αTilt) =

Δuperpendicular
v

Note:
• A normal vector to the measurement line is used to calculate the Rotation, Tilt and Δ uperpendicular.
• If the original measurement line is nearly vertical (i.e. an angle with the vertical of +/- 5 degrees or 180 +/- 5
degrees), then the normal vector N is defined as the vector product between the y-axis and the original vector
formed by the two selected points.
• Otherwise, the original measurement line is considered mostly horizontal. The normal vector N is defined as
the vector product between the original vector formed by the two selected points and the vector Nplane. Nplane
is defined as the vector product between the z-axis and the original vector obtained by the two selected
points.

Figure 277: Deformation measurement

Draw scanline
When the Contour lines option is selected , a distribution of the values can be displayed by clicking on the
Draw scanline button in the side toolbar and drawing a line on the regions of interest. Note that this option is
also available in the right mouse click pop-up menu.
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Hint box with node or stress point data
When nodes or stress points are displayed in the model using the corresponding option in the Tools menu, it
is possible to view data of these points in a hint box. This can be done by clicking on the corresponding button in
the side bar menu. If this option is active and the mouse is moved over a node, the hint box shows the global
node number, the node coordinates and the current displacement components.
If the Hint box option is active and the mouse is moved over a stress point, the hint box shows the global stress
point number, the current Young's modulus E, the current cohesion c, the current over-consolidation ratio OCR,
the current principal stresses and a sketch of Coulomb's envelope and Mohr's circles for that stress point.

Selecting nodes or stress points for curves
Nodes and stress points can be selected in the Output program by clicking the Select nodes and stress points
button in the side toolbar. Make sure the Nodes and/or Stress points option has been selected in the Mesh menu.
Nodes are generally used to draw displacements whereas stress points are generally used to draw stresses or
strains.
Note that for the nodes and stress points selected after the calculation process information is only valid for the
saved calculation steps. For a more detailed description see Selecting points for curves (on page 479).

8.5 Display area
The distribution of the results in the model is shown in the display area.
The presence of the legend, title bar, and axes in the drawing area is arranged using the options in the View
menu (View menu (on page 412)).
Note:
The icon in the title bar indicates the view in which the results are displayed. A more detailed description on
Views is given in View menu (on page 412).

8.5.1 Legend
The Legend is available for the display options where a variation in colour describes the variation in the
displayed result values. It is activated by selecting the corresponding option in the View menu.
When the Legend is double clicked, the Legend settings window pops up, where the scaling and the colouring can
be defined (Figure 278 (on page 434)). Note that this option is also available in the right mouse click pop-up
menu. Automatic, Manual or Logarithmic options are possible for scaling of results.
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Figure 278: Legend settings window
The distribution of values in the legend can be locked by clicking the Lock the legend button. When the
legend is locked, the value distribution will not change as the Ctrl++ or Ctrl+- keys are used to move the cross
section through the model or when similar result of other calculation phases or projects are displayed.

8.5.2 Modifying the display settings
The view settings can be defined in the Settings window, that is activated when the corresponding option in the
View menu is selected. Note that this option is also available in the right mouse click pop-up menu.
The visualization settings can be defined in the Visualization tabsheet of the Settings window (Figure 279 (on
page 435)).
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Figure 279: Visualization tabsheet of the Settings window
Symbol size

To modify the size of the symbols in the display for nodes, forces, etc.

Diffuse shading

To make the appearance of the 3D model even more realistic, the Diffuse shading option
may be used. Using this option, object surfaces that have the same colour by definition
(such as soil elements with the same material data set) appear 'brighter' or 'darker',
depending on their orientation with respect to the viewer. Object surfaces appear the
brightest when the normal to the surface points in the direction of the viewer. The
surfaces become darker the more the normal deviates from this direction. The contrast
can be set to the desired magnitude using the slide bar.

Anti aliasing

To select a convenient anti aliasing method from the options available in the drop-down
menu.

Rendering method

To select a convenient rendering method from the options available in the drop-down
menu.

Display

Toggle the display of the Cluster borders.

The displaying colours can be arranged in the Colours tabsheet of the Settings window (Figure 280 (on page
436)).
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Figure 280: Colours tabsheet of the Settings window
The function of the left and the middle mouse buttons can be defined in the Manipulation tabsheet of the
Settings window (Figure 281 (on page 436)).

Figure 281: Manipulation tabsheet of the Settings window
The display of particular results can be toggled on/off in the Results tabsheet of the Settings window (Figure
282 (on page 436)).

Figure 282: Results tabsheet of the Settings window
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The default visibility of Nodes, Stress points and Disabled structures can be toggled on/off in the Default
visibilities tabsheet of the Settings window (Figure 283 (on page 437)).

Figure 283: Default visibilities tabsheet of the Settings window

8.6 Views in Output
In the Output program the results are displayed in different views. The view type is indicated by the
corresponding icon in the title bar. The available views are:

8.6.1 Model view
In the Model view the results are displayed in the whole model. This is the default display of results.

8.6.2 Structures view
When a structure (or multiple structures) is selected and double clicked, the variation of the result is
displayed in the Structures view.

8.6.3 Cross section view
•
•
•
•
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In the Line cross section view the results in the defined line cross section are displayed.
In the Vertical cross section view the results in the defined vertical cross section are displayed.
In the Horizontal cross section view the results in the defined horizontal cross section are displayed.
In the Free cross section view the results in the defined free cross section are displayed.
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8.7 Report generation
To document project input data and computational results, a Report Generator facility is available in the
PLAXIS 3D Output program. The Report generator option can be selected from the File menu. The data files for
the report are generated in the following eight steps.
Step 1: The report can be generated in a group of files or all the information can be combined in a single file (a
RTF, PDF or HTML document). The directory where the report is stored should be defined (Figure 284 (on page
438)).

Figure 284: Report generator - Setup
Step 2: Select the phases for which results will be included in the report (Figure 285 (on page 438)).

Figure 285: Report generator - Phases
Step 3: Select general information sets to be included in the report. Note that the selection can be saved as a new
set besides All and None sets (Figure 286 (on page 439)).
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Figure 286: Report generator - General information
Step 4: Select model view sets to be displayed in the report. Note that the selection can be saved as a new set
besides All and None sets (Figure 287 (on page 439)).

Figure 287: Report generator - Model
Step 5: Select structure view sets to be displayed in the report are selected. Note that the selection can be saved
as a new set besides All and None sets (Figure 288 (on page 439)).

Figure 288: Report generator - Structures
Step 6: Select saved views to be included in the report (Figure 289 (on page 440)). For more details on saved
views, see Store the view for reports (on page 423).
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Figure 289: Report generator - Saved views
Step 7: Select generated charts to be included in the report (Figure 290 (on page 440)).

Figure 290: Report generator - Charts
Step 8: A summary of the number of rows and the number of figures in the report is given (Figure 291 (on page
440)). The report is created as the Export button is clicked. A progress bar appears displaying the number of the
remaining rows and images.

Figure 291: Report generator - Results

8.7.1 Configuration of the document
When the RTF, PDF or HTML document option is selected in the first step, after completing the steps required to
generate the report another window pops up (Figure 292 (on page 441)) where the document type, name, the
storage location and the display properties such as page setup (for RTF and PDF documents), the table
configuration and the type and size of the used font can be defined.
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Figure 292: Document properties

8.8 Creating animations
The Create animation option is available in the File menu. If the option is selected, the Create animation
window appears (see Figure 293 (on page 442)). The phases and calculation steps to be included in the
animations can be selected. Note that the animation will include only available output steps. This depends on the
Max number of steps stored parameter as defined for each phase in the Phases window. After selecting the
phase(s), click OK to start the process. The progress of this process is indicated in a separate window.
If a large number of steps is to be included in the animation, the process may take some minutes after which the
animation is presented. The result is stored in an animation file (*.AVI) in the project data directory.
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Figure 293: Selection of phases from Create animation window

8.9 Paraview Export
The open source tool ParaView has been enabled to export the FEM model and the calculation results from
PLAXIS. This tool allows to visualize and post-process large data from the calculations in PLAXIS 3D. The tool can
be accessed in the Output Program and clicking the File menu (See Figure 294 (on page 442)).

Figure 294: Export to ParaView
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After selecting the Export ParaView option a new window is displayed with the results that can be exported at
level of nodes and stress points (See Figure 295 (on page 443) ). Finalize the process by selecting the necessary
results and click in Export.

Figure 295: Export to ParaView -Result selection
Note:
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9.1 Connectivity plot
A Connectivity plot is a plot of the mesh in which the element connections are clearly visualised. It is the result of
the meshing process. It is available only in the representation of spatial variation of the results. This plot is
particularly of interest when interface elements are included in the mesh. Interface elements are composed of
pairs of nodes in which the nodes in a pair have the same coordinates. In the Connectivity plot however, the
nodes in a pair are drawn with a certain distance in between so that it is made clear how nodes are connected to
adjacent elements. This option is available from the Mesh menu.
In the Connectivity plot it can, for example, be seen that when an interface is present between two soil elements,
that the soil elements do not have common nodes and that the connection is formed by the interface. In a
situation where interfaces are placed along both sides of a plate (Positive interface and Negative interface), the
plate and the adjacent soil elements do not have nodes in common. The connection between the plate and the
soil is formed by the interface. An example of Connectivity plot is given in Figure 296 (on page 445).
In the Connectivity plot it is possible to view soil clusters and structural chains that are excluded from the
strength reduction procedure in a (enhanced) safety calculation, provided that the Hide items without strength
reduction option in the View menu has been selected. These clusters and structures are indicated by a custom
colour; the default colour is grey, but this can be changed in the settings onModifying the display settings (on
page 434).
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Figure 296: Example of the Connectivity plot
Note:
For (enhanced) safety calculations, results are NOT shown in soil clusters that are excluded from the strength
reduction procedure as long as the Hide items without strength reduction option in the View menu has been
selected.

9.2 Deformations
The Deformations menu contains various options to visualise the displacements and strains in the finite element
model. By default, the displayed quantities are scaled automatically by a factor (1, 2 or 5) ·10n to give a diagram
that may be read conveniently.
The scale factor may be changed by clicking the Scale factor button in the toolbar or by selecting the Scale
option from the View menu. The scale factor for strains refers to a reference value of strain that is drawn as a
certain percentage of the geometry dimensions. To be able to compare plots of different calculation phases or
different projects, the scale factors in the different plots must be made equal.

9.2.1 Deformed mesh
The Deformed mesh is a plot of the finite element model in the deformed shape. By default, the deformations are
scaled up to give a plot that may be read conveniently. If it is desired to view the deformations on the true scale
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(i.e. the geometry scale), then the Scale option ( Scaling the displayed results (on page 424)) may be used. The
deformed mesh plot may be selected from the Deformations menu.

9.2.2 Total displacements
The Total displacements option contains the different components of the accumulated displacements at the end
of the current calculation step, displayed on a plot of the geometry. This option may be selected from the
Deformations menu. A further selection can be made among the total displacement vectors, |u|, and the
individual total displacement components, ux, uy and uz. The total displacements may be presented as Arrows,
Contour Lines or Shadings by clicking the appropriate button in the toolbar (Display type of results (on page
426)).

9.2.3 Phase displacements
The Phase Displacements option contains the different components of the accumulated displacement increments
in the whole calculation phase as calculated at the end of the current calculation step, displayed on a plot of the
geometry. In other words, the phase displacements are the differential displacements between the end of the
current calculation phase and the end of the previous calculation phase. This option may be selected from the
Deformations menu.
A further selection can be made among the phase displacement vectors, |Pu|, and the individual phase
displacement components, Pux, Puy and Puz. The phase displacements may be presented as Arrows, Contour lines
or Shadings by clicking the appropriate button in the toolbar (Display type of results (on page 426)).

9.2.4 Sum phase displacements
In Staged construction calculations elements that are switched from inactive to active are, by default, predeformed such that the displacement field across the boundary between the new elements and the existing
elements is continuous. However, in some applications, such as the staged construction of dams and
embankments, this will lead to the undesired situation that the top of the embankment shows the largest
settlements (Figure 297 (on page 447)(a)) and is lower than what has been designed, because of the
accumulated settlements of the different construction layers. When the Sum phase displacements option is
selected, the pre-deformation of newly activated elements is ignored. In this way, the settlement of the last
construction layer will be limited and the largest settlement will most likely occur in the middle of the
embankment, as expected. When plotting the settlements in a vertical cross section through the embankment,
the results are somewhat discontinuous, but the overall settlement profile is more realistic than without
choosing this option (Figure 297 (on page 447)(b)). The more construction layers are used, the smoother the
settlement profile is (Figure 297 (on page 447)(b)).

PLAXIS

446

PLAXIS 3D-Reference Manual

Results available in Output program
Deformations

Figure 297: Settlement profile of an embankment on a stiff foundation layer: a. Phase displacement results; b. Sum
phase displacements results (5 construction layers); c. Sum phase displacements results (10 construction layers)
Note that, if displacements are set to zero in intermediate phases, the Sum phase displacements results may (at
some point) be larger than the total displacements.
Considering structural elements, the Sum phase displacements actually applies to the displacements of the
corresponding nodes as long as they are active. This means that when a structural element (like a plate) is
activated in Phase (i) whereas the corresponding nodes are already active from the initial phase, the Sum phase
displacements in Phase (i+j) includes displacements of the corresponding nodes before the structure itself was
activated.

9.2.5 Incremental displacements
The Incremental displacements option contains the different components of the displacement increments as
calculated for the current calculation step, displayed on a plot of the geometry. This option may be selected from
the Deformations menu. A further selection can be made among the displacement increment vectors, |Δ u|, and
the individual incremental displacement components, Δ ux, Δ uy and Δ uz. The displacement increments may be
presented as Arrows, Contour lines or Shadings by clicking the appropriate button in the toolbar (Display type of
results (on page 426)). The contours of displacement increment are particularly useful for the observation of
localisation of deformations within the soil when failure occurs.

9.2.6 Velocities
The option Velocities contains the different components of the velocities at the end of the current calculation
step, displayed on a plot of the geometry. This option may be selected from the Deformations menu. A further
selection can be made among the velocity vectors, |v|, the individual velocity components, . The velocities may be
presented as Arrows, Contour lines or Shadings by clicking the appropriate button in the toolbar (Display type of
results (on page 426)).
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9.2.7 Accelerations
The option Accelerations contains the different components of the accelerations at the end of the current
calculation step, displayed on a plot of the geometry. This option may be selected from the Deformations menu. A
further selection can be made among the acceleration vectors, |a|, the individual acceleration components, . The
accelerations may be presented as Arrows, Contour lines or Shadings by clicking the appropriate button in the
toolbar (Display type of results (on page 426)).

9.2.8 Accelerations in 'g'
The option Accelerations in 'g' contains the different components of the accelerations at the end of the current
calculation step, displayed on a plot of the geometry as multiples of the gravity acceleration. This option may be
selected from the Deformations menu. A further selection can be made among the acceleration vectors, |a('g' )|,
the individual acceleration components, . The accelerations may be presented as Arrows, Contour lines or
Shadings by clicking the appropriate button in the toolbar (Display type of results (on page 426)).

9.2.9 Total cartesian strains
The Total cartesian strains option contains the different components of the accumulated strains at the end of the
current calculation step, displayed in a plot of the geometry. This option may be selected from the Deformations
menu. A further selection can be made among the six individual Cartesian strain components εxx, εyy, εzz, γxy, γyz
and γzx. The individual strain components may be presented as Contour lines or Shadings by clicking the
appropriate button in the toolbar (Display type of results (on page 426)).

9.2.10 Phase cartesian strains
The Phase cartesian strains option contains the different components of the accumulated strain increments in
the whole calculation phase as calculated at the end of the current calculation step, displayed in a plot of the
geometry. This option may be selected from the Deformations menu. A further selection can be made among the
six individual Cartesian strain components Pεxx, Pεyy, Pεzz, Pγxy, Pγyz and Pγzx.
The individual strain components may be presented as Contour lines or Shadings by clicking the appropriate
button in the toolbar Display type of results (on page 426)).

9.2.11 Incremental cartesian strains
The Incremental cartesian strains option contains the different components of the strain increments as
calculated for the current calculation step, displayed in a plot of the geometry. This option may be selected from
the Deformations menu. A further selection can be made among the six individual Cartesian strain components
Δεxx, Δεyy, Δεzz, Δγxy, Δγyz and Δγzx.
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The individual strain components may be presented as Contour lines or Shadings by clicking the appropriate
button in the toolbar (Display type of results (on page 426)).

9.2.12 Total strains
The Total strains option contains various strain measures based on the accumulated strains in the geometry at
the end of the current calculation step, displayed in a plot of the geometry. This option may be selected from the
Deformations menu. A further selection can be made among the principal strain directions, the individual
principal strain components ε1, ε2, ε3 , (ε1 + ε3)/2, (ε1 - ε3)/2, the angle, the volumetric strain εv, the deviatoric
strain εq and the void ratio e.
• Note that the principal strain components are arranged in algebraic order:
ε1 > ε2 > ε3
Hence, ε1 is the largest compressive principal strain and ε3 is the smallest compressive principal strain.
• The volumetric strain is calculated as:
In normal calculations:
εv = εxx + ε yy + εzz

Eq. [103]

In Updated mesh calculations:
εv = εxx + ε yy + εzz + εxx ε yy + εxx εzz + ε yy εzz + εxx ε yy εzz

Eq. [104]

• The deviatoric strain is calculated as:
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Eq. [105]

• The void ratio is calculated as:
e = e0 + (1 + e0)εv

Eq. [106]

9.2.13 Phase strains
The Phase strains option contains various strain measures based on the accumulated strain increments in the
whole calculation phase as calculated at the end of the current calculation step, displayed in a plot of the
geometry. This option may be selected from the Deformations menu. A further selection can be made among the
volumetric strain (Pεv) and the deviatoric strain (Pεq).

9.2.14 Incremental strains
The Incremental strains option contains various strain measures based on the strain increments as calculated for
the current calculation step, displayed in a plot of the geometry. This option may be selected from the
Deformations menu. A further selection can be made among the volumetric strain (Δεv) and the deviatoric strain
(Δεq).
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9.3 Stresses
Various options are available to visualise the stress state in the finite element model. The Stresses menu also
contains options to display the results of groundwater flow and thermal flow calculations.
Note:
By default, the stresses developed in non-porous materials are not displayed in the plot. To display them select
the Show stress for nonporous material option in the Results tabsheet of the Settings window (Modifying the
display settings (on page 434)).

9.3.1 Cartesian effective stresses
The Cartesian effective stresses are different components of the effective stress tensor (i.e. the stresses in the soil
skeleton). A further selection can be made among the six individual Cartesian stress components σ'xx, σ'yy, σ'zz,
σxy, σyz and σzx.
Figure 298 (on page 450) shows the sign convention adopted for Cartesian stresses. Note that pressure is
considered to be negative.
y

�yz

x
z

�zz

�yy

�zy

�yx

�zx �xz

�xy

�xx

Figure 298: Sign convention for stresses

9.3.2 Cartesian total stresses
The Cartesian total stresses are different components of the total stress tensor (i.e. effective normal stresses +
active pore pressures). A further selection can be made among the six individual Cartesian stress components
σxx, σyy, σzz, σxy, σyz and σzx. The latter three quantities are equal to the corresponding ones in the Cartesian
effective stress option, but are repeated here for convenience (Cartesian effective stresses (on page 450)). The
individual stress components may be presented as Contour lines or Shadings by clicking the appropriate button
in the toolbar.
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9.3.3 Principal effective stresses
The Principal effective stresses are various stress measures based on the effective stresses σ' (i.e. the stresses in
the soil skeleton). A further selection can be made among the effective principal stresses, the individual principal
effective stress components σ'1, σ'2, σ'3, (σ'1+σ'3)/2, the mean effective stress p', the deviatoric stress q, the
relative shear stress τrel and the mobilised shear strength τmob.
Note that the effective stress components are arranged in algebraic order:
σ1′ ≤ σ2′ ≤ σ3′

Eq. [107]

Hence, σ'1 is the largest compressive (or smallest tension) principal stress and σ'3 is the smallest compressive
(or largest tension) principal stress.
The Mobilised shear strength τmob is the maximum value of shear stress (i.e. the radius of the Mohr stress circle
or half the maximum principal stress difference).
The Relative shear stress τrel gives an indication of the proximity of the stress point to the failure envelope, and is
defined as:
τrel =

τmob
τmax

Eq. [108]

where τmax is the maximum value of shear stress for the case where the Mohr's circle is expanded to touch the
Coulomb failure envelope while keeping the center of Mohr's circle constant.
τmax = −

σ ′ 1+σ ′ 3
sin φ
2

+ ccos φ

Eq. [109]

Note:
Particularly when the soil strength has been defined by means of effective strength parameters- Undrained (A)it is useful to plot the mobilised shear strength τmob in a vertical cross section and to check this against a known
shear strength profile.
When using the Hoek-Brown model to describe the behaviour of a rock section, the definition of the maximum
shear stress τmax is slightly modified. Starting from the Hoek-Brown failure criterion:
f HB = σ ′ 1 − σ ′ 3 + f̄ (σ ′ 3) = 0

Eq. [110]

the maximum shear stress is defined by :
τmax =

1
2

(

f̄ (σ ′ 3) where f̄ (σ ′ 3) = σci mb

−σ ′3
σci

+s

)

a

Eq. [111]

The relative shear stress is correspondingly defined by:
τrel =

PLAXIS

τmob
τmax

=

|σ′1−σ′3|
f̄ (σ ′ 3)

Eq. [112]
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9.3.4 Principal total stresses
The Principal total stresses are various stress measures based on the total stresses σ (i.e. effective stresses +
active pore pressures). A further selection can be made among the principal total stress directions, the individual
principal total stress components σ1, σ2, σ3, (σ1+σ3)/2, (σ1-σ3)/2, the mean total stress p, the deviatoric stress q,
the relative shear stress τrel and the mobilised shear strength τmob. The latter three quantities are equal to the
corresponding ones in the Principal effective stress option, but are repeated here for convenience (Principal
effective stresses (on page 450)).
Note that the total stress components are arranged in algebraic order:
σ1 ≤ σ2 ≤ σ3
Hence, σ1 is the largest compressive (or the smallest tension) principal stress and σ3 is the smallest compressive
(or the largest tension) principal stress.

9.3.5 Initial conditions
The Initial conditions sub-menu (Figure 299 (on page 452)) is only available in the initial phase. The spatial
distribution of the Pre-Overburden Pressure (POP), as defined in the Preconsolidation tab in the Modify soil
layers window, can be displayed and checked (Figure 300 (on page 453)).

Figure 299: Initial conditions in the Stresses menu (Initial phase)
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Figure 300: Example of POP distribution

9.3.6 State parameters
The State parameters are various additional quantities that relate to the state of the material in the current
calculation step, taking into account the stress history. For more information regarding state parameters of each
material model, see Material Models Manual.

The actual permeability
The actual permeability (Permeabilityactual,x, Permeabilityactual,y) is the relative permeability times the saturated
permeability. This value depends on the degree of saturation according to the Van Genuchten (or other)
relationship as defined in the flow parameters of the material set.

The strain history
The strain histories εxx - εv, εyy - εv, εzz - εv, εxy, εyz and εzx are only available in the Hardening Soil model with
small-strain stiffness.

The secant shear modulus
Gs: The secant shear modulus Gs is only available in the Hardening Soil model with small-strain stiffness. This
option may be used to check the actual secant shear modulus at the reference level, used in the current
calculation step. More information about this parameter can be found in the Material Models Manual - Chapter 7
- Describing small-strain stiffness with a simple hyperbolic law.

PLAXIS

453

PLAXIS 3D-Reference Manual

Results available in Output program
Stresses

The ratio between the actual shear modulus and the unloading reloading stiffness
G/Gur: The ratio between the actual shear modulus G and the unloading reloading stiffness Gur is only available in
the Hardening Soil model with small-strain stiffness.

The equivalent isotropic stress
Hardening Soil model
peq: The equivalent isotropic stress peq is only available in the , Hardening Soil model with small-strain stiffness,
Soft Soil model, Soft Soil Creep model, Modified Cam-Clay model.The equivalent isotropic stress is defined as the
intersection point between the stress contour (with similar shape as the yield contour) through the current
stress point and the isotropic stress axis. Depending on the type of model being used it is defined as:
peq =

peq = p ′ −

p2 +

q̃ 2
α2

for the Hardening Soil model and Hardening Soil
model with small-strain stiffness.
for the Soft Soil model, Soft Soil Creep model and
Modified Cam-Clay model. For the Modified Cam-Clay
model, the cohesion c is defined as 0 kN/m2.

q2
M 2 ( p ′ − ccot φ )

More information about this parameter for each model can be found in the Material Models Manual

The isotropic preconsolidation stress pp
The isotropic preconsolidation stress pp is only available in the Hardening Soil model, Hardening Soil model with
small-strain stiffness, Soft Soil model, Soft Soil Creep model, Modified Cam-Clay model. The isotropic
preconsolidation stress represents the maximum equivalent isotropic stress level that a stress point has
experienced up to the current load step.

The isotropic over-consolidation ratio OCR
The isotropic over-consolidation ratio OCR is only available in the Hardening Soil model, Hardening Soil model
with small-strain stiffness, Soft Soil model, Soft Soil Creep model, Modified Cam-Clay model. The isotropic overconsolidation ratio is the ratio between the isotropic preconsolidation stress pp and the equivalent isotropic
stress peq.

The hardening parameter γp
The hardening parameter γp is only available for the Hardening Soil model and Hardening Soil model with smallstrain stiffness. This option may be used to check the actual hardening during the current calculation step.

The actual Young's modulus E
The actual Young's modulus E is the unconstrained elastic stiffness modulus as used during the current
calculation step. This option is only available in the Linear Elastic model and Mohr-Coulomb model.
When the Linear Elastic model or the Mohr-Coulomb model is utilised with an increasing stiffness with depth
(Eincrement > 0), this option may be used to check the actual stiffness profile used in the calculation. Note that in
the Linear Elastic model and the Mohr-Coulomb model the stiffness is NOT stress-dependent.
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The actual stiffness Eur for unloading and reloading
The actual Young's modulus Eur for unloading and reloading is the unconstrained elastic stiffness modulus as
used during the current calculation step. This option is only available in the Hardening Soil model, Hardening
Soil model with small-strain stiffness, Soft Soil model, Soft Soil Creep model, Modified Cam-Clay model.
The stiffness Eur depends on the stress level. In models with stress-dependency of stress, the actual stiffness Eur
is calculated on the basis of the stresses at the beginning of the current step. The option may be used to check
the actual stress-dependent stiffness used in the current calculation step.

The actual cohesion c
The actual cohesion c is the cohesive strength as used during the current calculation step. This option is only
available in the Mohr-Coulomb model, Hardening Soil model, Hardening Soil model with small-strain stiffness,
Soft Soil model and Soft Soil Creep model.
When the Mohr-Coulomb model, Hardening Soil model or the Hardening Soil model with small-strain stiffness is
utilised with an increasing cohesive strength with depth (cincrement > 0), this option may be used to check the
actual cohesive strength profile used in the calculation.

9.3.7 Pore pressures
Pore pressures are the quantities that relate to the stress in the pores of the material. The pores in soil are
usually filled with a mixture of water and air. In most cases, stresses and pore pressures in the soil are negative
(pressure). However, due to capillary action or undrained unloading, pore pressures may become positive
(tension), which is denoted as suction.
PLAXIS 3D distinguishes between different types of pore pressures and related quantities. It is important to
understand the differences between these quantities in order to properly interpret the results from a PLAXIS 3D
calculation.
Total stresses are divided into effective stresses, σ', and active pore pressures, pactive.
σ = σ ′ + pactive

Eq. [113]

Note that all the effective and total stresses are tensorial quantities. Then pore pressure should be also
understood as a diagonal tensor (pore pressure only applies to normal stress components).
Active pore pressures are defined as the effective saturation, Seff, times the pore water pressures, pwater.
pactive = Seff ⋅ pwater

Eq. [114]

Pore water pressure differs from active pore pressure when the degree of saturation is less than unity, which is
usually the case above the phreatic level. Below the phreatic level pactive and pwater are generally equal. For more
details, refer Appendix D.
As an alternative to the pore water pressure, pwater, the groundwater head, h, can be viewed:
h =z−

pwater
γw

Eq. [115]

where z is the vertical coordinate and γw is the unit weight of water. In the pore water pressure a further
distinction is made between steady state pore pressure, psteady, and excess pore pressure, pexcess.
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pwater = psteady + pexcess

Eq. [116]

where steady-state pore pressure is the steady-state or long term part of pore pressure, which is supposed to be
input data for a deformation analysis.
Excess pore pressure is the result from undrained behaviour (Undrained (A) or (B), or low-permeable materials),
and is affected by stress changes due to loading or unloading, a (sudden) change in hydraulic conditions and
consolidation.
Below an overview is given of the various pore pressure related quantities that are available in the Stresses
menu of the PLAXIS 3D Output program. Most quantities can be presented as Contour lines, Shadings or Iso
surfaces. Although pore pressures do not have principal directions, the Principal stresses presentation can be
useful to view pore pressures inside the model. In that case the colour of the lines represents the magnitude of
the pore pressure and the directions coincide with the x-, y- and z-axis.

Groundwater head
The groundwater head is an alternative quantity for the pore water pressure, equivalent to the top level of a free
water column.

Active pore pressure
The part of total stress in the pores of the soil. In saturated soil, active pore pressure is equal to the pore water
pressure. In unsaturated soil, active pore pressure is the effective saturation times the pore water pressure.

Pore water pressure
The water pressure in the pores of the soil consisting of steady-state pore pressure and excess pore pressure. In
most cases, pore water pressure is negative (pressure). However, due to capillary action or undrained unloading,
pore water pressure may become positive (suction).

Steady-state pore pressures
Long-term part of pore water pressure which is supposed to be input data for a deformation analysis. Steadystate pore pressure is the result of a direct pore pressure generation based on phreatic levels and cluster-related
pore pressure definition, or the result of a steady-state groundwater flow calculation. In the case of a fully
coupled flow-deformation analysis, steady-state pore pressure is calculated from a steady-state groundwater
flow calculation using the hydraulic boundary conditions at the end of the calculation phase. When the option
Ignore suction has been used, the steady-state pore pressure only includes negative values.

Excess pore pressure
Instationary part of pore water pressure that is a result of undrained behaviour (Undrained (A) or (B), or lowpermeable materials), affected by stress changes due to loading or unloading, a (sudden) change in hydraulic
conditions and consolidation. In the case of a fully coupled flow-deformation analysis, excess pore pressure is
the difference between the calculated pore water pressure and the steady-state pore pressure. The latter is
calculated from a steady-state groundwater flow calculation using the hydraulic boundary conditions at the end
of the calculation phase. Excess pore pressure may show positive values (suction) as a result of undrained
unloading, even when the option Ignore suction has been selected.

Extreme excess pore pressure
Maximum and minimum values of excess pore pressure over the whole calculation phase up to the selected
calculation step.
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Change in pore pressure per phase
The change in active pore pressure from the beginning of a phase up to the selected calculation step.

Suction
Any positive value (tension) in the pore water pressure. Suction can be a result of capillary action (included in
the steady-state pore pressure if the option Ignore suction has NOT been used) or undrained unloading (included
in the excess pore pressure).

Effective suction
Any positive value (tension) in the active pore pressure. When multiplied by the tangent of the friction angle, the
effective suction gives a kind of 'artificial cohesion' in the soil.

9.3.8 Groundwater flow
When a groundwater flow calculation has been performed to generate the pore pressure distribution, then the
specific discharges at the element stress points are available in the Output program in addition to the pore
pressure distribution. The specific discharges can be viewed by selecting the Groundwater flow option from the
Stresses menu. A further selection can be made among the groundwater flow components, .
The flow field may be viewed as Arrows, Contour lines or Shadings by selecting the appropriate option from the
presentation box in the tool bar. When the specific discharges are presented as arrows, then the length of the
arrow indicates the magnitude of the specific discharge whereas the arrow direction indicates the flow direction.

Discharge (|q|, qx, qy, qz)
The total discharge through a cross section can be obtained by drawing a cross section through the interface
element and selecting Stresses → Groundwater flow→|q|/qx/qy/qz. The value of total discharge is displayed below
the plot in the unit of volume per unit of time .

Saturation
The PlaxFlow module within PLAXIS 3D may be used to calculate a pore pressure distribution for confined as
well as for unconfined flow problems. The determination of the position of the free phreatic surface and the
associated length of the seepage surface is one of the main objectives of an unconfined groundwater flow
calculation. In this case a relationship is used between the pore pressure and the degree of saturation. Both
quantities are calculated in a groundwater flow calculation and are made available in the Output program.
The degree of saturation is generally 100% below the phreatic level and it reduces to the residual saturation
within a finite zone above the phreatic level. Note that the residual saturation value is equal to zero when
suction is ignored. The saturation can only be presented as Contour lines or Shadings.

Hydraulic gradient (i)
The hydraulic gradient (also called groundwater head gradient or Darcy's slope) between any two points is the
rate of spatial variation of the hydraulic head measurements over the length of the flow path that links them. It is
more generally expressed as the spatial derivative of the hydraulic head field, i =∇ h. The hydraulic gradient
together with the permeability tensor determines the flux of groundwater in the space. In isotropic media, the
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magnitude and direction of this parameter are proportional and opposite to the flow vector (q), as water flows
from higher to lower hydraulic head locations. For the general evaluation of seepage problems in anisotropic
media, it is crucial to consider both vectors independently.
The hydraulic gradient can be visualised by selecting the |i| option or one of the available components ix, iy, and
iz. These can be presented as Contour lines, Shadings, Arrows, and Iso surfaces.

Effective saturation (Saturationeff)
The effective saturation is used as the Bishop coefficient in the definition of Bishop stress and also to calculate
the weight of soil. The effective saturation can only be presented as Contour lines or Shadings.

Relative permeability (Permeabilityrel)
The relative permeability can be visualised by selecting the Permeabilityrel option. The relative permeability can
only be presented as Contour lines or Shadings.

9.3.9 Plastic points
The Plastic points option shows the stress points that are in a plastic state, displayed in a plot of the
undeformed geometry. Plastic points can be shown in the 3D mesh, or in the elements around the work planes
or in the elements around a cross section.
Note:
The Plastic point history option in the Stresses menu enables displaying in the model all the points that have been
plastic in any step in the calculation history (depending on the specified criteria, Failure, Tension cut-off, etc.)
generated up to the current calculation phase.

The plastic stress points are indicated by small symbols that have different shapes and colours, depending on the
type of plasticity that has occurred:
• A red cube (Failure point) indicates that the stresses lie on the surface of the failure envelope.
• A white cube (Tension cut-off point) indicates that the tension cut-off criterion was applied.
• A blue upside-down pyramid (Cap point) represents a state of normal consolidation (primary compression)
where the preconsolidation stress is equivalent to the actual stress state. The latter type of plastic points only
occurs if the Hardening Soil model, the Hardening Soil model with small-strain stiffness, the Soft Soil model,
the Soft Soil Creep model or the Modified Cam-Clay model is used.
• A brown diamond (Cap+Hardening point) represents points that are on the shear hardening and cap
hardening envelope. Such plastic points can only occur in the Hardening Soil model or the Hardening Soil
model with small-strain stiffness.
• A green pyramid (Hardening point) represents points on the shear hardening envelope. Such plastic points
can only occur in the Hardening Soil model, the Hardening Soil model with small-strain stiffness and the
UBC3D-PLM model.
• A purple inverted triangle (Liquefaction point) represents a stress point which is liquefied, characterised by
the pore pressure ratio Ru > 0.95. Such plastic points can occur only in the UBC3D-PLM model and User-
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defined Soil Model. When viewed in the Table view (Table of Cartesian effective stresses), the Status shows as
'Liquefied'.
In case the Concrete model is adopted, the symbols have different meanings:
• A red cube (Failure point) indicates that the stresses lie on the Mohr-Coulomb peak surface or the MohrCoulomb softening surface.
• A white cube (Tension cut-off point) indicates that the stresses lie on the failure envelope in tension,
including the intersection between the Rankine surface and the Mohr-Coulomb surface.
• A green pyramid (Hardening point) represents points on the Mohr-Coulomb shear hardening envelope.
The failure points are particularly useful to check whether the size of the mesh is sufficient. If the zone of
plasticity reaches a mesh boundary (excluding the symmetry plane in a symmetric model) then this suggests
that the size of the mesh may be too small. In this case the calculation should be repeated with a larger model.

Figure 301: Plastic points window
When Plastic points is selected in the Stresses menu the Plastic points dialog is shown (Figure 301 (on page 459)).
Here the user can select which types of plastic points are displayed. When the Stress points option is selected, all
other stress points are indicated by a purple diamond shape . For details of the use of advanced soil models, the
user is referred to the Material Models Manual.
By default both accurate and inaccurate plastic points are displayed in the model. Only the inaccurate plastic
points are displayed as the corresponding check box is selected in the Plastic points window. Inaccurate plastic
points are points where the local error is larger then the tolerated error (Automatic error checks (on page 406)).
When the results are displayed with the Table option, an asterisk appears on the status column to identify the
inaccurate plastic points.

Conventions used for Plastic point information with Paraview Export
If plastic point information is exported from PLAXIS 3D to ParaView (see Paraview Export (on page 442)), the
point information will have associated different status described in Conventions used for Plastic point
information with Paraview Export (on page 459).
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Table 19: Conventions for plastic point results on Paraview
Value

Plastic point status

1 or -1

MC accurate

2

Tension cut-off accurate

3

Cap Hardening accurate

4

Cap + Shear hardening accurate

5

Shear hardening accurate

6

Liquefaction accurate

11 or -11

MC inaccurate

12

Tension cut-off inaccurate

13

Cap Hardening inaccurate

14

Cap + Shear hardening inaccurate

15

Shear hardening inaccurate

16

Liquefaction inaccurate

9.3.10 Fixed end anchors
When Fixed end anchors is selected in the Stresses menu a table appears displaying the fixed end anchors
available in the model, their location, the resulting axial force, the rotation angle and the equivalent length.

9.3.11 Node to node anchors
When Node to node anchors is selected in the Stresses menu a table appears displaying the node to node anchors
available in the model, the location of the nodes and the resulting axial forces.

9.3.12 Wells
When Wells is selected in the Stresses menu a table appears displaying the wells available in the model, the nodes
representing the well and their location, the discharge of the entire well and the defined minimum groundwater
head.
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9.3.13 Drains
When Drains is selected in the Stresses menu a table appears displaying the drains available in the model, the
nodes representing the drain and their location, the total discharge and the defined groundwater head of the
drain.

9.4 Structures and interfaces
By default, the structures active in the current phase are displayed in the model. Otherwise, these objects may be
displayed in by switching the view on in the explorer.
Output for structures and interfaces can be obtained by clicking the Select structures button and then
double-clicking the desired object in the 3D model. As a result, a new form is opened on which the selected
object appears. At the same time the menu changes to provide the particular type of output for the selected
object.
All objects of the same type with the same local coordinate system are automatically selected. When multiple
objects or multiple groups of objects of the same type need to be selected, the Shift key should be used while
selecting the objects. The last object to be included in the plot should then be double clicked. When all objects of
the same type are to be selected, select one of the objects while pressing Ctrl-A simultaneously. If it is desired to
select one or more individual elements from a group, the Ctrl key should be used while selecting the desired
element.
Another option of selecting structural elements in the output is by clicking the Drag a window to select
structures button and drawing a rectangle in the model. As a results, the structures in the rectangle will be
selected.

9.4.1 Deformation in structures and interfaces
The deformation options for the structural elements are given in the Deformations menu. The user may select
the Total displacements, the Phase displacements or the Incremental displacements (Deformations (on page 445)).
For each item a further selection can be made among the displacement vectors |u|, and the individual total
displacement components, ux, uy and uz.
The deformation options in the direction of local axis of the structures are available as well. The user may select
the Total local displacements, the Phase local displacements or the Incremental local displacements. For each item
a further selection can be made among the individual displacement components u1, u2 and u3.
The Rotation option is available for Plates displaying the total rotation (Rotation) and the incremental rotation
(ΔRotation) of the selected plates with respect to the global axes.
Options such as Relative total displacements, Relative phase displacements and Relative increments are available
for interfaces. Relative displacements are differential displacements between node pairs. These options may be
used to view if plastic shearing has occurred in the interface.
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Only in the case of semi-permeable interfaces, the output program shows the resulting specific discharge
through the interface elements. This output is not available in the case of fully impermeable or fully permeable
interface elements.
In the case of fully permeable interfaces, the resulting discharge through the interfaces can be obtained by
drawing a cross section just outside the wall or tunnel lining, and plotting the flow through this cross section.
The title of the cross section plot will indicate the total discharge through the cross section.

9.4.2 Resulting contraction in plates and geogrids
When a is used in the calculation and the correspondent plate or geogrid is displayed, the realised contractions
are available from the Deformations menu. The contraction can be positive (e.g. concrete shrinkage) or negative
(e.g. thermal expansion of geogrids).
The realised contraction outputs are Ctunnel and Cplanar. The realised tunnel contraction, Ctunnel, returns the value
as used in the calculation. The realised planar contraction, Cplanar, is equal to Ctunnel/2. Assuming a case of line
(circumference) contraction (Crefline) from an initial length L0 to a final length L against circular surface
contraction (Crefsurf) from an initial area A0 (with radius R0=L0/(2 π)) to a final area A (with radius R=L/(2 π)), the
factor 2 is derived as such:
line
Cref
=

ΔL
L0

surf
Cref

ΔA
A0

=

=

=

L − L 0
L0
A − A0
A0

=

Eq. [117]

(R0 + ΔR )2 − R02
2
R0

≅2

R − R0
R0

=2

L − L 0
L 0

Eq. [118]

The formulation above does not only apply to a circular surface but to all closed surfaces.

9.4.3 Resulting forces in beams
When a beam is displayed, the options Axial force N, Shear force Q12, Shear force Q13, Bending moment M2 and
Bending moment M3 are available from the Forces menu. Note that positive axial forces refer to tension whereas
negative forces refer to compression (Figure 302 (on page 462)). The sign of bending moments and shear forces
depend on the beam's local system of axes (Figure 303 (on page 463) (a)).

Figure 302: Sign convention for axial forces in beams
The Structure axes option from the View menu may be used to display the beam's local system of axes (1,2,3).
The first direction is always the axial direction.
The Axial force N is the force in the first (axial) direction (Figure 303 (on page 463) (b)). An axial force is
positive when it generates tensile stresses, as indicated in Figure 302 (on page 462).
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Figure 303: Positive axial force and shear forces in horizontal beams Axial force and shear forces. a) Local axes. b)
Axial force N. c) Shear force Q12. d) Shear force Q13
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Figure 304: Positive bending moments in beams. a) Bending Moment M3, b) Bending Moment M2
The Shear force Q12 is the shear force over the second beam axis (Figure 303 (on page 463) (c)), whereas the
Shear force Q13 is the shear force over the third beam axis (Figure 303 (on page 463) (d)).
The Bending moment M3 is the bending moment due to bending around the third axis (Figure 304 (on page 463)
(a)), whereas the Bending moment M2 is the bending moment due to bending around the second axis (Figure 304
(on page 463) (b)). The Bending moment M1 is the Torsion (bending around the first axis).

9.4.4 Resulting forces in embedded beams
When an embedded beam is displayed, the options Axial force N, Shear force Q12, Shear force Q13, Bending
moment M2, Bending moment M3 , Skin force Tskin (in axial pile direction) and lateral forces Tlat and Tlat2 are
available from the Forces menu. The latter three options relate to the pile-soil interaction (see below). For a
detailed description of structural forces in the embedded beam elements see Resulting forces in beams (on page
462).
Note:
The Axes option from the View menu may be used to display the pile's local system of axes (1,2,3). The first
direction is always the axial direction. The second direction is perpendicular to the pile axis with a component in
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the global x-direction and the third direction is also perpendicular to the pile with a component in the global zdirection.
The pile-soil interaction forces are obtained from the special interface that is automatically applied between the
embedded beam elements and the surrounding soil volume elements. The Skin force Tskin, expressed in the unit
of force per unit of pile length, is the force related to the relative displacement in the pile's first direction (axial
direction). This force is limited by the skin resistance as defined in the embedded beam material data set
(Material set (on page 307)).
The interaction force Tlat relates to the relative displacement perpendicular to the pile in the pile's second
direction whereas the interaction force Tlat2 relates to the relative displacement perpendicular to the pile in the
pile's third direction. These quantities are expressed in the unit of force per unit of pile length. Note that Tlat and
Tlat2 are not limited. In fact, when these forces become very large, plasticity will occur outside the elastic zone in
the surrounding soil volume elements.
The maximum shear stress Tskin,max is the limit defined for the material dataset. The relative shear stress Tskin,rel
gives an indication of the proximity of the stress point to the failure envelope.
The pile foot force Ffoot, expressed in the unit of force, is obtained from the relative displacement in the axial pile
direction between the foot or tip of the pile and the surrounding soil. The foot force is shown in the plot of the
Axial force N. The foot force is limited by the base resistance as defined in the embedded beam material data set
(Material set (on page 307)).

9.4.5 Resulting forces in plates
When a plate is displayed, axial forces N1 and N2, shear forces Q12, Q23 and Q13 and moments M11, M22 and M12
are available from the Forces menu. These forces represent the actual forces at the end of the calculation step.
Note that axial forces are positive when they generate tensile stresses, as indicated in Figure 283 . The sign of
bending moments and shear forces depend on the plate's local system of axes.
The Structure axes option from the View menu may be used to display the plate's local system of axes (1,2,3). The
first and second direction lie in the plane of the plate whereas the third direction is perpendicular to the plate.
The Axial force N1 is the axial force in the first direction (Figure 305 (on page 465) (b)). The Axial force N2 is the
axial force in the second direction (Figure 305 (on page 465) (c)).
The Shear force Q12 is the in-plane shear force (Figure 306 (on page 465) (a)). The Shear force Q13 is the shear
force perpendicular to the plate over the first direction (Figure 306 (on page 465) (b)), whereas the Shear force
Q23 is the shear force perpendicular to the plate over the second direction (Figure 306 (on page 465) (c)).
The Bending moment M11 is the bending moment due to bending over the second axis (around the second axis)
(Figure 307 (on page 465) (b)). The Bending moment M22 is the bending moment due to bending over the first
axis (around the first axis) (Figure 307 (on page 465) (c)).
The Torsion moment M12 is the moment according to transverse shear forces (Figure 307 (on page 465) (a)).
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Figure 305: Positive axial forces in plates and geogrids. a) Local plate directions, b) Axial force N1, c) Axial force N2
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Figure 306: Positive shear forces in plates. a) Shear force Q12, b) Shear force Q13, c) Shear force Q23
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Figure 307: Positive bending moments in plates. a) Torsion moment M12, b) M11, c) Bending moment M22
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9.4.6 Resulting forces in geogrids
When a geogrid is displayed, the options Axial force N1 and Axial force 2 are available from the Forces menu
(Figure 305 (on page 465)). Forces in geogrids are always positive (tension). Compressive forces are not allowed
in these elements.

9.4.7 Resulting force in anchors
Output for anchors (fixed-end anchors as well as node-to-node anchors) involves only the anchor force
expressed in the unit of force on the anchor (on the nodes in node-to-node anchor). The anchor force appears in
a table after double clicking the anchor in the model. The program displays the values of the historical maximum
and minimum forces in all calculation phases in node-to-node anchors.

9.4.8 Resulting stresses in interfaces
Interface elements are formed by node pairs, i.e. two nodes at each node position: one at the 'soil' side and one at
the 'structure' side or the other 'soil' side. Interfaces can be visualised by activating the corresponding option in
the Geometry menu. Output for interfaces can be obtained by double clicking on the interface elements in the
three-dimensional model. The output for interfaces comprises deformations (Deformations (on page 445)) and
stresses.
When an interface is displayed, the options Effective σ'N, Total σN, Shear τ1, Shear τ2, Relative Shear τrel,
Groundwater flow, steady-state pore pressure psteady, excess pore pressure pexcess, active pore pressure pactive,
pore water pressures pwater, effective degree of saturation Seff, suction, effective suction, Groundwater head and
Plastic points are available from the Interface stresses menu. The effective normal stress is the effective stress
perpendicular to the interface. Note that pressure is considered to be negative. The relative shear stress τrel
gives an indication of the proximity of the stress point to the failure envelope, and is defined as:
τrel =

2
2
τ1 + τ2
τmax

Eq. [119]

where τmax is the maximum value of shear stress according to the Coulomb failure envelope for the current value
of the effective normal stress.

Total discharge through an interface
In the case of semi-permeable interfaces, the total discharge through an interface can be obtained by selecting
the Interface stresses → Groundwater flow → qn/Qn. Beneath the interface plot, the value of total discharge is
displayed in the unit of volume per unit of time. This option is useful in scenarios where it is required to know
the groundwater discharge through a tunnel lining or a retaining wall.
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Note:
• It is strongly recommended to select only one interface, to view discharge results. If double interfaces (for
example, in the case of interfaces on both sides of a retaining wall) are selected, the results for discharge
through these interfaces can be misleading.
• This option is not viable in case of fully permeable interface elements as Darcy's law cannot compute
discharge for these scenarios. A workaround in such a case can be to use a semi-permeable interface and
assign a very low hydraulic resistance (d/k) in case of fully permeable interfaces.

9.4.9 Resulting forces in rigid bodies
Output for rigid bodies can be viewed by selecting Rigid body results in the Project menu of the Output program.
After selection, a window opens with four tabsheets, containing tables of rigid body input data and results. The
main results can be found in the tabsheets Deformations and Forces.
The Deformations tab sheet contains the displacements and rotations that have been applied to the rigid bodies
or are the result after applying forces / moments. They are shown as incremental, phase and total values as
follows.
|u|

Total displacements

φ

Rotations

|Pu|

Phase displacements

Pφ

Phase rotation

Δu

Incremental displacement

Δφ

Incremental rotation

The Prescribed displacements tab contains input values of displacements and rotations as follows.
|u|

Input prescribed displacement value

φ

Input rotation value

In case a displacement/rotation is prescribed in the reference point (both 0 or non-zero), the total reaction force
is based on ALL forces involved, i.e. stresses in soil and interfaces, forces in structural elements, as well as
external loads and body forces (self-weight of the rigid body). In case a force/moment is prescribed in the
reference point (both 0 or non-zero), the result of the calculation is a displacement (as listed in the Deformations
tab) as well as a reaction force (i.e. the sum of stresses external loads and body forces, as listed in the Forces tab).
The Forces tab sheet contains the resulting forces and bending moments that have been applied to the rigid
bodies or are the result after applying displacements / rotations. They are shown as total values, together with
their input value as follows.
|Freac|
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|Mreac|

Reaction bending moment of the soil

|F|

Input force value

|M|

Input bending moment value

|Fa|

Applied force (based on the ΣMstage value)

|Ma|

Applied bending moment (based on the ΣMstage value)

|Fprev|

Calculated force from previous phase

|Mprev|

Calculated bending moment from previous phase

9.4.10 Structural forces in volume piles
Note:
• Note that the structural forces are calculated by integrating the results in the stress points along the region
perpendicular to the cross section line. Special care is required when the structural forces in the region of
connection of the subparts are evaluated.
• The generation of the structural forces may take awhile if the generated mesh has many elements.

Creating a cross section line
When selecting the Structural forces in volumes option, a cross section line should be drawn in longitudinal
direction through the centre of the area that forms the structure.
Hide the clusters which are not of interest for generation of the structural forces, using the toggle in the
Model explorer. Select the Line cross section button in the side toolbar, the Cross section points window pops up.
A cross section line needs to be drawn along the structure which is of interest. The points defining the section
composing the cross section line can be defined either by directly clicking on the model or by defining the
coordinates of the location in the Cross section points window. The process of cross section line definition must
be completed by clicking the OK button in the Cross section points window. The Local axes window pops up
with approximated values. This can be accepted by clicking the OK button. Then the structural forces are
computed on-the-fly and visualised along the created line (Figure 308 (on page 469)).
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Figure 308: Figure displaying the structural force in a volume pile

Importing a centerline
When selecting the Structural forces in volumes piles option, it is also possible to import a centerline of a cylinder.
Select the Import centerlines button in the side toolbar. The Select centerlines to import window pops up
(Figure 309 (on page 470)). The specific volumes can be selected for which structural forces need to be
displayed. Note that importing is only possible for whole cylinders.
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Figure 309: Import centerline window

Automatic center lines wizard
As an alternative to the import of a center line, the center line can be automatically detected using the
Generate center lines wizard.
The automatic center lines wizard can be used in two situations as described below.

Structural forces in volume piles
By clicking the Structural forces in volume piles button, the Automatic center lines wizard pops up (Figure
310 (on page 471)). This can now be used to generate center lines specifically only for volume piles.
A user can use the tabsheets as described below to generate center lines using the automatic center lines wizard
tool.
Criteria

PLAXIS

In the Criteria tabsheet (Figure 310 (on page 471)), it is possible to select the materials
whose center line is required for calculation of structural forces. Individual volume
clusters can be specified in the right-hand panel by clicking on the checkbox Specify
clusters and selecting or deselecting specific soil volumes. The clusters can be: multiselected (Ctrl), selected all (Ctrl+A) and selected in a range (Shift+Arrowkeys or Shift
+PageUp/Down).
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Figure 310: Automatic center lines wizard Criteria tabsheet
Since structures can be modelled as a half or even a quarter of the complex structure (considering planes of
symmetry in the model), it is important for a proper visualisation of the structural forces to indicate if such
symmetry planes exist.
Symmetry
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This blue tabsheet (Figure 311 (on page 472)) allows users to select which horizontal
and / or vertical planes should act as a symmetry plane. This can be done, by selecting
anyone of the following checkboxes, xmin, xmax, ymin or ymax. The user may skip this
tabsheet if no symmetry plane is desired.
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Figure 311: Automatic center lines wizard Symmetry tabsheet
Once the Criteria and Symmetry have been selected, the user may then proceed to click on the button Detect in
order to generate the center lines.
Center lines

PLAXIS

In this orange tabsheet (Figure 312 (on page 473)), the results for the center lines are
shown. Here it is possible to select specific center lines of interest. Each center line can
easily be toggled to show or hide it.
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Figure 312: Automatic center lines wizard Center lines tabsheet
The structural forces are computed by integrating the stresses along the cross sections which are perpendicular
to the centerlines which have been generated in the previous step. Automatic local axes determination is based
on aligning the local axes with the global axes. For inclined piles, the automatic local coordinate system will be
rotated such that the axes remain parallel to the Global XZ and Global YZ planes. In the case of symmetry, the
axes will put on the applicable symmetry plane(s).

Creating a cross section line
When the feature is selected the Draw a centerline button in the side toolbar is automatically selected and
the Center line points window pops up (Figure 313 (on page 474)).
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Figure 313: Center line points window
The cross section line may consist of several line sections. The points defining the segments composing the
centerline can be defined either by directly clicking on the model or by defining the coordinates of the location in
the Center line points window. The process of center line definition can be quit by either clicking the OK button
in the Centerline points window or by right clicking and selecting the Finish option in the appearing menu. The
structural forces are then computed on-the-fly and visualised along the created line.
From tunnel designer: It is also possible to define the Center line points using the option From tunnel designer,
by clicking on the dropdown menu using Add. To be able to use this option, a thick lining must be present in the
tunnel. This can be done in Input using the Tunnel designer (for more detailed information, refer Create
polycurve (on page 99)). When the thick lining is added to a tunnel, PLAXIS 3D automatically generates a
data.otnl, which is stored in the folder of the current project. This file contains all the information about the
center line.
Click OK to view the Forces.
Note:
Note that when more than one thick lining is defined, the data.otnl is overwritten in the project folder. To save
both files, the user must manually rename the exsiting data.otnl before saving the new thick lining.
Import: Center line points can also be imported using the Import option, by clicking on the dropdown menu
using Add. The *.otnl, *.tnl or *.json files are located in the project folders.
Click OK to view the Forces.
At the drawn cross section line, the selected structural force is calculated on the basis of the integral of the
stresses perpendicular to the cross section line. The extent of the area that is used to integrate the stresses is
limited by a radius. The default radius, for each point of the cross section, is defined by the elements that contain
the same material data set as the element in which the cross section point is drawn. However, this radius may be
redefined by the user.

∙ Automatic center lines wizard
As an alternative to the manual creation of a centerline, the centerline can be automatically generated using
the Generate centerlines wizard.
The automatic center lines wizard can be used in two situations as described below.
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Figure 314: Automatic center lines wizard Criteria tabsheet
Criteria

Center lines

PLAXIS

In this blue tabsheet, it is possible to select the materials whose centerline is required
for calculation of structural forces. In addition, individual volume clusters can be
specified in the righthand panel. Click Detect button to generate the center lines.
In this orange tabsheet, the results for the centerlines are shown. Here it is possible to
select the specific centerline of interest. Each centerline can easily be toggled to show or
hide it.
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Figure 315: Automatic center lines wizard Center lines tabsheet
The structural forces are computed by integrating the stresses along the cross-sections which are perpendicular
to the centerlines which have been generated in the previous step.

Changing the extent of the stress range
The range of the stress to be taken into account can be modified by specifying the radius of the extension from
the centerline. The initial radius is determined by the distance, across the cross section line (centerline), to the
nearest cluster which has a different material assigned.
When the Edit radii button is clicked in the side toolbar, the extent of the stress range is indicated in the
plot by a transparent green colour (Figure 317 (on page 477)).
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Figure 316: Figure displaying the structural force in a volume and the default radii
It is possible to modify the stress range by clicking on the highlighted area and dragging this area by the mouse
(Figure 317 (on page 477)).

Figure 317: Figure displaying the structural force in a volume and the modified radii
Note that the dragging location affects the way how the radii are modified. If the area is dragged near the start or
near the end of the centerline, only the radius for that location (start radius or end radius) will be modified. This
option may be used for tapered structures. However if the dragging location is approximately in the middle of
both ends of the centerline, both radii will be modified.
Alternatively, if the segment is double-clicked, a dialog will be opened in which the radii can be specified
precisely (Figure 318 (on page 478)). The defined cross section lines (center lines) can be removed from the
plot by right clicking on the plot and by selecting the Clear all option appearing when the Lines option is pointed
in the appearing menu.
Note:
The Create animation feature can be used to view the evolution of the structural forces in volumes in calculation
phases.
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Figure 318: Edit radii window
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Curves

The development of quantities over multiple calculation steps at a specified location in the model can be viewed
using the Curve manager facility. This facility allows for the generation of load-displacement curves, forcedisplacement curves, stress-paths, strain paths, stress-strain curves and time-related curves.

10.1 Selecting points for curves
The location in the model where the variation of results through calculation steps is to be analysed is specified
by selecting nodes or stress points in the model. The selection of points should be done preferably before but
may also be done after calculating the project.
In order to specify points to be considered in curves, the Select points for curves option should be selected.
Selecting this option will open the Output program displaying the Connectivity plot and the Select points
window.
Nodes and stress points can be selected in the Output program either by clicking the Select points for curves
button in the side toolbar or by selecting the corresponding option in the Tools menu. More information on
selecting procedure is given in Mesh point selection (on page 479).
It is important to consider the differences in selecting the points before or after starting the calculation process.
A more detailed description is given in Pre-calculation points (on page 480) and Post-calculation points (on
page 481).

10.1.1 Mesh point selection
Nodes and stress points can directly be selected by clicking them in the 3D model. Make sure that the Nodes
numbers and/or Stress point numbers option has been selected in the Mesh menu.
The amount of visible nodes and stress points can be decreased using the Partial geometry option in the
Geometry menu or by clicking the Hide soil button in the side toolbar. In addition, the tabsheets corresponding to
the predefined work planes can be used to select nodes or stress points at the work plane levels.
In the Select points window (Figure 319 (on page 480)), the coordinates of the location of interest can be
specified. The program lists the number of the nearest node and stress points at the lower part of the window
when the Search closest button is clicked. The nodes and stress points can be selected by defining their ID as
well. The displayed nodes or stress points are selected as the corresponding button at the right of the cell is
checked. The selections are listed in the upper part of the window.
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Figure 319: Select points window
Selected nodes can be deselected by selecting the point in the list and pressing Delete or by clicking the point in
the model.
Note:
When the Select points for curves option is selected but the Select points window is closed, it can be displayed by
selecting the Mesh point selection option in the Tools menu.
If the finite element mesh is regenerated (after being refined or modified), the position of nodes and stress
points will change. As a result, previously selected nodes and stress points may appear in completely different
positions. Therefore nodes and stress points should be reselected after regeneration of the mesh.

10.1.2 Pre-calculation points
After the calculation phases have been defined and before the calculation process is started, some points may be
selected by the user for the generation of load-displacement curves or stress paths. During the calculation,
information for these selected points for all the calculation steps is stored in a separate file. The precalculation
points provide more detailed curves.
Note:
Pre-calculation points provide detailed information related to stress and strain at those points. However,
information about structural forces and state parameters is not provided.
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10.1.3 Post-calculation points
When the calculations are started without the selection of nodes and stress points for curves, the user will be
prompted to select such points. The user can then decide to select points or, alternatively, to start the
calculations without pre-selected points. In this case, it is still possible to generate load-displacement curves or
stress-strain curves after the calculation, but such curves may be less detailed.
When a node or stress point is selected after calculating the project, only the information for the saved
calculation steps is available. For more detailed curves the value of the Max number of steps stored should be
increased.
Note:
In generating curves, the user can use pre-calculation selected points and post-calculation selected points.
However, with structural forces, this can be done only using post-calculation selected structural nodes.
The information available for selected points (nodes or stress point) depends on the view in which they have
been selected in the Output program.
The points selected in the Model view, can be used to generate curves related to displacements, stresses,
strains and state parameters in soil elements. The Model view is the default view in the Output program.
The points selected in the Structure view, can be used to generate curves related to resulting structural
forces. The points should be selected after selecting the structure first (Select structures (on page 428)). The
Structure view is displayed when structures are selected and double clicked.
Note:
The type of the active view is indicated by the corresponding icon under the plot.

10.2 Generating curves
To generate curves, the Curves manager option should be selected from the Tools menu or the corresponding
button in the toolbar should be clicked. As a result, the Curves manager window appears with three tabsheets
named Charts, Curve points and Select points.
The Charts tabsheet contains the saved charts that were previously generated for the current project. The Curve
points tabsheet gives an overview of the nodes and stress points that were selected for the generation of curves,
with an indication of their coordinates. The list includes the points selected before the calculation (pre-calc) as
well as the points selected after the calculation (post-calc) (Figure 320 (on page 482)). For points that are part
of a structure further information is given in the list about the type of structure and the corresponding structure
element number. The Select points window is described in Mesh point selection (on page 479).
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Figure 320: Curve manager window
As a next step to generate curves, the New button should be pressed while the Charts tabsheet is active. As a
result, the Curve generation window appears, as presented in Figure 321 (on page 483).
Two similar groups with various items are shown, one for the x-axis and one for the y-axis of the curve. The xaxis corresponds to the horizontal axis and the y-axis corresponds to the vertical axis. For each axis, a
combination of selections should be made to define which quantity is plotted on that axis. First, for each axis a
selection should be made whether the data to be shown is related to the general project (Project) or a particular
selected node or stress point. The tree in the Curve generation window will then show all quantities which are
available depending for this type of data. The tree can be expanded by clicking the + sign in front of a group. The
Invert sign option may be selected to multiply all values of the x-quantity or the y-quantity by -1. When both
quantities have been defined and the OK button is pressed, the curve is generated and presented in a chart
window.
The combination of the step-dependent values of the x-quantity and the y-quantity forms the points of the curve
to be plotted. The number of curve points corresponds to the available calculation step numbers plus one. The
first curve point (corresponding to step 0) is numbered as 1.
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Figure 321: Curve generation window
Note:
• When curves are generated from points selected after the calculation, only information of saved steps can be
considered. The number of the saved steps for each calculation phase is defined by the Maximum number of
steps stored option in the Numerical control parameters subtree in the Phases window (Numerical control
parameters (on page 361)).
• All the calculation results are available for the pre-selected points.

10.2.1 Load-displacement curves
Load-displacement curves can be used to visualise the relationship between the applied loading and the
resulting displacement of a certain point in the geometry. In general, the x-axis relates to the displacement of a
particular node (Deformations), and the y-axis contains data relating to load level. The latter is related with the
value of ΣMstage in the following way: Applied load = Total load applied in previous phase + ΣMstage · (Total
load applied in current phase - Total load applied in previous phase). Also other types of curves can be
generated.
The selection of Displacement must be completed with the selection of a node in the drop-down menu and the
selection of a displacement component in the Deformations subtree. The type of displacement can be either the
length of the displacement vector (|u|) or one of the individual displacement components (ux, uy). The
displacements are expressed in the unit of length, as specified in the General Settings window of the Input
program.
To define a multiplier on the y-axis, first the Project option should be selected as the activation of a load system
is not related to a particular point in the geometry. The selection must be completed with the selection of the
desired load system, represented by the corresponding multiplier in the Multiplier subtree. Note that the 'load' is
not expressed in units of stress or force but in a multiplier value without unit. To obtain the actual load, the
presented value should be multiplied by the input load as specified by means of staged construction.
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Another quantity that can be presented in a curve is the Pore pressure. This quantity is available for selected
nodes as well as stress points. In the Pore pressures subtree of the Stresses tree pactive, psteady or pexcess can be
selected. Pore pressures are expressed in the unit of stress.
When non-zero prescribed displacements are activated in a calculation, the reaction forces against the
prescribed displacements in the x- and y-direction are calculated and stored as output parameters. These force
components can also be used in the load-displacement curves by selecting the option Project and then selecting
one of the forces in the Forces subtree.

10.2.2 Force-displacement curves
Force-displacement curves can be used to visualise the relationship between the development of a structural
force quantity and a displacement component of a certain point in the geometry. A structural force quantity can
only be selected for nodes being selected after the calculation. In general, the x-axis relates to the displacement
of a particular node (Displacement), and the y-axis relates to the corresponding structural force of a node of a
structural element.
To define a displacement on the x-axis, first the desired node should be selected. The selection must be
completed with the selection of the type of displacement. This displacement can be either the length of the
displacement vector (|u|) or one of the individual displacement components (ux, uy). The displacements are
expressed in the unit of length, as specified in the of the Input program.
To define a structural force on the y-axis, first the desired node of the structural element should be selected. The
selection of Structural force must be completed with the selection of type of force. Depending on the type of
structural element, a selection can be made among axial forces N, shear forces Q or bending moments M. In case
of interfaces, a selection can be made among the interface stresses (Structures and interfaces (on page 461)).

10.2.3 Displacement-time or force-time curves
Time-dependent curves can be useful to interpret the results of calculations in which the time-dependent
behaviour of the soil plays an important role (e.g. consolidation and creep). In this case, the Time option is
generally selected for the x-axis, and the y-axis contains data for a displacement component, a stress component,
a structural force quantity, or the temperature of a particular node or stress point. The selection of Time requires
the Project option to be selected. Time is expressed in the unit of time, as specified in the Project properties
window of the Input program.
Instead of selecting time for the horizontal axis, it is also possible to select the calculation step number (Step).
This may also give useful curves for time independent calculations. When interpreting such a curve it should be
noted that during the calculation the step size might change as a result of the automatic load stepping
procedures.

10.2.4 Stress and strain diagrams
Stress and strain diagrams can be used to visualise the development of stresses (stress paths) or strains (strain
paths) or the stress-strain behaviour of the soil in a particular stress point. These types of curves are useful to
analyse the local behaviour of the soil. Stress-strain diagrams represent the idealised behaviour of the soil
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according to the selected soil model. Since soil behaviour is stress-dependent and soil models do not take all
aspects of stress-dependency into account, stress paths are useful to validate previously selected model
parameters.
First a stress point should be selected before the desired quantity can be selected in the Stress or Strain tree. The
selection must be completed with the selection of the type of stress or strain. As a stress quantity all scalar
quantities available in the Stresses menu can be selected (Stresses (on page 450)). However, the State
parameters option is only available for stress points selected after the calculation Post-calculation points (on
page 481)). As a strain quantity all scalar strain quantities available in the Deformations menu can be selected
(Deformations (on page 445)).
See the Scientific Manual for a definition of the stress and strain components. The phrase 'in absolute sense' in
the description of the principal components is added because, in general, the normal stress and strain
components are negative (compression is negative). Stress components are expressed in the units of stress;
strains are dimensionless. A definition of the stress and strain components is given in the Material Models
Manual.

10.2.5 Curves in Dynamic calculations
The Curve generation window differs when dynamic calculations are executed in the project. The normal
tabsheet is similar to the tabsheet when no dynamic calculations are performed. However, the Dynamic time
option is available in the tree when Project is selected in the axis parameter drop down menu. When a node is
selected, the Velocities, Accelerations and Acceleration ('g') options are available under Deformation (Figure 322
(on page 486)).
Note:
In generating curves, the user can use pre-calculation selected points and post-calculation selected points.
However, with structural forces, this can be done only using post-calculation selected structural nodes. For more
information, see Post-calculation points (on page 481).
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Figure 322: Options available in Normal tabsheet for dynamic calculations

PSA spectrum
During an earthquake, the soil vibration causes forced vibrations on the overlying structure. The structure can
be idealised as a single degree of freedom (SDOF) system, i.e. a simple model characterized by a mass m,
concentrated in a point, a stiffness k and a damping ratio ξ. The dissipation, due to structural elements, is
simulated through viscous actions depending on the velocity (See Figure below).

Figure 323: Single Degree Of Freedom System
The dynamic equation of motion is given by:
mü + cu̇ + k u = − mü g

Eq. [120]

where u , u̇ and ü represent the displacement, velocity and acceleration of the mass with respect to the base,
respectively, c is a damping coefficient and ü g is the input motion. The relationship between c and ξ is expressed
by the following equation:
ξ=
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The solution u(t) of a SDOF system subjected to an earthquake is given by Duhamel's integral and its maximum
value is used to plot the relative displacement response spectrum. In general, the response spectrum is the locus
of the maximum response of SDOF systems characterised by different k and subjected to the same earthquake,
for a given damping ratio. The maximum response can be calculated in terms of displacements, velocities or
accelerations. The relative displacement response spectrum SD is given by:
S D = | u | max

Eq. [122]

The relative pseudospectral velocity PSV and the absolute pseudospectral acceleration PSA are related to the
relative displacement response spectrum according to the following equations:
PSV = ω0 ⋅ S D

Eq. [123]

PSA = ω02 ⋅ S D

Eq. [124]

where ω0 represents the natural angular frequency of the structure, ω0 = k / m
. PSV and PSA are
indicated as pseudo quantities because, in a damped system, they do not coincide exactly with the maximum
relative velocity ( | u̇ | max ) and the maximum absolute acceleration ( | ü + ü g | max ).
The maximum response is plotted on the y-axis of the response spectrum, while the natural period T is
represented on the x-axis, which contains the information about the structure stiffness k and mass m, as shown
in the following equation:
T =

2π
ω0

= 2π

m
k

Eq. [125]

By varying k, it is possible to obtain the response of all the possible SDOF systems for that specific seismic signal
for a given damping ratio ξ. For typical structures in reinforced concrete where the damping is mainly due to non
structural elements such as partition walls, ξ is generally set equal to 5%. Higher values may be used in other
specific cases, for instance when the structure is isolated at the base with dampers, which results in lower yvalues in the response spectrum.
Considering the PSA spectrum, the value that can be read on the Y-axis corresponding to the natural period of
vibration of the overlying structure allows to calculate the maximum shear stress at the base of the structure,
equal to the maximum inertial force of a structure with mass m subjected to an acceleration given by the
selected PSA value (Figure 324 (on page 488)):
F max = m ⋅ PSA =

PSA
w
g

Eq. [126]

where g is the gravity acceleration and w is the weight of the structure.
To generate the response spectrum, select the PSA tab from the Curve generation window when selecting New in
the Curve manager (Figure 324 (on page 488)). In the PSA tab, a selection has to be made among horizontal
acceleration (ax), vertical acceleration (ay) or absolute value of the acceleration (vectorial length). Subsequently,
the structural damping ratio, ξ, has to be specified, together with the maximum natural period of the structure, T.
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Figure 324: Generate PSA
An example of a pseudo-acceleration response spectrum determined at the foundation level at the end of a site
response analysis is shown in the figure below.

Figure 325: PSA
Based on the PSA diagram, it is possible to determine the predominant period, i.e. the period related to the peak
PSA value. In the PSA diagram in Figure 325 (on page 488), this is equal to 0.4 s. If the natural period of the
structure corresponds to the predominant period, the structure, subjected to the selected earthquake and in that
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specific soil condition, is in resonance, i.e. the system oscillates with very high amplitudes which can cause great
damages in the building.
Once the PSA spectrum has been generated, it is possible to display the relative displacement response spectrum
by selecting Settings under the Format menu. The Settings window opens and it is possible to select the Chart
tabsheet and the Relative displacement response spectrum option (Figure 326 (on page 489)).

Figure 326: Generate Relative displacement response spectrum
The corresponding chart (Figure 325 (on page 488)) shows the maximum relative displacement that can occur
in the structure, characterised by a natural period of vibration T and subjected to an earthquake, for a given
damping ratio ξ.
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Figure 327: Relative displacement response spectrum
The product of the maximum relative displacement and the stiffness k represents the maximum equivalent static
force, i.e. the static force that causes the same maximum deformation induced by the earthquake:
F max = k ⋅ S D

Eq. [127]

By comparing the PSA spectrum with the Relative displacement response spectrum, it can be seen that at low
periods, that characterize rigid structures, the displacement is close to zero. Ideally, in an undamped perfectly
rigid structure (T = 0) subjected at the base to an acceleration ü g ( t ) , the mass moves together with the soil, i.e.
there is no relative displacement of the mass ( | u | max = 0 ) and the pseudo spectral acceleration coincides
with the maximum absolute acceleration at that level and so, with the maximum acceleration of the soil
( | ü + ü g | max = | ü g | max ).
By increasing the period, both the PSA and the relative displacement increase. For very high periods, the
maximum response in terms of acceleration tends to decrease and reaches values even lower than the maximum
acceleration at the selected level. The relative displacement tends to the absolute displacement of the soil.
Ideally, in an undamped highly flexible structure (T = ∞) subjected at the base to an earthquake, the relative
displacement of the mass coincides with the absolute displacement of the soil.
Reinforced concrete structures are generally characterised by periods of vibration corresponding to an
amplification of the acceleration of the soil.

Amplification
The Amplification tabsheet enables obtaining the plot which shows the ratio of the acceleration response of any
point (Top) to the acceleration response of another point (Bottom) which is preferably the point where input
load is applied (“Figure 328 (on page 491)”). This gives the magnification of the response at one point with
respect to given excitation.
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Figure 328: Amplification spectrum generation

Fourier
A quantity plotted in the time domain can be transformed into the frequency domain through the Fast-Fourier
Transform (FFT), which contains both the amplitude and the phase information of the signal. From the
computed FFT, the user can plot the Power Spectrum and the Fourier Amplitude Spectrum(FAS) for each
acceleration component.
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Figure 329: Fourier curve generation

Arias intensity
The Arias intensity, Ia (length/dyn. time) is used to determine the strength of a ground motion (intensity of
shaking). It is calculated based on the time history acceleration, a(t), in a node:
Ia =

π Td
∫
2g 0

a (t )

2

dt

Eq. [128]

where g is the gravity acceleration and Td is the duration of the motion (i.e. maximum dynamic time in the time
history acceleration).
The Arias Intensity has the dimension of velocity (Figure 330 (on page 493)). In the Chart tabsheet, the user can
choose to represent Ia in percentage of the maximum Arias intensity.
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Figure 330: Arias curve generation
In the top toolbar, two options are available for specifying conditions for the Arias Intensity curves. Clicking the
Arias duration button, the user can specify the minimum and maximum value of Ia in order to perform the
calculation of the effective duration (based on Ia in length/dyn. time) or the significant duration (based on Ia as a
percent) (Figure 332 (on page 494)). Clicking the Extreme values button, the user can view the Extreme values
for the curve (Figure 331 (on page 493)).

Figure 331: Extreme values for Arias intensity curves
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Figure 332: Significant duration and Effective duration for Arias intensity curves

Transformation of curves from time to frequency domain
Once a time curve has been generated, it is possible to transform this curve into a frequency spectrum using the
Fast Fourier Transform (FFT). This can be done in the Chart tabsheet of the Settings window (Figure 333 (on
page 495)).
For curves created in the Normal and Amplifications tabsheets of the Curve generation window, you can
select the option Use frequency representation (spectrum) and one of the three types of spectrum (Standard
frequency (Hz), Angular frequency ({rad/s)} or Wave period(s)).
The three optional quantities on the horizontal axis are related as follows:
π

ω = 2πf = 2 T

Eq. [129]

where ω is the Angular Frequency, f is the Standard Frequency, T is the Wave Period.
Upon clicking on the OK button the existing time curve will be transformed into a spectrum. The original curve
can be reconstructed by de-selecting the frequency representation in the Chart tabsheet.
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Figure 333: Fast Fourier Transform
Note:
The Settings window is displayed by right clicking the chart and selecting the corresponding option in the
appearing menu or by selecting the option in the Format menu.

10.3 Formatting curves
Once a curve has been generated, a new chart window is opened in which the generated curve is presented. The
quantities used to generate the curve are plotted along the x- and y-axis. By default, a legend is presented at the
right hand side of the chart. For all curves in a chart, the legend contains the Curve title, which is automatically
generated with the curve. An example of curves in Output program is given Figure 334 (on page 496).
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Figure 334: Curves in Output program

10.3.1 Menus for curves
The menus in menu bar when curves are displayed vary slightly from the ones in the Output program. A
description of the menus and the options available in them is given as follows.

File menu
The File menu is basically the same with the one available in the Output program. For a more detailed
description see File menu (on page 412).

Edit menu
Note that Edit menu is only available when the curves are displayed. The options available can be used to include
curves in the current chart. These options are:
Copy

To export the chart to other programs using the Windows clipboard function. This
feature is described in detail in Exporting output data (on page 420).

Add curve from
current project

To add a new curve to the active chart from the current project.

Add curve from
another project

To add a new curve to the active chart from another project.
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Add curve from
clipboard

To add a new curve to the active chart from clipboard.

Note:
• The added curves are redefined using the data from either the current project, another project or clipboard.
It is not possible to mount a generated curve to the current chart.
• It is possible to add a curve to the active chart using the Add curve option in the corresponding option in the
right mouse click pop-up menu.

View menu
The display of the results in the window is arranged using the options available in the View menu. These options
are:
Reset view

To reset a zoomed view.

Table

To display the data series in a table. More information on tables is given in the Editing
curve data in table (on page 497).

Legend

To toggle the display of the legend in the chart.

Legend in chart

To locate the legend in the chart.

Value indication

To toggle the display of information about the points in the curves when the mouse
pointer is located on them.

Note:
• For a more detailed view of particular regions in curves, press the left mouse button at a corner of the zoom
area; hold the mouse button down and move the mouse to the opposite corner of the zoom area; then release
the button. The program will zoom into the selected area. The zoom option may be used repetitively.
•
The zoomed view can be reset by clicking the corresponding button in the toolbar as well.

Format menu
The Format menu contains the Settings option, selecting which displays the corresponding window where the
layout of the chart and curves can be modified.

Window and Help menus
These menus contain the same options as defined in Window menu (on page 418) and Help menu (on page 419).
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10.3.2 Editing curve data in table
In contrast to the general Output program, the Curves part allows for editing of the table by the user using the
options in the menu appearing as the table is right clicked.
Delete rows

To delete selected rows in the table.

Update chart

To update chart according to the modifications made in the table.

Align

To align the text in the selected part of the table.

Decimal

To display data in decimal representation.

Scientific

To display data in scientific representation.

Decimal digits

To define the number of decimal digits displayed.

View factor

To define a factor to the values in the table.

Copy

To copy the selected values in the table.

Find value

To find a value in the table.

Filter

To filter the results in the table.

10.3.3 Value indication
If the Value indication option in the View menu is active and the mouse is moved over a data point in a curve, the
hint box shows the precise value of the x- and y-quantities at that point. In addition, it shows the curve point
number and the step and phase numbers corresponding with that curve point.

10.4 Formatting options
The layout and presentation of charts can be modified by clicking the Settings button available in the toolbar
or by selecting the corresponding option in the Format menu. Alternatively, the Settings option can be selected
from the Format menu of the right mouse button menu. As a result, the Settings window will appear. Distinction
is made between the chart settings displayed on the first tabsheet and the curve settings displayed on a separate
tabsheet for each curve. The options available in the Chart tabsheet can be used to customize the frame and axes
of the chart (Chart settings (on page 499)). The options available in the tabsheets of the curves can be used to
customize the plot (Curve settings (on page 500)).
If the correct settings are defined, the OK button may be pressed to activate the settings and to close the window.
Alternatively, the Apply button may be pressed to activate the settings, keeping the Settings window active. The
changes to the settings can be ignored by pressing the Cancel button.
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10.4.1 Chart settings
The Settings window contains a tabsheet with options to customise the layout and presentations of the chart
(see Figure 335 (on page 499)).

Figure 335: Chart settings tabsheet

Titles

By default, a title is given to the x-axis and the y-axis, based on the quantity that is
selected for the curve generation. However, this title may be changed in the Title edit
boxes of the corresponding axis group. In addition, a title may be given to the full chart,
which can be entered in the Chart name edit box. This title should not be confused with
the Curve title as described in above.

Scaling of x- and yaxis

By default, the range of values indicated on the x- and y-axis is scaled automatically, but
the user can select the Manual option and enter the desired range in the Minimum and
Maximum edit boxes. As a result, data outside this range will not appear in the plot. In
addition, it is possible to plot the x- and/or y-axis on a logarithmic scale using the
Logarithmic check box. The use of a logarithmic scale is only valid if the full range of
values along an axis is strictly positive.
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Grid

Grid lines can be added to the plot by selecting items Horizontal grid or Vertical grid. The
grid lines may be customised by means of the Style and Colour options.

Orthonormal axes

The option Orthonormal axes can be used to ensure that the scale used for the x-axis and
the y-axis is the same. This option is particularly useful when values of similar quantities
are plotted on the x-axis and y-axis, for example when making diagrams of different
displacement components.

Exchange axes

The option Exchange axes can be used to interchange the x-axis and the y-axis and their
corresponding quantities. As a result of this setting, the x-axis will become the vertical
axis and the y-axis will become the horizontal axis.

Flip horizontal or
vertical

Selecting the option Flip horizontal or Flip vertical will respectively reverse the
horizontal or the vertical axis.

10.4.2 Curve settings

Figure 336: Curve settings tabsheet
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The Settings window contains for each of the curves in the current chart a tabsheet with the same options
(Figure 336 (on page 500)).
Title

A default title is given to any curve during its generation. This title may be changed in
the Curve title edit box. When a legend is presented for the active chart in the main
window, the Curve title appears in the legend.

Show

When multiple curves are present within one chart, it may be useful to hide temporarily
one or more curves to focus attention on the others. The Show curve option may be
deselected for this purpose. It is possible to select the check boxes for Min values and
Max values to display the minimum and maximum values in the chart with an orange
circle.

Phases

The Phases button may be used to select for which calculation phases the curve has to be
generated. This option is useful when not all calculation phases should be included in
the curve.

Fitting

To draw a smooth curve, the user can select the Fitting item. When doing so, the type of
fitting can be selected from the Type combo box. The Spline fitting generally gives the
most satisfactory results, but, as an alternative, a curve can be fitted to a polynomial
using the least squares method.

Line and marker
presentation

Various options are available to customise the appearance of the curve lines and
markers. It is possible to Mark start of phase by clicking on the checkbox, which shows a
distinction for the start of a new phase in the chart.

Arrow buttons

The arrow buttons can be used to change the order of the curves in the legend.

Regenerate

The Regenerate button may be used to regenerate a previously generated curve to
comply with new data (Regeneration of curves (on page 501)).

Add curve

The Add curve button may be used to add new curves to the current chart (Multiple
curves in one chart (on page 502)).

Delete

When multiple curves are present within one chart, the Delete button may be used to
erase a curve.

10.5 Regeneration of curves
If, for any reason, a calculation process is repeated or extended with new calculation phases, it is generally
desirable to update existing curves to comply with the new data. This can be done by means of the Regenerate
facility. This facility is available in the Settings tabsheet (Figure 335 (on page 499)), which can be opened by
selecting the Settings option from the Format menu. When clicking on the Regenerate button, the Curve
generation window appears, showing the existing setting for x- and y-axis. Pressing the OK button is sufficient
to regenerate the curve to include the new data. Another OK closes the Settings window and displays the newly
generated curve.
When multiple curves are used in one chart, the Regenerate facility should be used for each curve individually.
The Regenerate facility may also be used to change the quantity that is plotted on the x- or y-axis.
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10.6 Multiple curves in one chart
It is often useful to compare similar curves for different points in a geometry, or even in different geometries or
projects. Therefore PLAXIS 3D allows for the generation of more than one curve in the same chart. Once a single
curve has been generated, the Add curve options in the Edit menu can be used to generate a new curve in the
current chart. As an alternative, the Add curve option from the Settings window or from the right mouse button
menu can be used. Distinction is made between a new curve from the current project, a new curve from another
project or curves available on the clipboard.
The Add curve procedure is similar to the generation of a new curve (Generating curves (on page 481)).
However, when it comes to the actual generation of the curve, the program imposes some restrictions on the
selection of data to be presented on the x- and the y-axis. This is to ensure that the new data are consistent with
the data of the existing curve.
When the Add curve option is used, the current chart is modified. In order to preserve the current chart, a copy of
it can be created by selecting it first in the list and then by clicking the Copy button in the Curves manager
window.
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Engineering Applications
11.1 Modelling vacuum consolidation
Vacuum consolidation is a technique to apply preloading on a construction site by creating an 'under-pressure'
in the ground and thus using the external atmospheric pressure as preloading. In this way, the stability of the
sub-soil is increased and settlements during and after the construction are reduced. This technique is usually
applied on near-saturated soils with a high water table. This section explains the details of modelling vacuum
consolidation in PLAXIS 3D.
There are various methods of vacuum consolidation in the real world, but they are all modelled in a similar way
in PLAXIS 3D. Most methods in reality are using vertical drains, which are somehow connected at the top to an
air pump that reduces the air pressure in the drains until a near-vacuum exists. In practice, a complete vacuum
(100 kN/m2 pressure) is not achievable, but an effective under-pressure of 60 - 90 kN/m2 is feasible.
Since PLAXIS 3D does not take air pressure into account (atmospheric pressure is assumed to be the zero
reference pressure level), a reduction of the groundwater head is used instead to simulate vacuum
consolidation. This means that the way vacuum consolidation is modelled leads to negative pore stresses
(suction), which are not there in reality.

11.1.1 Vacuum consolidation in a one-dimensional soil column
In the simplified case of a one-dimensional soil column, vacuum consolidation can be modelled by performing a
groundwater flow calculation or a fully coupled flow-deformation analysis with hydraulic conditions at the
model boundaries such that in the vacuum area the groundwater head is prescribed at a level that is 10 m (or
less) lower than the vertical coordinate of the global phreatic level. A reduction of the groundwater head of 10 m
is equivalent to an under-pressure of 100 kN/m2 (i.e. complete vacuum).

11.1.2 Vacuum consolidation in a 2D or 3D model
In a 2D or 3D numerical model of a realistic project, vacuum consolidation can be modelled by performing a
groundwater flow calculation or a fully coupled flow-deformation analysis with vacuum drains (Line drain (on
page 177) and Surface drain (on page 178) ) in which the head specified in those drains is 10 m (or less) lower
than the vertical coordinate of the global phreatic level. A reduction of the groundwater head of 10 m is
equivalent to an under-pressure of 100 kN/m2 (i.e. complete vacuum). The distance between the vacuum drains
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in the model is arbitrary, but should be selected such that the difference in groundwater head in the vacuum
area is limited. In general, a distance between the drains less than a quarter of the drain length seems
appropriate.

11.1.3 Other requirements
A reduction of the groundwater head implies that the soil in the vacuum area becomes unsaturated, whilst this
soil volume is supposed to be fully saturated. The user must arrange additionally that saturated conditions apply
to this volume. This requires the following settings to be made in the corresponding material data sets:
• The unsaturated unit weight, γunsat (General tabsheet of the Material data set), must be set equal to the
saturated unit weight, γsat.
• The hydraulic model must be set to Saturated after selecting User-defined as hydraulic data set (Model group
in Groundwater tabsheet).
If these settings are not made, the unit weight of the soil will change from saturated to unsaturated as soon as
the phreatic level drops as a result of the reduction of the groundwater head in the vacuum drains. Moreover,
the soil permeability will reduce according to the reduced relative permeability in the unsaturated zone,
depending on the selected hydraulic data set (by default Fine material). Both effects are not realistic and can be
overcome by making the aforementioned changes in the corresponding material data sets.

11.1.4 Calculation options
Vacuum consolidation (using reduced groundwater head boundary conditions or reduced heads in vacuum
drains) can be applied in the following calculation types:
• Plastic (select Steady-state groundwater flow as Pore pressure calculation type)
• Consolidation (select Steady-state groundwater flow as Pore pressure calculation type)
• Fully-coupled flow-deformation analysis
This means that all input requirements for a groundwater flow calculation have to be met, i.e:
• All material data sets must have non-zero permeabilities
• Hydraulic boundary conditions (groundwater head and closed flow boundaries, if applicable) must have been
specified
Moreover, it is required to de-select the Ignore suction option in the Deformation control parameters section
of the Phases window.
Note that only vacuum drains allow a groundwater head to be specified below the actual drain level, which leads
to tensile pore stresses (suction). Normal drains do not allow for suction. Also note that, if vacuum drains are
used in a Consolidation calculation whilst the pore pressure calculation type is set to Phreatic, the drains will
work as normal drains rather than vacuum drains. This means that they only affect the consolidation of excess
pore pressures, whilst the steady-state pore pressure is fully determined by the global water level and local
cluster settings.
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11.1.5 Switching-off vacuum
If the vacuum is to be 'switched-off' in subsequent calculations while the drains are still supposed to be active for
consolidation purposes, the corresponding head in the drains needs to be changed from the reduced head level
to the original global water level. This leads to the situation that the new pressure head in the drain is higher
than the groundwater head in the area around the drain. As a result, one might expect that water will be flowing
from the drain into the ground, which is an artefact of the numerical modelling of vacuum consolidation.

11.2 Modelling ground anchors
Ground anchors are used to restrain soil retaining walls to prevent excessive forward movement or to restrain
excavation bottom plates to prevent uplift under high pore pressure conditions or to restrain other foundation
structures that are subjected to tensile forces. This section explains how ground anchors can be modelled in
PLAXIS 3D.
There are various ways to create ground anchors in the real world, but they can be all modelled in a similar way
in PLAXIS 3D. Most methods in reality are using a steel tube or anchor bar or a bunch of steel wires that are
drilled into the ground through an opening in the structure to be restrained. At the end part of the anchor in the
ground, grout (cement) is injected at high pressure, forming a grout body around the anchor bar with a diameter
that is significantly larger than the diameter of the anchor bar. This grout body has a strong interaction with the
surrounding soil, whereas the non-grouted part in between the grouted part and the wall (the 'free length') has
hardly any interaction with the soil. When the anchor is installed, it is usually pre-stressed up to 60-80% of its
designed working load. After that, the anchor force will further evolve as a result of the construction process.

11.2.1 Geometric modelling of ground anchors
The stress state around the grouted part of a ground anchor is highly three-dimensional. This makes it difficult
to model a ground anchor realistically in a 2D model. Nevertheless, an approximation is possible that enables a
realistic analysis of deformation and overall stability of soil retaining structures, both in 2D and 3D.
A ground anchor can be created by a combination of a node-to-node anchor and an , in which the represents the
grouted part of the anchor and the node-to-node anchor represents the anchor free length. The behaviour of the
is set to 'Grout body'. The connection type is internally set to 'Free'. This is required since otherwise the will also
be directly connected to the corresponding soil element, which will lead to an unrealistic loss of axial force in the
connection point. Setting the connection to 'Free' will ensure that the axial force in the node-to-node anchor is
more or less equal to the axial force at the top of the .

11.2.2 Properties of ground anchors
The stiffness of a ground anchor (i.e. the resistance against elongation) is formed by the axial stiffness of the
anchor bar, EA. This applies to the anchor free length as well as the grouted part of the anchor, since upon
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loading of the anchor, tensile cracks will occur in the grout body, and hence, the grout body itself will not
contribute to the axial stiffness.
The axial stiffness, EA, can be specified directly as input parameter in a material data set for anchors, as used for
the node-to-node anchor. In 2D, the anchor spacing in out-of-plane direction, ls required. Internally, will divide
the axial stiffness by the spacing in order to calculate the axial stiffness per unit of width in a plane strain model.
Optionally, a maximum anchor tensile force Fmax,tens force Fmax,comp should be set to 0). It is also possible to
specify the Material type as Elastoplastic with residual strength, which enables the modelling of anchor breakage
(Fresidual,tens = 0).
The properties of the , as used for the grouted part of the anchor, involve the stiffness properties as well as the
interaction properties with the surrounding soil. Rather than specifying EA directly as the axial stiffness, there is
a separate input of Young's modulus, E, and the anchor cross section geometry. Here, it should be considered
that the anchor geometry is dominated by the diameter of the grout body, Dg, whereas the axial stiffness is
dominated by EA of the anchor bar. Hence, when selecting Predefined as Pile type and Massive circular pile as
Predefined pile type (it is a ground anchor rather than a pile here), the Diameter should be set to the approximate
diameter of the grout body, Dg. It is important to select the diameter of the grout body (and not the diameter of
the anchor bar) to set the right size of the elastic zone around the embedded beam such that the specified anchor
bearing capacity can be obtained. Now, Young's modulus must be selected such that the product of E and A (= π
Dg2/4) is equal to EA of the anchor bar, as used in the material data set for the node-to-node anchor. Note that
this leads to a fictitious value of Young's modulus which is different than a realistic Young's modulus of steel. In
2D, the stiffness properties also involve the out-of-plane anchor spacing, ls, which is the same value as entered
for the node-to-node anchor.
The interaction properties involve only skin friction. Here, the distribution can be assumed uniform by setting
Tskin,start,max = Tskin,end,max equal to the total designed ground anchor bearing capacity (in the unit of force)
divided by the length of the . Ground anchors do not have a base resistance, so Fmax = 0. The interface stiffness
factors can be left to their default values.

11.2.3 Activation and pre-stressing of ground anchors
The activation of ground anchors in a calculation phase as part of the staged construction settings is done by
activating both the node-to-node anchor part and the part. Usually, when ground anchors are installed, they are
pre-stressed. The pre-stress force can be specified by selecting the node-to-node anchor part and checking the
Adjust prestress option in the Selection explorer and specifying the right pre-stress force Fprestress. Note that in all
models (2D and 3D) this is a force PER ANCHOR (not per unit of width out-of-plane).
In the calculation phase in which the ground anchor is pre-stressed, the resulting anchor force will be exactly
equal to the pre-stress force. In subsequent calculation phases, however, the anchor force is supposed to further
evolve as a result of the construction process. Therefore, the anchor should NOT be pre-stressed again in
subsequent calculation phases, unless this is also done in reality ('post tensioning' of ground anchors).

11.3 Transverse forces in embedded beams
In addition to displacement differences and shear forces in the axial direction, a pile can undergo transverse
forces, t⊥, due to lateral displacements. The lateral displacements can be induced by a transverse force applied at
the top of the pile or as a consequence of the transverse distributed load caused by the lateral displacement field
of the soil surrounding the pile. In the first case, the overall behaviour may not show realistic results. In the
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second case, although are not meant to be used as laterally loaded piles, they show reasonable results and the
overall behaviour is realistic. The second case, moreover, represents a lot of engineering cases and this section
explains the most common applications in PLAXIS 3D.

11.3.1 Abutment pile
An abutment is a structure at the ends of an arch (e.g. dams) or span (e.g. bridges) meant to transfer vertical or
horizontal loads to the ground or other foundation elements. The abutment is a crucial substructure in a lot of
geotechnical applications: dams, bridges, slope stability, embankments and retaining walls. When the abutment
structure is not sufficient to bear the external loads or guarantee compatible displacements, piles could be added
to improve the performance.
The abutment piles are subjected to axial as well as transverse forces through the displacement field of the soil.
TLateral forces can be induced by: moving loads (vehicles or trains on bridges and embankments), arching effect
(dams), landslides and ground flow (slope stability). The of PLAXIS 3D can realistically model the piles in these
engineering applications.
The user should refer to Embedded beams (on page 142) and Material set (on page 307). No further information
is required for the modelling techniques in abutment pile applications.

11.3.2 Quay wall with relieving platform
A quay wall is an earth retaining structure used to moor ships. It bears vertical loads caused by storage and
handling equipment and horizontal loads from the wind, soil pressure and ship impacts. Quay walls might differ
in type and magnitude of the terminal. The key requirement for ships is the retaining height; when handling the
freight, it is necessary to provide sufficient area and bearing capacity. For larger quay walls, using relieve
platforms frees the quay walls from the high soil pressure brought by the high retaining height and the vertical
loads induced by massive storage. The presence of the relieving platform, generally coupled with bearing piles,
reduces the horizontal loads on the quay wall and, consequently, the bending moments. The structure could
comprise an anchorage at the connection point of the quay wall and the relieving platform.
The bearing piles of the relieving platform take a part of the horizontal load that is typically taken by the
retaining wall. For this reason, these piles are subjected to transverse forces induced by the lateral displacement
field of the soil. The of PLAXIS 3D can realistically deal with this application. Furthermore, if the quay has a bulkstorage load, there are horizontal components difficult to model with other approaches (e.g. sub-grade reaction
models). PLAXIS 3D can easily deal with this complex loading conditions.
The user should refer to Embedded beams (on page 142) and Material set (on page 307). No further information
is required for the modelling techniques in quay wall with relieving platform applications.
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Program and data file structure
A.1 Program structure
The full PLAXIS 3D program consists of various sub-programs, modules and other files which are copied to
various directories during the installation procedure (See General Information). The most important files are
located in the PLAXIS 3D program directory. Some of these folders, files and their functions are listed below.
Folders
cef

Chrome embedded framework

Defaults

Default columns for phases explorer

manuals

The manuals of the software and the command reference

python

Python folder

pytools

Python scripts

tools

Tools for expert users

udsm

User defined soil models

Executables
CurveDataConverter.exe

Curve converter from pre-2017 to current version

PackProject.exe

Pack project

Plaxis3DInput.exe

Input program (pre-processor)

Plaxis3DOutput.exe

Output program (post-processor)

Plaxis3DOutput_2012.02.exe Output program 2012.02 version (post-processor)
Plaxis3DOutputViewer.exe

Output viewer

Postmesher.exe

Postmesher.exe

ReportGenerator.exe

Report generation module

Soiltest.exe

SoilTest module
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A.1 Project data files
The main file used to store information for a PLAXIS 3D project has a structured format and is named
<project>.P3D, where <project> is the project title. Besides this file, additional data is stored in multiple files in
the sub-directory <project>.P3DAT. The files in this directory may include:
data.###

The files having the extension ‘###’ are created by the calculation kernel1).

data.ant

Output annotations

data.c##

Contains data for curve generation 2).

data.centerlines

Centerlines data

data.gpv

Previews of the generated curves

data.gxl

Information about the generated curves

data.h00

Initial settings generated after the mesh generation for the 3D mesh

data.l##

Staged construction settings2)

data.m##

File containing information about the materials in the model

data.mesh.plxml

Mesh data

data.mesher3d.log

Additional information from the mesher

data.IMProOutput

Information about the mesh output

data.nsl

Information about the selected nodes and stress points (after Calculation)

data.opi

The information of project phases for output

data.p3d

All the commands executed successfully in the project

p3dlog File

File containing all the commands executed in the project

data.plxmat

Contains all material sets and parameters

PLXML Files

The PLXML file format is essentially a limited binary representation of XML,
tweaked for the needs of the Hierarchic Storages

S## Files

Files containing all the monitored values for the integration points

data.svs

Information about the saved views for Output
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data.w##

The files having the extension ‘ W##’ contain the current groundwater
conditions. The ‘##’ stands for the phase number in which the groundwater
condition is first created. A project always has a ‘W00’ file for the initial
conditions.

data.zin

Project model data. Supplement to the INP file

data.zms

Project model data. Supplement to the MSH file. The ‘ZMS’ file is generated only
once; directly after generating the mesh. It contains all data concerning the mesh.

debug.d##

Debug calculation logs generated by the kernel during the calculation2).

log.d##

General information about the calculation phase2)

1)Three digit deformation calculation step number (001, 002,....). Above 999 gives an additional digit in the file

extension.
2)Two digit calculation phase number (01, 02, .....). Above 99 gives an additional digit in the file extension.

To create a copy of a PLAXISproject under a different name or in a different directory, it is recommended to open
the project in the Input program and to save it under a different name using the Save as option in the File menu.
In this way the required file and data structure is properly created.
During the creation of a project, before the project is explicitly saved under a specific name, intermediately
generated information is stored in the TEMP directory as specified in the Windows® operating system using the
project name Plaxis3DTemp.
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The format required for the files to import CPT data
B.1 ASCII files
PLAXIS supports CPT data in CPT format CUR (2004) (on page 509). In case the data is not provided in CPT
format, PLAXIS enables importing them with the condition that they are saved in properly formatted ASCII files.
The file must contain a small header specifying the contained data. If it is not available, the field data cannot be
recognised and the importing of the file will be aborted. The header must be the first content in the file in order
to prevent that arbitrary data of the file is misinterpreted. The header must have the following format:
X[m]

# optional comment

Y

# optional comment

Z

# optional comment

d[m] q f x x u

# optional comment

X, Y, Z denote a number specifying the location and elevation of the starting point of the CPT. Missing coordinates
are set automatically to zero. Note that PLAXIS does not use this information for modelling purposes. Following
the coordinate specification, specifiers for the column content must be specified. The following specifiers are
supported:
d

penetration depth

q

tip resistance

f

sleeve friction

u

pore pressure

x

columns of data to be skipped

Except for the 'x' character, column specifiers can occur only once. If a column specifier occurs more than once,
the double specifier and all successive specifiers are skipped. Units can be introduces inside square brackets
next to the column specifier. Comments can be added behind a '#'.
The first number containing a decimal separator determines whether the decimal separator is used throughout
the import.
1. 1. or .23 or 1.23 or 1.23E-5 renders English format settings
2. 1, or ,23 or 1,23 or 1,23E-5 renders European format settings
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3. 1E-5 or 125 assumes English format settings, the next number containing a decimal separator decides on the
format settings.
4. Thousand separators are not recognised.

B.2 ASCII files with CPT extension
The user can assign the extension *.cpt to an ASCII file. In this case the program will recognize the content as CPT
data. No header needs to be specified because the file extension indicates its content. If no header is specified or
its data is incomplete, the following values are assumed:
1. Missing coordinates are set to 0.0
2. A default header is assumed which considers the number of available columns. A maximum of four columns
is considered with specifiers 'd ', 'q ', 'f ' and 'u '. In case of less columns, specifiers are skipped (either 'f '
and/or 'u '). If more than 4 columns are found, the additional columns are skipped.
3. At least 2 columns must be present.
4. If no dimensions are specified, the default project dimensions are used.

B.3 Unit conversion
The conversion of the data units to the project units shown in Table 20 (on page 516) is possible for pressure.
Table 20: Convertable units

PLAXIS

Data unit

Project unit

1 Pa

1 N/m2

1 kPa

1000 N/m2

1 kN/m2

1 MPa

1 · 106 N/m2

1000 kN/m2

1 N/mm2

1 · 106 N/m2

1000 kN/m2

1 kN/m2

1000 N/m2

1 kN/m2
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Summary of the creation of General Water Levels
No. of
No. of
boreho Head in boreholes
Layer condition
layers
les

No. of
water
levels

Description

1

Value specified

1

Head

1

horizontal water level at the level defined by
Head

1

Value specified

1

Hydrostatica)

2

horizontal water level; 1 at the level defined by
Head; 1 at the level resulting from ptop

1

Value specified

1

Interpolate

1

horizontal water levelat the level defined by Head

1

Value specified

1

Dry

1

horizontal water level at the level defined by
Head

1

Value specified

1

User-defined

2

horizontal water level; 1 at the level defined by
Head; 1 at the level resulting from ptop and
pbottom

>1

Different values
per borehole

1

Head

1

non-horizontal water level

>1

Different values
per borehole

1

Hydrostatic

2

1 non-horizontal water level due to specified
heads; 1 horizontal layer due to the hydrostatic
condition of the soil layer

>1

Different values
per borehole

1

Interpolate

1

non-horizontal water level

>1

Different values
per borehole

1

Dry

1

non-horizontal water level

>1

Different values
per borehole

2

1 non-horizontal water level due to specified
heads, the water level due to soil layer condition
can be either horizontal or non-horizontal
depending on the defined conditions.

1b)

User-defined

a) For hydrostatic cases, the situations different from the Head are considered. If the phreatic level in hydrostatic
condition is equal to Head, no extra water level will be generated.
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b)The number of generated water levels for cases where more than one soil layer is available can be derived
accordingly.
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D

Conventional and unsaturated soil behaviour in
PLAXIS
As of 2013, PLAXIS 3D can handle unsaturated soils. The unsaturated soil behaviour and suction are taken into
account using Bishop' s stress, whereas conventional calculations (without suction) are performed using
Terzaghi' s effective stress. The way to distinguish between conventional calculations (without suction) and
calculations in which unsaturated soil behaviour is taken into account (with suction) is by means of the
calculation option Ignore suction.
Before defining the possibilities and limitations of both options, a definition is given of the various stresses and
related quantities involved. Note that compression is negative and tension (or suction) are positive.

D.1 Definition of stresses and related quantities
Total stresses are divided into effective stresses and pore pressures. Pore pressures are composed of steadystate pore pressures and excess pore pressures. Since decades, PLAXIS 3D uses the term 'active pore pressure' to
denote the contribution of the pore stresses in the total stresses. In the context of unsaturated soil behaviour,
active pore pressure is defined as:
Active pore pressure: pactive = Seff (psteady + pexcess) = Seff pwater
Pore water pressure: pwater = psteady + pexcess
Note that for fully saturated soil the 'active pore pressure' is equal to the 'pore water pressure', but there is a
clear difference in unsaturated zone.
Steady-state pore pressure: psteady
• Input for a deformation analysis
• Direct generation based on phreatic levels and cluster-related pore pressure distribution
• Or, calculated from steady-state groundwater flow calculation
Excess pore pressure: pexcess
• Result from undrained behaviour (Undrained (A) or (B)) and Kw / n from Table 23 (on page 528)and Table
23 (on page 528)
• Affected by loading, a (sudden) change in hydraulic conditions and consolidation.
• In the case of a fully coupled flow-deformation analysis, psteady is calculated from a preliminary steady-state
groundwater flow calculation using the hydraulic boundary conditions at the end of the calculation phase.
This enables the calculation and output of pexcess for a fully coupled analysis in all steps. pexcess = pwater - psteady.
Effective degree of saturation: Seff = (S-Sres) / (Ssat-Sres)
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Degree of saturation: S
Residual degree of saturation: Sres
Saturated degree of saturation: Ssat (usually 1.0)
• There is a relationship between the (effective) degree of saturation (S or Seff) and the suction in the
unsaturated zone, which depends on the selected soil-water retention curve in the material data set.
The term 'suction' is used to denote any positive value the difference between pore air and water pressures: pa pwater.
In PLAXIS, a widely accepted hypothesis of constant atmospheric air pressure is assumed. The air pressure is
therefore taken zero since the atmospheric pressure can be taken as a reference value.
Suction is the tension component in pwater: Suction = Max(pwater, 0)
Atmospheric pressure: pa (100 kPa, but in PLAXIS 3D taken as the zero reference level)
Effective suction: Suctioneff = Seff Suction
• When multiplied by the tangent of the friction angle, this quantity gives a kind of 'artificial cohesion' in the
soil.
Effective stress: σ' (stress in the soil skeleton)
Total stress: σ = σ'+ pactive
Terzaghi's effective stress: σ'= σ - pactive
• Terzaghi's definition of effective stress applies to saturated soils
Bishop' s stress: σ' = σ - pa + χ (pa - pwater )
Effective stress coefficient: χ
In PLAXIS 3D, χ is supposed to be equal to Seff, so Bishop' s stress in PLAXIS 3D:
σ' = σ - Seff · (psteady + pexcess) = σ - pactive
• When the soil reaches full saturation (Seff = 1), Bishop's stress coincides with Terzaghi's effective stress.
• Using Bishop's effective stress as a basis for all calculations, distinction can still be made between
conventional calculations (fully saturated or dry materials) and calculations in which unsaturated soil
behaviour is taken into account
• The aforementioned distinction can be made by ignoring suction or allowing suction.
In the following, the consequences of ignoring or allowing suction are described.

D.2 Ignore suction
When the calculation option Ignore suction is selected, soil below the phreatic level is considered to be fully
saturated (S = 1), whereas soil above the phreatic level is considered to be ideally unsaturated (S = 0). The
phreatic level itself is defined directly by the user or calculated as a result of a groundwater flow calculation or a
fully coupled flow-deformation analysis. Positive steady-state pore stresses will be set to zero. However, any
excess pore pressure above and below the phreatic level, both positive and negative, will be taken into account.
This requires Seff to be set to 1, regardless of S, Sres and Ssat.
When selecting the calculation option Ignore suction, the following conditions apply:
• Any positive value of psteady is cut at 0.
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• On or below the phreatic level (psteady ≤ 0): S = 1
• In drained and undrained (A, B) materials: Seff = 1 (over-rules previous value)
With this, the stresses and related quantities as defined previously fully apply. In principle, almost all calculation
types (Plastic, Consolidation, Dynamic, Safety, except Fully coupled flow-deformation), are available, but some
specific features or combinations are not available. Limitations are described below:
Note that it is still possible to have suction (pore water tension) as a result of unloading in Undrained (A,B)
materials. Hence, the option Ignore suction will NOT ignore suction as a result of excess pore tension.
As mentioned in Undrained behaviour for unsaturated soil (on page 270), IgnoreSuction, in some cases, may
underestimate shear strength and overestimate volume change behaviour. In general, it is difficult to conclude
whether this leads to a more or less conservative design. Obviously, the use of Ignoresuction may require less
material parameters (especially Soil water-retention curve parameters), but on the other hand, the analysis is
less realistic than when suction is considered. The user is advised to keep this in mind with utmost care.

D.3 Allow suction (i.e. Ignore suction not selected)
When the calculation option Ignore suction is NOT selected, suction is allowed and included in the active pore
pressure and pore water pressure. The saturation of the soil depends on the soil-water retention curve as
defined in the corresponding material data sets.
With this, the stresses and related quantities as defined previously fully apply. In principle, all calculation types
(Plastic, Consolidation, Fully coupled flow-deformation, Dynamic, Safety) are available, but some specific features
or combinations are not available. Limitations are described below. (see Possibilities and limitations (on page
522)).

D.4 Cavitation cut-off
Positive pore stresses may also occur as a result of unloading in undrained materials. However, there is a limit to
the amount of positive pore stresses (pore water tension) that can occur, which is the cavitation stress. This limit
can be taken into account in PLAXIS 3D by selecting the Cavitation cut-off option and setting the cavitation stress.
As a result, the pore water pressure, pwater, cannot be higher than the cavitation stress, pcavitation. As soon as the
cavitation stress is reached, the excess pore pressure is manipulated:
At cavitation: pexcess = pcavitation- psteady

D.5 Unit weight of soil
Although a proper definition of the unit weight of soil would involve the degree of saturation, PLAXIS 3D applies
a unit weight based on the current position of the phreatic level in all types of calculations.
• On or below the phreatic level (psteady ≤ 0): γ = γsat
• Above the phreatic level (psteady > 0): γ = γunsat
For a fully coupled flow-deformation analysis the evaluation of the unit weight is based on pwater instead of
psteady. This means that during a fully coupled flow-deformation analysis the position of the phreatic level and
hence the material weight can change.
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D.6 Possibilities and limitations
There are limitations in the use of specific features in the various calculations types in PLAXIS 3D depending on
whether suction is ignored or allowed. An overview of the limitations is given below.

D.7 Steady-state groundwater flow
• To generate steady-state pore pressures as input for Gravity loading, Plastic calculation, Consolidation
analysis or without deformation analysis.
Drainage type

Zero pore pressures generated in soil clusters of the types Undrained (C) and
Non-porous

Suction

Possible when suction is allowed or in the case of large excess pore tension.
Included in active pore pressures, pore water pressures, saturation and relative
permeability.

Cavitation cut-off

Not applicable

The following warning will appear when starting the calculation:
Zero permeabilities in some Material set with zero permeability found, but not allowed in this type of
soil clusters
calculation.

D.8 Transient groundwater flow
• To calculate time-dependent pore pressures without deformation analysis.
Drainage type

Zero pore pressures generated in soil clusters of the types Undrained (C) and
Non-porous

Suction

Possible when suction is allowed or in case of large excess pore tension. Included
in active pore pressures, pore water pressures, saturation and relative
permeability.

Cavitation cut-off

Not applicable

The following warning will appear when starting the calculation:
Zero permeability in some
soil clusters

Material set with zero permeability found, but not allowed in this type of
calculation.

Zero time interval

Zero time interval

Note: Transient groundwater flow is ONLY possible in case of Flow only calculation.
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D.9 K0-procedure
• Only possible as first (initial) calculation phase
• Does not consider external loads; only material weight
• Recommended for situations involving a horizontal ground surface and horizontal soil layering without
excavations or structures.
Drainage type

No pore pressures generated in soil clusters of the types Undrained (C) and Nonporous; no generation of excess pore pressures.

Steady-state groundwater
flow

Possible, but not recommended since non-hydrostatic pore pressures may lead
to non-equilibrium.

Transient groundwater flow Not possible
Suction

Included in steady-state pore pressures when suction is allowed

Cavitation cut-off

Not possible, but also not relevant; undrained behaviour is ignored

Updated mesh

Not possible (deformations are not considered)

Updated water pressures

Not possible (deformations are not considered)

D.10 Gravity loading
• Only possible as first (initial) calculation phase.
• Does not consider OCR or POP. Initial over-consolidation needs to be 'simulated' using external loads (apply
and remove in next phase) or increased Σ Mweight (reset to 1 in next phase).
Drainage type

No pore pressures generated in soil clusters of the types Undrained (C) and Nonporous; no generation of excess pore pressures.

Steady-state groundwater
flow

Possible

Transient groundwater flow Not possible
Suction

Included in steady-state pore pressures when suction is allowed

Cavitation cut-off

Not possible, but also not relevant; undrained behaviour is ignored

Updated mesh

Not possible

Updated water pressures

Not possible
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D.11 Plastic calculation
Not possible as first (initial) calculation phase.
Drainage type

No pore pressures generated in soil clusters of the types Undrained (C) and Nonporous. Excess pore pressures generated in soil clusters of the types Undrained
(A) and (B), except when using Ignore undrained behaviour (A,B)

Steady-state groundwater
flow

Possible (semi-coupled analysis). Note that in Undrained (A,B) soil clusters a
change in steady-state pore pressures gives an opposite change in excess pore
pressures.

Transient groundwater flow Not possible.
Suction

Possible when suction is allowed or in case of large excess pore tension. Included
in active pore pressures and pore water pressures.

Cavitation cut-off

Possible

Updated mesh

Possible when starting from initial phase or when parent phase is also Updated
mesh

Updated water pressures

Possible when Updated mesh selected (only in 2D)

The following warning will appear when starting the calculation:
Pore pressures are changed Note that a change in steady-state pore pressures will introduce extra excess
and undrained materials are pore pressures in Undrained (A,B) materials
present while Ignore
undrained behaviour (A,B) is
NOT selected

D.12 Safety analysis
Not possible as first (initial) calculation phase.
Drainage type

No pore pressures generated in soil clusters of the types Undrained (C) and Nonporous. Excess pore pressures generated in soil clusters of the types Undrained
(A) and (B), except when using Ignore undrained behaviour (A,B)

Steady-state groundwater
flow

Not possible (steady-state pore pressures taken from parent phase)

Transient groundwater flow Not possible (steady-state pore pressures taken from parent phase)
Suction

Possible when suction is allowed or in case of large excess pore tension. Included
in active pore pressures and pore water pressures.

Cavitation cut-off

Possible
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Updated mesh

Possible when parent phase is also Updated mesh. Note that only deformations
from the parent phase are considered and that the mesh is not further updated
during the Safety analysis.

Updated water pressures

Possible when Updated mesh selected. Note that only updated water pressures
from the parent phase are considered and that water pressures are not further
updated during the Safety analysis.

The following warning will appear when starting the calculation:
Using Updated mesh

Note that the mesh is NOT further updated during a Safety analysis

D.13 Consolidation analysis
•
•
•
•
•

Not possible as first (initial) calculation phase.
Considers only consolidation of excess pore pressures.
Requires non-zero permeabilities.
Requires non-zero time interval.
Suction is included in active and pore water pressures but not in permeability, namely relative permeability
is always equal to unity.

Drainage type

No consolidation in clusters of the type Non-porous; other drainage types have
no effect on consolidation; drainage properties are defined by permeabilities,
stiffness and time.

Steady-state groundwater
flow

Possible (redefines steady-state pore pressures). Note that a change in steadystate pore pressures may initially lead to an opposite change in excess pore
pressures, depending on the drainage properties.

Transient groundwater flow Not possible

Suction

Possible when suction is allowed or in case of large excess pore tension. Included
in active pore pressures, pore water pressures, saturation but not in relative
permeability. In other words, relative permeability is always taken as unity in
Consolidation Analysis. This may induce a quicker dissipation of pore pressure.
Numerical convergence is also expected to be faster.

Cavitation cut-off

Not possible

Updated mesh

Possible when parent phase is also Updated mesh

Updated water pressures

Possible when Updated mesh selected

The following warnings will appear when starting the calculation:
Steady-state pore pressures Note that a change in steady-state pore pressures will introduce extra excess
are changed
pore pressures in Undrained (A,B) materials
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Zero time interval

Zero time interval

Some permeability zero

Zero permeability in some soil clusters

D.14 Fully coupled flow-deformation analysis
• Not possible as first (initial) calculation phase.
• Considers full coupling between flow and deformation, i.e. 'consolidation' based on total pore water
pressures
• Requires non-zero time interval
• Requires non-zero permeabilities
• Requires hydraulic boundary conditions (groundwater head, closed flow)
Drainage type

No flow in clusters of the type Non-porous; other drainage types have no effect
on flow; drainage properties are defined by permeabilities, stiffness and time.

Steady-state groundwater
flow

Not possible (groundwater flow is automatically included). Steady-state pore
pressures at the end of the phase are automatically calculated based on the
hydraulic boundary conditions.

Not possible (groundwater flow is automatically included). Steady-state pore
Transient groundwater flow pressures at the end of the phase are automatically calculated based on the
hydraulic boundary conditions.
Suction

Suction is always allowed. Included in active pore pressures, pore water
pressures, water saturation as well as relative permeability. The dissipation of
water pressure is expected to be slower than in Consolidation Analysis.

Cavitation cut-off

Not possible

Updated mesh

Not possible. Note that parent phase should NOT be Updated mesh

Updated water pressures

Not possible

The following warnings will appear when starting the calculation:
Zero time interval

Zero time interval

Some permeability zero

Zero permeability in some soil clusters

D.15 Dynamic analysis
• Not possible as first (initial) calculation phase.
• Requires non-zero time interval.
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Drainage type

No pore pressures generated in soil clusters of the types Undrained (C) and Nonporous. Excess pore pressures generated in soil clusters of the types Undrained
(A) and (B), except when using Ignore undrained behaviour (A,B)

Steady-state groundwater
flow

Not possible (steady-state pore pressures taken from parent phase)

Transient groundwater flow Not possible (steady-state pore pressures taken from parent phase)
Suction

Included in steady-state pore pressures when suction is allowed

Cavitation cut-off

Possible

Updated mesh

Possible

Updated water pressures

Not possible

D.16 Dynamic analysis with Consolidation
Table 21: Bulk modulus of water in Deformation analysis
Type of material

Plastic (ignore undrained)

Undrained (pwater ≤ 0)

Kw = 0

Undrained (pwater > 0)

Plastic
sat
Kw
n

=

2 ⋅ G
3

(

K wunsat =

Kw = 0

1+

1 + νu
1 − 2νu

Kw
Sw

(

−

1+ν ′
1 − 2ν ′

Kw

Drained (pwater ≤ 0)

Kw = 0

Kw = 0

Drained (pwater > 0)

Kw = 0

Kw = 0

Cluster just been activated

Kw = 0

Kw = 0

Non-porous or dry cluster

Kw = 0

Kw = 0

∂
−
S
∂ pw w

)

)

*

∂

(*) ∂ p Sw is the derivative of saturation w.r.t pore water pressure (suction) i.e. the slope of water retention
w

curve. As saturation decreases when suction increases, this slope is always negative and equal to zero at full
saturation.}
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Table 22: Bulk modulus of water in Deformation analysis
Type of
material
Undrained
(pwater ≤ 0)
Undrained
(pwater > 0)

Safety or
dynamic
(drained)

Consolidation and FC (0 < S < 1)
sat
Kw
n

sat
Kw
n

=

Drained
(pwater ≤ 0)

sat
Kw

Drained
(pwater > 0)

sat
Kw

n

n

=

2 ⋅ G
3

2 ⋅ G
3

(

(

1 + νu
1 − 2νu

1 + νu
1 − 2νu

=

2 ⋅ G
3

=

2 ⋅ G
3

(
(

−

1+ν ′
1 − 2ν ′

−

)

1+ν ′
1 − 2ν ′

)

1 + νu
1 − 2νu

−

1+ν ′
1 − 2ν ′

1 + νu
1 − 2νu

−

1+ν ′
1 − 2ν ′

Safety or dynamic (undrained)
sat
Kw

Kw = 0

n

)
)

2 ⋅ G
3

(

K wunsat =

Kw = 0

**

=

1+

1 + νu
1 − 2νu

Kw
Sw

(

−

1+ν ′
1 − 2ν ′

Kw

Kw = 0

Kw = 0

Kw = 0

Kw = 0

∂
−
S
∂ pw w

Cluster just
activated and
option 'force
drained
behaviour
newly
activated
clusters'
selected

FE Formulation K w = K wsat ⋅ 10 −8

Not relevant

Not relevant

Non-porous or
dry cluster

Not relevant

Kw = 0

Kw = 0

)

)

*

(**)Effect of S taken into account directly in the FE Formulation (Galavi (2010) (on page 509).
Type of Material
Undrained (pwater ≤ 0)

Undrained (pwater > 0)

Drained (pwater ≤ 0)
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Steady - state
sat
Kw
n
sat
Kw
n
sat
Kw
n

=

2 ⋅ G
3

=

2 ⋅ G
3

=

2 ⋅ G
3

(
(
(

1 + νu
1 − 2νu
1 + νu
1 − 2νu
1 + νu
1 − 2νu
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Transient

−

1+ν ′
1 − 2ν ′

−

1+ν ′
1 − 2ν ′

−

1+ν ′
1 − 2ν ′

)
)
)

sat
Kw
n
sat
Kw
n
sat
Kw
n

=

2 ⋅ G
3

=

2 ⋅ G
3

=

2 ⋅ G
3

(
(
(

1 + νu
1 − 2νu

−

1+ν ′
1 − 2ν ′

1 + νu
1 − 2νu

−

1+ν ′
1 − 2ν ′

1 + νu
1 − 2νu

−

1+ν ′
1 − 2ν ′

)
)
)
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Type of Material
Drained (pwater > 0)

Cluster just been activated
Non-porous or dry cluster

PLAXIS

Steady - state
sat
Kw
n
sat
Kw
n

=

2 ⋅ G
3

=

2 ⋅ G
3

(
(

Transient

1 + νu
1 − 2νu

−

1+ν ′
1 − 2ν ′

1 + νu
1 − 2νu

−

1+ν ′
1 − 2ν ′

Kw = 0
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)
)

sat
Kw
n

=

2 ⋅ G
3

(

1 + νu
1 − 2νu

−

1+ν ′
1 − 2ν ′

)
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Shortcuts Input program

PLAXIS

Key

Action

Ctrl - A

Select all

Ctrl - E

Explode

Ctrl - L

Modify soil layers (only in Soil mode)

Ctrl - M

Show materials

Ctrl - N

New Project

Ctrl - O

Open Project

Ctrl - R

Snap to grid

Ctrl - S

Save Project

Ctrl - Y

Redo

Ctrl - Z

Undo

Ctrl - F9

Run commands (GSE)

Shift - Alt - C

Change soil colour intensity

Shift - Ctrl - E

Implode

Shift - Ctrl - S

Save project as

Tab

Snap to object while drawing

Delete

Delete selection

F1

Manuals

F10

Visualisation settings

F12

Toggle the display in the Phases window
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Shortcuts Output Program

PLAXIS

Key

Action

View

Ctrl - A

Select all structures of selected type

Model, Structure, Cross section

Ctrl - C

Copy

All

Ctrl - D

Display prescribed displacements

All

Ctrl - E

Explode

Model

Ctrl - F

Display fixities

All

Ctrl - H

Display phreatic level

All

Ctrl - I

Stress points

All

Ctrl - L

Display loads

All

Ctrl - M

Materials

All

Ctrl - N

Nodes

All

Ctrl - O

Open project

All

Ctrl - P

Print

All

Ctrl - R

Reset view

All

Ctrl - S

Save view

All

Ctrl - T

Table

All

Ctrl - W

Shrink

Model

Ctrl - F4

Close window

All

Ctrl - 0

Connectivity plot

All

Ctrl - 1

Deformed mesh

All

Ctrl - 2

Total displacements

All
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Shortcuts Output Program

PLAXIS

Key

Action

View

Ctrl - 3

Incremental displacements

All

Ctrl - 4

Total strains

All

Ctrl - 5

Incremental strains

All

Ctrl - 6

Plastic points

All

Ctrl - 7

Pore pressures

All

Ctrl - +

Move Cross section forward 1/100
of the model size

Cross section

Ctrl - -

Move Cross section backward
1/100 of the model size

Cross section

Ctrl - Alt - C

Change soil colour intensity

Model, Cross section

Ctrl - Shift - A

Show all soil elements

Model

Ctrl - Shift - M

Create animation

Model, Cross section, Structure

Ctrl - Shift - N

Hide all soil elements

Model

Ctrl - Shift - Enter

Goes to structure view with
selected materials

Model, Cross section, Structure

Ctrl - Shift - +

Move Cross section 1/1000 of the
model size

Cross section

Ctrl - Shift - -

Move Cross section 1/1000 of the
model size

Cross section

Escape

Clear selected structures

Model, Cross section, Structure

Shift - Ctrl - E

Implode

Model

Shift - Ctrl - W

Expand

Model

F1

Manuals

All

F2

Curves manager

All

F10

Settings

All

Key

Action

Ctrl - A

Select all
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Shortcuts Output Program
Key

Action

Ctrl - F

Find value

Ctrl - M

Jump to maximum value in column

Ctrl - N

Jump to minimum value in column

Key

Action

View

Wheel move

Zoom in/out

All

Press Select structures - Click on
structure

Select small group the structure
belongs to

Model, Cross section, Structure Resets current selection

Model, Cross section, Structure Press Select structures - Shift - Click Toggles selection of small group the
Selection of other structure type
on structure
structure belongs to
will be cleared.
Model, Cross section, Structure Selection of other structure type
will be cleared

Press Select structures - Ctrl - Click
on structure

Toggles selection of structure

Press Select structures - Alt - Click
on structure

Model, Cross section, Structure Toggles selection of large group the
Selection of other structure type
structure belongs to
will be cleared

Press Hide soil - Ctrl - Click on soil

Hides soil element

Model, Forces - Won’t work if
structure is selected

Press Hide soil - Ctrl + Shift - Click
on soil

Hides soil cluster

Model, Forces - Won’t work if
structure is selected
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G

Python HTTP REST API wrapper
The Python wrapper for the PLAXIS HTTP REST API hides the technicalities of dealing with the HTTP
communications behind a comfortable object-oriented wrapper.

G.1 Python HTTP REST API wrapper
Prerequisites
1. An editor for writing Python scripts in. This documentation assumes that the SciTE editor will be used that
comes with the PLAXIS installation.
2. At least a very rudimentary knowledge of the Python language is recommended, as this document makes no
attempt to teach it. Good resources for this purpose are:
a. Dive Into Python 3 (Seehttp://diveintopython3.problemsolving.io/)
b. After Hours Programming http://www.afterhoursprogramming.com/tutorial/Python/Overview/
c. Think Python: How to Think Like a Computer Scientist http://greenteapress.com/thinkpython/html/
index.html
3. Your firewall must not block the PLAXIS application from accessing the internet, nor must it block other
applications (in particular the python.exe executable) from talking to the remote scripting server embedded
inside the PLAXIS application.
Note: Note that when using Python and other modules, users must do so under the licensing conditions of those
modules. The user can check the Python version delivered by PLAXIS by launching the interactive interpreter
from the Expert menu.

G.2 Starting the scripting server
1. Start your PLAXIS application.
2. Start a new project.
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3. Go to the Expert menu and select the Configure remote scripting server option. The corresponding window
pops up. Depending on your machine, the window may look slightly different.

4. Ensure you find an available port and then start the server.
5. A default password will have been generated to ensure a secure connection between the server and the
remote scripting interface. You can change this password if you want to, just be aware that leaving the text
box empty disables the encryption.
6. Information about ports currently in use can be retrieved in a Windows Command Prompt, with the
following commands (the second one may require administrator privileges):
netstat -a
netstat -ab
When using the remote scripting in an automated process, you can start the server without manual interaction
by launching your PLAXIS application with the AppServerPort command line parameter. For example in order to
start the server in PLAXIS 3D on port 21403:
c:\Program Files (x86)\Plaxis\PLAXIS 3Dx\Plaxis3DXInput.exe
--AppServerPassword=mypassword --AppServerPort=21403
Changing the password can be done by using the AppServerPassword command line parameter. Passing the
password this way is optional and it will default to the generated one.
When the server is running, the main window of your PLAXIS application will reflect this information:

G.3 Connecting to a scripting server
Local server (using SciTE)
• Start SciTE from the Windows Start menu. It will be called ‘Python editor for PLAXIS 3D. This will present you
with an empty document. Let us write a script that will start a new project.
• First we must import the scripting library:
from plxscripting.easy import*
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• Connect to the PLAXIS application (21403 is the port number, substitute yours as applicable):
s_i, g_i = new_server('localhost', 21403, password='yourpassword')
The variable s_i is bound to an object representing the PLAXIS application. It is now possible to control that
from the interactive Python prompt.
• Start a new project as follows:
>>> s_i.new()
Save this script somewhere on your hard drive. Make sure it ends with .py so SciTE correctly identifies it as a
Python script. Now we are able to run this script by going to Tools and then clicking on Go or by pressing F5
• A new project should now be visible in the PLAXIS application. If instead an error is returned, check the
following for the PLAXIS application you are trying to control:
• Is the application running?
• Does its title bar indicate that the server is active?
• Is the server active on the port you have specified when calling new_server? You can also try a different
port.
• Is your firewall blocking communications to the application?
• Is the password given to new_server the same as the one in the ‘configure remote scripting server’
dialog?

Remote PLAXIS application
Connecting to a PLAXIS application running on a computer other than your own requires you to know the name
or IP address of that machine. The IP address can be found by typing in a Windows command prompt the
following:
ipconfig | find "IPv4"
The result will give a set of four numbers separated by dots. Example:
IPv4 Address. . . . . . . . . . . : 10.4.2.178
In order to connect to this machine from within the same network, you can simply replace 'localhost' in the
boilerplate
connection code with the IP address you found, such as '10.4.2.178'. For example:
>>> s_i, g_i = new_server('10.4.2.178', 21403, password='yourpassword')
If you want to connect to the same machine over the internet, you will need to set up appropriate port
forwarding rules in your router. Note that opening up your computer to access from the network or even the
internet carries significant security risks - do so only if you have considered these risks.

G.4 Creating standalone scripts
In the examples above, we have looked at possibilities for using the API interactively from a Python prompt.
While this is very useful for testing and finding out how things work, soon you will need the ability to save code
and run it again without having to retype it.
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In the SciTE editor make a new text file by going to File > New or by pressing Ctrl+N. After that, you can type the
code, save and run it using Tools >Go. A Python script equivalent to the interactive session presented above
(using a 2D example) looks as follows:
from plxscripting.easy import *
s_i, g_i = new_server('localhost', 21403, password='yourpassword')
s_i.new()
g_i.SoilContour.initializerectangular(0, 0, 10, 10)
g_i.borehole(0)
g_i.soillayer(10)
material = g_i.soilmat()
material.setproperties("SoilModel", 1, "gammaUnsat", 16,
"gammaSat", 20, "Gref", 10000)
g_i.Soils[0].Material = material
g_i.gotostructures()
g_i.lineload((3, 0), (7, 0))
g_i.gotomesh()
g_i.mesh(0.2)
output_port = g_i.selectmeshpoints()
s_o, g_o = new_server('localhost', output_port, password='yourpassword')
g_o.addcurvepoint('node', g_o.Soil_1_1, (5, 0))
g_o.update()
g_i.gotostages()
phase1 = g_i.phase(g_i.Phases[0])
g_i.LineLoads[0].Active[phase1] = True
g_i.calculate()
output_port = g_i.view(phase1)
s_o, g_o = new_server('localhost', output_port, password='yourpassword')
#In newer versions of the scripting layer it is possible to just write:
g_o.CurvePoints.Nodes[0]
utot = g_o.getcurveresults(g_o.CurvePoints.Nodes.value[0], g_o.Phases[1],
g_o.ResultTypes.Soil.Utot)
print(utot)
g_i.save(r'c:\data\scripting_sample')

G.5 Calling new_server without arguments
It is possible to call new_server without any arguments, but in that case a script can only be executed from the
Expert menu in PLAXIS. Either choose Expert > Python > Run Script > Open to run your script or put it in one of
the pytools folders and choose Expert > Python > Run Script > Tools.
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G.6 Disabling the user interface
For some projects the overhead of updating the user interface may slow down the execution of the script quite
significantly. If you want maximum execution speed, launch your PLAXISapplication with the command
parameter --NO_CONTROLLERS. For example:
Plaxis2DXInput.exe --AppServerPort=21403 --NO_CONTROLLERS
The downside of this approach is that you will be unable to monitor progress or diagnose problems visually.
Instead, you will have to:
1. Stop the running script
2. Save the current project
3. Restart the application and open the saved project

G.7 Identifying the type and version of PLAXIS
If there is a need to write codes that are usable under both programs PLAXIS 2D and PLAXIS 3D, it is possible to
check the type and version of PLAXIS software. With s being a server-type object as returned by the
new_server(...) method, the following code must be valid:
>>> print(s.name, s.major_version, s.minor_version, s.is_2d, s.is_3d)
PLAXIS 2D 2018 0 True False
>>> if s.major_version + s.minor_version / 10 > 2020: # i.e. both are numbers
...
print('We come from the future')
We come from the future
>>> from .const import PLAXIS_2D, PLAXIS_3D
>>> if s.name == PLAXIS_2D:
...
print('This is PLAXIS 2D')
... elif s.is_3d: # indicates whether the application is 2D or 3D *capable*
# (not whether it's the 2D or 3D *product*; 2D MPM will have
is_2d=True!)
...
print('This is 3D or 3D MPM')
... else:
...
print('Unknown application!')
This is PLAXIS 2D
The following also work:
from easy import * # must implicitly import the app type constants
s_i, g_i = new_server('localhost', 10000)
if s_i.name == PLAXIS_3D:
print('Is PLAXIS 3D')
Drawing a rectangular/prismatic soil cluster in either 2D or 3D
from plxscripting.easy import new_server
from math import isnan, nan
s_i, g_i = new_server() # works when launched from Expert menu
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def get_number(msg):
nr = nan
while isnan(nr):
try:
nr = float(input(msg + ': '))
except:
pass
return nr
width = get_number('Width')
height = get_number('Height')
if s_i.is_3d: # must also work for 3D MPM!
# get the depth of the cluster
depth = get_number('Depth')
make_coords = lambda x, z: (x, 0, z)
else:
make_coords = lambda x, y: (x, y)
coords = [(0, 0), (width, 0), (width, height), (0, height)]
result = g_i.polygon(*[make_coords(*pos) for pos in coords])[0]
if s_i.is_3d: # perform the extrusion and remove original polygon
volume = g_i.extrude(result, (0, depth, 0))[0]
g_i.delete(result)
result = volume
print('Created cluster: {}'.format(result.Name))

G.8 Creating a simple project
All commands that are available in the PLAXIS command line are also available via the Python wrapper. For
more information, see the commands reference provided with your PLAXIS application. Note that private
commands in the application (i.e. commands starting with a double underscore, __) are spelled without the
double underscore when used from Python. Commands that conflict with Python keywords should be spelled
with an extra trailing underscore in Python (e.g. import becomes import_). Identifiers containing characters
that are not part of the ASCII character set will be stripped of those characters (e.g. °C becomes C).
• Start by connecting from Python to PLAXIS 2D as described above.
• Make sure that the folder where the scripting sample will be saved does exist (c:\data\).
• Execute the code displayed below. For the sake of completeness, the replies returned by the different
statements are included, but some of them are session-specific and will be different for you. It is helpful while
executing the Python code to keep an eye on the command line in the PLAXIS application, in order to gain an
understanding of how Python code maps to commands. Keep also in mind that Python, unlike the PLAXIS
command line, is case sensitive.
>>> s_i.new()
'OK'
>>> g_i.SoilContour.initializerectangular(0, 0, 10, 10)
'OK'
>>> g_i.borehole(0)
<Borehole {BB449552-2ABF-408D-8293-897B5939D764}>
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>>> g_i.soillayer(10)
<GeneratedSoilVolume {859D7DB5-585E-4452-8C38-E700C398EF9C}>
>>> material = g_i.soilmat()
>>> material.setproperties("SoilModel", 1, "gammaUnsat", 16,
"gammaSat", 20, "Gref", 10000)
'Edited SoilMat_1'
>>> g_i.Soils[0].Material = material
>>> g_i.gotostructures()
'OK'
>>> g_i.lineload((3, 0), (7, 0))
[<Point {AD9DB344-A82E-4ACD-93BB-A3C02369556B}>, <Point {9E140226-A968-46A1A2EA-5125EE83968F}>, <Line {F1E1AE01-C72A-44CD-A647-8EC39CA024D7}>, <LineLoad
{B3A5244F-3097-44CC-8E3E-2290AC4508B0}>]
>>> g_i.gotomesh()
'OK'
>>> g_i.mesh(0.2)
Generated 181 elements, 374 nodes
>>> output_port = g_i.selectmeshpoints()
>>> s_o, g_o = new_server('localhost' , output_port, password="yourpassword")
>>> g_o.addcurvepoint('node' , g_o.Soil_1_1, (5, 0))
'OK'
>>> g_o.update()
'OK'
>>> g_i.gotostages()
'OK'
>>> phase1 = g_i.phase(g_i.Phases[0])
'OK'
>>> g_i.LineLoads[0].Active[phase1] = True
>>> g_i.calculate()
'OK'
>>> output_port = g_i.view(phase1)
>>> s_o, g_o = new_server ('localhost', output_port, password="yourpassword")
>>> utot = g_o.getcurveresults(g_o.Curvepoints.Nodes.value[0],
g_o.Phases[1],g_o.ResultTypes.Soil.Utot)
>>> print(utot)
8.76955286493468E-5
>>> g_i.save(r'c:\data\scripting_sample')
'Project saved as: c:\\data\\scripting_sample.p2dx'
• The command line history on the application side looks as follows (excluding the commands sent to Output):
0001> initializerectangular SoilContour 0 0 10 10
0002> borehole 0
0003> soillayer 10
0004> soilmat
0005> setproperties SoilMat_1 "SoilModel" 1 "gammaUnsat" 16
"gammaSat" 20 "Gref" 10000
0006> set Soil_1.Material SoilMat_1
0007> gotostructures
0008> lineload (3 0) (7 0)
0009> gotomesh
0010> mesh 0.2
0011> selectmeshpoints
0012> gotostages
0013> phase InitialPhase
0014> set LineLoad_1_1.Active Phase_1 True
0015> calculate
0016> view Phase_1
0017> save "c:\data\scripting_sample"
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G.9 Performance and logging
By default the server object (typically referred to as s in these examples) implements a caching system to reduce
the number of calls by the script to the PLAXIS application, thereby improving the overall performance of the
system. It can be switched off using:
s_i.allow_caching = False
Additionally, a logging system is available in order to monitor the communications between the Python script
and the PLAXIS application. It can be toggled on or off using the enable_logging() and disable_logging()
methods of the server object:
s_i.enable_logging() # will write to TEMP\PlaxisScriptLogs\
s_i.disable_logging()

G.10 External manipulations during script execution
While using Python scripts to manipulate the state of your PLAXIS application, it is technically possible to
interact with the same application in other ways as well (e.g. by changing a project manually, or firing commands
separately in an interpreter while the main script is paused). This is very useful for troubleshooting.
In particular situations it may however lead to problems, in that internal data structures built on the Python side
have become obsolete due to actions outside of the script. The main culprit is (re)opening a project while the
script already has some internal state/variables. Errors can look like this:
plxscripting.plx_scripting_exceptions.PlxScriptingError: Unsuccessful command:
GUID does not refer to object in registry: {F00F9FB0-B903-42BE-AE1F-C7B8E200885D}
If you encounter such an error, simply stop the execution of your script and restart it.

G.11 Error handling mode
When the server is started, it is possible to optionally set an error handling mode by using the error_mode
option. The error_mode consists of a behaviour and optionally one or more modifiers.
The error_mode option influences the behaviour of in-request exceptions, as well as out-of-request exceptions.
In-request exceptions are raised during execution of a request and out-of-request exceptions occur outside an
HTTP request. An example of the latter is if repainting the UI leads to a crash after the command has been
executed and returned to the scripting client.
The error_mode is always a tuple consisting of none, one or more of:
1. Behaviour RAISE [default; empty error_mode means RAISE]: raises an exception.
2. Behaviour INTERPRETER: upon exception, fires an interactive Python interpreter for troubleshooting, if the
server is not currently in an interactive interpreter mode already.
3. Modifier RETRY: tries the same API call again with a delay of 200 ms.
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4. Modifier PRECONDITION: checks (and clears) the exception stack prior to making another API call.
5. Modifier NOCLEAR: ensures that when an out-of-request exception is retrieved, it is not cleared from the
server.
If the user specifies RAISE, INTERPRETER as combo behaviour in the new_server call, INTERPRETER wins.

Examples
1. Setting the error handling mode:
s, g = new_server('localhost', 10000,
error_mode=(INTERPRETER, RETRY))
2. Manual API calls
It's useful to be able to manually request information about out-of-request failure state, particularly when
using NOCLEAR or using the interactive interpreter to troubleshoot issues.
# raise a Python exception including the cleaned madExcept info, because this is an
in-request failure
s.raise_()
# triggers out-of-request exception, retrievable using get_error, but does
not crash immediately
s.raiseasync()
# give the raiseasync time to work
import time; time.sleep(0.5)
# None if no exception, exception string otherwise
s.get_error(clear=False)
# as above, but does clear the exception information from the server
s.get_error(clear=True)
# equivalent to clear=True
s.get_error()

G.12 Installing third-party Python modules
When you want to install a third party package that isn‘t already available in the Python installation then you can
do so by opening the command prompt from Expert > Python > Command prompt or by selecting ‘Console for
PLAXIS 3D’ from the PLAXIS folder in the start menu. From there you can install new packages by either using
conda or pip.
For example, if you want to install the dropbox package you would type:
pip install dropbox
And if you want to install the cffi (C foreign function interface) package you would type:
conda install cffi
Note that not all packages that are available to pip are available to conda and some complex packages such as
numpy might be easier to install using conda than with pip. Lastly installing new packages requires
administrator rights on your PC.
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G.13 Tokenizer
The Python API allows parsing a command line string into the separate tokens.
• The server object has a tokenize method. This method returns a Tokenizer object. This object may be in a
fully valid state, or a partially valid state. It always contains one list of Token objects, but depending on the
success of the action, this list may be available only as Tokenizer.partial_tokens or as both
Tokenizer.tokensand Tokenizer.partial_tokens simultaneously - see the example below for more
information.
The list of tokens contains Token objects.
partial_tokens contains the successfully parsed tokens, which may or may not be all tokens in the string.
• There are subclasses of the Token class to match the types of tokens from the HTTP REST API, see HTTP
REST API (on page 560)
• The Token classes have properties as specified for the HTTP REST API (see HTTP REST API (on page 560)).
The only exception is the type property: this one will be absent in Python, since it is implicitly encoded in the
Token subclass.

Examples
from plxscripting.easy import *
s, g = new_server("localhost", 10000)
tokenizer = s.tokenize("addpoint Polygon_2 0 4 0 # comment")
print(tokenizer.success) # prints True
print(tokenizer.error_position) # prints -1
print(tokenizer.tokens == tokenizer.partial_tokens) # prints True
tokens = tokenizer.tokens
print(len(tokens)) # prints 6
token = tokens[0]
print(token.position) # prints 0
print(token.length) # prints 8
print(token.end_position) # prints 7
print(token.__class__) # prints <class 'plxscripting.tokenizer.TokenIdentifier'>
# The various Token classes mirror the ones of HTTP REST API
print(token.value) # prints 'addpoint' (w/o quotes)
print(token) # prints plxscripting.tokenizer.TokenIdentifier
# ({'type': 'identifier', 'value': 'addpoint', 'length': 8, 'position':
1})
print(tokens[2].__class__) # prints <class plxscripting.tokenizer.TokenInteger'>
print(tokens[2].value) # prints 0
print(tokens[-1].value) # prints '# comment'
print(tokens[-1].content) # prints ' comment' (with leading space, w/o quotes)
for token in tokens:
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print(token) # prints all the tokens
# error conditions
tokenizer = s.tokenize("abc ?")
tokens = tokenizer.tokens # raises an exception about Unrecognized token
print(tokenizer.success) # prints False
print(tokenizer.error) # prints 'Unrecognized token' (w/o quotes)
print(tokenizer.error_position) # prints 4
print(len(tokenizer.partial_tokens)) # prints 1, since the first token is OK

G.14 Sample Applications
This section contains a few simple tasks that highlight different aspects of the Python scripting wrapper. It is
assumed PLAXIS 3D is running and the necessary connection boilerplate code has been executed already.

Opening a project, removing all lines containing beams and saving again
s_i.open(r'c:\data\lines_with_plates.p2dx')
lines = [b.Parent for b in g_i.Plates]
g_i.delete(*lines)
# alternatively (look at the difference in the command line):
# g_i.delete(lines)
g_i.save()

Reporting all points that are not used by lines and that have no features
points_in_lines = set()
for line in g_i.Lines[:]:
for point in line:
points_in_lines.add(point)
points = set(g_i.Points)
points_no_lines = points - points_in_lines
points_to_report = []
for p in points_no_lines:
if len(p.UserFeatures.value) == 0:
points_to_report.append(p)
for p in points_to_report:
print(p.Name)

Creating an array, storing the results and performing actions on the diagonal
# Code will work in any project, as it operates only on its own local results,
regardless of what else is present in the project.
g_i.gotostructures()
point = g_i.point(0, 0)
added_points = g_i.arrayr(point, 6, (1, 0), 6, (0, 1))
diagonal_points = []
for p in added_points:
if abs(p.x - p.y) < 1E-4
diagonal_points.append(p)
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g_i.pointload(diagonal_points)

Lengthening all the embedded beam rows in a model
# Code below can be used to quickly generate a test model
## res = g_i.embeddedbeam((0, 0), (0, -15))
## line = [item for item in res if item._plx_type=='Line'][0]
## g_i.arrayr(line, 5, (1, 0))
def get_bottom_point(line):
first, second = line.First, line.Second
delta = second.y - first.y
if abs(delta) < 1E-4: # horizontal line
return None
if delta > 0: # Second point is higher -> move First down
return first
else: # First point is higher -> move Second down
return second
def lengthen_embedded_beams(extra_depth):
# start by selecting the lines which have embedded beam rows
pile_lines = [pile.Parent for pile in g_i.EmbeddedBeams[:]]
# we don't know whether the line is drawn top-to-bottom
# or bottom-to-top, so find out which point is lowest
points_to_move = []
for line in pile_lines:
bottom_point = get_bottom_point(line)
if bottom_point:
points_to_move.append(bottom_point)
g_i.move(points_to_move, (0, -extra_depth))
lengthen_embedded_beams(2.5)

Making all plates in all phases have identical settings in staged construction
refplate = g_i.Plates[0]
otherplates = g_i.Plates[1:]
for phase in g_i.Phases:
if refplate.Active[phase] is None: # phase not yet initialized
continue
for otherplate in otherplates:
otherplate.Material[phase] = refplate.Material[phase]
otherplate.Active[phase] = refplate.Active[phase]

Create safety phase after every consolidation phase
for phase in g_i.Phases[:]:
if phase.DeformCalcType == phase.DeformCalcType.consolidation:
newphase = g_i.phase(phase)
newphase.DeformCalcType = newphase.DeformCalcType.safety
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Send an email using Gmail after calculations are finished
# A Gmail account is needed for this. Google Apps for Business accounts
# should work as well.
import smtplib
from email.mime.multipart import MIMEMultipart
from email.mime.text import MIMEText
def opensession_gmail(username, password):
# Courtesy of http://segfault.in/2010/12/sending-gmail-from-python/
# Other email providers may require a different way of connecting.
# It may be necessary to enable access for less secure apps when
# using GMail, see https://www.google.com/settings/security/lesssecureapps
session = smtplib.SMTP('smtp.gmail.com', 587)
session.ehlo()
session.starttls()
session.ehlo()
session.login(username, password)
return session
def sendmail(smtp_session, sender_address,
to_address, subject, body):
msg = MIMEMultipart()
msg['From'] = sender_address
msg['To'] = to_address
msg['Subject'] = subject
part = MIMEText('text', 'plain')
part.set_payload(body)
msg.attach(part)
smtp_session.sendmail(sender_address, to_address, msg.as_string())
def report_phases_by_kind(target_report, phases,
kind, report_func):
if phases:
target_report.append(kind)
target_report.append('=' * len(kind))
for phase in phases:
target_report.append(report_func(phase))
target_report.append('')
def phase_to_string(phase):
return "{} [{}]".format(phase.Identification, phase.Name)
def phase_to_string_with_error_code(phase):
return "{} [{}]. LogInfo: {}".format(
phase.Identification, phase.Name, phase.LogInfo)
def report_phases(phases_list):
successful_phases = []
failed_phases = []
uncalculated_phases = []
for phase in phases_list:
if phase.ShouldCalculate:
uncalculated_phases.append(phase)
elif phase.LogInfo == '0':
successful_phases.append(phase)
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else:
failed_phases.append(phase)
report_lines = []
report_phases_by_kind(report_lines, successful_phases,
'Successful', phase_to_string)
report_phases_by_kind(report_lines, failed_phases,
'Failed', phase_to_string_with_error_code)
report_phases_by_kind(report_lines, uncalculated_phases,
'Skipped', phase_to_string)
return '\n'.join(report_lines)
def calculate_with_report():
phases_to_calculate = []
for phase in g_i.Phases[:]:
if phase.ShouldCalculate:
phases_to_calculate.append(phase)
res = g_i.calculate()
report = [
'Title: {}'.format(g_i.Project.Title),
'Location: {}'.format(g_i.Project.Filename),
'',
report_phases(phases_to_calculate),
'',
'Command feedback:',
res]
return '\n'.join(report)
message = calculate_with_report()
# change the account information below for your own account
username = 'your.name@gmail.com'
password = 'abc123'
to_address = username # sending to ourselves, but can specify something else too
session = opensession_gmail(username, password)
sendmail(session, username, to_address,
'Plaxis calculation report',
message)

Executing commands specified in a file
#
#
#
#
#
#
#
#

For debugging particular problems it may be interesting to execute
commands directly (effectively bypassing the Python object wrapper)
and parse feedback on demand. It may also have some performance
benefits as the communication with the server is reduced. This way
of communicating with the application also allows you to do your
own error handling. The code below demonstrates several approaches
to this task, examine the data that's printed out to better
understand the differences.

# Code below can be used to quickly generate a test model
## from tempfile import NamedTemporaryFile
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##
##
##
##

import os
f = NamedTemporaryFile(mode='w', delete=False)
f.write('\n'.join(['bh 0', 'sl 2', 'plate 0 0 1 1']))
filename = f.name

f = open(filename, 'r') # filename should be defined in advance
commands = [line.rstrip() for line in f.readlines()]
f.close()
# If you used the quickly generated test model, also enable
# the cleaning below:
## os.remove(filename)
# Run one command at a time and have the wrapper handle the response
# for you - not much extra control.
for command in commands:
print(s_i.call_and_handle_command(command))
# Run multiple commands at a time and have the wrapper handle
# the responses for you. There is less communication with the
# server than when executing one command at a time so it's
# potentially faster.
print(s_i.call_and_handle_commands(*commands))
# Run one command at a time and handle the response yourself. The
# response now consists of Python primitives representing the
# JSON communication rather than comfortable objects.
for command in commands:
print(s_i.call_commands(command))
# Run multiple commands at a time and handle the responses yourself.
print(s_i.call_commands(*commands))
# call_commands will not lead to an exception in case of invalid
# commands, unlike the other method calls presented.
print(s_i.call_commands('this is an invalid command'))

Creating a polar array of inclined piles
from math import radians, sin, cos
# input parameters
nr_pilerows = 4 # must be > 1
total_angle_deg = 180 # over which to distribute the piles, must be > 0 and <= 360
pilerow_length = 10
pilerow_inclination_deg = 15
array_center = (5, 0)
array_radius = 10
# calculations
def rel_coords_to_absolute(rel_coords, radius, offset):
coords = [radius * coord for coord in rel_coords]
return [p[0] + p[1] for p in zip(coords, offset)]
if total_angle_deg == 360: # fencepost problem -> decrease angle
total_angle_deg = total_angle_deg / (nr_pilerows) * (nr_pilerows - 1)
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pilerow_inclination_rad = radians(pilerow_inclination_deg)
array_bottom_radius = array_radius + \
pilerow_length * sin(pilerow_inclination_rad)
array_bottom_center = (array_center[0], array_center[1] - pilerow_length *
cos(pilerow_inclination_rad))
pilerow_coords = []
for i in range(nr_pilerows):
angle = radians(total_angle_deg * i / (nr_pilerows - 1))
rel_coords = [cos(angle), sin(angle), 0]
top_coords = rel_coords_to_absolute(
rel_coords, array_radius, array_center)
bottom_coords = rel_coords_to_absolute(
rel_coords, array_bottom_radius, array_bottom_center)
pilerow_coords.append((top_coords, bottom_coords))
for coords_pair in pilerow_coords:
g_i.embeddedpilerow(*coords_pair)

Convert 2D to 3D
# This is a limited converter that will only work for a small subset of potential 2D
geometry configurations. We need to be careful about which environment variables
# live in (3D will not be able to accept as input objects that live in the 2D
environment and the other way around).
# For this reason we will append a 2 or 3 to each variable in order to indicate where
the object lives. Keep in mind that for this case both 2D and 3D need to
# be running simultaneously, and they must open different ports for the scripting
engine. Depending on which versions are in use, it may also happen that the scripting
# API is incompatible between the two, so additional effort will need to be undertaken
to load different versions of the API for 2D and 3D.
# connect to 2D
s2, g2 = new_server('localhost', 10002, password='yourpassword')
# Code below can be used to quickly build a 2D project that
# we can use for conversion
## s2.new()
## g2.gotostructures()
## g2.plate((2, 5), (2, 2))
## g2.plate((6, 5), (6, 2))
## g2.polygon((0, 0), (8, 0), (8, 5), (0, 5))
# connect to 3D
s3, g3 = new_server('localhost', 10003, password='yourpassword')
# In 3D we need to specify a particular slice thickness
while True:
try:
depth = float(input('Specify non-zero 3D slice thickness> '))
if depth != 0.0:
break
else:
print('Must be non-zero!')
except:
print('Invalid input, try again!')
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pass
s3.new()
g3.gotostructures()
# convert each line to a polygon (map y to z!)
for line2 in g2.Lines:
# Need to dereference the values, because the intrinsic
# properties live in 2D, cannot send them over to 3D!
pointcoords = [
(line2.First.x.value, 0.0, line2.First.y.value),
(line2.Second.x.value, 0.0, line2.Second.y.value),
(line2.First.x.value, depth, line2.First.y.value),
(line2.Second.x.value, depth, line2.Second.y.value)
]
surface3 = g3.surface(
pointcoords[0], pointcoords[1],
pointcoords[3], pointcoords[2])
# Limitations
# - not all 2D line features become surface
#
feature in 3D (e.g. N2N anchors).
# - features may depend on normal orientation
#
(e.g. interfaces)
for uf2 in line2.UserFeatures.value:
# shorthand: assume that the command == type name,
# which is not necessarily true for all user features
ufconstructor 3 = g3.__getattr__(
uf2._plx_type.lower())
# add the feature
ufconstructor3(surface3)
# convert each polygon to a volume
for polygon2 in g2.Polygons:
# the addition operation on numerical intrinsic properties
# automatically dereferences their value
pointcoords = [(polygon2.x + p2.x, 0.0, polygon2.y + p2.y)
for p2 in polygon2.Points.value]
surface3 = g3.surface(*pointcoords)
# use extrusion to create a volume
volume3 = g3.extrude(surface3, (0.0, depth, 0.0))
# remove the original surface
g3.delete(surface3)

Using both Input and Output at the same time
# Sometimes you also want to automate the selection of history points
# or the retrival of results in Output.
s_i, g_i = new_server('localhost', 10000, password='yourpassword')
s_i.open(r'C:\Users\x\Document\PlaxisProjects\some_existing_project.p2dx')
# Calling the view command while Input has a running server will also start
# Output with a server and return the port that the new server uses.
# The commands preview, view and viewmesh will behave similarly.
output_port = g_i.selectmeshpoints()
# Connect to the Output server the same way we connect to the Input one.
s_o, g_o = new_server('localhost', output_port, password='yourpassword')
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# Select a history point and close Output with the update command.
g_o.addcurvepoint('node', g_o.Soil_1_1, 0, 0)
g_o.update()

Computing a derived result from existing result types
This example shows how to compute a derived result starting from standard result types. This code requires
existing results to be processed.
import math
from plxscripting.easy import new_server
s_i, g_i = new_server('localhost', 10000, password='yourpassword')
last_phase = g_i.Phases[-1]
ux = g_i.getresults(last_phase, g_i.ResultTypes.Soil.Ux, 'node')
uy = g_i.getresults(last_phase, g_i.ResultTypes.Soil.Uy, 'node')
displacement_angles = [math.atan2(y, x) for x, y in zip(ux, uy)]
print(displacement_angles)

Finding the local maximum displacement from existing result types
This example shows how to find the local maximum displacement using the getsingleresult command. This code
requires existing results to be processed.
import math
from plxscripting.easy import new_server
s_i, g_i = new_server('localhost', 10000, password='yourpassword')
step = 0.1
last_phase = g_i.Phases[-1]
result_type = g_i.ResultTypes.Soil.Utot
def get_displacement(coordinate):
result = g_i.getsingleresult(last_phase, result_type, *coordinate)
if result == 'not found':
return float('nan')
else:
return float(result)
#Use simple hill climbing to get to the coordinate with the highest
#displacement.
def get_walk_direction(coordinate, utot):
coordinate_dx = (coordinate[0] + step, coordinate[1])
result_dx = get_displacement(coordinate_dx)
if math.isnan(result_dx):
return (0.0, 0.0, True)
coordinate_dy = (coordinate[0], coordinate[1] + step)
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result_dy = get_displacement(coordinate_dy)
if math.isnan(result_dy):
return (0.0, 0.0, True)
max_utot = 0.0
coordinate_at_max = (0.0, 0.0)
coordinate = (0.0, 0.0)
done = False
while not done:
utot = get_displacement(coordinate)
if math.isnan(utot):
break
max_utot = max(utot, max_utot)
coordinate_at_max = coordinate
dutot_dx, dutot_dy,
#Get new coordinate
coordinate = (
coordinate[0] +
coordinate[1] +

done = get_walk_direction(coordinate, utot)
with sign of partial derivatives.
math.copysign(step, dutot_dx),
math.copysign(step, dutot_dy))

unit_length = g_i.GeneralInfo.UnitLength
print("Found coordinate ({0} {3}, {1} {3}). "
"With a displacement of: {2} {3}".format(
coordinate_at_max[0], coordinate_at_max[1], max_utot, unit_length))

Receiving an image in the scripting layer created by Output
from plxscripting.easy import new_server
s_o, g_o = new_server('localhost', 10000, password='yourpassword')
newest_plot = g_o.Plots[-1]
newest_plot.ResultType = g_o.ResultTypes.Soil.Utot
newest_plot.PlotType = 'shadings'
newest_plot.Phase = g_o.Phases[-1]
#image_wrapper is an object that can save the created
#image or, if Pillow is installed, you can get the internal
#Pillow.Image object and use that.
image_wrapper = newest_plot.export(1600, 1200)
try:

from PIL import ImageFilter
pil_image = image_wrapper.image
new_image = pil_image.filter(ImageFilter.BLUR)
new_image.save("test.png")
except ImportError:
#Just save if we don't have Pillow
image_wrapper.save("test.png")

A class that can be used to quickly create simple projects
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The following code demonstrates a possible approach to building a model template class, that can be tweaked in
subclasses in order to create model variants without duplicating large amounts of code. Other examples in this
document will build upon this class. Make sure you save it as "simple\_project.py" in the same directory where
you save the examples that need it.
imoprt os
import subprocess
INPUT_SERVER_PORT = 10000
PLAXIS_PATH = r"C:\Program Files\Plaxis\PLAXIS 2D"
class SimpleProject(object):
"""
Class that provides a way to quickly setup a project for example purposes.
"""
def __init__(self, g_i):
from plxscripting.easy import new_server
self._new_server = new_server
args = [os.path.join(plaxis_path, "Plaxis2DXInput.exe"),
"--AppServerPort={}".format(INPUT_SERVER_PORT)]
self._input_process = subprocess.Popen(args)
self._s_i, self._g_i = self._new_server(
'localhost', 10000, password='yourpassword', timeout=10.0)
def gather_results(self):
raise NotImplementedError("Override gather_results in subclass.")
def output_results(self):
raise NotImplementedError("Override output_results in subclass.")
def close_input(self):
self._input_process.kill()
@property
def g_i(self):
return self._g_i
def add_soil_layers(self):
raise NotImplementedError("Override add_soil_layers in subclass.")
def apply_soil_material(self):
SAND_PARAMETERS = [
('MaterialName', 'Sand'),
('Colour', 10676870),
('SoilModel', 3), # Hardening soil
('DrainageType', 'Drained'),
('gammaUnsat', 17),
('gammaSat', 20),
('E50ref', 43000),
('EoedRef', 28000),
('EurRef', 129000),
('powerm', 0.5),
('cref', 1),
('phi', 34.0),
('psi', 4.0),
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('nu', 0.2),
('Rinter', 0.7),
('KONC', 0.5),
('OCR', 1.0),
('POP', 0.0)

]
sand = self._g_i.soilmat(*SAND_PARAMETERS)
for soil_layer in self._g_i.SoilLayers:
self._g_i.setmaterial(soil_layer, sand)
def add_structures(self):
pass # Not adding any plates is fine too.
def apply_plate_materials(self):
DIAPHRAGM_WALL_PARAMETERS = [
('MaterialName', 'Wall'),
('Colour', 16711680),
('Elasticity', 0), # Elastic
('IsIsotropic', True),
('IsEndBearing', True),
('EA', 12000000),
('EI', 120000),
('nu', 0.15),
('d', 0.34641),
('w', 8.3),
('Mp', 1000000000000000.0),
('Np', 10000000000.0),
('Np2', 10000000000.0),
('RayleighAlpha', 0),
('RayleighBeta', 0),
('Gref', 15061311)
]
diaphragm_wall_material = self._g_i.platemat(*DIAPHRAGM_WALL_PARAMETERS)
for plate in self._g_i.Plates:
self._g_i.setmaterial(plate, diaphragm_wall_material)
def mesh(self):
self._g_i.gotomesh()
self._g_i.mesh(0.06)
def select_curve_points(self):
pass # Not selecting any curve-points is fine too.
def configure_phases(self):
raise NotImplementedError("Override configure_phases in subclass.")
def make_project(self):
self.add_soil_layers()
self.apply_soil_material()
self.add_structures()
self.apply_plate_material()
self.mesh()
self.select_curve_points()
self.configure_phases()
self._g_i.calculate()
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def run(project_class):
# Replace with the path to your PLAXIS installation.
project = project_class(r"c:\Program Files (x86)\Plaxis\PLAXIS 2DX")
project.make_project()
project.gather_results()
project.output_results()
project.close_input()

Create a csv file from curve results
This example must be saved in the same directory as the "simple\_project.py" module created in a previous
paragraph.
import sys
import csv
from simple_project import SimpleProject, run
class ExportCSVProject(SimpleProject):
def add_soil_layers(self):
self._g_i.SoilContour.initializerectangular(0, 0, 100, 30)
borehole = self._g_i.borehole(0)
self._g_i.soillayer(0)
self._g_i.setsoillayerlevel(borehole,
self._g_i.setsoillayerlevel(borehole,
self._g_i.soillayer(0)
self._g_i.setsoillayerlevel(borehole,
self._g_i.soillayer(0)
self._g_i.setsoillayerlevel(borehole,
borehole.Head = 23

0, 30)
1, 27)
2, 15)
3, 0)

def add_structures(self):
self._g_i.gotostructures()
self._g_i.plate(40, 30, 40, 14)
self._g_i.plate(60, 30, 60, 14)
for plate in self._g_i.Plates:
self._g_i.posinterface(plate.Parent)
self._g_i.neginterface(plate.Parent)
self._g_i.lineload(28, 30, 38, 30)
def select_curve_points(self):
output_port = self._g_i.selectmeshpoints()
s_o, g_o = self._new_server('localhost', output_port, password='yourpassword')
g_o.addcurvepoint('node', 40, 30, -1, 0)
g_o.update()
def configure_phases(self):
self._g_i.gotostages()
self._g_i.activate(self._g_i.LineLoads, self._g_i.InitialPhase)
self._g_i.activate(self._g_i.Plates, self._g_i.InitialPhase)
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self._g_i.activate(self._g_i.Interfaces, self._g_i.InitialPhase)
self._g_i.deactivate(
self._g_i.SoilPolygons[1], self._g_i.InitialPhase)
line_load = self._g_i.LineLoads[0]
current_phase = self._g_i.InitialPhase
line_load.qy_start[current_phase] = 0.0
for i in range(1, 10):
current_phase = self._g_i.phase(current_phase)
self._g_i.setcurrentphase(current_phase)
line_load.qy_start[current_phase] = -10.0 * i
def gather_results(self):
output_port = self._g_i.view(self._g_i.InitialPhase)
s_o, g_o = self._new_server('localhost', output_port, password='yourpassword')
self._results = []
# phaseID is only correct because we know the phases are in order!
for phaseID, phase in enumerate(g_o.Phases):
if phaseID == 0:
# Skip the initial phase and just write 0, because getcurveresults
# won't return any results for it.
self._results.append({
'phaseID': 0,
'displacement': 0
})
else:
displacement_string = g_o.getcurveresults(g_o.Nodes[0],
phase, g_o.ResultTypes.Soil.Utot)
self._results.append({
'phaseID': phaseID,
'displacement': displacement_string
})
g_o.update()
def output_results(self):
# Prevent excess newlines.
if sys.version_info.major == 2:
file_kwargs = { 'mode': 'wb' }
else:
file_kwargs = { 'mode': 'w', 'newline': '' }
# By default the csv writers will separate values with a comma and the
# period will be used as the decimal separator.
# However, this might be problematic when trying to import a csv file
# on a system that uses comma as the decimal separator.
# In these cases do the following:
# - import the locale modules and call: locale.setlocale(locale.LC_ALL, '')
# - get the correct separator with: locale.localeconv()['decimal_point']
# - replace the period in the output results with the correct separator
# - use a different csv dialect (see Python docs) so the comma isn't used
#
as the column separator.
with open("results.csv", **file_kwargs) as csv_file:
writer = csv.DictWriter(csv_file, fieldnames=['phaseID', 'displacement'])
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for row in self._results:
writer.writerow(row)
if __name__ == '__main__':
run(ExportCSVProject)

Create a combined image of the mesh for two different phases
This example must be saved in the same directory as the simple\_project.py module created in a previous
paragraph.
from simple_project import SimpleProject, run
from PIL import Image, ImageFont, ImageDraw
class ExportPlotProject(SimpleProject):
def add_soil_layers(self):
self._g_i.borehole(0)
self._g_i.soillayer(4)
def add_structures(self):
self._g_i.gotostructures()
self._g_i.plate(6, 0, 6, -2)
self._g_i.pointload(self._g_i.Points[0])
self._g_i.PointLoads[0].Fy = -10
def configure_phases(self):
self._g_i.gotostages()
self._g_i.activate(self._g_i.Plates, self._g_i.InitialPhase)
next_phase = self._g_i.phase(self._g_i.InitialPhase)
self._g_i.activate(self._g_i.PointLoads, next_phase)
def gather_results(self):
width, height = 800, 600
output_port = self._g_i.view(self._g_i.InitialPhase)
s_o, g_o = self._new_server('localhost', output_port, password='yourpassword')
# Hide everything except the mesh itself.
g_o.Plots[0].DrawFrame = False
g_o.Plots[0].DrawTitle = False
g_o.Plots[0].DrawLegend = False
g_o.Plots[0].DrawAxes = False
g_o.Plots[0].Phase = g_o.InitialPhase
self._initial_phase_image = g_o.Plots[0].export(width, height)
g_o.Plots[0].Phase = g_o.Phase_1
self._phase_1_image = g_o.Plots[0].export(width, height)
g_o.close()
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def output_results(self):
# Get Pillow.Image objects.
inner_initial_image = self._initial_phase_image.image
inner_phase_1_image = self._phase_1_image.image
assert inner_initial_image.size == inner_phase_1_image.size
cropping_left = (0, 0,
inner_initial_image.width // 2, inner_initial_image.height)
left_image = inner_initial_image.crop(cropping_left)
cropping_right = (inner_phase_1_image.width // 2, 0,
inner_phase_1_image.width, inner_phase_1_image.height)
right_image = inner_phase_1_image.crop(cropping_right)
result_image = Image.new(
inner_initial_image.mode, inner_initial_image.size)
result_image.paste(left_image, cropping_left)
result_image.paste(right_image, cropping_right)
default_font = ImageFont.load_default()
drawing_context = ImageDraw.Draw(result_image)
initial_phase_ID = self._g_i.Phases[0].Identification.value
drawing_context.text((200, 160), initial_phase_ID,
font=default_font, fill=(0, 0, 0, 255))
phase_1_ID = self._g_i.Phases[1].Identification.value
after_text_size = default_font.getsize(phase_1_ID)
drawing_context.text((600 - after_text_size[0], 160),
phase_1_ID, font=default_font, fill=(0, 0, 0, 255))
result_image.save("plot_initial_vs_phase_1.png")
if __name__ == '__main__':
run(ExportPlotProject)

Create a matplotlib plot from a line cross-section
This example must be saved in the same directory as the simple\_project.py module created in a previous
paragraph.
from simple_project import SimpleProject, run
from matplotlib import pyplot
SAMPLE_COUNT = 16
class CrossSectionProject(SimpleProject):
def add_soil_layers(self):
self._g_i.borehole(0)
self._g_i.soillayer(4)
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def add_structures(self):
self._g_i.gotostructures()
self._g_i.lineload(5, 0, 7, 0)
def configure_phases(self):
self._g_i.gotostages()
self._g_i.activate(self._g_i.Plates, self._g_i.InitialPhase)
next_phase = self._g_i.phase(self._g_i.InitialPhase)
self._g_i.activate(self._g_i.PointLoads, next_phase)
def gather_results(self):
start = (0.0, -4.0)
end = (6.0, 0.0)
output_port = self._g_i.view(self._g_i.Phases[-1])
s_o, g_o = self._new_server('localhost', output_port, password='yourpassword')
# Assumes that start and end contain floats, will not work correctly
# with integers in Python 2.
step = [(e - s) / (SAMPLE_COUNT - 1) for e, s in zip(end, start)]
self._results = []
for i in range(SAMPLE_COUNT):
position = (start[0] + i * step[0], start[1] + i * step[1])
result_string = g_o.getsingleresult(g_o.Phases[-1],
g_o.ResultTypes.Soil.Utot, position)
# Check if position lies outside the mesh, it might make more sense
# to use 0 as the result for other result types.
if result_string == "not found":
raise Exception("Used getsingleresult for point outside mesh.")
self._results.append(float(result_string))
g_o.update()
def output_results(self):
pyplot.plot(range(len(self._results)), self._results, 'r')
pyplot.grid(True)
pyplot.show()
if __name__ == '__main__':
run(CrossSectionProject)
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H.1 Overview
PLAXIS provides an HTTP based API. This API allows a developer or user to do normal PLAXIS tasks such as
creating projects, firing regular commands as found on the existing command line, performing meshing and
calculations. In addition, unique representations of Plaxis objects can be retrieved, kept, and then used in later
operations, such as the fetching of their properties and methods, as well as calling methods. This provides
additional flexibility and power to the existing command line.
There are several categories of actions that can be performed via the HTTP API. Each of these have their own
URL path, as follows:
/environment

Start, close, recover or open projects

/commands

Fire regular PLAXIS command line commands and fetch any created objects

/members

Fetch the members of objects

/propertyvalues

Fetch the property values of objects

/namedobjects

Fetch existing objects by their command line names

/list

Fetch items from listable objects

/enumeration

Fetch all possible values of enumeration objects

/exceptions

Get information about exceptions that occurred outside the server requests

/tokenizer

Offers tokenization services

All request data must be encoded using UTF-8.

H.2 Object representations
Resources which create or retrieve objects return representations of those objects. These representations
comprise a Globally Unique Identifier (GUID), a type name, and a flag indicating whether the object is listable or
not. The JSON structure for this representation is as follows:
"guid": <string>
"islistable": <boolean>
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"ownerguid": <string>
"type": <string>
The server can recognise and retrieve information about objects contained within the PLAXIS project based on
that object's GUID. This means that, for example, a particular PLAXIS object can be created using the /commands
resource, and then later the values of that object's properties can be retrieved by sending that object's GUID in a
request to the /propertyvalues resource. The same GUID can be used in the creation of additional objects by
sending it in a request to the /commands resource. If the object is listable, sending the guid as part of a request to
the /list resource will enable access to the object's properties by index, and so on. The ownerguid is only
returned for objects that are intrinsic properties. It is the guid of the owning object.

H.3 Using a web browser to access the API
It is possible to perform a subset of the actions that are described below by using a browser address bar. This
can be useful for quickly viewing the data representations that are returned from the API.
There is a limitation to the complexity of queries that can be made in this mode, which means that certain
resources and actions are not possible. This includes the /list resource, and also the querying of specific named
properties in the /propertyvalues resource (however it is still possible to query all properties for an object using
a browser address bar).
Each resource description below includes an example action using the address bar.

H.4 HTTP API Resources
/environment
This resource is for managing projects. Creating, restoring, closing or opening a project are permitted. If a
project is opened, then a filename string is supplied for locating an existing project locally, or otherwise becomes
the name of a new project.
Note that it is not possible to save projects via this resource. Instead, fire a save command using the /commands
resource.
Method: POST
Data parameters
{
"action":
{
"name": *1 <string> from {"new", "open", "close", "restore"}*,
"filename": *1 <string>*
}
}
Data parameters example
{
"action":
{
"name": "open",
"filename": "my_plaxis_project.p2dx"
}
}
{
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"action":
{
"name": "close",
"filename": ""
}
}
Success responses
Code

Reason

200

OK

404 STATUS NOT FOUND

"Incorrect or unspecified action: [action-name]"

404 STATUS NOT FOUND

"Incorrect or unspecified file name, or not a valid
project: [filename]"

400 BAD REQUEST

"Syntax of request could not be understood by the
server."

415 UNSUPPORTED MEDIA TYPE

"Unsupported content-encoding of [encoding type]"

Example JSON request
payload = {"action": {"name": "new", "filename": ""}}
headers = {"content-type": "application/json"}
response = requests.post("/environment", data=json.dumps(payload), headers=headers)
Example browser request
http://localhost:8001/environment?action.name=new
http://localhost:8001/environment?
action.name=open&action.filename=my_plaxis_project.p2dx
/commands
This resource allows all standard commands (see command reference pages) to be run on an active PLAXIS
project. Any objects created as the result of commands are represented in the response.
The server can recognise and "translate" GUIDs that refer to existing objects, as part of the command string. This
means that it is possible to use GUIDs in the place of regular command line names to refer to other objects. This
is beneficial, because the names of objects may be changed over the lifetime of a project (e.g. using the rename
command), but the GUID remains fixed.
For example, it is possible to create a line between two existing points by referring to the GUIDs of those points
in the command string of a request:
line <guid1> <guid2>
Note that a command that fails on the command line will not result in an error response from the server. These
are treated as successful requests to the API. The server response indicates whether a command failed or not in
the 'success' field. (See example below.) Whether the command succeeded or not, the ' additionalinfo' field
indicates the response from that action as seen on the regular command line.
Method: POST
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Data parameters
{
"action":
{
"commands":
[
*{1, ...}[<string>]*
]
}
}
Data parameters example
{
"action":
{
"commands":
[
"point 1 2"
]
}
}
{
"action":
{
"commands":
[
"embeddedbeamrow 4 4 {860C1FC5-BDE1-4887-98A2-8FE20B61FCD5}"
]
}
}
{
"action":
{
"commands":
[
"bad"
]
}
}
Code

Reason

200

OK

Data
{
"commands":
[
{
"feedback":
{
"extrainfo": "Added Point_1",
"returnedobjects":
[
{
"islistable": true,
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"type": "Point",
"guid": "{860C1FC5-BDE1-4887-98A2-8FE20B61FCD5}"
}
],
"debuginfo": "",
"success": true,
"errorpos": -1
},
"command": "point 1 2"
}
]
}
{
"commands": [
{
"feedback": {
"extrainfo": "Added Point_3\r\nAdded Line_1\r\nAdded EmbeddedBeamRow_1",
"returnedobjects": [
{
"islistable": true,
"type": "Point",
"guid": "{92851C68-561A-4C21-9ACD-46F50905FD4E}"
},{
"islistable": true,
"type": "Line",
"guid": "{7DB7DF8E-1FE4-4624-A3D2-F682DB9C8F18}"
},{
"islistable": false,
"type": "EmbeddedBeamRow",
"guid": "{A678F396-C8F3-41EE-9A8E-5798BB0B6054}"
}],
"debuginfo": "",
"success": true,
"errorpos": -1
},
"command": "embeddedbeamrow 4 4 Point_1"
}]
}
Code

Reason

200

OK

Data
{
"commands":
[
{
"feedback":
{
"extrainfo": "Command \"bad\" is not recognized as a global command.
Check the spelling or try specifying a target object.",
"debuginfo": "",
"success": false,
"errorpos": 1
},
"command": "bad"
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}
]
}
Here the command returned an associative dictionary containing the 'ContentType'field. This will indicate what
the rest of the dictionary will contain. In this particular case where the 'ContentType'is 'image/png'the
dictionary will contain an additional 'data'field whose value is a base64 encoded PNG image.
The 'json'field does not necessarily have to be a dictionary, it can also be an integer or any other type allowed in
JSON.
Error responses
Code

Reason

400 BAD REQUEST

"Syntax of request could not be understood by the
server."

404 STATUS NOT FOUND

"Commands not specified"

405 METHOD NOT ALLOWED

"No active project"

415 UNSUPPORTED MEDIA TYPE

"Unsupported content-encoding of [encoding type]"

Example JSON request
payload = {"action": {"commands": ["point 1 2"]}
headers = {"content-type": "application/json"}
response = requests.post("/commands", data=json.dumps(payload), headers=headers)
Example browser request
http://localhost:8001/commands?action.commands=gotostages
/members
This resource fetches the members (properties and methods) of an existing object within PLAXIS, identified by
its GUID.
Property members are represented as objects.The type names of these objects are simplified in comparison to
their type names within PLAXIS 3D. This means that all 'Text' subtypes for instance will be simply described as
having a type of 'Text'. The same principle applies to numerical, boolean, enumeration and object types.
Method members are represented as names only.
Method: POST
Data parameters
{
"action":
{
"members":
[
*{1,...}[GUID string]*
]
}
}
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Data parameters example
{
"action":
{
"members":
[
"{68A2C1A7-924B-46C3-89DF-F597DAADC359}"
]
}
}
{
"action":
{
"members":
[
"bad"
]
}
}
Code

Reason

200

OK

Data
{
"queries": {
"{68A2C1A7-924B-46C3-89DF-F597DAADC359}": {
"extrainfo": "",
"success": true,
"properties": {
"z": {
"islistable": false,
"ownerguid": "{68A2C1A7-924B-46C3-89DF-F597DAADC359}",
"type": "Number",
"guid": "{5FCCF1CC-7576-4565-B931-DE54241EA21B}"
},
"y": {
"islistable": false,
"ownerguid": "{68A2C1A7-924B-46C3-89DF-F597DAADC359}",
"type": "Number",
"guid": "{D52CBED3-8C59-4967-A5BA-89ECE6E9BD94}"
},
"x": {
"islistable": false,
"ownerguid": "{68A2C1A7-924B-46C3-89DF-F597DAADC359}",
"type": "Number",
"guid": "{25DA6A75-4F25-42F3-9654-3672A93FCE1F}"
},
"Name": {
"islistable": false,
"ownerguid": "{68A2C1A7-924B-46C3-89DF-F597DAADC359}",
"type": "Text",
"guid": "{A4209590-9487-4B98-9966-34A6A58DBE2D}"
},
"Comments": {
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"islistable": false,
"ownerguid": "{68A2C1A7-924B-46C3-89DF-F597DAADC359}",
"type": "Text",
"guid": "{9430592C-7D5D-4735-B572-2B29C87FBF1F}"
}
},
"commands": [
"echo","__dump","commands","rename","set","info","__observers","setproperties","move","
rotate","rotateline"],
"commandlinename": "Point_1"
}
}
}
{
"queries": {
"{0D04D0CB-86BF-4430-882C-FA56E45DF7AB}": {
"extrainfo": "GUID does not refer to object in registry: {0D04D0CB-86BF-4430-882CFA56E45DF7AB}",
"success": false
}
}
}
{
"queries": {
"bad": {
"extrainfo": "Supplied string is not a valid GUID: bad",
"success": false
}
}
}
Error responses
Reason

Code
400 BAD REQUEST

"Syntax of request could not be understood by the
server."

404 STATUS NOT FOUND

"No GUIDs specified"

405 METHOD NOT ALLOWED

"No active project"

415 UNSUPPORTED MEDIA TYPE

"Unsupported content-encoding of [encoding type]"

Example JSON request
payload = {"action": {"members": ["{9C5875EE-ABA4-4DC2-9E81-1FF839215232}"]}}
headers = {"content-type": "application/json"}
response = requests.post("/members", data=json.dumps(payload), headers=headers)
Example browser request
http://localhost:8001/members?action.members={0D04D0CB-86BF-4430-882C-FA56E45DF7AB}
/propertyvalues
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This resource provides the current values of particular properties of PLAXIS objects. If a property is itself an
object (such as the point properties of a line), then it is represented as a full object. If a property is a primitive
value type, then the relevant primitive value is returned.
There are two ways of calling this resource. One is to supply just a guid of the owner object, in which case all
properties of this object are represented in the response. The other way is to supply not just the owner guid, but
also a property name and an optional phase parameter. Such a structure is treated as a request for one single
property. If that property is staged, and the supplied phase guid is valid, then the value for that property and
phase is returned.
Method: POST
Data parameters
{
"action":
{
"propertyvalues":
[*{1} GUID string*]
}
}
{
"action":
{
"propertyvalues":
{
"owner": *{1} GUID string*
("phaseguid: *{1} GUID string*)
}
}
}
Data parameters example
{
"action":
{
"propertyvalues":
["{D4981EA8-EC07-471D-A8C3-7510B4F74F25}"]
}
}
{
"action":
{
"propertyvalues":
{
"owner": "{D4981EA8-EC07-471D-A8C3-7510B4F74F25}"
"propertyname": "Active"
"phaseguid": "{C3581EA8-FB07-5344-A8C3-569359320603}"
}
}
Success responses
{
"queries": {
"{D4981EA8-EC07-471D-A8C3-7510B4F74F25}": {
"extrainfo": "",
"success": true,
"properties": {
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"Second": {
"islistable": true,
"type": "Point",
"guid": "{A67959C9-C12D-41D6-8136-52C1E5711165}"
},
"Length": 6.92820323027551,
"First": {
"islistable": true,
"type": "Point",
"guid": "{4B889C3F-7F5C-4611-8D31-F4A39C71B11A}"
},
"Name": "Line_1",
"Comments": ""
}
}
}
}
{
"queries":
{
"{A10835D7-AE38-449C-BF67-6C9CE22705BD}":
{
"extrainfo": "",
"properties": {"Comments": ""},
"success": true
}
}
}
Error responses
Reason

Code
400 BAD REQUEST

"Syntax of request could not be understood by the
server."

404 STATUS NOT FOUND

"No GUIDs specified"

405 METHOD NOT ALLOWED

"No active project"

415 UNSUPPORTED MEDIA TYPE

"Unsupported content-encoding of [encoding type]"

Sample JSON request
payload = {"action": {"propertyvalues": ["{9C5875EE-ABA4-4DC2-9E81-1FF839215232}"]}}
headers = {"content-type": "application/json"}
response = requests.post("/propertyvalues", data=json.dumps(payload), headers=headers)
Sample browser request
http://localhost:8001/propertyvalues?action.propertyvalues={0D04D0CB-86BF-4430-882CFA56E45DF7AB}
/namedobjects
Supplies a representation of objects within PLAXIS 3D which are identified by their command line name. This is
useful when accessing internal lists of objects within Plaxis with known names, such as lists of particular user
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features or geometric objects. This resource can also be used to retrieve unique representations of objects for
which the command line name is known, such as 'Point1'.
Method: POST
Data parameters
Example Request:
{
"action":
{
"namedobjects":
[
"namedobjects": ["Points"]
]
}
}
{
"action":
{
"namedobjects":
[
"namedobjects": ["Plate_1"]
]
}
}
Code

Reason

200

OK

Data
{
"namedobjects": {
"Points": {
"extrainfo": "",
"success": true,
"returnedobject": {
"islistable": true,
"type": "ModelGroup",
"guid": "{32871FF1-809C-470A-94B0-4B56B28BC67B}"
}
}
}
}
Code

Reason

200

OK

Data
{
"namedobjects": {
"Plate_1": {
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"extrainfo": "",
"success": true,
"returnedobject": {
"islistable": false,
"type": "Plate",
"guid": "{C0C4EDA6-DFF7-4593-A280-A1EC20D5EADD}"
}
}
}
}
Code

Reason

400 BAD REQUEST

"Syntax of request could not be understood by the
server."

404 STATUS NOT FOUND

"No object names specified"

405 METHOD NOT ALLOWED

"No active project"

415 UNSUPPORTED MEDIA TYPE

"Unsupported content-encoding of [encoding type]"

Sample browser request
http://localhost:8001/namedobjects?action.namedobjects=Lines
http://localhost:8001/namedobjects?action.namedobjects=Phases
/list
Provides the ability to perform read operations on lists within PLAXIS 3D, such as getting values at particular
indices, finding the number of objects in the list, and filtering.
Method: POST
Data parameters
Example request:
{"action": {"listqueries": [{"guid": "{CF1DECEB-A28D-4609-B38C-8D3FF5E573A1}",
"method": "sublist",
"startindex": 0,
"stopindex": 1]}}
{"action": {"listqueries": [{"guid": "{CF1DECEB-A28D-4609-B38C-8D3FF5E573A1}",
"method": "count"]}}
{"action": {"listqueries": [{"guid": "{CF1DECEB-A28D-4609-B38C-8D3FF5E573A1}",
"method": "index",
"startindex": 0]}}
Success responses
{"listqueries": [{"extrainfo": "",
"guid": "{CF1DECEB-A28D-4609-B38C-8D3FF5E573A1}",
"methodname": "sublist",
"outputdata": [{"guid": "{81A754C8-1393-48BA-AD6E-5F6953F9FBE7}",
"islistable": true,
"type": "Point"}],
"startindex": 0,
"stopindex": 1,
"success": true}]}
{"listqueries": [{"extrainfo": "",
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"guid": "{CF1DECEB-A28D-4609-B38C-8D3FF5E573A1}",
"methodname": "count",
"outputdata": 5,
"success": true}]}
{"listqueries": [{"extrainfo": "",
"guid": "{CF1DECEB-A28D-4609-B38C-8D3FF5E573A1}",
"methodname": "index",
"outputdata": [{"guid": "{81B754C8-1353-48BA-AD6E-5A6953F9CBE5}",
"islistable": true,
"type": "Point"}],
"success": true}]}
Error responses
Code

Reason

400 BAD REQUEST

"Syntax of request could not be understood by the
server."

405 METHOD NOT ALLOWED

"No active project"

415 UNSUPPORTED MEDIA TYPE

"Unsupported content-encoding of [encoding type]"

Sample browser request
Not currently possible to call this resource via the browser address bar.
/enumeration
Provides a list of all possible enumeration values of one or more enumeration objects, when supplied with their
GUIDs.
Success responses
Code

Reason

200

OK

Data
{
"queries": {
"{31AFFD41-0EB4-4A67-94F4-298642E17507}": {
"extrainfo": "",
"success": true,
"enumvalues": {
"hinged": 1,
"free": 2,
"rigid": 0
}
}
}
}
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Data
{
"queries": {
"{0B4774CE-3307-4B86-B644-BFDE82CF3AAA}": {
"extrainfo": "GUID does not refer to object in registry:
{0B4774CE-3307-4B86-B644-BFDE82CF3AAA}",
"success": false
}
}
}
Code

Reason

200

OK

Data
{
"queries": {
"{C896C54E-1CBA-4B0F-9987-E1FF57A9131E}": {
"extrainfo": "Guid {C896C54E-1CBA-4B0F-9987-E1FF57A9131E} does not refer to
an enumeration intrinsic property type.",
"success": false
}
}
}
Error responses
Code

Reason

400 BAD REQUEST

"Syntax of request could not be understood by the
server."

405 METHOD NOT ALLOWED

"No active project"

415 UNSUPPORTED MEDIA TYPE

"Unsupported content-encoding of [encoding type]"

/exceptions
Exceptions that occur during execution of a server request are automatically caught and returned as error result
in the response of that request. Exceptions however may also happen independently of the requests, e.g. because
a problem during repainting. In such situations, an exception message box may be displayed by the application.
This resource allows access to information about this type of exceptions.
The getlast variant will clear the last exception message on the server, while the peeklast variant will leave it in
place.
Method: POST
Data parameters
{
"action":
{
"name": *1 <string> from {"getlast", "peeklast"}*
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}
}
Data parameters example
{
"action":
{
"name": "getlast"
}
}{
"action":
{
"name": "peeklast"
}
}
Success responses
Code

Reason

200

OK

Data
{
"exceptions": [
"date/time : 2015-04-17, 16:09:46, 750ms\r\ncomputer name : PC075\r\nwts client
name : ...etc..."
]
}
Error responses
Code

Reason

400 BAD REQUEST

"Syntax of request could not be understood by the
server."

415 UNSUPPORTED MEDIA TYPE

"Unsupported content-encoding of [encoding type]"

payload

"action": "name": "getlast"

headers

"content-type": "application/json"

response

requests.post("/exceptions",
data=json.dumps(payload)

headers

headers)

Example browser request
http://localhost:8001/exceptions?action.name=getlast
/tokenizer
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Allows parsing a command line string into the separate tokens according to the PLAXIS command line language.
A token is a sequence of one or more characters that together form a basic indivisible entity of source code.
Each token has the following properties:
• type: indicates what type of token it is (see list below)
• value: which is the parsed representation of the item (e.g. the token consisting of the characters 10 will
resolve to be of integer type with value 10).
• position: indicates the start position of the token in the original string (0-based)
• length: the number of characters the token consumed from the original string
The following types of tokens exist:
• identifier: something that will act either as command or as object identifier
• comment: a piece of comment, i.e. a sequence of characters starting with # up to the end of the string. The
value of the token includes the starting # sign.
• content: e.g. running in the case of #running
• externalinterpreter: a line that should be executed by an external interpreter, e.g. /output echo Points. The
value of the token includes the starting / sign. It has three additional properties:
• interpretername: e.g. output in the case of /output echo Points
• externalcommand: e.g. echo Points in the same case
• content: e.g. output echo Points in the case of output echo Points
• operand tokens:
• bracket: identifies a bracket type. Bracket tokens have additional properties:
• brackettype: can be round, square, curly for (), [], {} respectively
• bracketstate: can be open or close for ([{respectively )]}
• member: used to separate an object from its members (e.g. the . in Line\_1.Beam)
• comma, plus, minus, multiplier, divider, assign: currently unused, but they are the ,, +,-,*,/,=operands
respectively
• numerical tokens:
• integer: represents a number that can be represented by a 32-bit signed integer
• float: represents a number that can be represented as a floating point value
Method: POST
Data parameters
{
"action":
{
"tokenize":
[
*{1,...}[string]*
]
}
}
Data parameters example
{
"action":
{
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"tokenize":
[
"point 10"
]
}
}
{
"action":
{
"tokenize":
[
"point 10", "point 8"
]
}
}
{
"action":
{
"tokenize":
[
"a ?"
]
}
}
Success responses
Code

Reason

200

OK

{
"tokenize":
[
{
"tokens": [
{"position": 0,
"length": 5,
"type": "identifier",
"value": "point"},
{"position": 6,
"length": 2,
"type": "integer",
"value": 10},
],
"success": true,
"extrainfo": "",
"errorpos": -1
},
"tokenize": "point 10"
}
]
}
Data
{
"tokenize":
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[
{
"tokens": [
{"position": 0,
"length": 1,
"type": "identifier",
"value": "a"},
],
"success": false,
"extrainfo": "Unrecognized token",
"errorpos": 2
},
"tokenize": "a ?"
}
]
}
Error responses
Code

Reason

400 BAD REQUEST

"Syntax of request could not be understood by the
server."

415 UNSUPPORTED MEDIA TYPE

"Unsupported content-encoding of [encoding type]"

Example JSON request
payload = {"action": {"name": "getlast"}
headers = {"content-type": "application/json"}
response = requests.post("/exceptions", data=json.dumps(payload), headers=headers)
Example browser request
http://localhost:8001/tokenizer?action.tokenize=point%201
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Calculation warning and errors in PLAXIS
The errors that may occur while using PLAXIS.
Table 23: Warnings

PLAXIS

Error code

Message

Hint

10

PICOS solver was used instead of PARDISO
due to lack of memory.

Install more RAM in your computer

9

Different stress type was used in the
previous phase.

In the previous phase, a different stress
type (Terzaghi stress or Bishop stress) was
used. Please check your input.

8

Internally changes in setting: Updated
mesh is selected.

Due to settings of previous phase(s), the
updated mesh option was selected in the
calculation.

7

Free field cannot be used in an
axisymmetric geometry

Free field boundaries cannot be used in
axisymmetric models (2D).

6

Dynamic loads applied on free field base
elements are moved to main domain by
kernel

Dynamic loads that where applied on a free
field boundary will be applied directly on
the elements inside the model.

5

One or more Tension of Mohr-Coulomb
points found

Inspect Output for the Initial phase (K0
procedure) and check the K0 values for the
materials in which the plastic points occur
as well

4

Static loads have been changed in a
dynamic analysis

The value for a static load has been
changed in a dynamic analysis. Please recheck your load values if this was
unintentional.

3

Prescribed ultimate state fully reached.
Non-zero static prescribed displacements
are ignored

Non-zero static prescribed displacements
were ignored.
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Error code
2

Message

Hint

Prescribed ultimate state fully reached.
Unfinished construction stage. Next
calculation must be staged construction

For this phase a Σ Mstage < 1 was defined.
The next phase should be staged
construction.

Table 24: Errors
Error code
0

Message

Hint

OK.

Calculation succeeded and converged

1, 8, 9

Stiffness matrix too big for reserved RAM
memory

Decrease model size. If the problem
persists, install more RAM in your
computer

2, ...., 7

Decrease model size. If the problem
Problem too big for reserved RAM memory persists, install more RAM in your
computer

10

Deformation not compatible in STRESBL

Sometimes in Updated mesh calculations it
may happen that elements are turned
'inside out'. Inspect the results. It might
help to increase the stiffness in the
problem area.
The determinant is zero or nearly zero.
Causes for this could be:

11, 16

12

Material set not found.

Check if all assigned materials (soils and
structural elements) are available and
defined

13

Water weight is zero

Check the project's water weight

Deformation not compatible in GLBMB.

A (very) large deformation occurred in a
(2D) beam, resulting in a too large
curvature. Try to force smaller steps by
using smaller load increments and/or a
tighter tolerance (or use smaller DSC max
value)

14

PLAXIS

Determinant is zero or nearly zero.

• Bad mesh quality. (elements with low
quality). This can be reviewed in the
generated mesh (Mesh ->Quality)
• Missing boundary conditions. Review
the boundary conditions for this phase
• Floating (unconnected) clusters/
volumes
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Error code

Message

Hint
This is usually the result of one of these
two causes (or a combination):

15

Jacobian matrix is less than or nearly zero.

• Badly shaped elements: good elements
are those with the same size for width,
length and height of the element. Please
inspect the mesh quality.
• Large stiffness differences. For
numerical reasons, the stiffness values
in the model may not differ too much
(e.g. a ratio larger than 106 between the
lowest stiffness and the highest stiffness
should be avoided).
Stiffness matrix is nearly singular and
cannot be solved. & Causes for this could
be:

17, 19, 20

24

Material set with zero permeability found,
but not allowed in this type of calculation.

Groundwater flow and consolidation
calculations require non-zero permeability
in all elements. Check materials and add
permeability value: ki > 0

25

Groundwater weight is zero.

Check the project's water weight

26

Unable to load dll. <param1>

Check the presence of user defined soil
models dll files in the program folder.
<param1> is the name of the file.

File not found. <param1>

A file needed for the calculation was not
found. Regenerating the mesh could solve
it. If not, please send it to support.
<param1> is the name of the missing file.

27

PLAXIS

Stiffness matrix is nearly singular and
cannot be solved.

• Bad mesh quality. (elements with low
quality). This can be reviewed in the
generated mesh (Mesh ->Quality).
• Large stiffness differences. For
numerical reasons, the stiffness values
in the model may not differ too much
(e.g. a ratio larger than 106 between the
lowest stiffness and the highest
stiffness) should be avoided.
• A combination of the two above.
• Missing boundary conditions. Review
the boundary conditions for this phase.
• Floating/unconnected clusters/
volumes.
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Error code

Message

Hint

28

Peak plastic shear strain is too low.

NGI-ADP model, UDCAM-S model: γpeak
value(s) nearly zero. Please check the input
values. Note that the value is expressed in
percent (%).

29

Error factorization matrix

Check for floating clusters or insufficient
boundary conditions.

30

Number of dynamic sub-steps is ZERO.

The defined value for dynamic substeps is
zero. To solve it, increase the number of
dynamic substeps (see iterative settings).

31

Error backsub matrix.

Internal error. Please send the PLAXIS
project to support.

32

Memory allocation error.

There is not enough memory available.
An internal error occurred. It could be one
of these causes:

33

Internal error. Please, pack this project
using Pack project and send to support

• Zero length of embedded beam row in
2D. Update version and remesh.
• An error with free field boundaries.
Please check the input
For any other cause, please send the
PLAXIS 3D project to support

PLAXIS

34

Ultimate state not reached in GW-Flow
analysis.

The groundwater flow calculation did not
converge. Please check the input
parameters and the phase settings.

35

No critical time step found; no draining
boundaries

Check boundary conditions. It could be that
all boundaries are closed.

36

NaN found in an element stiffness matrix.

(NaN = Not a Number) Causes could be
elements with a zero area or bad material
parameters

37

DeAllocation memory error.

Internal error. Please send the PLAXIS
project to support.

38

Invalid plate material table.

Check non-linear structural materials
datasets.

39

NaN found during calculation, probably
severe divergence.

(NaN = Not a Number). This could be
caused by bad input parameters. If the
problem persists, please send the PLAXIS
project to support.
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Error code

PLAXIS

Message

Hint

40

Severe divergence.

The global error grew too large in the
calculation ((> 106)). This could be related
to bad input for soil parameters. Please
check the model in the last step to identify
the problem area. Otherwise, please send
the PLAXIS project to support.

41

0
K nc
≃ 0 in Sekiguchi-Ohta model, please
correct.

Re-evaluate Sekiguchi-Ohta model material
datasets.

42

Water file does not exist. <param1>

2D2011/2D2012: Please regenerate water
conditions file by opening staged
construction, generate water pressures and
then press update. If more than one phase
has this problem, regenerating the mesh
might solve it faster for all phases.

43

Not proper Newmark coefficients.

Re-evaluate Newmark coefficients.

44

No drift correction for unequal time steps.

Drift correction is based on equal time
steps. Create a table of equal time steps or
switch off drift correction

45

At least 2 data points are needed for drift
correction.

Drift correction needs at least 2 data
points. Increase the number of data points
or switch off drift correction.

46

Time must be increasing in a tabular
multiplier function.

Re-evaluate dynamic multiplier tables:
time must be increasing each time step

47

Invalid material parameter set. <param1>

Re-evaluate the mentioned material
parameter set.

48

Error in reading flow communication file.
<param1>

File <param1> not found, probably
something went wrong in flow calculation
or flow calculation is very slow. Usually
this is solved by decreasing differences in
permeabilities.

49

non-zero dynamic load without multiplier.

Please assign a dynamic multiplier function
to all dynamic loads

50

non-zero dynamic displacement without
multiplier.

Please assign a dynamic multiplier function
to all dynamic loads

51

Gravitational acceleration (g) is zero.

Re-evaluate the gravitational acceleration
in the project properties
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Hint

52

Both left and right hand side free field
boundaries must be active.

Activate both sides of the free field
boundaries

53

Number of nodes on lateral boundaries
must be equal to tie their degrees of
freedom.

Regenerate the mesh to match this
criterion. Make sure the left and right side
of the geometry are identical.

54

Redefine an Updated mesh state for prior
Parent phase uses updated mesh while this phases, or reset displacements to zero for
type of calculation does not support
this phase. Note that displacements cannot
updated mesh.
be reset to zero after an updated mesh
analysis.

101

Soil body collapses

The program has detected soil failure.
Please evaluate the calculation results in
Output to show why it fails

102

Not enough load steps.

Increase the value assigned to the Max
steps parameter.

Load advancement procedure fails.

The program has detected numerical
problems. Please inspect the input data and
the calculation results in Output to
evaluate why it fails.

Prescribed ultimate time not reached.

Prescribed time interval in a consolidation
analysis is not reached. Probably due to
soil failure. Please inspect the input data
and the calculation results in Output to
evaluate why it fails.

105

Prescribed minimum excess pore pressure
not reached.

Prescribed minimum excess pore pressure
in a consolidation analysis is not reached.
Probably due to soil failure. Please inspect
the input data and the calculation results in
Output to evaluate why it fails.

107

Prescribed ultimate level Σ Msfsf not
reached

Increase the value assigned to the Max
steps parameter.

110

Accuracy condition not reached in last step.

This could be solved by increasing the
value assigned to Max steps.

111

Soil body collapses. Accuracy condition not
Combination of 101 and 110.
reached in last step.

112

Not enough load steps. Accuracy condition
not reached in last step.

103

104

PLAXIS

Message
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Error code

Message

Hint

113

Not enough load steps. Load advancement
procedure fails. Accuracy condition not
reached in last step.

114

Prescribed ultimate time not reached.
Combination of 104 and 110.
Accuracy condition not reached in last step.

115

Prescribed minimum excess pore pressure
not reached. Accuracy condition not
reached in last step.

117

Prescribed ultimate level Σ Msfsf not
reached.

Combination of 103 and 110.

Combination of 105 and 110.

Combination of 107 and 110.

Accuracy condition not reached in last step.

PLAXIS

201

Picos_Dec: matrix type differs from initial
type

Internal error. Please send the PLAXIS
project to support.

202

Picos_Back: matrix type differs from initial
type.

Internal error. Please send the PLAXIS
project to support.

203

Picos_Prep: iDof > nDof.

Internal error. Please send the PLAXIS
project to support.

241

Unexpected problem. Please contact Plaxis.

Internal error. Please send your project to
support.

244

Unexpected problem. Please contact Plaxis.

Internal error. Please send your project to
support.

245

Unexpected problem. Please contact Plaxis.

Internal error. Please send your project to
support.

246

Programmer abort request. For more
details see the .Ixx or .Dxx file. <Params>

See the details in these files, or send your
project to support.

247

Complex error. For more details see
the .Ixx or .Dxx file. <Params>

See the details in these files, or send to
support.

248

Reference to non-existing material set.
Redefined staged construction phase.

Redefine staged construction for this phase
and check material assignments.

249

Not enough (virtual) memory

Decrease model size. If the problem
persists, install more RAM in your
computer

250

Mesh files does not exist.

Missing mesh data. Regenerate the mesh.
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Message

Hint

251

Use dt > 0 for dynamics.

Make sure that the time interval is larger
than 0: dt>0

252

Calculation results of previous phase do
not match the current mesh. Recalculate
the previous phase.

Recalculate the previous phase(s) to solve
it.

253

Disk (nearly) full.

Disk is full: clear some disk space or move
the calculation to a larger disk. Note: since
2012, all calculations are performed in the
Windows TEMP folder. That means that
there should be enough space available on
the drive where your TEMP folder is
installed.

254

Cancelled by user.

The user stopped the calculation.

255

Abort request from USER-subroutine.

This is caused by a programmer error in de
UDSM (user defined soil model) code.

256

Run-time-error in kernel.

This is caused by an undetermined error/
crash of the kernel (in the newer versions).
Please send the PLAXIS project to support.

501

Beam material set: ratio I3/I2 too large

Check beam material datasets for the ratio
I3/I2.

501

Beam material set: ratio I2/I3 too large

check beam material datasets for the ratio
I2/I3

1000

The results from the previous phase are
missing. Please recalculate the previous
phase.

Recalculate the previous phase.

I.1 Meshing errors
Errors such as invalid surface mesh or invalid element(s) found etc, that may occur during meshing can be
solved by taking into account the hint/solution provided in the command line.

I.2 Cyclic accumulation and optimization tool errors
The errors that may occur in the Cyclic accumulation tab:

PLAXIS
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Table 25: Errors that may occur in the Stress-strain curves tab
Error message

Hint

Too many strain contours, maximum is 150

It may occur when the user uploads custom contour
data for a number of contour lines larger than 150

The contour diagrams should be defined up to the
same maximum number of cycles

It indicates that the last point of each line of a custom
contour data should be defined at the same number of
cycles.

Interpolation problem, shear stress level =

The cyclic accumulation procedure could not be
successfully performed for a combination of wrong
load parcels data or custom contours.

Infinite slope, cannot interpolate

the cyclic accumulation procedure could not be
successfully performed for a combination of wrong
load parcels data or custom contours.

The errors that may occur in the Parameter optimisation tab:
Table 26: Exit codes, message printed in Optimization_results.txt and message shown in the GUI
Exit code

PLAXIS

Error message

1

Internal error, model is invalid

2

Optimisation file not indicated

3

Cannot load "hscapitr.dll"

4

"hscapitr.dll" is corrupt

5

Unknown search intensity is given

6

Cannot allocate memory

7

Internal error, PSWARM

8

Could not start optimisation. Check parameter ranges

9

Cannot find feasible points

10

Cannot find curve file

11

The curve phase information is incompatible with the test configuration

12

Cannot find optimisation input file

13

Material parameter index is outside of the range

14

Material parameter bounds are outside of the range
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Exit code

Error message

15

Cannot find VLC input file

16

Error in VLC input file

17

Wrong material parameter in curve file

18

Aborted by user

19

Small overlap curves

For the errors mentioned in table above, please send your project to support.
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